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This manual describes the following R&S®RTM models:

● R&S®RTM1052 (1305.0008K52)

● R&S®RTM1054 (1305.0008K54)

In addition to the base unit, the following options are described:

● R&S®RTM-K1 (1305.0295.02)

● R&S®RTM-K2 (1305.0308.02)

● R&S®RTM-K3 (1317.3065.02)

The firmware of the instrument makes use of several valuable open source software packages. For information, see the "Open Source
Acknowledgement" on the user documentation CD-ROM (included in delivery).
Rohde & Schwarz would like to thank the open source community for their valuable contribution to embedded computing.

© 2012 Rohde & Schwarz GmbH & Co. KG
Muehldorfstr. 15, 81671 Munich, Germany
Phone: +49 89 41 29 - 0
Fax: +49 89 41 29 12 164
E-mail: info@rohde-schwarz.com
Internet: http://www.rohde-schwarz.com
Subject to change – Data without tolerance limits is not binding.
R&S® is a registered trademark of Rohde & Schwarz GmbH & Co. KG.
Trade names are trademarks of the owners.

The following abbreviations are used throughout this manual: R&S®RTM is abbreviated as R&S RTM.
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Basic Safety Instructions 

Always read through and comply with the following safety instructions! 

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety 

standards of our products up to date and to offer our customers the highest possible degree of safety. Our 

products and the auxiliary equipment they require are designed, built and tested in accordance with the 

safety standards that apply in each case. Compliance with these standards is continuously monitored by 

our quality assurance system. The product described here has been designed, built and tested in 

accordance with the EC Certificate of Conformity and has left the manufacturer’s plant in a condition fully 

complying with safety standards. To maintain this condition and to ensure safe operation, you must 

observe all instructions and warnings provided in this manual. If you have any questions regarding these 

safety instructions, the Rohde & Schwarz group of companies will be happy to answer them. 

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed 

for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must 

not be used in any way that may cause personal injury or property damage. You are responsible if the 

product is used for any purpose other than its designated purpose or in disregard of the manufacturer's 

instructions. The manufacturer shall assume no responsibility for such use of the product.  

The product is used for its designated purpose if it is used in accordance with its product documentation 

and within its performance limits (see data sheet, documentation, the following safety instructions). Using 

the product requires technical skills and, in some cases, a basic knowledge of English. It is therefore 

essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be 

allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this 

will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions 

and the product documentation in a safe place and pass them on to the subsequent users. 

Observing the safety instructions will help prevent personal injury or damage of any kind caused by 

dangerous situations. Therefore, carefully read through and adhere to the following safety instructions 

before and when using the product. It is also absolutely essential to observe the additional safety 

instructions on personal safety, for example, that appear in relevant parts of the product documentation. In 

these safety instructions, the word "product" refers to all merchandise sold and distributed by the Rohde & 

Schwarz group of companies, including instruments, systems and all accessories. For product-specific 

information, see the data sheet and the product documentation. 

Safety labels on products 

The following safety labels are used on products to warn against risks and dangers. 

Symbol Meaning Symbol Meaning 

Notice, general danger location 

Observe product documentation 

ON/OFF supply voltage 

Caution when handling heavy equipment Standby indication 

Danger of electric shock Direct current (DC) 
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Symbol Meaning Symbol Meaning 

Warning! Hot surface Alternating current (AC) 

Protective conductor terminal Direct/alternating current (DC/AC) 

Ground Device fully protected by double (reinforced) 

insulation 

Ground terminal EU labeling for batteries and accumulators 

For additional information, see section "Waste 

disposal/Environmental protection", item 1. 

Be careful when handling electrostatic sensitive 

devices 

EU labeling for separate collection of electrical 

and electronic devices 

For additonal information, see section "Waste 

disposal/Environmental protection", item 2. 

Warning! Laser radiation 

For additional information, see section 

"Operation", item 7. 

 

Signal words and their meaning 

The following signal words are used in the product documentation in order to warn the reader about risks 

and dangers. 

Indicates a hazardous situation which, if not avoided, will result in death or 

serious injury. 

Indicates a hazardous situation which, if not avoided, could result in death or 

serious injury. 

Indicates a hazardous situation which, if not avoided, could result in minor or 

moderate injury. 

Indicates information considered important, but not hazard-related, e.g. 

messages relating to property damage. 

In the product documentation, the word ATTENTION is used synonymously.  

 

These signal words are in accordance with the standard definition for civil applications in the European 

Economic Area. Definitions that deviate from the standard definition may also exist in other economic 

areas or military applications. It is therefore essential to make sure that the signal words described here 

are always used only in connection with the related product documentation and the related product. The 

use of signal words in connection with unrelated products or documentation can result in misinterpretation 

and in personal injury or material damage. 
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Operating states and operating positions 

The product may be operated only under the operating conditions and in the positions specified by the 

manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are 

not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local 

or national safety regulations and rules for the prevention of accidents must be observed in all work 

performed.  

1. Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:  

predefined operating position is always with the housing floor facing down, IP protection 2X, use only 

indoors, max. operating altitude 2000 m above sea level, max. transport altitude 4500 m above sea 

level. A tolerance of ±10 % shall apply to the nominal voltage and ±5 % to the nominal frequency, 

overvoltage category 2, pollution severity 2. 

2. Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability 

are unsuitable for this purpose. Always follow the manufacturer's installation instructions when 

installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation 

that is not carried out as described in the product documentation could result in personal injury or 

even death. 

3. Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient 

temperature must not exceed the maximum temperature specified in the product documentation or in 

the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or 

even death. 

Electrical safety 

If the information on electrical safety is not observed either at all or to the extent necessary, electric shock, 

fire and/or serious personal injury or death may occur.  

1. Prior to switching on the product, always ensure that the nominal voltage setting on the product 

matches the nominal voltage of the AC supply network. If a different voltage is to be set, the power 

fuse of the product may have to be changed accordingly.  

2. In the case of products of safety class I with movable power cord and connector, operation is 

permitted only on sockets with a protective conductor contact and protective conductor. 

3. Intentionally breaking the protective conductor either in the feed line or in the product itself is not 

permitted. Doing so can result in the danger of an electric shock from the product. If extension cords 

or connector strips are implemented, they must be checked on a regular basis to ensure that they are 

safe to use. 

4. If there is no power switch for disconnecting the product from the AC supply network, or if the power 

switch is not suitable for this purpose, use the plug of the connecting cable to disconnect the product 

from the AC supply network. In such cases, always ensure that the power plug is easily reachable and 

accessible at all times. For example, if the power plug is the disconnecting device, the length of the 

connecting cable must not exceed 3 m. Functional or electronic switches are not suitable for providing 

disconnection from the AC supply network. If products without power switches are integrated into 

racks or systems, the disconnecting device must be provided at the system level. 

5. Never use the product if the power cable is damaged. Check the power cables on a regular basis to 

ensure that they are in proper operating condition. By taking appropriate safety measures and 

carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be 

hurt by, for example, tripping over the cable or suffering an electric shock.  
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6. The product may be operated only from TN/TT supply networks fuse-protected with max. 16 A (higher 

fuse only after consulting with the Rohde & Schwarz group of companies). 

7. Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the 

socket provided for this purpose. Otherwise, sparks that result in fire and/or injuries may occur.  

8. Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric 

shocks. 

9. For measurements in circuits with voltages Vrms > 30 V, suitable measures (e.g. appropriate 

measuring equipment, fuse protection, current limiting, electrical separation, insulation) should be 

taken to avoid any hazards. 

10. Ensure that the connections with information technology equipment, e.g. PCs or other industrial 

computers, comply with the IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 standards that apply 

in each case. 

11. Unless expressly permitted, never remove the cover or any part of the housing while the product is in 

operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the 

product. 

12. If a product is to be permanently installed, the connection between the protective conductor terminal 

on site and the product's protective conductor must be made first before any other connection is 

made. The product may be installed and connected only by a licensed electrician. 

13. For permanently installed equipment without built-in fuses, circuit breakers or similar protective 

devices, the supply circuit must be fuse-protected in such a way that anyone who has access to the 

product, as well as the product itself, is adequately protected from injury or damage. 

14. Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of 

lightning) can reach the product. Otherwise, the person operating the product will be exposed to the 

danger of an electric shock. 

15. Any object that is not designed to be placed in the openings of the housing must not be used for this 

purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries. 

16. Unless specified otherwise, products are not liquid-proof (see also section "Operating states and 

operating positions", item 1). Therefore, the equipment must be protected against penetration by 

liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product 

itself may be damaged, which can also lead to personal injury. 

17. Never use the product under conditions in which condensation has formed or can form in or on the 

product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water 

increases the risk of electric shock. 

18. Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network 

or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such 

as alcohol, acetone or diluents for cellulose lacquers. 

Operation 

1. Operating the products requires special training and intense concentration. Make sure that persons 

who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries 

or material damage may occur. It is the responsibility of the employer/operator to select suitable 

personnel for operating the products. 
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2. Before you move or transport the product, read and observe the section titled "Transport". 

3. As with all industrially manufactured goods, the use of substances that induce an allergic reaction 

(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a 

skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz 

product, consult a physician immediately to determine the cause and to prevent health problems or 

stress.  

4. Before you start processing the product mechanically and/or thermally, or before you take it apart, be 

sure to read and pay special attention to the section titled "Waste disposal/Environmental protection", 

item 1. 

5. Depending on the function, certain products such as RF radio equipment can produce an elevated 

level of electromagnetic radiation. Considering that unborn babies require increased protection, 

pregnant women must be protected by appropriate measures. Persons with pacemakers may also be 

exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces 

where there is a special risk of exposure to radiation and, if necessary, take measures to avert the 

potential danger. 

6. Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can 

cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and 

protective clothing must be worn. 

7. Laser products are given warning labels that are standardized according to their laser class. Lasers 

can cause biological harm due to the properties of their radiation and due to their extremely 

concentrated electromagnetic power. If a laser product (e.g. a CD/DVD drive) is integrated into a 

Rohde & Schwarz product, absolutely no other settings or functions may be used as described in the 

product documentation. The objective is to prevent personal injury (e.g. due to laser beams). 

8. EMC classes (in line with EN 55011/CISPR 11, and analogously with EN 55022/CISPR 22, 

EN 55032/CISPR 32) 

− Class A equipment:  

Equipment suitable for use in all environments except residential environments and environments 

that are directly connected to a low-voltage supply network that supplies residential buildings  

Note: Class A equipment is intended for use in an industrial environment. This equipment may 

cause radio disturbances in residential environments, due to possible conducted as well as 

radiated disturbances. In this case, the operator may be required to take appropriate measures to 

eliminate these disturbances. 

− Class B equipment: 

Equipment suitable for use in residential environments and environments that are directly 

connected to a low-voltage supply network that supplies residential buildings 

Repair and service 

1. The product may be opened only by authorized, specially trained personnel. Before any work is 

performed on the product or before the product is opened, it must be disconnected from the AC supply 

network. Otherwise, personnel will be exposed to the risk of an electric shock.  
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2. Adjustments, replacement of parts, maintenance and repair may be performed only by electrical 

experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant 

to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed 

after parts relevant to safety have been replaced (visual inspection, protective conductor test, 

insulation resistance measurement, leakage current measurement, functional test). This helps ensure 

the continued safety of the product.  

Batteries and rechargeable batteries/cells 

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the 

extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal 

injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g. 

lithium cells) must be handled in accordance with the EN 62133 standard. 

1. Cells must not be taken apart or crushed.  

2. Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided. 

Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth. 

3. Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a 

drawer where they can short-circuit each other, or where they can be short-circuited by other 

conductive materials. Cells and batteries must not be removed from their original packaging until they 

are ready to be used. 

4. Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted. 

5. If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If 

contact occurs, wash the affected area with plenty of water and seek medical aid. 

6. Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells) 

can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see 

parts list) in order to ensure the safety of the product.  

7. Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries 

and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the 

national regulations regarding waste disposal and recycling.  

Transport 

1. The product may be very heavy. Therefore, the product must be handled with care. In some cases, 

the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid 

back or other physical injuries.  

2. Handles on the products are designed exclusively to enable personnel to transport the product. It is 

therefore not permissible to use handles to fasten the product to or on transport equipment such as 

cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the 

means of transport or lifting. Observe the safety regulations of the manufacturer of the means of 

transport or lifting. Noncompliance can result in personal injury or material damage. 

3. If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely 

and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the 

product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the 

product in the vehicle to prevent injuries or other damage in the event of an accident.  
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Waste disposal/Environmental protection 

1. Specially marked equipment has a battery or accumulator that must not be disposed of with unsorted 

municipal waste, but must be collected separately. It may only be disposed of at a suitable collection 

point or via a Rohde & Schwarz customer service center. 

2. Waste electrical and electronic equipment must not be disposed of with unsorted municipal waste, but 

must be collected separately. 

Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and takes full responsibility for 

take-back obligations and disposal obligations for manufacturers within the EU. Contact your 

Rohde & Schwarz customer service center for environmentally responsible disposal of the product. 

3. If products or their components are mechanically and/or thermally processed in a manner that goes 

beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel) 

may be released. For this reason, the product may only be disassembled by specially trained 

personnel. Improper disassembly may be hazardous to your health. National waste disposal 

regulations must be observed.  

4. If handling the product releases hazardous substances or fuels that must be disposed of in a special 

way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the 

manufacturer of the hazardous substances or fuels and the applicable regional waste disposal 

regulations must be observed. Also observe the relevant safety instructions in the product 

documentation. The improper disposal of hazardous substances or fuels can cause health problems 

and lead to environmental damage. 

For additional information about environmental protection, visit the Rohde & Schwarz website. 

Instrucciones de seguridad elementales 

¡Es imprescindible leer y cumplir las siguientes instrucciones e informaciones de seguridad! 

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al día 

con los estándares de seguridad y de ofrecer a nuestros clientes el máximo grado de seguridad. Nuestros 

productos y todos los equipos adicionales son siempre fabricados y examinados según las normas de 

seguridad vigentes. Nuestro sistema de garantía de calidad controla constantemente que sean cumplidas 

estas normas. El presente producto ha sido fabricado y examinado según el certificado de conformidad 

de la UE y ha salido de nuestra planta en estado impecable según los estándares técnicos de seguridad. 

Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario deberá 

atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de empresas 

Rohde & Schwarz está siempre a su disposición en caso de que tengan preguntas referentes a estas 

informaciones de seguridad. 

Además queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto 

está destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente 

autorizado, para aplicaciones de campo y de ninguna manera deberá ser utilizado de modo que alguna 

persona/cosa pueda sufrir daño. El uso del producto fuera de sus fines definidos o sin tener en cuenta las 

instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna 

forma responsable de consecuencias a causa del mal uso del producto.  



Instrucciones de seguridad elementales 

1171.0000.42 - 07 Page 8 

Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las 

indicaciones de la correspondiente documentación del producto y dentro del margen de rendimiento 

definido (ver hoja de datos, documentación, informaciones de seguridad que siguen). El uso del producto 

hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener 

en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en 

profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el 

uso de productos de Rohde & Schwarz, encontraría la información debida en la documentación del 

producto en el capítulo correspondiente. Guarde bien las informaciones de seguridad elementales, así 

como la documentación del producto, y entréguelas a usuarios posteriores. 

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o daños por 

peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las 

siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del 

producto. Deberán tenerse en cuenta todas las demás informaciones de seguridad, como p. ej. las 

referentes a la protección de personas, que encontrarán en el capítulo correspondiente de la 

documentación del producto y que también son de obligado cumplimiento. En las presentes 

informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas 

Rohde & Schwarz bajo la denominación de "producto", entre ellos también aparatos, instalaciones así 

como toda clase de accesorios. Los datos específicos del producto figuran en la hoja de datos y en la 

documentación del producto. 

Señalización de seguridad de los productos 

Las siguientes señales de seguridad se utilizan en los productos para advertir sobre riesgos y peligros. 

Símbolo Significado Símbolo Significado 

Aviso: punto de peligro general 

Observar la documentación del producto 

Tensión de alimentación de PUESTA EN 

MARCHA / PARADA 

Atención en el manejo de dispositivos de peso 

elevado 

Indicación de estado de espera (standby) 

Peligro de choque eléctrico Corriente continua (DC) 

Advertencia: superficie caliente Corriente alterna (AC) 

Conexión a conductor de protección Corriente continua / Corriente alterna (DC/AC) 

Conexión a tierra El aparato está protegido en su totalidad por un 

aislamiento doble (reforzado) 

Conexión a masa Distintivo de la UE para baterías y 

acumuladores 

Más información en la sección 

"Eliminación/protección del medio ambiente", 

punto 1. 
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Símbolo Significado Símbolo Significado 

Aviso: Cuidado en el manejo de dispositivos 

sensibles a la electrostática (ESD) 

Distintivo de la UE para la eliminación por 

separado de dispositivos eléctricos y 

electrónicos 

Más información en la sección 

"Eliminación/protección del medio ambiente", 

punto 2. 

Advertencia: rayo láser 

Más información en la sección 

"Funcionamiento", punto 7. 

 

Palabras de señal y su significado 

En la documentación del producto se utilizan las siguientes palabras de señal con el fin de advertir contra 

riesgos y peligros. 

Indica una situación de peligro que, si no se evita, causa lesiones 

graves o incluso la muerte. 

Indica una situación de peligro que, si no se evita, puede causar 

lesiones graves o incluso la muerte. 

Indica una situación de peligro que, si no se evita, puede causar 

lesiones leves o moderadas. 

Indica información que se considera importante, pero no en relación 

con situaciones de peligro; p. ej., avisos sobre posibles daños 

materiales.  

En la documentación del producto se emplea de forma sinónima el 

término CUIDADO. 

 

Las palabras de señal corresponden a la definición habitual para aplicaciones civiles en el área 

económica europea. Pueden existir definiciones diferentes a esta definición en otras áreas económicas o 

en aplicaciones militares. Por eso se deberá tener en cuenta que las palabras de señal aquí descritas 

sean utilizadas siempre solamente en combinación con la correspondiente documentación del producto y 

solamente en combinación con el producto correspondiente. La utilización de las palabras de señal en 

combinación con productos o documentaciones que no les correspondan puede llevar a interpretaciones 

equivocadas y tener por consecuencia daños en personas u objetos. 

Estados operativos y posiciones de funcionamiento 

El producto solamente debe ser utilizado según lo indicado por el fabricante respecto a los estados 

operativos y posiciones de funcionamiento sin que se obstruya la ventilación. Si no se siguen las 

indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con 

posible consecuencia de muerte. En todos los trabajos deberán ser tenidas en cuenta las normas 

nacionales y locales de seguridad del trabajo y de prevención de accidentes.  
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1. Si no se convino de otra manera, es para los productos Rohde & Schwarz válido lo que sigue:  

como posición de funcionamiento se define por principio la posición con el suelo de la caja para 

abajo, modo de protección IP 2X, uso solamente en estancias interiores, utilización hasta 2000 m 

sobre el nivel del mar, transporte hasta 4500 m sobre el nivel del mar. Se aplicará una tolerancia de 

±10 % sobre el voltaje nominal y de ±5 % sobre la frecuencia nominal. Categoría de sobrecarga 

eléctrica 2, índice de suciedad 2.  

2. No sitúe el producto encima de superficies, vehículos, estantes o mesas, que por sus características 

de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalación del 

fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si 

se realiza la instalación de modo distinto al indicado en la documentación del producto, se pueden 

causar lesiones o, en determinadas circunstancias, incluso la muerte. 

3. No ponga el producto sobre aparatos que generen calor (p. ej. radiadores o calefactores). La 

temperatura ambiente no debe superar la temperatura máxima especificada en la documentación del 

producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse 

choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte. 

Seguridad eléctrica 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad 

eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia 

de muerte.  

1. Antes de la puesta en marcha del producto se deberá comprobar siempre que la tensión 

preseleccionada en el producto coincida con la de la red de alimentación eléctrica. Si es necesario 

modificar el ajuste de tensión, también se deberán cambiar en caso dado los fusibles 

correspondientes del producto.  

2. Los productos de la clase de protección I con alimentación móvil y enchufe individual solamente 

podrán enchufarse a tomas de corriente con contacto de seguridad y con conductor de protección 

conectado. 

3. Queda prohibida la interrupción intencionada del conductor de protección, tanto en la toma de 

corriente como en el mismo producto. La interrupción puede tener como consecuencia el riesgo de 

que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de 

enchufe, deberá garantizarse la realización de un examen regular de los mismos en cuanto a su 

estado técnico de seguridad. 

4. Si el producto no está equipado con un interruptor para desconectarlo de la red, o bien si el 

interruptor existente no resulta apropiado para la desconexión de la red, el enchufe del cable de 

conexión se deberá considerar como un dispositivo de desconexión.  

El dispositivo de desconexión se debe poder alcanzar fácilmente y debe estar siempre bien accesible. 

Si, p. ej., el enchufe de conexión a la red es el dispositivo de desconexión, la longitud del cable de 

conexión no debe superar 3 m).  

Los interruptores selectores o electrónicos no son aptos para el corte de la red eléctrica. Si se 

integran productos sin interruptor en bastidores o instalaciones, se deberá colocar el interruptor en el 

nivel de la instalación. 

5. No utilice nunca el producto si está dañado el cable de conexión a red. Compruebe regularmente el 

correcto estado de los cables de conexión a red. Asegúrese, mediante las medidas de protección y 

de instalación adecuadas, de que el cable de conexión a red no pueda ser dañado o de que nadie 

pueda ser dañado por él, p. ej. al tropezar o por un choque eléctrico.  
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6. Solamente está permitido el funcionamiento en redes de alimentación TN/TT aseguradas con fusibles 

de 16 A como máximo (utilización de fusibles de mayor amperaje solo previa consulta con el grupo de 

empresas Rohde & Schwarz). 

7. Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por 

completo y fuertemente en la toma de corriente. La no observación de estas medidas puede provocar 

chispas, fuego y/o lesiones. 

8. No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto 

podría causar fuego o choques eléctricos. 

9. En las mediciones en circuitos de corriente con una tensión Ueff > 30 V se deberán tomar las medidas 

apropiadas para impedir cualquier peligro (p. ej. medios de medición adecuados, seguros, limitación 

de tensión, corte protector, aislamiento etc.). 

10. Para la conexión con dispositivos informáticos como un PC o un ordenador industrial, debe 

comprobarse que éstos cumplan los estándares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1 

válidos en cada caso. 

11. A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa 

mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y 

puede causar lesiones, fuego o daños en el producto. 

12. Si un producto se instala en un lugar fijo, se deberá primero conectar el conductor de protección fijo 

con el conductor de protección del producto antes de hacer cualquier otra conexión. La instalación y 

la conexión deberán ser efectuadas por un electricista especializado. 

13. En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automático ni otros 

mecanismos de seguridad similares, el circuito de alimentación debe estar protegido de modo que 

todas las personas que puedan acceder al producto, así como el producto mismo, estén a salvo de 

posibles daños. 

14. Todo producto debe estar protegido contra sobretensión (debida p. ej. a una caída del rayo) mediante 

los correspondientes sistemas de protección. Si no, el personal que lo utilice quedará expuesto al 

peligro de choque eléctrico. 

15. No debe introducirse en los orificios de la caja del aparato ningún objeto que no esté destinado a ello. 

Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o 

lesiones. 

16. Salvo indicación contraria, los productos no están impermeabilizados (ver también el capítulo 

"Estados operativos y posiciones de funcionamiento", punto 1). Por eso es necesario tomar las 

medidas necesarias para evitar la entrada de líquidos. En caso contrario, existe peligro de choque 

eléctrico para el usuario o de daños en el producto, que también pueden redundar en peligro para las 

personas. 

17. No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido 

condensaciones sobre el producto o en el interior de éste, como p. ej. al desplazarlo de un lugar frío a 

otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico. 

18. Antes de la limpieza, desconecte por completo el producto de la alimentación de tensión (p. ej. red de 

alimentación o batería). Realice la limpieza de los aparatos con un paño suave, que no se deshilache. 

No utilice bajo ningún concepto productos de limpieza químicos como alcohol, acetona o diluyentes 

para lacas nitrocelulósicas. 
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Funcionamiento 

1. El uso del producto requiere instrucciones especiales y una alta concentración durante el manejo. 

Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos 

necesarios en cuanto a aptitudes físicas, psíquicas y emocionales, ya que de otra manera no se 

pueden excluir lesiones o daños de objetos. El empresario u operador es responsable de seleccionar 

el personal usuario apto para el manejo del producto. 

2. Antes de desplazar o transportar el producto, lea y tenga en cuenta el capítulo "Transporte". 

3. Como con todo producto de fabricación industrial no puede quedar excluida en general la posibilidad 

de que se produzcan alergias provocadas por algunos materiales empleados ―los llamados 

alérgenos (p. ej. el níquel)―. Si durante el manejo de productos Rohde & Schwarz se producen 

reacciones alérgicas, como p. ej. irritaciones cutáneas, estornudos continuos, enrojecimiento de la 

conjuntiva o dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las 

causas y evitar cualquier molestia o daño a la salud.  

4. Antes de la manipulación mecánica y/o térmica o el desmontaje del producto, debe tenerse en cuenta 

imprescindiblemente el capítulo "Eliminación/protección del medio ambiente", punto 1. 

5. Ciertos productos, como p. ej. las instalaciones de radiocomunicación RF, pueden a causa de su 

función natural, emitir una radiación electromagnética aumentada. Deben tomarse todas las medidas 

necesarias para la protección de las mujeres embarazadas. También las personas con marcapasos 

pueden correr peligro a causa de la radiación electromagnética. El empresario/operador tiene la 

obligación de evaluar y señalizar las áreas de trabajo en las que exista un riesgo elevado de 

exposición a radiaciones. 

6. Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias tóxicas 

(gases, líquidos etc.) que pueden generar daños a la salud. Por eso, en caso de incendio deben 

usarse medidas adecuadas, como p. ej. máscaras antigás e indumentaria de protección. 

7. Los productos con láser están provistos de indicaciones de advertencia normalizadas en función de la 

clase de láser del que se trate. Los rayos láser pueden provocar daños de tipo biológico a causa de 

las propiedades de su radiación y debido a su concentración extrema de potencia electromagnética. 

En caso de que un producto Rohde & Schwarz contenga un producto láser (p. ej. un lector de 

CD/DVD), no debe usarse ninguna otra configuración o función aparte de las descritas en la 

documentación del producto, a fin de evitar lesiones (p. ej. debidas a irradiación láser). 

8. Clases de compatibilidad electromagnética (conforme a EN 55011 / CISPR 11; y en analogía con EN 

55022 / CISPR 22, EN 55032 / CISPR 32) 

− Aparato de clase A:  

Aparato adecuado para su uso en todos los entornos excepto en los residenciales y en aquellos 

conectados directamente a una red de distribución de baja tensión que suministra corriente a 

edificios residenciales.  

Nota: Los aparatos de clase A están destinados al uso en entornos industriales. Estos aparatos 

pueden causar perturbaciones radioeléctricas en entornos residenciales debido a posibles 

perturbaciones guiadas o radiadas. En este caso, se le podrá solicitar al operador que tome  las 

medidas adecuadas para eliminar estas perturbaciones. 

− Aparato de clase B: 

Aparato adecuado para su uso en entornos residenciales, así como en aquellos conectados 

directamente a una red de distribución de baja tensión que suministra corriente a edificios 

residenciales. 
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Reparación y mantenimiento 

1. El producto solamente debe ser abierto por personal especializado con autorización para ello. Antes 

de manipular el producto o abrirlo, es obligatorio desconectarlo de la tensión de alimentación, para 

evitar toda posibilidad de choque eléctrico.  

2. El ajuste, el cambio de partes, el mantenimiento y la reparación deberán ser efectuadas solamente 

por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los 

aspectos de seguridad (p. ej. el enchufe, los transformadores o los fusibles), solamente podrán ser 

sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad 

deberá realizarse un control de seguridad (control a primera vista, control del conductor de 

protección, medición de resistencia de aislamiento, medición de la corriente de fuga, control de 

funcionamiento). Con esto queda garantizada la seguridad del producto.  

Baterías y acumuladores o celdas 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterías y 

acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible 

consecuencia de muerte. El manejo de baterías y acumuladores con electrolitos alcalinos (p. ej. celdas de 

litio) debe seguir el estándar EN 62133. 

1. No deben desmontarse, abrirse ni triturarse las celdas.  

2. Las celdas o baterías no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz 

directa del sol. Las celdas y baterías deben mantenerse limpias y secas. Limpiar las conexiones 

sucias con un paño seco y limpio. 

3. Las celdas o baterías no deben cortocircuitarse. Es peligroso almacenar las celdas o baterías en 

estuches o cajones en cuyo interior puedan cortocircuitarse por contacto recíproco o por contacto con 

otros materiales conductores. No deben extraerse las celdas o baterías de sus embalajes originales 

hasta el momento en que vayan a utilizarse. 

4. Las celdas o baterías no deben someterse a impactos mecánicos fuertes indebidos. 

5. En caso de falta de estanqueidad de una celda, el líquido vertido no debe entrar en contacto con la 

piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un 

médico. 

6. En caso de cambio o recarga inadecuados, las celdas o baterías que contienen electrolitos alcalinos 

(p. ej. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o 

baterías solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de 

recambios).  

7. Las baterías y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterías o 

acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales. 

Respete en esta relación las normas nacionales de eliminación y reciclaje.  

Transporte 

1. El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con 

precaución y, si es necesario, usando un sistema de elevación adecuado (p. ej. una carretilla 

elevadora), a fin de evitar lesiones en la espalda u otros daños personales.  
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2. Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por 

personas. Por eso no está permitido utilizar las asas para la sujeción en o sobre medios de transporte 

como p. ej. grúas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los 

productos de manera segura a los medios de transporte o elevación. Para evitar daños personales o 

daños en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o 

elevación utilizado. 

3. Si se utiliza el producto dentro de un vehículo, recae de manera exclusiva en el conductor la 

responsabilidad de conducir el vehículo de manera segura y adecuada. El fabricante no asumirá 

ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un 

vehículo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehículo 

debidamente para evitar, en caso de un accidente, lesiones u otra clase de daños.  

Eliminación/protección del medio ambiente 

1. Los dispositivos marcados contienen una batería o un acumulador que no se debe desechar con los 

residuos domésticos sin clasificar, sino que debe ser recogido por separado. La eliminación se debe 

efectuar exclusivamente a través de un punto de recogida apropiado o del servicio de atención al 

cliente de Rohde & Schwarz. 

2. Los dispositivos eléctricos usados no se deben desechar con los residuos domésticos sin clasificar, 

sino que deben ser recogidos por separado. 

Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminación de residuos y asume 

plenamente los deberes de recogida y eliminación para los fabricantes dentro de la UE. Para 

desechar el producto de manera respetuosa con el medio ambiente, diríjase a su servicio de atención 

al cliente de Rohde & Schwarz. 

3. Si se trabaja de manera mecánica y/o térmica cualquier producto o componente más allá del 

funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales 

pesados como p. ej. plomo, berilio o níquel). Por eso el producto solo debe ser desmontado por 

personal especializado con formación adecuada. Un desmontaje inadecuado puede ocasionar daños 

para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminación de 

residuos. 

4. En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que 

deban tratarse como residuos especiales (p. ej. refrigerantes o aceites de motor con intervalos de 

cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas 

sustancias y las normas regionales de eliminación de residuos. Tenga en cuenta también en caso 

necesario las indicaciones de seguridad especiales contenidas en la documentación del producto. La 

eliminación incorrecta de sustancias peligrosas o combustibles puede causar daños a la salud o 

daños al medio ambiente. 

Se puede encontrar más información sobre la protección del medio ambiente en la página web de 

Rohde & Schwarz. 
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Customer Support 
 

Technical support – where and when you need it 

For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support 
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a 
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz 
equipment. 
 

Up-to-date information and upgrades 

To keep your instrument up-to-date and to be informed about new application notes related to your 
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish. 
We will take care that you will get the right information. 
 

Europe, Africa, Middle East Phone +49 89 4129 12345 
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772) 
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988 
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +65 65 13 04 88 
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /  
 +86-400-650-5896 
customersupport.china@rohde-schwarz.com
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1 Preface

1.1 Documentation Overview

The user documentation delivered with the R&S RTM consists of the following parts:

● Online Help system on the instrument
● "Getting Started" printed manual in English
● Documentation CD-ROM with:

– Getting Started
– User Manual
– Service Manual
– Data sheet and product brochure
– Links to useful sites on the R&S internet

Online Help

The Online Help is embedded in the instrument's firmware. It offers quick, context-sen-
sitive description of the softkeys and front panel controls.

Getting Started

The English edition of this manual is delivered with the instrument in printed form. The
manual is also available in other languages in PDF format on the Documentation CD-
ROM. It provides the information needed to set up and start working with the instrument.
Basic operations and typical measurement examples are described. The manual includes
also general information, e.g., Safety Instructions.

User Manual

The User Manual is available in PDF format - in printable form - on the Documentation
CD-ROM. In this manual, all instrument functions are described in detail. Furthermore, it
provides an introduction to remote control and a complete description of the remote con-
trol commands with programming examples. Information on maintenance, instrument
interfaces and error messages is also given.

Service Manual

The Service Manual is available in PDF format - in printable form - on the Documentation
CD-ROM. It informs on how to check compliance with rated specifications, on instrument
function, repair, troubleshooting and fault elimination. It contains all information required
for repairing the instrument by the replacement of modules.

Documentation updates

You can download the newest version of the "Getting Started" and "User Manual" from
the "Downloads > Manuals" section on the Rohde & Schwarz "Scope of the Art" Web
page: http://www.scope-of-the-art.com/product/rtm.html.
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The online help is included in the firmware update package. The help has to be updated
separately to get the information suitable for the firmware version. The firmware and help
update package is available in the "Downloads > Firmware" section on the Rohde &
Schwarz "Scope of the Art" Web page.

1.2 Conventions Used in the Documentation

This chapter describes the conventions used throughout this documentation.

1.2.1 Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description

"Graphical user interface ele-
ments"

All names of graphical user interface elements on the screen, such as dia-
log boxes, menus, options, buttons, and softkeys are enclosed by quota-
tion marks.

KEYS Key names are written in capital letters.

File names, commands,
program code

File names, commands, coding samples and screen output are distin-
guished by their font.

Input Input to be entered by the user is displayed in italics.

​Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quotation
marks.
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2 Acquisition and Waveform Setup
The chapter describes the horizontal and vertical basic settings including the acquisition
and probe settings.

2.1 Basics

This chapter provides background information on the essential settings in the vertical and
horizontal systems, on acquisition setup and probing.

2.1.1 Vertical System

The controls and parameters of the vertical system are used to scale and position the
waveform vertically.

2.1.1.1 Input coupling

The input coupling influences the signal path between input connector and the following
internal signal stage. The coupling can be set to DC, AC, or ground.
● DC coupling shows all of an input signal. DC coupling is available with 1 MΩ input

impedance to connect standard passive probes. DC coupling is the default for 50 Ω
input impedance.

● AC coupling is useful if the DC component of a signal is of no interest. AC coupling
blocks the DC component of the signal so that the waveform is centered around zero
volts.

2.1.1.2 Vertical scale and position

Vertical scale and vertical position directly affect the resolution of the waveform ampli-
tude. The vertical scale corresponds to the ADC input range. To get the full resolution of
the ADC, waveforms should cover most of the height of the diagram.
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Fig. 2-1: Input range and resolution of the ADC

2.1.1.3 Bandwidth

For analog applications the highest signal frequency determines the required oscillo-
scope bandwidth. As a rule of thumb, the oscilloscope bandwidth should be 3 times higher
than the maximum frequency included in the analog test signal to measure the amplitude
with high accuracy.

Most test signals are more complex than a simple sine wave and include several spectral
components. A digital signal, for example, is built up of several odd harmonics. As a rule
of thumb, for digital signals the oscilloscope bandwidth should be 5 times higher than the
clock frequency to be measured.

The oscilloscope is not a stand-alone system. You need a probe to measure the signal
of interest, and the probe has a limited bandwidth, too. The combination of oscilloscope
and probe creates a system bandwidth. To maintain the oscilloscope bandwidth, that is,
to reduce the effect of the probe on the system bandwidth, the probe bandwidth should
exceed the bandwidth of the oscilloscope, the recommended factor is 1.5 x oscilloscope
bandwidth.

See also: ​chapter 2.1.4.1, "Voltage Probes", on page 16

2.1.2 Sampling and Acquisition

The vertical system of a digital oscilloscope conditions the test signal in a way that the
following A/D Converter (ADC) can transform the measured voltage into digital data.
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2.1.2.1 Sampling and Processing

The A/D converter samples the continuous signal under test at specific points in time and
delivers digital values called ADC samples. The rate at which the converter is working
is the ADC sample rate, a constant value usually specified in GHz: fADC = 1 / TI

The digital ADC samples are processed according to the acquisition settings. The result
is a waveform record that contains waveform samples and is stored in the waveform
memory. The waveform samples are displayed on the screen and build up the waveform.

The number of waveform samples in one waveform record is called record length, and
the rate of recording waveform samples - the number of waveform samples per second
- is the sample rate. The higher the sample rate, the better is the resolution and the more
details of the waveform are visible.

A sufficient resolution is essential for correct reconstruction of the waveform. If the signal
is undersampled, aliasing occurs - a false waveform is displayed. To avoid aliasing and
accurately reconstruct a signal, Nyquist theorem postulates that the sample rate must be
at least twice as fast as the highest frequency component of the signal. However, the
theorem assumes ideal conditions, so the Nyquist sample rate is usually not sufficient.
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Fig. 2-2: Waveforms acquired with different sample rates

This means that the sample rate must be set to a value 3 to 5 times the fastest frequency
component of the signal. A higher sample rate increases signal fidelity, increases the
chance to capture glitches and other signal anomalies, and improves the zoom-in capa-
bilities.

2.1.2.2 Acquisition Settings

The resulting sample rate can be the same as the constant ADC sample rate, or higher,
or lower.

By default, the real time sample mode is used. With fast time base settings, the sample
rate becomes higher than the ADC sample rate. The missising waveform samples are
added to the ADC samples with sin(x)/x interpolation automatically.

When measuring high-frequency, repetitive signals whose frequency components are
even higher than the ADC sample rate, equivalent-time sampling is used to capture
the waveform. This sample mode captures ADC samples over a number of subsequent
repetitions at different points in time, and creates one waveform with higher sample rate
from this data.

At lower time base settings, the required sample rate is lower than the ADC sample rate.
To reduce the sample rate, decimation methods are used: sample and peak detect.

As digital waveform data is stored in the memory, and the memory can save many wave-
form records, further waveform arithmetic processing is possible: average and enve-
lope waveforms are resulting waveforms, created from a composite of sample points
taken from multiple acquisitions. Another function called smoothing calculates a mean
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value of several adjacent sample points of the same waveform and displays it. The result
is a moving average that uses the full data and can be used for non-periodic signals.

2.1.2.3 Acquisition Control

You can run the R&S RTM in two ways:
● Continuous: the instrument acquires data until you stop it manually.
● NxSingle: the instrument samples and processes a specified number of acquisitions.

The determining point of an acquisition is the trigger. It defines the time-zero point in the
waveform record. The instrument acquires continuously and keeps the sample points to
fill the pre-trigger part of the waveform record. When the trigger occurs, the instrument
continues acquisition until the post-trigger part of the waveform record is filled. Then it
stops acquiring and waits for the next trigger. When a trigger is recognized, the instrument
will not accept another trigger until the acquisition is complete.

The trigger modes define how the instrument triggers:
● Normal: The instrument acquires a waveform only if a real trigger occurs, that is, if

all trigger conditions are fulfilled.
● Auto: The instrument triggers repeatedly after a fixed time interval if the trigger con-

ditions are not fulfilled. If a real trigger occurs, it takes precedence. If the real trigger
is faster than the auto trigger, both modes are virtually the same.

In practice, both trigger modes are useful: The auto mode lets you see the signal with
very little adjustment, while the normal mode selects the interesting part of the waveform.
If you want to acquire a specified number of waveforms with NxSingle, make sure to
select the normal trigger mode. Thus you get only the required number of interesting
acquisitions.

See also: ​chapter 3, "Triggers", on page 35

2.1.3 Horizontal System

2.1.3.1 Horizontal Position

As described before in ​chapter 2.1.2.3, "Acquisition Control", on page 15, the trigger
defines the time-zero point in the waveform record.

Two parameters set the position of the horizontal acquisition window in relation to the
trigger point: reference point (time reference) and trigger offset. With these parameters
you choose the part of the waveform you want to see: around the trigger, before, or after
the trigger.
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2.1.4 Probes

A probe connects the signal source (DUT) to the oscilloscope, and delivers the signal to
be measured. It is the essential first link in the measurement chain.

An ideal probe fulfills the following requirements:
● Safe and reliable contacts
● Infinite bandwidth
● The probe should not load the signal source and thus impact the circuit operation.
● The connection should not introduce or suppress signal components (hum, noise,

filter) and thus degrade or distort the transferred signal.

In reality, the probe can never be an ideal one, it always affects the signal transmission
and the signal source, and thus the measured signal. It depends on the frequency to be
measured and on the signal source to determine the acceptable loading, and to determine
which kind of probe delivers good results.

The solution depends on the quantity to be measured with respect to:
● Signal type: voltage, current, power, pressure, optical, etc.
● Signal amplitude: The oscilloscope itself can only display voltages in a limited range.

Most probes can adjust the dynamic range to amplitudes from a few mV to 10 V.
Smaller or much larger signals require specialized equipment.

● Signal frequency: High frequencies require advanced equipment in order to get cor-
rect results.

● Source characteristic: The source impedance is the decisive factor when choosing
the suitable connection.

2.1.4.1 Voltage Probes

The following table provides an overview on common voltage probes and their usage.
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Table 2-1: Voltage probes overview

Probe type Attenuation Typical bandwidth
range

Oscilloscope
input

Usage

Passive, high impe-
dance

1:1 10 MHz 1 MΩ Low speed, low level
signals

Passive, high impe-
dance

10:1 500 MHz 1 MΩ General purpose

Passive, low impe-
dance

10:1 up to 10 GHz 50 Ω High frequency

Active, single-ended 10:1 up to 10 GHz 50 Ω High speed

Active, differential 10:1  50 Ω Floating

For a list of recommended probes refer to the R&S RTM product brochure.

Besides the possible input voltage range, two factors are very important when selecting
a voltage probe: Bandwidth and impedance over frequency.
● Bandwidth:

The combination of probe and oscilloscope builds up a system. The resulting system
bandwidth is approximately determined with:
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scopeprobesystem BWBWBW

To measure the signal with low measurement error, the system bandwidth should be
higher than the highest frequency component of the signal. The probe bandwidth
must be even higher than the system bandwidth.

● Impedance:
A minimum impedance is required to keep the circuit loading low. Over frequency,
the impedance decreases, in particular with passive probes. The probe impedance
should be approximately 10 times the impedance of the circuit test point at the highest
signal frequency.

Passive voltage probes

Passive probes have the following qualities:
● No active components inside
● BNC connector for universal use
● Compensation needs to be executed when the probe is connected to a scope input:

LF compensation matches the probe (mainly cable) capacitance to the oscilloscope
input capacitance.
High frequency adjustment is an option for higher measurement frequencies in the
MHz range.

● With high impedance probes, the impedance varies significantly over frequency.
● With low impedance probes, the impedance variation over frequency is low, but the

load on the source is high.

Basics



Acquisition and Waveform SetupR&S®RTM

18User Manual 1305.0595.02 ─ 08

If you use passive probes, remember some recommendations:
● Use a probe recommended for your oscilloscope model.
● Use a ground lead as short as possible to minimize the effect of ground lead induc-

tance. The resonance frequency can be much lower than the system bandwidth and
thus can affect the measurement results, in particular, if you measure steep edge rise
times.

● Select a probe that has a bandwidth of 5 to 10 times the highest frequency being
measured. This will preserve the harmonics and thus the waveform integrity.

Active voltage probes - general

Active probes require operating power from the instrument and have a proprietary inter-
face to the instrument. Their main qualities are:
● Low loading on signal source
● The probe is automatically recognized by the instrument, no adjustment is required.
● Adjustable DC offset at probe tip allows for high resolution on small AC signals which

are superimposed on DC levels.
● Connections should be as short as possible to keep the usable bandwidth high.
● The operating voltage range has to be observed.
● The probe impedance depends on the signal frequency.

RT-ZS single-ended active probes and RT-ZD differential active probes provide special
features for easier use and precise measurements. These special featuers are not avail-
able on RT-ZSxxE probes.

● The micro button on the probe head remotely controls important functions on the
instrument, like running and stopping the acquisition, autoset, auto zero and setting
the offset to mean value.

● The R&S ProbeMeter measures DC voltages between the probe tip and the ground
connection with very high precision. The result is displayed on the instrument's
screen. So you can check DC voltages with different levels without having to adjust
the measurement range of the oscilloscope. The R&S ProbeMeter also measures
the zero error of the probe to optimize measurement results at small signal levels.

When you connect an R&S RT-ZSxx active probe to a channel input of the R&S RTM,
the oscilloscope recognizes the probe, reads the identification and calibration data from
the probe box and shows the result in the "Setup" and "Probe Attributes" tabs. This data
together with the deskew time for a given channel is stored and processed by the
R&S RTM. If you connect the probe the next time to the same channel, the information
is fetched and used.

Differential active probes

Differential active probes are designed to measure signals that are referenced against
each other, and voltages that are not references to ground, for example twisted pair signal
lines. The R&S RT-ZD probes are differential probes with high input impedance, they can
be used to measure voltages between any two test points.

Compared with two-channel measurement setup with single-ended probes, the mea-
surement with differential probes is symmetric due to the same amplification and cable
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length on both paths. It is also immune to interference and noise and occupies only one
input channel.

A differential probe has three sockets: the positive signal socket (+), the negative signal
socket (-), and the ground socket.

Differential probes provide multiple input voltages:
● Differential mode input voltage (Vin)

Voltage between the positive and negative signal sockets
● Positive single-ended input voltage (Vp)

Voltage between the positive signal socket and the ground socket
● Negative single-ended input voltage (Vn)

Voltage between the negative signal socket and the ground socket
● Common mode input voltage (Vcm)

Mean voltage of positive and negative signal sockets referred to the ground socket,
respectively

Two of these voltages are independent values, the other two can be calculated:
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R&S RT-ZD probes detect only differential input voltages and provide it to the oscillo-
scope. Common mode signals are suppressed by the probe. This characteristic is descri-
bed by the Common Mode Rejection Ratio (CMRR):

GainCommonMode
alGainDifferentiCMRR 

In addition, the R&S ProbeMeter of R&S RT-ZD differential probes can measure differ-
ential and common mode DC voltages. The measurement result is displayed on the
oscilloscope's screen. The common mode mesurement of the R&S ProbeMeter allows
to check the input voltage relative to ground and is a convenient way to detect breaches
of the operating voltage window, and the reason of unwanted clippings.
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2.2 Setting up the Waveform

This chapter contains the fundamental procedures for setting up the acquisition and
adjusting the channel waveforms.

Passive probes
Passive probes require compensation for exact signal display and measurement. The
compensation procedure is described in the "Getting Started" manual.

2.2.1 Setting Up the Signal Input with Autoset

Autoset is the solution for the major part of routine test-setup. It is also a good start if you
need to use more complex trigger settings. Autoset finds appropriate horizontal and ver-
tical scales and trigger conditions to present a stable waveform.

1. Connect the probe to the input connector CH N.

The instrument recognizes the probe and turns the channel on.

2. Press the AUTOSET button on the left of the display.

2.2.2 Adjusting the Signal Input Manually

The settings mentioned here are described in detail in:
● ​chapter 2.3.1, "HORIZONTAL Controls", on page 22
● ​chapter 2.3.3.2, "Channel Menu", on page 29
● ​chapter 2.3.3.1, "VERTICAL Controls", on page 27

1. Connect the probe to the input connector CH N.

The instrument recognizes the probe and turns the channel on.

2. Use the SCALE rotary knob in the HORIZONTAL area of the front panel to set up the
time base.

3. Use the POSITION rotary knob to set up the trigger position. Press the knob to reset
the trigger offset to 0 s.

4. Press the channel key corresponding to the input channel. It is lighted with the color
of the channel waveform.

5. In the softkey menu, press the "Coupling" softkey repeatedly to select the correct
coupling.

6. Select the "Bandwidth" limit.

7. If you use a passive probe, adjust the probe settings:

a) Select the "Termination" (input impedance).
b) Select "More" to switch the menu page.
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c) Press the "Probe" softkey and select the attenuation.

8. Use the SCALE rotary knob in the VERTICAL area of the front panel to adjust the
vertical scale of the waveform. Press the knob to toggle between fine and rough
adjustment.

9. Use the POSITION rotary knob to adjust the vertical position of the waveform. Vertical
position is defined by the position of the waveform's zero line and the offset between
the zero line and the waveform axis. Pressing the knob toggles between these
parameters.
By default, offset is disabled. Press the "Offset" softkey in the "Channel" menu to
enable the offset. Use the NAVIGATION knob or the POSITION / OFFSET knob to
adjust. Turn clockwise to move the waveform down.

10. Proceed with: ​chapter 2.2.3, "Setting the Acquisition", on page 21.

2.2.3 Setting the Acquisition

Prerequisites:
● Probes are connected.
● Vertical and horizontal settings are adjusted.

For details on acquisition settings, see ​chapter 2.3.2, "Acquisition Menu", on page 23.

1. Press the ACQUISITION key in the HORIZONTAL area of the front panel.

2. Select the "Sample Mode" - Real time or Equivalent time.
This defines the behavior of the oscilloscope if the sample rate is higher than the ADC
sample rate.
Use Equivalent time to capture fast repetitive signals whose frequency components
may be much higher than the sample rate of the ADC.

3. Select the "Decimation Mode" - for example, Peak detect.
This defines the behavior of the instrument if the oscilloscope captures more samples
than the waveform memory can save.

4. Select the "Wavef. Arithmetic" - for example, Average or Envelope.
This defines how the resulting waveform is built from several consecutive acquisitions
of the signal.

5. If "Average" is selected, enter the "Number of Averages", that is the number of wave-
forms used for average calculation.

6. Select the "Waveform Rate".

2.2.4 Starting and Stopping Acquisition

You can control the acquisition in two ways:
● Running continuous acquisition until you stop it

 

 

Setting up the Waveform



Acquisition and Waveform SetupR&S®RTM

22User Manual 1305.0595.02 ─ 08

● Running one acquisition or a given number of acquisitions

Prerequisites:
● Probes are connected.
● Vertical and horizontal settings are adjusted.
● Triggering is set.
● Channels to be acquired are turned on.

To start and stop continuous acquisition

1. Check if the trigger mode is set to "Normal". The trigger mode is shown in the top
information bar.
If not, press the MODE key on the front panel to toggle the setting.

2. Press the RUN CONT key to start acquisition.

The acquisition starts if a trigger occurs.

3. To stop, press the RUN CONT key again.

The acquisition stops immediately.

To acquire a limited number of acquisitions

1. Press the ACQUISITION key in the HORIZONTAL area of the front panel.

2. Select "Nx Single" and enter the number of acquisitions.

3. Press the RUN N× SINGLE key on the front panel.
You can stop the acquisition before it is finished by pressing the key again.

2.3 Reference for Waveform Setup

2.3.1 HORIZONTAL Controls

Time base settings adjust the display in horizontal direction. Use the rotary knobs in the
HORIZONTAL functional block for setting.
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POSITION.....................................................................................................................23
SCALE..........................................................................................................................23

POSITION
The rotary knob changes the trigger offset. This is the horizontal position of the trigger
point in relation to the reference point - the zero point of the grid. Thus, you can set the
trigger point even outside the diagram and analyze the signal some time before or after
the trigger.

The reference point is set with SETUP >"Time Reference".

Turn clockwise to move the trigger point to the right. At zero-crossing, the knob shortly
snaps in and the setting is kept constant to simplify the zero-setting. The current trigger
position is shown in the top information bar, denoted by "T". Press the knob to reset the
trigger offset to 0.

Note: If a zoom or FFT window is displayed, the knob can adjust other values depending
on the selection of the SCALE rotary knob.
See also: ​"Time Reference" on page 225

Remote command: 
​TIMebase: ​POSition​ on page 274

SCALE
The rotary knob adjusts the time scale of the horizontal axis for all signals, also known
as time base. The current scale value is shown in the top information bar, denoted by
"TB". Turn clockwise to stretch the waveforms - the scale value time/div decreases.

If a Zoom or FFT window is displayed, press the knob to switch between the settings,
then turn to adjust the selected value.

Remote command: 
​TIMebase: ​SCALe​ on page 273

2.3.2 Acquisition Menu

The ACQUISITION key in the Horizontal functional block opens the "Acquisition" softkey
menu, where you select the acquisition mode. Acquisition modes control the data pro-
cessing - how the waveform is built from the captured ADC samples.

The softkeys are placed on two menu pages. The current acquisition mode is shown in
the top information bar, the second value from right.
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Sample Mode................................................................................................................24
Decimation Mode..........................................................................................................24
Wavef. Arithmetic..........................................................................................................25
Nx Single.......................................................................................................................25
No. of Averages............................................................................................................25
Limit Freq......................................................................................................................26
Waveform Rate.............................................................................................................26
Interpolation..................................................................................................................26
Roll................................................................................................................................26

Sample Mode
Defines how the waveform is created from the sample points which are acquired by the
ADC.

"Real Time" At slow time base settings the oscilloscope can acquire enough points
to create an accurate waveform, so the sampled points of the input sig-
nal are used directly to build the waveform.
With fast time base settings, the sample rate is higher than the ADC
sample rate. Waveform samples are added to the ADC samples
according to the selected interpolation method.
See also: ​"Interpolation" on page 26
Real-time sampling is used to capture fast, single-shot, transient sig-
nals.

"Equivalent
Time"

Random equivalent-time sampling: This mode requires repetitive, sta-
ble signals. It is used to capture fast signals whose frequency compo-
nents may be much higher than the sample rate of the ADC. The wave-
form points are taken from several acquisitions at a different time in
relation to the trigger point. The time difference between the sample
and the trigger is random. Then, all the sampled points are put together
into one composite waveform.

Remote command: 
​ACQuire: ​MODE ​ on page 275

Decimation Mode
Decimation reduces the data stream of the ADC to a stream of waveform points with
lower sample rate and a less precise resolution if the oscilloscope captures more samples
than the waveform memory can save.

"Sample" The oscilloscope acquires the input data with a sample rate which is
aligned to the time base (horizontal scale) and the memory depth. Usu-
ally, most signals are displayed optimally with this acquisition mode if
all trigger conditions are met.

"Peak Detect" The minimum and the maximum of n samples are recorded as wave-
form points, the other samples are discarded. Thus the instrument can
detect fast signal peaks at slow time scale settings that would be missed
with other acquisition modes.
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"High Resolu-
tion"

The average of n captured sample points is recorded as one waveform
sample. Averaging reduces the noise, the result is a more precise
waveform with higher vertical resolution.

Remote command: 
​CHANnel<m>: ​TYPE ​ on page 276

Wavef. Arithmetic
Waveform arithmetic builds the resulting waveform from several consecutive acquisitions
of the signal (envelope and average) or by other operations on the captured data. The
arithmetic works with all sample modes and decimated waveforms.

"Off" No arithmetic is applied.

"Envelope" The minimum and maximum values are saved in addition to the normal
waveform samples. The resulting diagram shows two envelope wave-
forms below and above the normal waveform: the minimums (floor) and
maximums (roof) representing the borders in which the signal occurs.
The envelope is refreshed with each acquisition and it is reset each time
the waveform parameters are changed.

"Average" The average is calculated from the data of the current acquisition and
a number of acquisitions before. The method reduces random noise
and other heterodyne signals. It requires a stable, triggered and repet-
itive signal.
The number of acquisitions for average calculation is defined with ​No.
of Averages.

"Smooth" Smoothing calculates a mean value of several adjacent sample points
and displays it. The result is a smoothed waveform. Thus, smoothing
is a moving average that uses the full data and can be used for non-
periodic signals. It works like a low-pass, and increases the vertical
resolution at the expense of bandwidth reduction.

"Filter" Filter is a low-pass with 3 db attenuation at a configurable limit fre-
quency set with "Limit Freq.". The filter removes higher frequencies
from the channel signals.

Remote command: 
​CHANnel<m>: ​ARIThmetics ​ on page 277

Nx Single
Sets the number of waveforms acquired with RUN N× SINGLE.

Remote command: 
​ACQuire: ​NSINgle: ​COUNt​ on page 272

No. of Averages
Defines the number of waveforms used to calculate the average waveform with "Wfm.
Arithmetics" = "Average". Only numbers from the 2n progression are available. The higher
the number, the better the noise is reduced.

Remote command: 
​ACQuire: ​AVERage: ​COUNt​ on page 275
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Limit Freq.
Sets the limit frequency for "Wfm. Arithmetics" = "Filter". The low pass filter has 3 dB
attenuation at the given limit frequency.

Remote command: 
​ACQuire: ​FILTer: ​FREQuency ​ on page 277

Waveform Rate
Defines the mode to set the sample rate (samples per second saved in the memory) and
the waveform acquisition rate (waveforms per second).

"Max. Wfm.
Rate"

The instrument combines sample rate and memory depth to acquire at
maximum waveform acquisition rate. In connection with persistence,
the mode can display rare signal anomalies.
Note: Due to less memory depth, aliasing effects may occur.

"Max. Sa.
Rate"

The instrument acquires the signal at maximum sample rate and uses
the full memory depth. The result is a waveform with maximum number
of waveform samples, high degree of accuracy, and low risk of aliasing.
However, the waveform acquisition rate is low.

"Automatic" Default mode: To display the best waveform, the instrument selects the
optimum combination of waveform acquisition rate and sample rate
using the full memory depth.

Remote command: 
​ACQuire: ​WRATe​ on page 276

Interpolation
Selects the interpolation method if the real time sample mode needs interpolation.

"Sin (x)/x" Two adjacent ADC sample points are connected by a sin(x)/x curve,
and also the adjoining sample points are considered by this curve. The
interpolated points are located on the resulting curve. This interpolation
method is the default method. It is very precise and shows the best
signal curve.

"Linear" Two adjacent ADC sample points are connected by a straight line, the
interpolated points are located on the line. You see a polygonal wave-
form similar to the real signal, and also the ADC sample points as ver-
texes.

"Sample &
Hold"

The ADC sample points are displayed like a histogram. For each sam-
ple interval, the voltage is taken from the sample point and considered
as constant, and the intervals are connected with vertical lines. Thus,
you see the discrete values of the ADC.

Remote command: 
​ACQuire: ​INTerpolate ​ on page 275

Roll
Enables the roll mode.

Reference for Waveform Setup



Acquisition and Waveform SetupR&S®RTM

27User Manual 1305.0595.02 ─ 08

The roll mode moves the captured input data on the display from the right to the left. The
instrument shows the waveform immediately, without waiting for the complete acquisition
of the waveform record. The roll mode displays the untriggered signal. Use the roll mode
for slow, non-repetitive signals with 200 kHz or slower.

Remote command: 
​TIMebase: ​ROLL:​ENABle ​ on page 277

2.3.3 Vertical Settings

To adjust the vertical settings, you use the keys and rotary knobs in the VERTICAL func-
tional block of the front panel and the channel-specific softkey menu.

2.3.3.1 VERTICAL Controls

REF functions are described in ​chapter 5, "Reference Waveforms", on page 71. MATH
functions are described in ​chapter 7, "Mathematics", on page 94.

CH N.............................................................................................................................27
SIGNAL OFF.................................................................................................................28
POSITION / OFFSET....................................................................................................28

└ POSITION.......................................................................................................28
└ OFFSET..........................................................................................................28

SCALE, Y-Scale............................................................................................................29

CH N
Each channel key turns on an analog channel, selects it, and opens the "Channel" menu
with the vertical settings of the selected channel. The key is illuminated in the channel
color, if the channel is active.

The effect of the keypress depends on state of the channel:
● If channel is off: Pressing the key turns the channel on and selects it. The rotary knobs

alongside light up in the channel color.
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● If the channel is on: Pressing the key selects the channel waveform for vertical setup.

Remote command: 
​CHANnel<m>: ​STATe ​ on page 278

SIGNAL OFF
Turns the selected signal off and selects the next channel, math or reference waveform.

The key lights up in the color of the selected signal and changes the light according to
the new selection.

Remote command: 
​CHANnel<m>: ​STATe ​ on page 278

POSITION / OFFSET
The rotary knob adjusts the vertical position or the DC offset. It lights up in the color of
the selected waveform. Pressing the key toggles the parameter, the current parameter
and its value are shown in a temporary label marked with the channel color.

Note: By default, offset is disabled. Press the "Offset" softkey in the "Channel" menu to
enable the offset.

POSITION ← POSITION / OFFSET
Position changes the vertical location of the selected channel, math, or reference wave-
form, or of the decoded bus signal. Turn clockwise to move the waveform up. At zero-
crossing, the knob shortly snaps in and the setting is kept constant to simplify the zero-
setting.

Remote command: 
​CHANnel<m>: ​POSition ​ on page 280
​CALCulate: ​MATH<m>: ​POSition ​ on page 331
​BUS: ​POSition ​ on page 360

OFFSET ← POSITION / OFFSET
The offset voltage is subtracted to correct an offset-affected signal. The vertical center
of the selected channel is shifted by the offset value and the signal is re-positioned within
the diagram area.

Use the offset to measure small AC voltages that are overlaid by higher DC voltages.
Unlike AC coupling, the DC part of the signal is not lost with offset setting. The device
under test is not affected. The offset always has to be set manually, it is not included in
the autoset process.

Turn clockwise to move the waveform down. At zero-crossing, the knob shortly snaps in
and the setting is kept constant to simplify the zero-setting.

If an active probe is connected, the offset limit is defined by the probe. Refer to the doc-
umentation of the probe for allowed values.

Remote command: 
​CHANnel<m>: ​OFFSet​ on page 280
​PROBe<m>: ​SETup:​UOFFset ​ on page 290
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SCALE, Y-Scale
Sets the vertical scale in Volts per division to change the amplitude of the selected chan-
nel, math, or reference waveform, or of the decoded bus signal. The current value is
shown in the waveform label above the grid. The knob lights up in the color of the selected
waveform.

Turn SCALE clockwise to stretch the waveform. Doing so, the scale value V/div decrea-
ses. Press the knob to toggle between fine and rough adjustment.

To set the vertical sclae for a channel waveform numerically, press the "Y-Scale" softkey
in the channel menu and then use the NAVIGATION knob.

Remote command: 
​CHANnel<m>: ​SCALe ​ on page 279
​CALCulate: ​MATH<m>: ​SCALe ​ on page 330
​BUS: ​DSIZe ​ on page 360

2.3.3.2 Channel Menu

The softkeys of the "Channel <n>" menu are placed on two menu pages. Each channel
has its own menu.

The channel label shows the basic vertical settings: vertical scale (in the figure below,
channel 1: 5 mV/div), coupling (DC), termination (50 Ω, and bandwidth (limited). The label
of the active channel is highlighted with the channel color (channel 1).

Coupling........................................................................................................................29
Termination...................................................................................................................30
Bandwidth.....................................................................................................................30
Offset.............................................................................................................................30
Invert.............................................................................................................................30
Y-Scale..........................................................................................................................31
Probe.............................................................................................................................31
Deskew.........................................................................................................................31
Threshold......................................................................................................................31
Label.............................................................................................................................31

Coupling
Selects the connection of the input signal. The current coupling of each channel is shown
in the waveform labels above the grid.
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"AC" A 2 Hz high-pass filter is placed into the signal path that removes the
DC offset voltage from the input signal. AC coupling is labeled with ≈.

"DC" DC coupling passes the input signal unchanged. It is labeled with ≅.

"GND" Connects the input virtually to the ground. All channel data is set to a
constant ground value. Ground connection is labeled with .

Remote command: 
​CHANnel<m>: ​COUPling ​ on page 279

Termination
Adjusts the input impedance of the instrument to the impedance of the DUT. By default,
the oscilloscope has an input impedance of 1 MΩ || 13 pF. If an active probe is used, the
termination is read out from the probe - usually it is 50 Ω.

"50Ω" In measurement systems that are dimensioned for a characteristic
impedance of 50 Ω, reflections along the signal path are minimized by
setting the input resistor of the oscilloscope also to 50 Ω. This increases
the accuracy of measurement results. 50 Ω termination is identified for
each channel by the icon Ω in the waveform label.

"1 MΩ" The high input resistor minimizes the loading effect on the device under
test. This value is set automatically if a passive probe is connected and
cannot be changed.

Remote command: 
​CHANnel<m>: ​COUPling ​ on page 279

Bandwidth
Selects the bandwidth limit. The specified full bandwidth indicates the range of frequen-
cies that the instrument can acquire and display accurately with less than 3dB attenua-
tion. The probe has also a limited bandwidth and thus affects the resulting system band-
width.

See also: ​chapter 2.1.1.3, "Bandwidth", on page 12

"Full" At full bandwidth, all frequencies in the specified range are acquired
and displayed. Full bandwidth is used for most applications.

"400 MHz,
200MHz,
20MHz"

Frequencies above the selected limit are removed to reduce noise at
different levels. These bandwidth limits are indicated by the icon  in
the waveform label.

Remote command: 
​CHANnel<m>: ​BANDwidth ​ on page 280

Offset
See ​"OFFSET" on page 28.

Invert
Turns the inversion of the signal amplitude on or off. To invert means to reflect the voltage
values of all signal components against the ground level. Inversion affects only the display
of the signal but not the trigger. For example: if the oscilloscope triggers on the rising
edge, the trigger is not changed by inversion, but the actually rising edge is displayed as
falling edge.
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Inversion is indicated by a line above the channel name in the waveform label.

Remote command: 
​CHANnel<m>: ​POLarity ​ on page 281

Y-Scale
See ​"SCALE, Y-Scale" on page 29

Probe
Opens the Probe menu. The menu is different for active and passive probes.

● ​chapter 2.3.3.3, "Probe Menu (Passive Probe)", on page 32
● ​chapter 2.3.3.4, "Probe Menu (Active Probe)", on page 32

Deskew
Deskew compensates delay differences between channels caused by the different length
of cables, probes, and other sources. Correct deskew values are important for accurate
triggering.

Signals which are routed over lines with different lengths have a different propagation
delay. If high speed signals are measured, this delay may lead to a non-synchronous
waveform display. For example, a coax cable with a length of one meter has a propaga-
tion delay of typically 5.3 ns.

Remote command: 
​CHANnel<m>: ​SKEW ​ on page 281

Threshold
Access: CH N > "More" (page 2) > "Threshold"

Threshold value for digitization of analog signals. If the signal value is higher than the
threshold, the signal state is high (1 or true for the boolean logic). Otherwise, the signal
state is considered low (0 or false) if the signal value is below the threshold.

You can:

● Select one of the default values for TTL, ECL, or CMOS
– TTL: 1,4 V
– ECL: -1,3 V
– CMOS: 2,5 V

● Set the "User" value individually
● Let the instrument analayze the signal and find an appropriate level
The threshold is applied to the selected channel.

Remote command: 
​CHANnel<m>: ​THReshold ​ on page 282

Label
Opens the "Label" menu to define an additional name label for the selected waveform.
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See: ​chapter 2.3.3.5, "Label Menu", on page 34

2.3.3.3 Probe Menu (Passive Probe)

In the probe menu for passive probes, the probe attenuation for the selected channel is
set. If the probe is known to the instrument, the attenuation factor is set automatically.
For unknown probes, you can select a default factor or enter a user-defined value.

Access: CH N > "More > Probe"

x1, x10, x100, x1000: attenuation factor
The keys select a default attenuation factor of the connected probe. The vertical scaling
and measured values are multiplied by this factor so that the displayed values are equal
to the undivided measured signal values.

To set an arbitrary attenuation factor, press the "User" softkey.

User: user-defined attenuation factor
You can enter an arbitrary attenuation factor in the range between x0.001 and x1000.
The vertical scaling and measured values are multiplied by this factor so that the dis-
played values are equal to the undivided measured signal values.

Remote command: 
​PROBe<m>: ​SETup:​ATTenuation: ​MANual​ on page 287

Unit
Selects the unit that the probe can measure.
● V - for voltage measurements
● A - for current measurements

Remote command: 
​PROBe<m>: ​SETup:​ATTenuation: ​UNIT ​ on page 287

2.3.3.4 Probe Menu (Active Probe)

In the probe menu for active probes, you can also adjust the offset value for the selected
channel. Termination and attenuation are read out from the probe and do not need any
adjustment.

Access: CH N > "More > Probe"
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Offset
See ​"OFFSET" on page 28.

ProbeMeter
Activates the integrated R&S ProbeMeter of active R&S probes and selects the probe
type. This voltmeter measures DC voltages between the probe tip and ground connection
with very high precision and enables ground-referenced measurements of voltages. The
DC measurement is performed continuously and in parallel to the measurements of the
oscilloscope. If activated, the DC offset measured on the probe tip is shown in a colored
label below the channel label.

"Inactive" ProbeMeter is disabled.

"Single Ended" ProbeMeter of a single-ended active probe is enabled.

Remote command: 
​PROBe<m>: ​SETup:​OFFSwitch ​ on page 289
​PROBe<m>: ​SETup:​DCOFfset? ​ on page 288

Micro Button
Active R&S probes have a configurable Micro Button on the probe head. Pressing this
button, you can perform an action on the instrument directly from the probe. During inter-
nal automatic processes the button is disabled, for example, during self alignment, auto-
set, and find level.

Select the action that you want to start from the probe.

"Continuous" Pressing the Micro Button starts continuous acquisition like the RUN
key. The acquisition is running as long as you press the Micro Button
again.

"Single" Starts one acquisition.

"Autoset" Starts the autoset procedure.

"None" Select this option to prevent unwanted actions due to unintended usage
of the Micro Button.

Remote command: 
​PROBe<m>: ​SETup:​MODE ​ on page 289

Info
Shows general information on the connected probe, for example, type, serial number,
and production date, as well as electrical characteristics like bandwidth, attenuation, input
capacitance and impedance, voltage and DC offset range.
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2.3.3.5 Label Menu

Access: CH N > "More > Label"

In the "Label" menu, you can define an additional name label for the selected waveform.

Label
Shows or hides the channel name. The name label is shown at the vertical center of the
channel on the right edge of the display.

Remote command: 
​CHANnel<m>: ​LABel:​STATe ​ on page 282

Library
Selects a predefined name text and assigns it to the selected channel. The text can be
edited with "Edit Label".

Edit Label
Opens on-screen keyboard to enter a waveform name. If you previously have selected
a text from the library, it is already written in the entry line, and you can modify it.

The maximum name length is 8 characters, and only ASCII characters provided on the
on-screen keyboard can be used.

Remote command: 
​CHANnel<m>: ​LABel ​ on page 282
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3 Triggers

3.1 Basics of Triggering

Triggering means to capture the interesting part of the relevant waveforms. Choosing the
right trigger type and configuring all trigger settings correctly allows you to detect various
incidents in analog, digital, and logic signals.

Trigger

A trigger occurs if the complete set of trigger conditions is satisfied simultaneously. It
establishes the time-zero point in the waveform record. The instrument acquires contin-
uously and keeps the sample points to fill the pretrigger part of the waveform record.
When the trigger occurs, the instrument continues acquisition until the posttrigger part of
the waveform record is filled. Then it stops acquiring and displays the waveform. When
a trigger is recognized, the the instrument will not accept another trigger until the acqui-
sition is complete.

Trigger conditions

A simple set of trigger conditions includes:
● Source of the trigger signal
● Trigger type and and its setup
● Horizontal position of the trigger: trigger position and reference point
● Trigger mode

The R&S RTM provides various trigger types for troubleshooting and signal analysis, for
example, edge trigger, width trigger, pattern trigger, and specific triggers like video and
bus triggers.

More complex trigger conditions are also available: you can setup a trigger sequence to
join two edge triggers with an optional delay time or event count. Similar setups are also
known as multi-step trigger or A/B trigger.

Furthermore, hysteresis avoids unwanted trigger events caused by noise.

Trigger event

In particular for the A/B trigger sequence, it is important to distinguish between the trigger
and the event. An event is the fulfillment of the event conditions, but an event may not
be the trigger. The trigger occurs only if the conditions of all events - the A event and the
B event - in a trigger sequence and all further trigger conditions are all fulfilled.

Trigger information

Information on the most important trigger settings are shown in the information bar. The
label shows:
● Trigger source and level
● Trigger coupling and filters
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● Trigger slope or other conditions specific for the selected trigger type

Fig. 3-1: Trigger information: Normal trigger mode, trigger source is channel 1, width trigger to find
negative pulses shorter than a given pulse width, trigger level = 1.71 mV

Fig. 3-2: Trigger information: Normal trigger mode, trigger sequence; A-event has source channel 1,
edge trigger on rising edge with DC coupling and HF reject, trigger level 1.71 mV; B-event
has source channel 2, edge trigger on rising edge and trigger level 0 V; instrument trig-
gers on the second B-event

3.2 Setting Up the Trigger

This chapter provides step-by-step procedures for the important stages of trigger setup.
The settings mentioned here are described in detail in ​chapter 3.3, "Reference for Trig-
gers", on page 37.

3.2.1 Configuring the Trigger Event

Prerequisites:
● Horizontal and vertical settings are set appropriately to the signals.
● The acquisition is running, the RUN CONT key lights green.

1. Press the SETUP key in the TRIGGER functional block.

The "Trigger" menu opens.

2. Press the "Source" softkey and select the trigger source.

3. Press "Setup" to return to the "Trigger" menu.

4. Press the "Type" softkey repeatedly until the required trigger type is selected.

5. Select "Setup".

6. Configure the settings for the selected trigger type.

For details, see:

● ​chapter 3.3.2.2, "Edge", on page 41
● ​chapter 3.3.2.3, "Width", on page 43
● ​chapter 3.3.2.4, "Video", on page 45
● ​chapter 3.3.2.5, "Pattern", on page 47
● ​chapter 3.3.2.6, "Protocol", on page 48

7. Set the "Normal" trigger mode: Press the AUTO/NORMAL key on the front panel until
"Norm" is shown in the information bar.
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3.2.2 Positioning the Trigger

By positioning the trigger, you define which part of the waveform is displayed: mainly the
pretrigger part, or the posttrigger part, or the part around the trigger point. Therefore, you
set the time reference (also known as reference point) and the trigger position in relation
to the time reference.

1. To set the time reference point:

a) Press the SETUP key on the left of the display.
b) Select "Time Reference".
c) Turn the navigation knob to move the reference point.

2. To set the trigger position, turn the POSITION rotary knob in the HORIZONTAL func-
tional block.

3.2.3 Setting Up a Trigger Sequence

An A/B trigger sequence consists of two edge triggers connected by a time delay or event
count.

1. Press the SETUP key in the TRIGGER functional block.

2. Press the "Trigger Type" softkey and select "Edge" trigger.

3. Select "Setup", configure the A trigger and select "Back".

4. Press the "B-Trigger" softkey to enable the B-trigger.

The LEVEL knob and SLOPE key on the front panel are automatically assigned to
the B-trigger. You can change the assignment with the "Trigger Level" softkey in the
"Trigger" menu.

5. Press the "B-Setup" softkey.

6. Configure the B-trigger: Select "B-Source" and "Slope", and turn the LEVEL rotary
knob to adjust the B-trigger level.

7. Define the connection between the A and B triggers by doing one of the following:

● Press "Time" and adjust the delay time with the navigation knob.
● Press "Events" and enter the number of B-trigger events that have to be fulfilled

until the instrument triggers.

3.3 Reference for Triggers

The trigger settings are located in the TRIGGER functional block on the front panel and
in the "Trigger" softkey menu.
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3.3.1 TRIGGER Controls

The keys and the rotary knob in the TRIGGER functional block adjust the trigger and start
or stop acquisition.

RUN CONT
Starts and stops the continuous acquisition. A green light indicates a running acquisition.
A red light shows that acquisition is stopped.

The status is also shown at the right end of the information bar: "Run" or "Complete".

Remote command: 
​RUN​ on page 271
​RUNContinous ​ on page 272
​STOP ​ on page 272

RUN Nx SINGLE
Starts a defined number of acquisitions. Press the key again to stop running acquisitions.

To set the number of acquisitions, press the ACQUISITION key and enter "Nx Single".

Remote command: 
​SINGle​ on page 272
​RUNSingle ​ on page 272

FORCE
If the acquisition is running in normal mode and no valid trigger occurs, forcing the trigger
provokes an immediate single acquisition. Thus you can confirm that a signal is available
and use the waveform display to determine how to trigger on it.

MODE
Toggles the trigger mode between Auto and Normal. The trigger mode determines the
behaviour of the instrument if no trigger occurs. The current setting is shown in the infor-
mation bar.

"Auto" The instrument triggers repeatedly after a time interval if the trigger
conditions are not fulfilled. If a real trigger occurs, it takes precedence.
This mode helps to see the waveform even before the trigger is set. The
waveform on the screen is not synchronized, and successive wave-
forms are not triggered at the same point of the waveform.
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"Normal" The instrument acquires a waveform only if a trigger occurs, that is, if
all trigger conditions are fulfilled. If no trigger occurs, no waveform is
acquired and the last acquired waveform is displayed. If no waveform
was captured before, nothing is displayed.

Remote command: 
​TRIGger: ​A:​MODE ​ on page 292

LEVEL
The rotary knob changes the trigger treshold voltage for all trigger types that require a
trigger level.

Turn clockwise to move the trigger level up. At zero-crossing, the knob shortly snaps in
and the setting is kept constant to simplify the zero-setting. Press the knob to set the level
to 50% of the signal amplitude.

If a B-trigger is enabled, the knob can set the level for both the A- and B-trigger. To assign
the level to the A- or B-trigger, use "Trigger Level" in the "Trigger" menu.

Remote command: 
​TRIGger: ​A:​LEVel<n>[: ​VALue]​ on page 292
​TRIGger: ​A:​FINDlevel ​ on page 292
​TRIGger: ​B:​FINDlevel ​ on page 299

SETUP
Opens the "Trigger" menu.

SOURCE
Opens the "Trigger Source" menu. Press the key repeatedly until the required source is
selected. The key lights up in the color of the selected trigger channel. The selected
source is shown in the information bar.

SLOPE
If you have selected "Edge" trigger as trigger type with an analog trigger source, the
SLOPE key toggles the trigger slope. The current setting is shown by an icon in the
information bar.

If a B-trigger is enabled, the key can set the slope for both the A- and B-trigger. To assign
the slope to the A- or B-trigger, use "Trigger Level" in the "Trigger" menu.

3.3.2 Trigger Settings

Trigger settings consist of general settings in the "Trigger" menu and the trigger type-
specific setup. For B-trigger setup, a separate menu is provided.

● Trigger Menu and Trigger Source...........................................................................40
● Edge........................................................................................................................41
● Width.......................................................................................................................43
● Video.......................................................................................................................45
● Pattern.....................................................................................................................47
● Protocol...................................................................................................................48
● B-Setup...................................................................................................................48
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3.3.2.1 Trigger Menu and Trigger Source

The "Trigger" menu is general menu for all trigger types and leads to the type-specific
menus.

The content of the "Trigger Source" menu depends on the trigger type. The figure below
shows the trigger source menu for edge, width, and video triggers.

To set the trigger offset, use the horizontal POSITION rotary knob, see ​"POSITION"
on page 23.

Trigger Type..................................................................................................................40
Setup.............................................................................................................................40
Source...........................................................................................................................40

└ Channel N.......................................................................................................41
└ AC Line...........................................................................................................41
└ Extern..............................................................................................................41

Hold Off.........................................................................................................................41
B-Trigger.......................................................................................................................41
B-Setup.........................................................................................................................41
Trigger Level.................................................................................................................41

Trigger Type
Selects the trigger type.

For details, see:
● ​chapter 3.3.2.2, "Edge", on page 41
● ​chapter 3.3.2.3, "Width", on page 43
● ​chapter 3.3.2.4, "Video", on page 45
● ​chapter 3.3.2.5, "Pattern", on page 47
● ​chapter 3.3.2.6, "Protocol", on page 48

Remote command: 
​TRIGger: ​A:​TYPE ​ on page 293

Setup
Opens the setup menu for the selected trigger type.

Source
Opens the "Trigger Source" menu for the selected trigger type.

Remote command: 
​TRIGger: ​A:​SOURce ​ on page 293
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Channel N ← Source
Selects one of the input channels as trigger source.

AC Line ← Source
Selects the mains supply of the oscilloscope as trigger input for the edge trigger. The
instrument extracts the trigger signal from the power supply.

Extern ← Source
Sets the External Trigger Input on the rear panel as trigger source. Select the signal type
that is connected: AC or DC.

Remote command: 
​TRIGger: ​EXTern: ​COUPling ​ on page 293

Hold Off
Defines the holdoff as a time period. The next trigger occurs only after the holdoff time
has passed.

The trigger holdoff defines when the next trigger after the current will be recognized. Thus,
it affects the next trigger to occur after the current one. Holdoff helps to obtain stable
triggering when the oscilloscope is triggering on undesired events.

Remote command: 
​TRIGger: ​A:​HOLDoff: ​TIME ​ on page 294

B-Trigger
Activates or deactivates the second event in a trigger sequence. The instrument triggers
if both trigger event conditions (A and B) are fulfilled.

If the B-trigger is activated, the LEVEL rotary knob and the SLOPE key are automatically
assigned to the B-event. You can toggle the assignment of these controls with the "Trigger
Level" setting in the "Trigger" menu.

Remote command: 
​TRIGger: ​B:​ENABle ​ on page 299

B-Setup
Opens the menu for B-trigger configuration. The B-trigger is a second edge trigger event
that can be combined with a preceeding edge trigger event. The trigger conditions of this
second event are considered when the conditions of the main event (A-trigger) are met.

For a description of the menu, see ​chapter 3.3.2.7, "B-Setup", on page 48.

Trigger Level
Assigns the SLOPE key and the LEVEL rotary knob on the front panel to the A- or B-
event. The function is only relevant if the B-trigger is enabled. The SOURCE key sets
always the A-trigger source.

3.3.2.2 Edge

The edge trigger is the simpliest and most common trigger type. It is well-known from
analog oscilloscopes; and you can use it for analog and digital signals. The trigger event
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occurs when the signal from the trigger source passes the specified treshold voltage -
the trigger level - in the specified direction (slope).

The edge trigger is also selected with the AUTOSET function.

Slope.............................................................................................................................42
Coupling........................................................................................................................42
LF Reject.......................................................................................................................42
HF Reject......................................................................................................................42
Low-pass.......................................................................................................................43
Hysteresis A / B.............................................................................................................43

Slope
Sets the edge for the trigger.

"Rising" Selects the rising edge, that is a positive voltage change.

"Falling" Selects the falling edge, that is a negative voltage change.

"Both" Selets the rising as well as the falling edge.

Remote command: 
​TRIGger: ​A:​EDGE: ​SLOPe ​ on page 294

Coupling
Sets the coupling for the trigger source.

"AC" Alternating Current coupling. A 5 Hz high pass filter is connected into
the trigger path and removes the DC offset voltage from the trigger sig-
nal.

"DC" Direct Current coupling. The trigger signal remains unchanged.

Remote command: 
​TRIGger: ​A:​EDGE: ​COUPling ​ on page 294

LF Reject
Sets the trigger coupling to high frequency. A 15 kHz high-pass filter is connected into
the trigger path and removes lower frequencies from the trigger signal. Use this mode
only with very high frequency signals.

Remote command: 
​TRIGger: ​A:​EDGE: ​COUPling ​ on page 294

HF Reject
Turns an additional 5 kHz low-pass filter in the trigger path on or off. This filter removes
higher frequencies and is available with AC and DC coupling.

Remote command: 
​TRIGger: ​A:​EDGE: ​FILTer: ​LPASs ​ on page 295
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Low-pass
Turns an additional 100 MHz low-pass filter in the trigger path on or off. This filter removes
higher frequencies and is available with AC and DC coupling.

Remote command: 
​TRIGger: ​A:​EDGE: ​FILTer: ​NREJect ​ on page 295

Hysteresis A / B
Sets a hysteresis range around the trigger level. If the signal jitters inside this range and
crosses the trigger level thereby, no trigger event occurs. Thus, hysteresis avoids unwan-
ted trigger events caused by noise oscillation around the trigger level.

Hysteresis is available for the edge trigger (A-event and B-event) and for the width trigger.

To see the hysteresis on the display, activate "Trigger Hyst." in the "Display > Auxillary
Cursors" menu.

The hysteresis value depends on the vertical scale.

Remote command: 
​TRIGger: ​A:​HYSTeresis ​ on page 293
​TRIGger: ​B:​HYSTeresis ​ on page 300

3.3.2.3 Width

The width trigger compares the pulse width (duration) with a given time limit. It detects
pulses with an exact pulse width, pulses shorter or longer than a given time, as well as
pulses inside or outside the allowable time range.

The instrument triggers if the pulse does not cross the specified voltage treshold twice.
The pulse width is measured at the trigger level.

Comparison...................................................................................................................43
Polarity..........................................................................................................................44
Time t............................................................................................................................44
Variation........................................................................................................................44
Time t1, Time t2............................................................................................................44
Hysteresis A / B.............................................................................................................44

Comparison
Sets how the measured pulse width is compared with the given limit(s).

"ti<t, ti>t" Triggers on pulse width shorter or longer than the reference "Time t".
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"ti=t" Triggers on pulse width equal to the reference "Time t" if "Variation" Δt
= 0.
If "Variation" ≠ 0: this setting triggers on pulses within the range t±Δt.

"ti≠t" Triggers on pulses unequal to the reference "Time t", if "Variation" Δt =
0.
If "Variation" ≠ 0: this setting triggers on pulses outside a range t±Δt.

"Inside, Out-
side"

Triggers on pulses inside or outside a range specified with "Time t1"
and "Time t2".
This method is an alternative setting to the range definition with "Time
t" and "Variation". The values are interdependent. "Variation" and "Time
t" are adjusted If you change t1 and t2, and vice versa.

Remote command: 
​TRIGger: ​A:​WIDTh: ​RANGe​ on page 295

Polarity
Sets the polarity of the pulse.

"Pos." Positive going pulse, the width is defined from the rising to the falling
slopes.

"Neg." Negative going pulse, the width is defined from the falling to the rising
slopes.

Remote command: 
​TRIGger: ​A:​WIDTh: ​POLarity ​ on page 295

Time t
Sets the reference time, the nominal value for comparisons ti<t, ti>t, ti=t, ti≠t.

Remote command: 
​TRIGger: ​A:​WIDTh: ​WIDTh​ on page 296

Variation
Sets a range Δt to the reference "Time t", if comparison is set to "ti=t" or "ti≠t". The instru-
ment triggers on pulses inside or outside the range ti±Δt.

Remote command: 
​TRIGger: ​A:​WIDTh: ​DELTa​ on page 296

Time t1, Time t2
Set the lower and upper time limits defining the time range if "Inside" or "Outside" is set
for comparison. "Time t" and "Variation" are adjusted accordingly.

Hysteresis A / B
Sets a hysteresis range around the trigger level. If the signal jitters inside this range and
crosses the trigger level thereby, no trigger event occurs. Thus, hysteresis avoids unwan-
ted trigger events caused by noise oscillation around the trigger level.

Hysteresis is available for the edge trigger (A-event and B-event) and for the width trigger.

To see the hysteresis on the display, activate "Trigger Hyst." in the "Display > Auxillary
Cursors" menu.
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The hysteresis value depends on the vertical scale.

Remote command: 
​TRIGger: ​A:​HYSTeresis ​ on page 293
​TRIGger: ​B:​HYSTeresis ​ on page 300

3.3.2.4 Video

The video or TV trigger is used to analyze analog baseband video signals. You can trigger
on baseband video signals from standard definition and high definition standards.

The trigger level is determined and set automatically by the instrument.

First select the standard and the signal polarity, then decide to trigger on lines or fields
and enter the specific settings.

Most video signals have an output impedance of 75 Ω. The channel inputs of the
R&S RTM have an input impedance of 50 Ω or 1 MΩ. Make sure to provide the adequate
matching to ensure amplitude fidelity. A simple 75 Ω feed-through termination combined
with 1 MΩ oscilloscope inputs is suitable for most applications.

Standard........................................................................................................................45
Signal............................................................................................................................45
Trigger On.....................................................................................................................46
Line...............................................................................................................................46
All Lines.........................................................................................................................46
Frame............................................................................................................................46

Standard
Selects the color television standard.

You can trigger on various SDTV signals like PAL, PAL-M, SECAM, NTSC and
SDTV 576i (PAL and SECAM).

HDTV standards are indicated by the number of active lines and the scanning system (p
for progressive scanning, i for interlaced scanning.

Remote command: 
​TRIGger: ​A:​TV:​STANdard ​ on page 296

Signal
Selects the polarity of the signal. Note that the sync pulse has the opposite polarity. If the
video modulation is positve, the sync pulses are negative. If the modulation is negative,
sync pulses are positive. The edges of the sync pulses are used for triggering, therefore
incorrect polarity setting causes a sporadic triggering by the video information.
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T T

Fig. 3-3: Positive video signal with negative bi-level sync pulse (SDTV, left) and negative signal with
positive tri-level sync pulse (HDTV, right)

Remote command: 
​TRIGger: ​A:​TV:​POLarity ​ on page 297

Trigger On
Toggles between triggering on line starts or frame starts.

Line aloows to trigger on "All Lines" or on one specified "Line".

"Frame" has different effect depending on the selected signal standard:
● For standards using progressive scanning (HDTV 720/1080i), the instrument triggers

on the frame start.
● All other available standards use interlaced scanning, and the instrument triggers on

the field start. You can select the field type to be triggered on using "Frame".

Remote command: 
​TRIGger: ​A:​TV:​FIELd ​ on page 297

Line
Sets an exact line number if "Trigger on" is "Line". If the other trigger conditions are also
met, the oscilloscope triggers exactly on the beginning of the selected line in any field.

Remote command: 
​TRIGger: ​A:​TV:​LINE ​ on page 297

All Lines
The oscilloscope triggers on the beginning of all video signal lines if "Trigger on" is
"Line".

Remote command: 
​TRIGger: ​A:​TV:​FIELd ​ on page 297

Frame
The oscilloscope triggers on the beginning of the video signal fields if the other trigger
conditions are fulfilled. The setting is available for video signals using interlaced scanning.

"All" Triggers on all fields

"Odd" Triggers only on odd fields.

"Even" Triggers only on even fields.

Remote command: 
​TRIGger: ​A:​TV:​FIELd ​ on page 297
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3.3.2.5 Pattern

The Pattern trigger is is a logic trigger. It provides any logical combination of the input
channels and supports you in verifying the operation of digital logic.

The "Setup" and the "Source" menus for the pattern trigger are identical.

Channel N.....................................................................................................................47
Combination..................................................................................................................47
Trigger On.....................................................................................................................48

Channel N
Select the state for each digital channel. The states are:

"H" High: the signal voltage is higher than the trigger level.

"L" Low: the signal voltage is lower than the trigger level.

"X" Don't care: the channel does not affect the trigger.
If X is set for all channels, the oscilloscope triggers only in automatic
trigger mode.

Remote command: 
​TRIGger: ​A:​PATTern: ​SOURce ​ on page 298

Combination
Sets the logical combination of the trigger states of the channels.

"And" The required states of all channels must appear in the input signal at
the same time.

"Or" At least one of the channels must have the required state.

Remote command: 
​TRIGger: ​A:​PATTern: ​FUNCtion ​ on page 298
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Trigger On
Sets the trigger point depending on the result of the logical combination of the channel
states.

Remote command: 
​TRIGger: ​A:​PATTern: ​CONDition ​ on page 298

3.3.2.6 Protocol

The "Protocol" trigger menu contains the trigger settings for the serial bus or interface
that is configured with PROTOCOL. Protocol analysis requires additional options.

For protocol setup and trigger settings, see ​chapter 11, "Protocol Analysis",
on page 144.

To trigger on parallel buses, use the pattern trigger. See: ​chapter 3.3.2.5, "Pattern",
on page 47.

3.3.2.7 B-Setup

The B-trigger is a second edge trigger event that can be combined with a preceeding
edge trigger event. The conditions of this second event are considered when the condi-
tions of the main event (A-trigger) are met.

B-Source.......................................................................................................................48
Slope.............................................................................................................................48
Level..............................................................................................................................49
Trigger On.....................................................................................................................49
Time..............................................................................................................................49
Events...........................................................................................................................49
Hysteresis A / B.............................................................................................................49

B-Source
Selects one of the input channels as B-trigger source. Press the softkey repeatedly until
the required source is selected.

Remote command: 
​TRIGger: ​B:​SOURce ​ on page 299

Slope
Sets the edge for the B-trigger event.

"Positive" Selects the rising edge, that is a positive voltage change.

"Negative" Selects the falling edge, that is a negative voltage change.
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"Both" Selets the rising as well as the falling edge.

Remote command: 
​TRIGger: ​B:​EDGE: ​SLOPe ​ on page 299

Level
Sets the trigger level for the B-trigger event.

Remote command: 
​TRIGger: ​B:​LEVel ​ on page 299

Trigger On
Sets an additional delay condition for the B-event: time delay or event delay. According
to this selection, set also "Time" or "Events" to define the condition completely.

Remote command: 
​TRIGger: ​B:​MODE ​ on page 300

Time
Sets the time the instrument waits after an A-event until it recognizes B-events.

Remote command: 
​TRIGger: ​B:​DELay ​ on page 300

Events
Sets a number of B-trigger events that fulfill all B-trigger conditions but do not cause the
trigger. The oscilloscope triggers on the n-th event (the last of the specified number of
events).

Remote command: 
​TRIGger: ​B:​EVENt: ​COUNt​ on page 300

Hysteresis A / B
Sets a hysteresis range around the trigger level. If the signal jitters inside this range and
crosses the trigger level thereby, no trigger event occurs. Thus, hysteresis avoids unwan-
ted trigger events caused by noise oscillation around the trigger level.

Hysteresis is available for the edge trigger (A-event and B-event) and for the width trigger.

To see the hysteresis on the display, activate "Trigger Hyst." in the "Display > Auxillary
Cursors" menu.

The hysteresis value depends on the vertical scale.

Remote command: 
​TRIGger: ​A:​HYSTeresis ​ on page 293
​TRIGger: ​B:​HYSTeresis ​ on page 300
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4 Display
This chapter provides information on display configuration and display modes.

The default display is a waveform diagram with a time axis in x-direction and the signal
amplitudes displayed in y-direction - the Y(t) or time diagram. You can adjust the visibility
of diagram elements and waveform to your needs. See ​chapter 4.1, "General Display
Settings", on page 50 for details.

You can also display and configure XY-diagrams to combine the voltage levels of two
waveforms in one diagram. This display mode is described in ​chapter 4.2, "XY-Dia-
gram", on page 57.

Furthermore, you can zoom into waveforms to analyze the results in more detail. The
zoom display mode is described in ​chapter 4.3, "Zoom", on page 62.

In a Y(t)-diagram and in zoom mode, you can set markers to mark positions of interest
in the waveform. See ​chapter 4.4, "Markers", on page 67 for details.

In addition to zoom and XY-diagram modes, the following functional modes are available:
● FFT analysis, see ​chapter 8.2, "Configuring and Using FFT Calculations",

on page 107
● Mask testing, see ​chapter 9.2, "Working with Masks", on page 120

4.1 General Display Settings

General display settings adjust the visibility of diagram elements and waveforms.

The individual diagram elements can be shown or hidden:
● Basic diagram elements: grid and crosshairs
● Point of the trigger event
● Channel cursors to mark the ground level and the DC offset

You can also adjust how the waveforms are displayed. The intensity and brightness of
the individual screen elements can influence the readability of the results. Depending on
which type of result you are interested in, e.g. frequency of occurance, time of occurance,
or amplitude of a specific value, different settings may be necessary to highlight that
aspect in the display.

The waveform display depends on the following criteria:
● Waveform style: dots or line
● Intensity: adjusts the optimal contrast of the display

Three settings can be changed to improve the contrast for the relevant display ele-
ments.
– The intensity of the waveform determines the strength of the signal in the diagram.
– The intensity of the background lighting determines the contrast of the signal.
– The intensity of the grid has an influence on the readability of the signal.
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● Persistence defines how long a data point is displayed in the diagram. Each new data
point remains on the screen for the defined persistence time, or infinitely until the
persistence time is changed or the persistence is cleared.

● Signal colors or brightness depend on on the cumulative frequency of the values.
By default, values that occur frequently are displayed brighter than rare values. Alter-
natively, the brightness level can be converted to a color range, i.e. the color changes
gradually with increasing cumulative occurance.
It is also possible to invert the brightness display so that rare values are brighter than
frequent values. This setting is useful in combination with persistence to detect rare
values within the waveform.

4.1.1 Configuring the Display

4.1.1.1 Configuring the Diagram Elements

To display the grid or crosshairs

1. Press "DISPLAY > Grid > Lines" to display a grid.

2. Press "DISPLAY > Grid > Reticle" to display crosshairs.

3. Press "DISPLAY > Grid > Off" to remove both the grid and the crosshairs.

To display the trigger event or the channel cursors

The marker of trigger event and the channel cursors are auxiliary cursors. By default,
both auxiliary cursors are displayed. They help to evaluate specific results more easily.

1. Press "DISPLAY > Aux. Cursor > Trigger Event" to display a trigger cursor.

A rhombus marks the point where the trigger event happened.

2. Press "DISPLAY > Aux. Cursor > Channel Cursors" to display a channel cursor.

A dashed line is displayed that marks the ground level of the displayed channel. If a
DC offset is defined, a second auxiliary line is displayed. The distance between those
two lines is the DC offset.

3. Press "DISPLAY > Aux. Cursor > Defaults" to restore the default setting (both cursors
displayed).

4.1.1.2 Configuring the Waveform Display

The waveform display depends on the following criteria:
● Intensities adjust the optimal contrast of the display. See ​"To configure intensity"

on page 52.
● Persistence defines how long a data point is displayed in the diagram. See ​"To con-

figure persistence" on page 52.
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● Brightness and signal colors depend on the cumulative frequency of the value. See:
​"To configure brightness" on page 52

● Waveform as line or points: see ​"To set the waveform style" on page 53.

To configure intensity

For optimal contrast, you can change the intensity of the waveform, of the grid, and of
the backlight.

1. Press "DISPLAY > Intensities".

2. To set the intensity of the waveform:

a) Press "Waveform".
b) Enter a percentage between 0 (not visible) and 100% (very strong). The default

value is 50%. You can also use the "INTENSITY" knob on the left side of the
screen to adjust the waveform intensity directly.

3. To set the intensity of the grid:

a) Press "Grid".
b) Enter a percentage between 0 and 100%. The default value is 34%.

4. To set the intensity of the backlight:

a) Press "Backlight".
b) Enter a percentage between 10 and 100%. The default value is 50%.

To configure persistence

1. To display only the current signal at any time, press "DISPLAY > Intensities > Per-
sistence" until "Off" is highlighted.

2. To have the instrument define the optimal persistence automatically, press "DISPLAY
> Intensities > Persistence" until "Automatic" is highlighted.

3. To configure the persistence manually:

a) Press "DISPLAY > Intensities > Persistence" until "Manual" is highlighted.
b) Press "DISPLAY > Intensities > Persist. Time" to define the persistence time.
c) Enter a value between 50 ms and 9.6 s or "Infinite".

Each new data point in the diagram area remains on the screen for the defined dura-
tion. If "Infinite" is selected, each new data point in the diagram area remains on the
screen infinitely until this setting is changed or the persistence is cleared.

4. To update the waveform, press "DISPLAY > Intensities > Clear Persist.".

To configure brightness

For better distinction of rare and frequent values, you can apply a color range to the value
frequency. With this color range, rare values are displayed in blue, while more frequent
values are red and very frequent values are displayed in yellow or white, with various
colors inbetween.
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It is also possible to invert the brightness display so that rare values are brighter than
frequent values.

1. To convert the brightness level to a color range, press "DISPLAY > Temperature
Colors".

2. To invert the brightness level of the signals, press "DISPLAY > Inverse Brightn.".

To set the waveform style

By default, the individual data points are connected by a line. Alternatively, only the indi-
vidual data points can be displayed.

You can change the strength of the line using the "INTENSITY" knob on the left side of
the screen.

► Press "DISPLAY > Dots Only" to display the data points only.

4.1.2 Display Menu

The DISPLAY key provides functions for configuring the display.

Display Mode................................................................................................................54
XYZ Setup.....................................................................................................................54
Intensities......................................................................................................................54

└ Waveform........................................................................................................54
└ Backlight.........................................................................................................54
└ Grid.................................................................................................................54
└ Persistence.....................................................................................................55
└ Persist. Time...................................................................................................55
└ Clear Persist...................................................................................................55

Dots Only......................................................................................................................55
Inverse Brightn..............................................................................................................55
Temper. Colors.............................................................................................................55
Aux. Cursors.................................................................................................................56

└ Trigger Event..................................................................................................56
└ Channel Cursors.............................................................................................56
└ Trigger Hyst....................................................................................................56
└ Defaults...........................................................................................................56

Grid...............................................................................................................................57
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Display Mode
Toggles the diagram mode.

"Y(t)" Default time diagram with a time axis in x-direction and the signal ampli-
tudes displayed in y-direction.

"XY-diagram" XY-diagrams combine the voltage levels of two waveforms in one dia-
gram. They use the voltage level of a second waveform as the x-axis,
rather then a time base. This allows you to perform phase shift meas-
urements, for example.You can also define the intensity of the XY-dia-
gram according to a further signal source Z.
Together with the XY-diagram, the Y(t)-diagrams of the source signals
are displayed in separate windows.
With R&S RTM1054, it is also possible to define two source signals in
y-direction for comparison.

Remote command: 
​DISPlay: ​MODE ​ on page 301

XYZ Setup
See ​chapter 4.2.2, "XYZ Setup Menu", on page 60.

Intensities
Provides functions to define the intensity of various display elements.

Waveform ← Intensities
This value determines the strength of the waveform line in the diagram. Enter a percent-
age between 0 (barely visible) and 100% (very strong). The default value is 50%. You
can also use the "INTENSITY" knob on the left side of the screen to adjust the waveform
intensity directly.

Remote command: 
​DISPlay: ​INTensity: ​WAVeform ​ on page 304

Backlight ← Intensities
Defines the intensity of the background lighting of the display in percent. Enter a per-
centage between 10% and 100%. The default value is 50%.

Remote command: 
​DISPlay: ​INTensity: ​BACKlight ​ on page 304

Grid ← Intensities
Defines the intensity of the grid on the screen in percent. Enter a percentage between
0%and 100%. The default value is 34%.

Remote command: 
​DISPlay: ​INTensity: ​GRID ​ on page 304
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Persistence ← Intensities
Defines the persistence of the waveform on the screen.

"Off" Deactivates persistence

"Automatic" The optimal persistence time is determined automatically by the instru-
ment

"Manual" User-defined persistence according to "Persist. Time" setting.

Remote command: 
​DISPlay: ​PERSistence: ​STATe​ on page 304
​DISPlay: ​PERSistence: ​TIME:​AUTO ​ on page 305

Persist. Time ← Intensities
User-defined persistence time if "Manual" persistence is selected. Each new data point
remains on the screen for the duration defined here. Possible values are from 50 ms to
9.6 s or "Infinite". If "Infinite" is selected, each new data point remains on the screen
infinitely until this setting is changed or the persistence is cleared.

Remote command: 
​DISPlay: ​PERSistence: ​TIME ​ on page 305
​DISPlay: ​PERSistence: ​INFinite ​ on page 305

Clear Persist. ← Intensities
Clears the displayed persistence on the screen.

Remote command: 
​DISPlay: ​PERSistence: ​CLEar​ on page 305

Dots Only
If activated, only the individual data points are displayed. If deactivated, the individual
data points are connected by a line. Define the strength of the line using the "INTEN-
SITY" knob on the left side of the screen.

Remote command: 
​DISPlay: ​STYLe​ on page 305

Inverse Brightn.
Inverts the brightness level of the signals. Normally, values that occur frequently are
brighter than rare values. This setting inverts this behavior: Rare values are brighter than
frequent values. Use this setting in combination with persistence to detect rare values
within the waveform.

Remote command: 
​DISPlay: ​PALette ​ on page 301 (INVerse, IFColor)

Temper. Colors
Temperature Colors: Converts the brightness level of the displayed signals into a color
range, i.e. the color changes gradually in a wide color spectrum with increasing cumula-
tive occurance.

By default, rare values are displayed in blue, while more frequent values are red and very
frequent values are displayed in yellow or white, with various colors inbetween. This
results in a higher contrast, which provides a better perception of details in the waveforms.
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Note: The colors change if you invert the brightness display.

Remote command: 
​DISPlay: ​PALette ​ on page 301 (NORMal, FColor)

Aux. Cursors
Provides functions to display auxiliary cursors. Highlighted functions are active.

Trigger Event ← Aux. Cursors
Show or hides the point of the trigger. A small rhombus markes the intersection of the
trigger level and the trigger offset T.

The offset is related to the reference point and is displayed in the header of the display.
If you change the trigger level or the trigger position, a line appears temporarily to highlight
the changed value.

If the B-trigger is activated, the trigger is the result of an A-event followed by an B-event.
The trigger point has the color of the B-trigger source.

Channel Cursors ← Aux. Cursors
Activates or deactivates the channel cursor of the active channel. A channel cursor is a
line that marks the ground level of a channel. This line is displayed temporarily if the y-
scaling is modified and fades out automatically.

If a DC offset is defined, a second auxiliary line is displayed. The distance between those
two lines is the DC offset.

Trigger Hyst. ← Aux. Cursors
Shows or hides the hysteresis range around the trigger level when the trigger level or the
hysteresis are changed. Hysteresis avoids unwanted trigger events caused by noise
oscillation around the trigger level.

See also: ​"Hysteresis A / B" on page 43

Defaults ← Aux. Cursors
Restores the default cursor settings, i.e. both auxiliary cursors are displayed.
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Grid
Defines how the grid is displayed.

"Lines" Displays the grid as horizontal and vertical lines.

"Reticle" Displays crosshairs instead of a grid.

"Off" Removes the grid from the display.

Remote command: 
​DISPlay: ​GRID:​STYLe ​ on page 306

4.2 XY-Diagram

XY-diagrams combine the voltage levels of two waveforms in one diagram. They use the
amplitude of a second waveform as the x-axis, rather then a time base. This allows you
to perform phase shift measurements, for example. With harmonically related signals the
resulting XY-diagrams are Lissajous patterns. XY-diagrams can also be used to display
the IQ representation of a signal.

It is also possible to define two source signals in y-direction for comparison.

The intensity of the XY-waveform can be set to a defined level, or be modulated dynam-
ically using a further source signal. In the latter case, the amplitudes of additional source
signal determine the intensity of the displayed waveform. For details, see ​chapter 4.2.1.2,
"Configuring the Intensity of an XY-Waveform", on page 59.

Together with the XY-diagram, the time diagrams of the source signals are displayed in
separate windows.
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Fig. 4-1: XYZ-display

4.2.1 Configuring XY-Diagrams

XY-diagrams combine the voltage levels of two waveforms in one diagram. A further
signal source can be used to determine the intensity of the XY-waveform.

4.2.1.1 Setting Up the XY-Diagram

To switch the display to XY-diagram and vice versa

► Press "DISPLAY > Display Mode" until the "XY" mode is selected.

To configure an XY-diagram

Prerequisite: The "Display Mode" is set to "XY".

1. Select "DISPLAY > XYZ Setup > Source X" to define the signal to be used as the x-
axis source. Press "Source X" repeatedly until the required channel is highlighted.
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2. Select "DISPLAY > XYZ Setup > Source Y1" to define the signal to be used as the
(first) y-axis source. Press "Source Y1" repeatedly until the required channel is high-
lighted.

3. Optionally, select "DISPLAY > XYZ Setup > Source Y2" to define the signal to be
used as a second y-axis source. Press "Source Y2" repeatedly until the required
channel is highlighted.

The XY-diagram is displayed in the main window, and additional windows are opened
to display the X, Y1, Y2, and Z time diagrams, if the source is defined.

4.2.1.2 Configuring the Intensity of an XY-Waveform

You can define the intensity of the XY-diagram as a constant value or according to the
amplitude of a further signal source Z.
● Constant intensity: ​To configure the intensity of an XY-waveform at a defined level
● The waveform intensity is modulated dynamically according to the signal source Z.

The higher the signal level Z is, the stronger the waveform is displayed: ​To configure
the intensity of an XY-waveform modulated by a signal amplitude.

● The waveform intensity is defined by a threshold value: If the Z signal value is below
the selected threshold, the corresponding x/y point is not displayed. If the Z signal
value is above the threshold, the x/y point is displayed with the defined intensity level:
​To configure the intensity of an XY-waveform using a threshold value

To configure the intensity of an XY-waveform at a defined level

Prerequisite: The "Display Mode" is set to "XY", and the XY-diagram is configured.

1. Press "DISPLAY > XYZ Setup > Z Setup".

2. Press the left "Source Z" softkey until "OFF" is highlighted to deactivate intensity
control by the Z source.

3. Press "DISPLAY > Intensities > Trace" to define the intensity level of the waveform.

4. Enter a percentage between 0 (not visible) and 100% (very strong). The default value
is 50%.

Regardless of which menu is currently displayed, you can use the "INTENSITY" knob on
the left side of the screen to adjust the waveform intensity directly.

To configure the intensity of an XY-waveform modulated by a signal amplitude

Prerequisite: The "Display Mode" is set to "XY", and the XY-diagram is configured.

1. Press "DISPLAY > XYZ Setup > Z Setup".

2. Press the left "Source Z" softkey until "ON" is highlighted to activate intensity control
by the Z source.

3. Press the second "Source Z" softkey repeatedly until the required channel for inten-
sity control is selected.
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4. Press "Z-Intensity" until "Modulation" is highlighted to select intensity control via
modulation.

To configure the intensity of an XY-waveform using a threshold value

Prerequisite: The "Display Mode" is set to "XY", and the XY-diagram is configured.

1. Press "DISPLAY > XYZ Setup > Z Setup".

2. Press the left "Source Z" softkey until "ON" is highlighted to activate intensity control
by the Z source.

3. Press the second "Source Z" softkey repeatedly until the required channel for inten-
sity control is selected.

4. Press "Z-Intensity" until "ON | OFF" is highlighted to select intensity control via a
threshold value.

5. Press "Threshold" and enter the required value to define the threshold value.

4.2.2 XYZ Setup Menu

The setup of XY-diagrams is a submenu of the "Display" menu.

Access: DISPLAY > "XYZ Setup"

Source X
Defines the source to be displayed in x direction in an XY-diagram, replacing the usual
time base. The source can be selected from any of the analog channels.

The function is available in R&S RTM1054.

Remote command: 
​DISPlay: ​XY:​XSOurce ​ on page 302

Source Y1
Defines the (first) source to be displayed in y direction in an XY-diagram. The source can
be selected from any of the analog channels.

The function is available in R&S RTM1054.

Remote command: 
​DISPlay: ​XY:​Y1Source ​ on page 302

Source Y2
Defines an optional second source to be displayed in y direction in an XY-diagram. The
source can be selected from any of the analog channels.
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The function is available in R&S RTM1054.

Remote command: 
​DISPlay: ​XY:​Y2Source ​ on page 302

X-CH1 Y-CH2
Defines channel 1 to be displayed in x direction in an XY-diagram, replacing the usual
time base, and sets channel 2 to the y-axis.

The function is available in R&S RTM1052.

X-CH2 Y-CH1
Defines channel 2 to be displayed in x direction in an XY-diagram, replacing the usual
time base, and sets channel 1 to the y-axis.

The function is available in R&S RTM1052.

Z Setup
The intensity of the waveform displayed in an XY-diagram can be set to a defined level,
or be modulated dynamically using a further source signal Z. In the latter case, the ampli-
tudes of the source signal determine the intensity of the displayed waveform.

Z ← Z Setup
Activates or deactivates the intensity control of the waveform via an additional signal
source. If deactivated, the intensity is defined by the general "Intensity" setting for the
trace.

Remote command: 
​DISPlay: ​XY:​ZMODe ​ on page 302

Source Z ← Z Setup
Defines the source to be used to determine the intensity of the waveform. The source
can be selected from any of the analog channels. Pressing the softkey repeatedly scrolls
through the list of available source channels.

Remote command: 
​DISPlay: ​XY:​ZSOurce ​ on page 303

Z-Intensity ← Z Setup
Toggles between intensity modes.

"Modulation" Modulated intensity; Intensity is modulated continuously according to
the selected "Source Z".

XY-Diagram
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"On | Off" Intensity is determined by a "Threshold" value. If the Z signal value is
below the selected threshold, the corresponding x/y point is displayed
with lowest intensity. If the Z signal value is above the threshold, the x/
y point is displayed with the defined intensity level.

Remote command: 
​DISPlay: ​XY:​ZMODe ​ on page 302

Threshold ← Z Setup
Defines the threshold for intensity with a two-state modulation, if "Z-Intensity" is set to
"ON | OFF".

Remote command: 
​DISPlay: ​XY:​ZTHReshold ​ on page 303

4.3 Zoom

You can zoom into waveforms to analyze the results in more detail. The zoomed area
and its position can be configured numerically or using the rotary knobs.

Using Markers
You can use markers to quickly zoom into a place of interest in the display, see ​"To zoom
into a marker position" on page 68.

4.3.1 Zoom Display

When you activate zoom display, two windows are displayed: the original waveform dia-
gram at the top (Y(t)-window), and the zoom window at the bottom. The zoom area
defines the part of the original waveform to be zoomed. It is indicated by white lines in
the original Y(t)-window.
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The usual channel parameters are displayed in the information bar above the original
Y(t)-window (see the general display information described in the "Getting Started" man-
ual).

In addition, the zoom area parameters are indicated in the information bar above the
zoom window. The following information is given there:

Z Zoom Time Base, i.e. scaling for the time base in the zoom window in seconds per division; deter-
mines the width of the zoom area that is displayed in the zoom window (10 divisions * scaling per
division)

Tz Zoom Time, i.e. the offset of the trigger point to the reference point 0s in the zoom window; deter-
mines the position of the zoom area

 Sample rate for zoom window

Pressing the horizontal SCALE rotary knob moves the focus between the Y(t)-window
(Time Control), the zoom area (Zoom Control) and the zoom window. The currently
selected screen area is highlighted and displayed in the information bar of the zoom
window. Depending on the selection, the functions of the SCALE and POSITION rotary
knobs may change.

Zoom
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Fig. 4-2: Zoom area width and position

When you deactivate the zoom display, the previous display is restored.

4.3.2 Zooming for Details

The zoomed area and its position can be configured numerically or using the rotary knobs.

To display a zoom diagram

► Press the ZOOM key.

The key lights up and two windows are displayed: the original signal vs. time at the
top, the zoom at the bottom.

To deactivate the zoom display

► Press the ZOOM key again, or press the "Zoom Off" softkey in the "Zoom" menu to
close the zoom window.

The ZOOM key is no longer illuminated and the previous display is restored.

To configure the zoom area numerically

1. Press the "Zoom Time Base" softkey to define the scaling for the time base in the
zoom diagram in seconds per division. The scaling is indicated by "Z" in the infor-
mation bar above the zoom diagram and determines the width of the zoom area that
is displayed in the zoom diagram (10 divisions * scaling per division).

2. Press the "Zoom Time" softkey to define the offset of the trigger point to the reference
point 0s in the zoom diagram. The offset is indicated by "Tz" in the information bar
above the zoom window and determines the position of the zoom area.

The zoom area is indicated by white lines in the original Y(t)-window. The zoom win-
dow displays the data in the defined zoom area from the main time base in greater
detail.
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To configure the zoom area via the rotary knobs

Pressing the horizontal SCALE rotary knob moves the focus between the Y(t)-window
(Time Control), the zoom area (Zoom Control) and the zoom window. The currently
selected screen area is highlighted and displayed in the information bar of the zoom
window. Depending on the selection, the functions of the SCALE and POSITION rotary
knobs may change.

1. Press the horizontal SCALE rotary knob to select "Zoom Control" or "Zoom Win-
dow". The functions for the rotary knobs are the same for both elements; for very high
zoom factors, however, it may be faster to scroll through with the "Zoom Window"
focus.

2. Turn the horizontal SCALE rotary knob counter-clockwise to enlarge the zoom area,
or clockwise to decrease it.

The zoom diagram and the "Z" parameter ( ​Zoom Time Base) in the information bar
above it are adapted.

3. Turn the horizontal POSITION rotary knob counter-clockwise to move the zoom area
to the left, or clockwise to move it to the right.

The zoom diagram and the "Tz" parameter ( ​Zoom Time) in the information bar above
it are adapted.

The zoom window displays the data in the defined zoom area from the main time
base in greater detail.

To configure the original Y(t)-diagram

1. Press the horizontal SCALE rotary knob to select "Time Control", the original Y(t)-
window.

2. Press "Main Time Base" to define the scaling for the time base in the original Y(t)-
window in seconds per division. Alternatively, turn the horizontal SCALE rotary knob.

3. Press "Trigger Offset" to define the offset of the trigger point to the reference point
for 0s in the original Y(t)-window. Alternatively, turn the horizontal POSITION rotary
knob.
Note that changing the offset in the original window also changes the offset for the
zoom window ( ​Zoom Time).

4.3.3 Zoom Menu

The ZOOM key provides functions for configuring the zoom display.
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Main Time Base............................................................................................................66
Zoom Time Base...........................................................................................................66
Trigger Offset................................................................................................................66
Zoom Time....................................................................................................................66
Zoom Off.......................................................................................................................67

Main Time Base
Defines the scaling for the time base in the (original) Y(t)-window in seconds per division.
The scaling is indicated by "TB" in the information bar above the window.

Note: If "Time Control" is selected, the main time base can be adjusted using the hori-
zontal SCALE rotary knob.

See also ​"SCALE" on page 23, ​"To configure the original Y(t)-diagram" on page 65 and ​
figure 8-2.

Remote command: 
​TIMebase: ​SCALe​ on page 273

Zoom Time Base
Defines the scaling for the time base in the zoom window in seconds per division. The
scaling determines the width of the zoom area that is displayed in the zoom window (10
divisions * scaling per division).

The zoom area is indicated by white lines in the original Y(t)-window.

Remote command: 
​TIMebase: ​ZOOM:​SCALe ​ on page 306

Trigger Offset
Defines the horizontal position of the trigger point in relation to the reference point - to
the zero point of the grid. The value is indicated by "T" in the information bar above the
window.

The reference point is set with SETUP >"Time Reference".

Note: If a zoom or FFT window is displayed and "Time Control" is selected, the trigger
offset can be adjusted using the horizontal POSITION rotary knob.
See also:
● ​"POSITION" on page 23
● ​"Time Reference" on page 225
● ​"To configure the original Y(t)-diagram" on page 65

Remote command: 
​TIMebase: ​POSition​ on page 274

Zoom Time
Defines the offset of the trigger point to the reference point 0s in the zoom window. The
offset determines the position of the zoom area that is displayed in the zoom window.

Remote command: 
​TIMebase: ​ZOOM:​TIME ​ on page 307

Zoom
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Zoom Off
Closes the zoom window and returns to the previous display.

Remote command: 
​TIMebase: ​ZOOM:​STATe ​ on page 306

4.4 Markers

Markers allow you to mark certain positions on the screen, e.g. a rising or falling edge,
or an unexpected signal value, or a search result. You can then use the markers to identify
areas of interest you want to zoom into, and quickly move through the data.

Two marker types are available:
● Timestamp markers can be used if no search is enabled. They can be set manually

at any position of the waveform. These markers are indicated by blue vertical lines.
You can set up to 8 timestamp markers. Timestamp markers are descibed in this
chapter.

● If a search is active, you can set search markers to selected search results. These
markers are indicated by magenta search result flags. Search result markers are
described in ​chapter 10.1, "Search Conditions and Results", on page 128

4.4.1 Using Timestamp Markers

Timestamp markers are displayed as colored lines on the screen. If more markers are
available but currently not visible on the screen (e.g. in a zoomed display), this is indicated
by a small arrow at the right or left edge of the display.

See also: ​"To use markers on search results" on page 131.
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Fig. 4-3: Zoomed display using markers

To set a marker

1. Turn the horizontal "Position" rotary knob and move the position to be marked to the
reference point, usually in the middle of the display.

2. Press the SET key to insert a new marker at the reference position.

To select a marker

When you select a marker it is automatically moved to the reference point of the display.

1. Press the NEXT key to move the next (right) marker to the reference point of the
display or zoom area.

2. Press the PREV key to move the previous (left) marker to the reference point of the
display or zoom area.

To remove a marker

1. Select the marker to be deleted using the NEXT or PREV key.

2. Press the CLEAR key to remove the marker at the reference position.

To zoom into a marker position

1. Set a marker in the display as described above.

Markers
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2. If not yet active, activate the zoom function by pressing the ZOOM key.

The marker lines are displayed both in the original window and in the zoom window.

3. Select the marker that indicates the area you want to zoom into using the NEXT or
PREV key.

The center of the zoom area is moved to the marker (see ​figure 4-3).

4. If necessary, fine-tune the position of the zoom area around the marker as described
in ​"To configure the zoom area via the rotary knobs" on page 65.

4.4.2 Reference for Markers

The marker keys are used for both marker types, timestamp markers and search result
markers.

For details on setting and moving markers; see
● ​chapter 4.4.1, "Using Timestamp Markers", on page 67
● ​"To use markers on search results" on page 131

NEXT.............................................................................................................................69
PREV............................................................................................................................69
SET...............................................................................................................................69
CLEAR..........................................................................................................................70

NEXT
Moves the next (right) marker to the reference point of the display or zoom area.

Note: If another marker is available at the right, but currently not visible on the screen, a
small red arrow is displayed at the right edge of the display. If a search is enabled, the
key navigates the search result markers only.

Remote command: 
​TSTamp: ​NEXT ​ on page 307 (for timestamp markers only)

PREV
Moves the previous (left) marker to the reference point of the display or zoom area.

Note: If another marker is available at the left, but currently not visible on the screen, a
small red arrow is displayed at the left edge of the display. If a search is enabled, the key
navigates the search result markers only.

Remote command: 
​TSTamp: ​PREVious ​ on page 307 (for timestamp markers only)

SET
Sets a new marker at the reference point of the display, unless an existing marker is
already set there.

In the display of search results, the marker is set to the search result that is selected in
the "Event Table".

Remote command: 
​TSTamp: ​SET​ on page 307 (for timestamp markers only)
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CLEAR
Deletes the marker at the reference point. Use the NEXT and PREV keys to move the
markers to the reference point.

In the display of search results, the marker is removed from the search result that is
selected in the "Event Table".

Remote command: 
​TSTamp: ​CLEar ​ on page 308 (for timestamp markers only)

Markers
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5 Reference Waveforms
Reference waveforms are waveform data stored in in the internal reference storages.
Four internal reference storages are available: RE1 - RE4. These four reference wave-
forms can be displayed.

Reference waveforms can be saved to and loaded from any storage device - internal
memory or external USB flash device. The file format is .TRF, and the file size is about
12.4 Byte. The file content depends on the storage device:
● Internal storage of the R&S RTM: TRF files contain also the instrument settings, so

you can restore also the settings when you load a reference waveform.
● External USB flash drive: TRF files contain only the waveform data, the instrument

settings are not saved and cannot be restored.

See ​chapter 12.2.4.1, "Waveform File Formats", on page 216 for details on file formats.

You can copy the stored references to another storage device with usual export/import
functions. With export/import, you can also change the target file format and convert the
data. If you export a TRF file to a USB flash drive, the instrument settings get lost and
cannot be loaded with the waveform data anymore. To copy a stored reference, use
FILE >"Import/Export References". See also: ​chapter 12.2.1.2, "Importing and Exporting
Data", on page 207.

Furthermore, you can save waveforms directly to a USB flash drive with FILE > "Wave-
forms", without creating a reference waveform before. See: ​chapter 12.2.4, "Wave-
forms", on page 216.

5.1 Using References

You can store any of the active waveforms as reference waveform - channel, math, and
other reference waveforms - or load a previously saved reference.

For each selected reference waveform, you can adjust the vertical position and scale as
usual, and, unlike for other waveform types, you can also adjust the horizontal position
and scale individually.
The current scale values are shown in the waveform label of the reference waveform.

5.1.1 Displaying a Reference Waveform

A reference waveform is displayed as soon as data is written to its storage, either from
an active waveform, or loaded from a reference file. You can hide it and display it again
by using the "Visible" key.

1. Press the REF key to display the "Reference" menu.

2. Press "Reference" and select the reference storage position.
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If a reference was already loaded to the selected reference position before, the stored
reference waveform is displayed.

3. Select the data that will be used as reference by doing one of the following:

● Press "Source" and select one of the active waveforms, then press "Update".
● Load a previously saved reference.

See also: ​"To load references and reference settings" on page 72.

The selected data is written to the selected reference storage and displayed.

4. Press "Visible" to hide and show the reference waveform.

5.1.2 Saving and Loading References

If you need more than four references, or you want to keep a reference for other meas-
urements, you can save it and load it back to the instrument when needed. Import and
export is also possible.

The instrument settings are saved together with the reference waveform only in the inter-
nal storage. They are removed from the reference file when you save or export the file
to an external storage (USB flash device).

To save references

1. Press REF to display the "Reference" menu

2. Press "Save".

3. Press "Source" and select the waveform whose data you want to save as a reference.
All active waveforms can be saved.

4. Press "Storage" and define the storage settings.
See: ​"To select the storage directory" on page 207.

5. Press "File Name" and enter the name of the target file.
See: ​"To define a new file or directory name" on page 207.

6. Press "Save".

To copy a stored reference, use FILE > "Import/Export References". For import/export
procedure, see ​chapter 12.2.1.2, "Importing and Exporting Data", on page 207.

To load references and reference settings

1. Press REF.

2. Press "Load".

3. Press "Reference" and select the reference number you want to load the reference
to.
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4. Press "Load".

A file explorer is displayed.

5. Select the storage device and the file that contains the reference. Use the "Naviga-
tion" knob to scroll through the directories. To change the directory, scroll to the name
of the directory and press the knob, or press "Change Directory".

6. Press "Load".

The saved reference is loaded to the R&S RTM.

7. If you also want to load the settings that were used to create the reference waveform:

a) In the "Reference" or "Load" menu, press "Reference" and select the reference
number you want to load the settings to.

b) Press "Load Settings".
"Load Settings" is only available if the waveform was loaded to the reference
storage before, you cannot laod the setting first.

5.2 Reference for REF key

The REF key provides functions for working with reference waveforms on the instrument.

For details on working with these functions, see ​chapter 5.1, "Using References",
on page 71.

Reference......................................................................................................................73
Source...........................................................................................................................74
Update...........................................................................................................................74
Visible............................................................................................................................74
Save..............................................................................................................................74
Load..............................................................................................................................74

└ Reference.......................................................................................................74
└ Load................................................................................................................74

Load Settings................................................................................................................74

Reference
Selects one of the four possible internal reference storages.

See also: ​chapter 5.1, "Using References", on page 71.
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Source
Defines the source of the reference waveform. Any active channel, math or reference
waveform can be selected.

Remote command: 
​REFCurve<m>: ​SOURce​ on page 309
​REFCurve<m>: ​SOURce: ​CATalog? ​ on page 309

Update
Stores the waveform defined as the "Source" to the selected reference waveform. The
reference waveform is kept until you update or load another waveform to the reference.

See also: ​chapter 5.1.1, "Displaying a Reference Waveform", on page 71.

Remote command: 
​REFCurve<m>: ​UPDate​ on page 309

Visible
Displays or hides the selected reference waveform.

Remote command: 
​REFCurve<m>: ​STATe​ on page 308

Save
Opens the "Save" menu with basic functions to save the equation set.

See ​"Save Menu" on page 209 .

Remote command: 
​REFCurve<m>: ​SAVE ​ on page 309

Load
Provides functions to load reference data.

Reference ← Load
Selects one of the four possible internal reference storages.

See also: ​chapter 5.1, "Using References", on page 71.

Load ← Load
Opens the "Load" menu and a file explorer to select the reference waveform file for load-
ing.

See ​"Load Menu" on page 210.

Remote command: 
​REFCurve<m>: ​LOAD ​ on page 310

Load Settings
Loads the device settings that were used to obtain the stored reference waveform. The
settings are only available if the file was stored to the internal storage /INT/
REFERENCE and never written to an external storage (USB stick).

Remote command: 
​REFCurve<m>: ​LOAD:​STATe ​ on page 310

Reference for REF key
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6 Measurements
The following measurement methods are available:

● CURSOR: Cursor measurements determine specific measurement results at the
current cursor positions of an active waveform; the results are displayed in a result
table.

● QUICK MEAS: performs basic automatic measurements for the selected channel
immediately; the results are displayed directly at the waveform and in a result table.

● MEAS: With automatic measurements, up to four amplitude and time measurements
or pulse counts can be configured and performed simultaneously; based on an active
channel, reference, or math waveforms. The results are displayed in a result table,
the color of the results corresponds with the source waveform color. These meas-
urements can be performed together with the "Quick Meas" measurements.

Use the full height of the screen for waveform display to get best vertical resolution and
measurement results.

6.1 Cursor Measurements

Using the CURSOR key you can determine specific measurement results at the current
cursor positions for an active channel, math, or reference waveform. The cursors can be
set to the required position with the Navigation rotary knob, or set to typical positions on
a keypress.

6.1.1 Cursor Measurements Types and Results

Cursor measurements are based on automatic measurements. The cursor measurement
is limited to the cursor positions or the part of the waveform between the cursors while
automatic measurements considers the complete display of the waveform. Thus you can
focus the measurement to the interesting part of the waveform by using cursors. The
results are displayed in the right part of the result table.
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For cursor measurements on channel, math, and reference waveforms, various mea-
surement types are available, for example, Peak, RMS, Mean und Count. Cursor mea-
surement is also possible on the results of an FFT analysis. It measures the frequencies
and levels at the cursor positions and their differences. Available cursor measurements
are:

Voltage..........................................................................................................................76
Time..............................................................................................................................77
Voltage & Time..............................................................................................................77
Ratio X..........................................................................................................................77
Ratio Y..........................................................................................................................77
Count.............................................................................................................................77
Peak Values..................................................................................................................77
RMS, Mean, σ...............................................................................................................77
Duty Ratio.....................................................................................................................78
Burst Width....................................................................................................................78
Rise Time......................................................................................................................78
V-Marker.......................................................................................................................78

Voltage
Sets two horizontal cursor lines and measures the voltages at the two cursor positions
and the delta of the two values.

Results: V1, V2, ΔV

Cursor Measurements
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Time
Sets two vertical cursor lines and measures the time from the trigger point to each cursor
point, the time between the two cursors and the frequency calculated from that time.

Results: t1, t2, Δt, 1/t

Voltage & Time
Combines the "Voltage" cursor and "Time" cursor measurements. Two horizontal and
two vertical cursor lines are set and the voltages and time from the trigger point are
measured at the cursor positions, as well as the delta of the voltage and time values.

Results: t1, t2, Δt, V1, V2, ΔV

Ratio X
Provides three cursors and measures the ratio of the x-values (e.g. a duty cycle) between
the first and second cursors and the first and third cursors:

(x2-x1)/(x3-x1)

The ratio is displayed as a floating value, in percent, in degrees and as a radian.

Results: abs, %, °, π

Ratio Y
Provides three cursors and measures the ratio of the y-values (e.g. overshooting)
between the first and second cursors and the first and third cursors:

(y2-y1)/(y3-y1)

The ratio is displayed as a floating value and in percent.

Results: abs, %

Count
Provides three cursors to count signal transitions. The time base is defined by the first
two cursors, the third cursor defines the threshold value. As a result, the number of rising
and falling edges as well as the number of positive and negative impulses is counted.

Results: , , , 

Peak Values
Measures the positive and negative peak values between the two cursors, as well as the
absolute difference between the two peak values (peak-to-peak value):

Vpp = |(Vp+) - (Vp-)|

Results: Vp+, Vp-, Vpp

RMS, Mean, σ
Measures the root mean square (RMS), the mean value, and the standard deviation of
measurement results between the two cursors.

Results: Mean, RMS, σ

Cursor Measurements
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Duty Ratio
Measures the positive and negative duty cycles. The duty cycle is the ratio between the
duration of a positve pulse (high active) or a negative pulse (low-active) and the period
of a rectangular waveform. The measurement requires at least one complete period of
the signal between cursor 1 and cursor 2. Pulse duration and period are measured at
cursor 3.

Results: Dty+, Dty- (in %)

Burst Width
Measures the duration of a burst. Two vertical cursors mark the beginning and the end
of the burst. The horizontal cursor sets the threshold value, and the time between the first
and the last edge of the burst is returned.

Result: BstW

Rise Time
Measures the rise and fall times of the left-most edge in the display between the upper
and lower reference levels. The reference levels are set in the Auto Measure menu:
MEAS > "Reference Level".

See also: ​Reference Level: Upper, Middle, Lower Levels.

Results: tr, tf

V-Marker
Two vertical markers are provided and the values of the waveform at the marker positions
are measured. Additionally, the differences of the two values in x- and y-direction are
displayed.

Results: V1, V2, Δt, ΔV

6.1.2 Performing Cursor Measurements

The cursors are activated according to the latest setting as soon as you press the
CURSOR key.

To configure cursor measurements

1. Press the CURSOR key.

The cursors are activated according to the latest setting.

2. Press "Meas. Type" to select the type of measurement to perform. The type deter-
mines which results are displayed in the result table.
See also: ​"Meas.Type" on page 80.

3. Press "Source" to select the waveform for which the measurement is to be performed.
The source can be any active channel, reference, or math waveform, or a decoded
bus signal.

4. Move the cursors to obtain the required results.
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See also: ​"To change the position of the cursors" on page 79.

The cursor measurement is performed and the results are displayed in the result
table.

To change the position of the cursors

The cursor measurement displays the results depending on the current position of the
cursors. Move the cursors to obtain the results for a specific time range or at specific
signal points.

1. Press the NAVIGATION rotary knob to select the first cursor. If a selection menu is
open, it is closed.

Tip: If the cursors have disappeared from the screen or must be moved extensively
within the screen, press "Set To Screen" in the "Cursor" menu to reset the cursors to
their default positions.

2. Turn the NAVIGATION knob to change the position of the selected cursor line.

3. Press the knob again to select the next cursor line, and turn to adjust position.

4. To simplify the cursor positioning, the following functions are helpful:

● "Track Scaling" to adjust the cursor position when the vertical or horizontal scaling
are changed

● "Coupling" to keep the distance between two cursor lines constant while one of
the cursors is moved

● "Set to Wave" to set the cursor lines to typical points of the waveform based on
automatic measurements in the background

See also: ​chapter 6.1.3, "Cursor Menu", on page 79.

The results of the cursor measurement in the result table are updated.

To deactivate cursor measurements

1. Press the CURSOR key.

2. Press the "Cursor" softkey.

The "Cursor" softkey is no longer highlighted, no more measurements are performed,
the cursor lines disappear and the results are removed from the result table.

6.1.3 Cursor Menu

The CURSOR key opens the "Cursor" menu to configure manual measurements.

See also: ​chapter 6.1.2, "Performing Cursor Measurements", on page 78.
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Cursor...........................................................................................................................80
Meas.Type....................................................................................................................80
Source...........................................................................................................................80
Track Scaling................................................................................................................81
Coupling........................................................................................................................81
Set to Wave...................................................................................................................81
Set To Screen...............................................................................................................81
Prev. peak.....................................................................................................................81
Next peak......................................................................................................................81
NAVIGATION................................................................................................................82

Cursor
Activates or deactivates the selected cursor measurement.

Remote command: 
​CURSor<m>: ​STATe ​ on page 313

Meas.Type
Selects the cursor measurement type. Depending on the type, different results are dis-
played in the result table.

For a list of all cursor measurement types and their description, see ​chapter 6.1.1, "Cursor
Measurements Types and Results", on page 75.

Two or three cursors are provided which can be set to the required position using the
"Navigation" rotary knob. See also: ​"To change the position of the cursors" on page 79.

The setting is not available for cursor measurments on FFT analysis.

Remote command: 
​CURSor<m>: ​FUNCtion ​ on page 313

Source
Defines the source of the cursor measurement as one of the active channel, math, or
reference waveforms, or a decoded bus signal.
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The setting is not available for cursor measurments on FFT analysis.

Remote command: 
​CURSor<m>: ​SOURce ​ on page 313

Track Scaling
If enabled, "Track Scaling" adjusts the cursor lines if the vertical or horizontal scales are
changed. The cursor lines keep their relative position to the waveform.

If disabled, the cursor lines remain on their position on the display if the scaling is
changed.

Remote command: 
​CURSor<m>: ​TRACking: ​SCALe[: ​STATe]​ on page 317

Coupling
If enabled, the cursors of a can be coupled and moved together. Press the
NAVIGATION key to select both corsors or one cursor to be moved.

If disabled, the NAVIGATION key toggles the single cursor lines.

Remote command: 
​CURSor<m>: ​XCOupling ​ on page 316
​CURSor<m>: ​YCOupling ​ on page 316

Set to Wave
Autoset for cursor lines, sets the cursor lines to typical points of the waveform depending
on the selected measurement type. For example, for voltage measurement, the cursor
lines are set to the upper and lower peaks of the waveform. For time measurement, the
cursor lines are set to the edges of two consecutive positive or two consecutive negative
pulses.

Remote command: 
​CURSor<m>: ​SWAVe ​ on page 316

Set To Screen
Resets the cursors to their initial positions. This is helpful if the cursors have disappeared
from the display or need to be moved for a larger distance.

Remote command: 
​CURSor<m>: ​SSCReen ​ on page 316

Prev. peak
For FFT analysis only: sets the selected cursor to the previous (left) level peak.

To select the cursor, press the NAVIGATION knob.

Remote command: 
​CURSor<m>: ​SPPeak ​ on page 316

Next peak
For FFT analysis only: sets the selected cursor to the next (right) level peak.

To select the cursor, press the NAVIGATION knob.

Remote command: 
​CURSor<m>: ​SNPeak ​ on page 317
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NAVIGATION
Select cursor: Press the NAVIGATION rotary knob to select a cursor line. If a menu is
open, it is closed. Press the knob repeatedly to select the required cursor line or - if
Coupling is enabled - a pair of coupled cursor lines.

Move selected cursor: Turn the rotary knob to change the position of the selected cursor
line.

Remote command: 
​CURSor<m>: ​X1Position ​ on page 315
​CURSor<m>: ​X2Position ​ on page 315
​CURSor<m>: ​X3Position ​ on page 315
​CURSor<m>: ​Y1Position ​ on page 315
​CURSor<m>: ​Y2Position ​ on page 315
​CURSor<m>: ​Y3Position ​ on page 315

6.2 Quick Measurements

Quick measurement performs all currently available automatic measurements for the
selected channel. The measurements cannot be configured. The results are displayed
either directly at the waveform (WF) or in the right part of the result table (T) and are
updated continuously.

► Press the QUICK MEAS key to activate quick measurement.
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The following measurement results are determined for the displayed section of the wave-
form:

Label Description Display

Vp+ Positive peak value WF

Vp- Negative peak value WF

tr Rising time of the first rising edge WF

Mean Mean value WF

tf Falling time of the first falling edge WF

RMS RMS T

Vpp Peak to peak value T

T Period length T

f Frequency T

When you activate quick measurements, cursor measurements are automatically deac-
tivated, as well as the reference and math menus. Deactivate quick measurements before
selecting these functions. Channels other than the selected one are switched off in quick
measurement mode.

► Press the QUICK MEAS key again to deactivate the quick measurement and remove
the results.

SCPI command:
● ​MEASurement<m>: ​ALL[: ​STATe]​ on page 320

● ​MEASurement<m>: ​AON ​ on page 320

● ​MEASurement<m>: ​AOFF ​ on page 320

● ​MEASurement<m>: ​ARESult? ​ on page 320

6.3 Automatic Measurements

Using the MEAS key you can configure up to four amplitude and time measurements or
pulse counts, based on the active channel, reference or math waveforms.

● Measurement Types and Results...........................................................................83
● Configuring and Performing Automatic Measurements..........................................90
● Auto Measure Menu (MEAS key)............................................................................91

6.3.1 Measurement Types and Results

● Measurement Types...............................................................................................84
● Measurement Results.............................................................................................88
● Statistics..................................................................................................................89
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6.3.1.1 Measurement Types

The R&S RTM provides a varity of automatic measurements:

Mean Value...................................................................................................................84
RMS Value....................................................................................................................84
Mean Cycle...................................................................................................................84
RMS Cycle....................................................................................................................85
Peak Peak.....................................................................................................................85
Peak +...........................................................................................................................85
Peak -............................................................................................................................85
Frequency.....................................................................................................................85
Period............................................................................................................................85
Amplitude......................................................................................................................85
Top Level......................................................................................................................85
Base Level....................................................................................................................85
Pulse Width (positive pulse)..........................................................................................85
Pos. Overshoot.............................................................................................................86
Neg. Overshoot.............................................................................................................86
Pulse Width (negative pulse)........................................................................................86
Duty Cycle +..................................................................................................................86
Duty Cycle -...................................................................................................................86
Rise Time......................................................................................................................86
Fall Time.......................................................................................................................87
σ-Std. Dev. Wave..........................................................................................................87
σ-Std. Dev. Cycle..........................................................................................................87
Delay.............................................................................................................................87
Phase............................................................................................................................87
Burst Width....................................................................................................................87
Count positive pulses....................................................................................................87
Count negative pulses...................................................................................................88
Count rising edges........................................................................................................88
Count falling edges.......................................................................................................88
Trigger Freq..................................................................................................................88
Trigger Period...............................................................................................................88
Trigger B Freq...............................................................................................................88
Trigger B Period............................................................................................................88

Mean Value
Determines the mean value of the complete displayed waveform. The measurement
value is displayed as "Mean" in the result table.

RMS Value
Measures the RMS (Root Mean Square) value of the voltage of the complete displayed
waveform. The measurement value is displayed as "RMS" in the result table.

Mean Cycle
Measures the mean value of the left-most signal period. The measurement value is dis-
played as "MnCy" in the result table.
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RMS Cycle
Measures the RMS (Root Mean Square) value of the voltage of the left-most signal
period. The measurement value is displayed as "RMSCy" in the result table.

Peak Peak
Measures the peak-to-peak value within the displayed section of the waveform. The
measurement value is displayed as "Vpp" in the result table.

Peak +
Measures the maximum value within the displayed section of the waveform. The mea-
sured value is displayed as "Vp+" in the result table.

Peak -
Measures the minimum value within the displayed section of the waveform. The mea-
sured value is displayed as "Vp-" in the result table.

Frequency
Measures the frequency of the signal. The result is based on the length of the left-most
signal period within the displayed section of the waveform. The measurement value is
displayed as "f" in the result table.

Period
Measures the length of the left-most signal period within the displayed section of the
waveform. The measurement value is displayed as "T" in the result table.

Amplitude
Measures the amplitude of a square wave. To do so, the potential difference between
high and low level ("Vbase" and "Vtop") is calculated. The measurement requires at least
one complete period of a triggered signal. The measured value is displayed as "VAmp"
in the result table.

Top Level
Measures the mean value of the high level of a square wave. To do so, the mean value
of the tilt is calculated (without the overshoot). The measurement and requires at least
one complete period of a triggered signal. The measured value is displayed as "Vtop" in
the result table.

Base Level
Measures the mean value of the low level of a square wave. To do so, the mean value
of the tilt is calculated (without the overshoot). The measurement requires at least one
complete period of a triggered signal. The measured value is displayed as "Vbase" in the
result table.

Pulse Width (positive pulse)
: Measures the width of a positive pulse. A positive pulse consists of a rising edge

followed by a falling edge. The measurement and requires at least one complete period
of a triggered signal. The measured value is displayed as "t " in the result table.
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Pos. Overshoot
Positive overshoot of a square wave, calculated from measurement values Top Level,
Peak +, and Amplitude. The measured value is displayed as "+Ovr" in the result table.

%100



Ampl

HighMax
Pos X

XX
R

XMax = Peak +
XHigh = Top Level
XAmpl = Amplitude

Neg. Overshoot
Negative overshoot of a square wave, calculated from measurement values Min, Low,
and Amplitude. The measured value is displayed as "-Ovr" in the result table.
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XMin = Peak -
XLow = Base Level
XAmpl = Amplitude

Pulse Width (negative pulse)
: Measures the width of a negative pulse. A negative pulse consists of a falling edge

followed by a rising edge. The measurement requires at least one complete period of a
triggered signal. The measured value is displayed as "t " in the result table.

Duty Cycle +
Measures the positive duty cycle. The duty cycle is the ratio between the duration of a
positve pulse (high active) and the period of a rectangular waveform. The measurement
requires at least one complete period of a triggered signal.

The result is the measured value as a percentage of the signal period and is displayed
as "Dty+" in the result table.

Duty Cycle -
Measures the positive duty cycle. The duty cycle is the ratio between the duration of a
negative pulse (low active) and the period of a rectangular waveform. The measurement
requires at least one complete period of a triggered signal.

The result is the measured value as a percentage of the signal period and is displayed
as "Dty-" in the result table.

Rise Time
Measures the rise time of the left-most rising edge within the displayed section of the
waveform. The rise time is determined as the time it takes the signal to rise from the lower
reference level to the upper reference level which are set with "Upper Level" and "Lower
Level" in the "Reference Level" menu. The measurement result is displayed as "tr" in the
result table.

See also: ​"Reference Level: Upper, Middle, Lower Levels" on page 93.
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Fall Time
Measures the falling time of the left-most falling edge within the displayed section of the
waveform. The fall time is determined as the time it takes the signal to fall from the upper
reference level to the lower reference level which are set with "Upper Level" and "Lower
Level" in the "Reference Level" menu. The measurement result is displayed as "tf" in the
result table.

σ-Std. Dev. Wave
Measures the standard deviation of the complete waveform.
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XMean = Mean Value
X(i) = Value of the measured waveform sample
NEval = Number of waveform samples

σ-Std. Dev. Cycle
Measures the standard deviation of one cycle, usually of the first, left-most signal period.

Delay
Measures the time difference on the middle reference level between two slopes of the
same or different waveforms. The measurement value is displayed as "Delay" in the result
table.

Select the sources and slopes in the ​Delay Setup menu.

Set the middle reference level in the ​Reference Level menu.

Phase
Phase difference between two waveforms (time difference/period * 360) on the middle
reference level. The measurement value is displayed as "Phase" in the result table.

Select the waveforms in the ​Phase Setup menu.

Set the middle reference level in the ​Reference Level menu.

Burst Width
Duration of one burst, measured from the first edge to the last edge that cross the middle
reference level. The measurement value is displayed as "Bst" in the result table.

Set the middle reference level in the ​Reference Level menu.

Count positive pulses
Count : Counts positive pulses within the displayed section of the waveform. A positive
pulse consists of a rising edge followed by a falling edge. The mean value of the signal
is determined. If the signal passes the mean value, an edge is counted. The pulse is
counted if a rising edge and a falling edge are detected. The number of positive pulses
is displayed as "Cnt " in the result table.
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Count negative pulses
Count : Counts negative pulses within the displayed section of the waveform. A neg-
ative pulse consists of a falling edge followed by a rising edge. The mean value of the
signal is determined. If the signal passes the mean value, an edge is counted. The pulse
is counted if a falling edge and a rising edge are detected. The number of negative pulses
is displayed as "Cnt " in the result table.

Count rising edges
Count : Counts transitions of the signal from low level to high level within the displayed
section of the waveform. To do so, the mean value of the signal is determined. If the
signal passes the mean value, a rising edge is counted. The number of rising edges is
displayed as "Cnt " in the result table.

Count falling edges
Count : Counts transitions of the signal from high level to low level within the displayed
section of the waveform. To do so, the mean value of the signal is determined. If the
signal passes the mean value, a falling edge is counted. The number of falling edges is
displayed as "Cnt " in the result table.

Trigger Freq.
Measures the frequency of the A-trigger signal based on the length of its period. The
measurement value is displayed as "f(Tr)" in the result table.

Trigger Period
Measures the length of the A-trigger signal periods (hardware counter). The measure-
ment value is displayed as "T(Tr)" in the result table.

Trigger B Freq.
Measures the frequency of the B-trigger signal based on the length of its period. The
measurement value is displayed as "f(TrB)" in the result table.

Trigger B Period
Measures the length of the B-trigger signal periods. The measurement value is displayed
as "T(TrB)" in the result table.

6.3.1.2 Measurement Results

The results of an automatic measurement are displayed in the result table below the
diagram. The color of the results in the left part of the result table corresponds with the
source waveform color. If the result for the selected measurement type cannot be deter-
mined, e.g. because a complete period of a signal is required but not available, a "?" is
displayed.

 

Automatic Measurements



MeasurementsR&S®RTM

89User Manual 1305.0595.02 ─ 08

SCPI command:

​MEASurement<m>: ​RESult[: ​ACTual]? ​ on page 324

6.3.1.3 Statistics

For each active measurement, you can enable a statistic evaluation of the measurement
results. It returns the current, minimum and maximum measurement values, the average
and standard deviation, and the number of measured waveforms.

For configuration settings, see ​"Statistic" on page 92.

SCPI command:
● ​MEASurement<m>: ​RESult[: ​ACTual]? ​ on page 324

● ​MEASurement<m>: ​RESult: ​AVG?​ on page 328

● ​MEASurement<m>: ​RESult: ​STDDev? ​ on page 328

● ​MEASurement<m>: ​RESult: ​NPEak?​ on page 328
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● ​MEASurement<m>: ​RESult: ​PPEak?​ on page 328

● ​MEASurement<m>: ​RESult: ​WFMCount?​ on page 329

● ​MEASurement<m>: ​STATistics: ​VALue: ​ALL? ​ on page 329

● ​MEASurement<m>: ​STATistics: ​VALue<n>? ​ on page 329

6.3.2 Configuring and Performing Automatic Measurements

To configure and activate automatic measurements

1. Press the MEAS key.

2. Press "Meas. Place" to select one of the four measurement positions.

3. Press "Source" to select the waveform for which the measurement is to be performed.
The source can be any active signal or math waveform.

4. Press "Meas. Type" to select the type of measurement to perform. The type deter-
mines which results are displayed in the result table.
See also: ​"Meas. Type" on page 92.

5. For rise time, fall time, delay and phase measurements, press Reference Level and
set the reference levels as percentages of the high signal level.
See also: ​"Reference Level: Upper, Middle, Lower Levels" on page 93

6. Press "Measure 1-4" until "On" is highlighted to activate the measurement.

The selected measurement is activated and the results are displayed in the result
table.

To activate configured automatic measurements

1. Press the MEAS key.

2. Press "Meas. Place" to select one of the four measurement positions.

3. Press "Measure 1-4" until "On" is highlighted.

To deactivate automatic measurements

1. Press the MEAS key.

2. Press "Meas. Place" to select the measurement you want to deactivate.

3. Press "Measure 1-4" until "Off" is highlighted.

4. If you want to reset and deactivate all automatic measurements at once, press the
"Clear All" softkey in the "Auto measure" menu.

No more measurements are performed, the results are removed from the result table.

To use statistics

1. Press the MEAS key.
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2. Configure at least one mesurement as described in ​"To configure and activate auto-
matic measurements" on page 90.

3. Press "Statistic".

4. Press "Meas. Place" to select the measurement for which you need statistical results.

5. Press "Statistic" until "On" is highlighted.

6. Press Average No. and enter the number of measured waveforms to be used for
calculation of average and standard deviation.

6.3.3 Auto Measure Menu (MEAS key)

The MEAS key opens the "Auto Measure" menu to configure automatic measurements.

For details, see ​chapter 6.3, "Automatic Measurements", on page 83.

Meas. Place..................................................................................................................91
Measure 1-4..................................................................................................................92
Meas. Type...................................................................................................................92
Source...........................................................................................................................92
Statistic..........................................................................................................................92

└ Meas. Place....................................................................................................92
└ Statistic...........................................................................................................92
└ No. of Averages..............................................................................................92
└ Reset, Reset All..............................................................................................92
└ Clear All..........................................................................................................93

Reference Level: Upper, Middle, Lower Levels............................................................93
Clear All.........................................................................................................................93
Delay Setup...................................................................................................................93
Phase Setup..................................................................................................................93

Meas. Place
Selects one of the four available measurements to be configured or activated.
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Measure 1-4
Activates or deactivates the selected measurement (1-4).

Remote command: 
​MEASurement<m>[: ​ENABle] ​ on page 321

Meas. Type
Defines the measurement type to be performed on the selected source. Depending on
the type, different results are displayed in the result table.

For a list of all automatic measurement types and their description, see ​chapter 6.3.1,
"Measurement Types and Results", on page 83.

Remote command: 
​MEASurement<m>: ​MAIN ​ on page 321
​MEASurement<m>: ​RESult[: ​ACTual]? ​ on page 324

Source
Selects one of the active signal, reference or math waveforms as the source of the
selected measurement.

Remote command: 
​MEASurement<m>: ​SOURce​ on page 323

Statistic
Opens a submenu to enable and configure up to four statistics.

Meas. Place ← Statistic
Selects the measurement for which statistical evaluation is configured.

Statistic ← Statistic
Activates or deactivates the statistical evaluation for the selected measurement (1-4).

Remote command: 
​MEASurement<m>: ​STATistics[: ​ENABle] ​ on page 327

No. of Averages ← Statistic
Sets the number of measured waveforms used for calculation of average and standard
deviation. The maximum number is 1000.

Remote command: 
​MEASurement<m>: ​STATistics: ​WEIGht​ on page 327

Reset, Reset All ← Statistic
Deletes the statistical results for the current measurement or all measurements, respec-
tivley, and starts a new statistical evaluation if the acquisition is running.

Remote command: 
​MEASurement<m>: ​STATistics: ​RESet ​ on page 327
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Clear All ← Statistic
Resets and deactivates all active statistic measurements.

Reference Level: Upper, Middle, Lower Levels
Set the lower and upper reference levels for rise and fall time mesurements (cursor and
automatic mesurements) as well as the middle reference level used for phase and delay
measurements. The levels are defined as percentages of the high signal level. The set-
tings are valid for all measurement places.

Remote command: 
​REFLevel: ​RELative:​MODE ​ on page 325
​REFLevel: ​RELative:​LOWer ​ on page 326
​REFLevel: ​RELative:​MIDDle ​ on page 326
​REFLevel: ​RELative:​UPPer ​ on page 326

Clear All
Resets and deactivates all four measurements.

Remote command: 
​MEASurement<m>: ​AOFF ​ on page 320

Delay Setup
Configures the delay measurement that measures the time difference between two edges
of the same or different waveforms.

"Source 1,
Source 2"

Select one of the active channel, math or reference waveforms for each
measurement source.

"Slope" Select the rising or falling slope for each measurement source.

Remote command: 
​MEASurement<m>: ​SOURce​ on page 323
​MEASurement<m>: ​DELay:​SLOPe ​ on page 324

Phase Setup
Configures the phase measurement that measures the pahse difference between two
waveforms.

"Source 1,
Source 2"

Select one of the active channel, math or reference waveforms for each
measurement source.

Remote command: 
​MEASurement<m>: ​SOURce​ on page 323
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7 Mathematics
Mathematical (math) waveforms are calculated data. Each math waveform is defined by
an equation. You can configure and save up to five equations (MA1 – MA5), four of these
equation can be displayed (MA1 – MA4).

Each equation consists of one or two operands and a operator. An operand can be an
input channel, a constant value, or a math waveform with lower number than the oper-
and's number. For example, the MA3 equation can use the results of MA2 and MA1 as
operands.

Each equation and also the set of all defined equations can get a label.

An equation set can be saved to and loaded from any storage device - internal memory
or external USB flash device. The file format is always .FML, and the file size is 526 Byte.
It is also possible to copy the stored equation sets to another storage device with FILE >
"Import/Export Equation Sets". See also: ​chapter 12.2.1.2, "Importing and Exporting
Data", on page 207.

7.1 Configuring and Using Math Waveforms

Math waveforms are configured using the "Equation Set Editor". Each equation for a math
waveform is configured and displayed individually, and you can save and load the con-
figuration of all five math waveforms as an "Equation Set".

7.1.1 Displaying Mathematical Waveforms

For each of the math waveforms MA1 - MA4 you can define whether it is displayed or not
and which equation is performed in each one. MA5 is always invisible.

1. Press MATH to display the "Mathematics" menu.

2. Press "Equation" and select the mathematical waveform that contains the equation
you want to display.
To check which equation is configured for which channel:

a) Press "Edit Equations". The "Equation Set Editor" is displayed, where you can
see the configuration for each math waveform. Currently displayed waveforms
are indicated by the  symbol.

b) Press "Back" to exit the editor.

3. Press "Visible" until "On" is highlighted.

The selected equation is calculated and the results are displayed as an additional
(mathematical) waveform on the screen. If necessary, change the vertical scaling of
the math waveform to improve the display using the vertical SCALE rotary knob.
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If the required equation is not included, edit the current equation set, or load an appro-
priate equation set that was saved before. See also: ​"To configure an equation"
on page 95 and ​"To load an equation set" on page 97.

7.1.2 Editing Equations and Equation Sets

To each math waveform an equation is assigned. The mathematical operation is defined
by the operator and is performed on the operands. Operands are one or two of the active
channel or math waveforms, or a constant value.

All five math waveforms together build an equation set that can be stored and loaded.

To configure an equation

1. Press "MATH > Edit Equations" to display the "Equation Set Editor" with the current
equation set configuration.

2. Press "Equation" and select the equation to be configured.

3. Press "Operator" to select the operator of the equation.
See also: ​"Operator" on page 99.

4. Press "Operand1".
See also: ​"Operand 1" on page 103.

5. If the equation requires a second operand, press "Operand2" and define the second
operand.

6. If one of the operands is defined as a constant, define its value:

a) Press "Operand1" or "Operand2" to select the constant for the corresponding
operand.

b) Press "Edit Constant" to define its value.
c) Press "Constant" and select either a pre-defined constant, or one of 10 available

user-defined constants.

 

Configuring and Using Math Waveforms



MathematicsR&S®RTM

96User Manual 1305.0595.02 ─ 08

d) If you selected a user-defined constant, define its value:

● Press "Value" and enter the numeric value.
● Press "Decimal Point" to move the decimal point within the numeric value.
● Press "Prefix" to define an SI-prefix to the unit. See also: ​"Prefix"

on page 104.
● Press "Unit" to define the unit of the value. See also: ​"Unit" on page 105.

e) Press "Save" to store the user-defined constant.

7. Press "Unit" to define the unit of the equation results. See also: ​"Unit" on page 98.

8. Optionally, press "Equation Label" to define a name for the equation. This label is
displayed on the "Equation" softkey and in the "Equation Set Editor".

To edit an equation set

1. Press "MATH > Edit Equations" to display the "Equation Set Editor".

2. Press "Equation" to select the first equation to be configured. This equation is
assigned to the first math waveform (MA1).

3. Configure the equation.
See: ​"To configure an equation" on page 95.

4. Repeat steps 3 and 4 to configure all 5 equations in the equation set.

5. Press "Back" to exit the editor and return to the main "Mathematics" menu.

6. For each equation MA1 to MA4, define whether it is to be displayed or not:

a) Press "Equation" to select the equation.
b) Press "Visible" to switch the display of the math waveform on or off.

7. Optionally, press "Eq. Set Label" to define a name for the equation set. This label is
displayed in the "Equation Set Editor".

7.1.3 Saving and Loading Equation Sets

If you want to keep math configurations for specific measurement purposes for later use,
you can save equations sets in the instrument or on external storage device.

To copy a stored equation sets to another storage device, use FILE > "Equation Sets".
For import/export procedure, see ​chapter 12.2.1.2, "Importing and Exporting Data",
on page 207.

To save the current equation set

1. Press MATH to display the "Mathematics" menu.

2. Press "Save".

3. Define the storage location using the "Storage" softkey, and the file name using the
"File name" softkey.
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See: ​chapter 12.2.1.1, "Configuring Storage Locations", on page 207.

4. Optionally, define a comment to be added to the equation set using the "Comment"
softkey.

5. Press "Save".

The equation set is saved as configured.

To load an equation set

1. Press "MATH > Load".

A file explorer is displayed.

2. If necessary, switch to the storage location that contains the file by pressing "Stor-
age".

3. Select the file that contains the equation set. Use the "Navigation" knob to scroll
through the directories. To change the directory, scroll to the name of the directory
and press the knob, or press "Change dir.".

4. Press "Load".

The equation set is loaded to the R&S RTM.

7.2 Reference for Mathematics

The MATH key provides functions to configure and display calculated data.

For details on working with these functions, see ​chapter 7.1, "Configuring and Using Math
Waveforms", on page 94.

Equation........................................................................................................................98
Visible............................................................................................................................98
Unit................................................................................................................................98
Edit Equations...............................................................................................................99

└ Equation..........................................................................................................99
└ Operator..........................................................................................................99
└ Operand 1.....................................................................................................103
└ Operand 2.....................................................................................................104
└ Edit Constant................................................................................................104

└ Constant.............................................................................................104
└ Value...................................................................................................104
└ Decimal Point......................................................................................104
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└ Unit.....................................................................................................105
└ Save....................................................................................................105
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└ Equation Label..............................................................................................105
Eq. Set Label...............................................................................................................105
Save............................................................................................................................105
Load............................................................................................................................105

Equation
Selects one of five possible mathematical channels.

Visible
Defines whether the selected mathematical waveform is displayed on the display or not.

Note: MA5 cannot be displayed, it is always invisible.

Remote command: 
​CALCulate: ​MATH<m>: ​STATe ​ on page 330

Unit
Defines the unit of the equation results. The selected unit only has an effect on the dis-
played unit, not on the size of the values.

The following units are available:
● V (Volts)
● A (Amperes)
● Ω (Ohms)
● S (Siemens)
● V/A (Volts per Ampere)
● W (Watts, active power)
● VA (Voltamps, apparent power)
● VAr (Voltamps, reactive power)
● Vs (Volt-seconds = Weber, unit of magnetic flux)
● V/s (Volts per second)
● dB (decibels)
● dBm (dB referred to 1 mW)
● dBV (dB referred to 1 V)
● dBμV (dB referred to 1 μV)
● s (Second)
● 1/s, Hz (Hertz)
● s/DIV
● F (Farad)
● H (Henry)
● % (Percent)
● ° (Degree)
● π (Pi)
● Pa (Pascal)
● m (Meter)
● g (Acceleration)
● °C (Degrees Celsius)
● K (Kelvin)
● °F (Degrees Fahrenheit)
● N (Newton)
● J (Joule)
● C (Coulomb)
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● Wb (Weber)
● T (Tesla)
● (dez) (dezimal)
● (bin) (binary)
● (hex) (hexadezimal)
● (oct) (octal)
● DIV (Division, graticule)
● px (pixel)
● Bit
● Bit/s
● Byte
● Bd (Baud)
● Sa (Samples)
● Sa/sec. (Samples per second)
● cyc (cycles)
● Trc. (Traces)
● Sa/X
●  Rising edge
●  Falling edge
●  Positive impulse
●  Negative impulse
● Ev. (Events)
● Symb. (symbols)
● Sy./s (symbols per second)
● Wfm. (waveforms)

Edit Equations
Provides functions to configure the calculations for the mathematical channels.

Remote command: 
​CALCulate: ​MATH<m>[: ​EXPRession][: ​DEFine] ​ on page 331

Equation ← Edit Equations
Selects one of five possible mathematical channels.

Operator ← Edit Equations
Defines the operation to be performed on the specified operands in the mathematical
channel.

"Addition" Op1 + Op2
Adds the two operands.
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"Subtraction" Op1 - Op2
Subtracts the second operand from the first operand.

"Multiplication" Op1 * Op2
Multiplies the two operands.

"Division" Op1 / Op2
Divides the first operand by the second operand.
For small amplitudes of the second operand, the result increases
quickly. If the second operand crosses zero, the result would be a range
of +∞ to -∞. In this case, instead of 0V, the calculation function uses the
value that the Least Significant Bit (LSB) of the second operand repre-
sents. (For an 8-bit value, for example, 1/256).
You can limit the zero-crossings of the operand by using the "Maxi-
mum" operator. This limitation results in a smaller result range and a
finer resolution.

"Maximum" Maximum (Op1, Op2)
Compares the amplitudes of both operands and displays the maximum
amplitude. The sign of the result is taken from Operand1. Use this
operation in combination with the "Reciprocal" or "Division" operation
to limit the minimal amplitudes of an operand.
Example: Operand1 is a homopolar sine signal with Vpp=3V. Operand2
is a constant value of 1V. The result is always larger than 1V or smaller
than -1V.
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"Minimum" Minimum (Op1, Op2)
Compares the amplitudes of both operands and displays the minimum
amplitude. The sign of the result is taken from Operand1. Use this
operation in combination with the "Reciprocal" or "Division" operation
to limit the maximal amplitudes of an operand.
Example: Operand1 is a MATH waveform within the range of +/-10V.
Operand2 is a constant value of 1V. The result is always smaller than
1V or larger than -1V.

"Square" Op1 * Op1
Squares the operand. If the operand contains negative values that have
been clipped, then the result contains positive clipping.

"Square Root" Square Root (Op1)
Calculates the square root of the operand. Note that the square root of
a negative number is undefined and the result is clipped.

"Abs. Value" |Op1|
Calculates the absolute value of the operand. All negative values are
inverted to positive values. The positive values remain unmodified. If
the operand has negative values that have been clipped, the result
contains positive clipping.

"Pos. Wave" Max (Op1, 0)
Extracts the positive data points from the operand. For all negative val-
ues the result is zero. The positive values remain unmodified.
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"Neg. Wave" Min (Op1, 0)
Extracts the negative data points from the operand. For all positive val-
ues the result is zero. The negative values remain unmodified.

"Reciprocal" 1V / Op1
Divides 1V by the operand values.
For small operand amplitudes the result increases quickly. If the oper-
and crosses zero, the result would be a range of +∞ to -∞. In this case,
instead of 0V, the calculation function uses the value that the Least
Significant Bit (LSB) of the operand represents. (For an 8-bit value, for
example, 1/256).
You can limit the zero-crossings of the operand by using the "Maxi-
mum" operator. This limitation results in a smaller result range and a
finer resolution.

"Inverse" Inverts all voltage values of the operand, i.e. all values are mirrored at
the ground level. Thus, a positive voltage offset becomes negative. If
the amplitude of the operand is clipped, the result is the inverted limi-
tation.

"Common
Log."

log (Op1)
Calculates the logarithm to the basis 10 of the operand. Note that the
logarithm of a negative number is undefined and the result is clipped.

"Natural Log." ln (Op1)
Calculates the logarithm to the basis e (Euler number) of the operand.
Note that the logarithm of a negative number is undefined and the result
is clipped.
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"Derivative" f'(Op1)
The derivative corresponds to the rise of the tangent through a function
point and indicates the dimension of the change in quantity of the oper-
and in time. The larger the quantity change of the operand per time
becomes, the larger the result of the derivative is.
The calculation is approximated using the secant based on the current
calculated value and a value with a distance of 0.1 DIV. Due to this, the
time axis has a finitely small resolution. Therefore, scale the input signal
to display the required area appropriately.

"Integral" Calculates the definite integral of the operand.
The calculation is displayed in the illustration. The integration starts at
point "a" and adds the area beneath the waveform. Point "b" indicates
the currently calculated value. At the end of the positive alternation, the
integral function reaches its maximum. Due to the homopolar operand
used in this example, the waveform of the area reaches zero after the
negative alternation.
Use a V-Marker to measure the area for an extract of the waveform.
See also: ​"Meas.Type" on page 80.

"IIR low pass" IIR  (Op1,fg=Op2)
Calculates a low-pass filtered waveform of "Operand 1". The cut-off
frequency is set with constant "Operand 2". Signal components with
frequencies higher than the cut-off frequency are attenuated signifi-
cantly.

"IIR high pass" IIR  (Op1,fg=Op2)
Calculates a high-pass filtered waveform of "Operand 1". The cut-off
frequency is set with constant "Operand 2". Signal components with
frequencies below the cut-off frequency are attenuated significantly.

Remote command: 
​CALCulate: ​MATH<m>[: ​EXPRession][: ​DEFine] ​ on page 331

Operand 1 ← Edit Equations
Defines the first operand for the mathematical operation. The source can be any active
channel signal, a constant value, or a mathematical waveform with lower number than
the one to be defined.

"CH1 | CH2 |
CH3 | CH4"

An active channel waveform

"Const." A constant value
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"MA1 | MA2 |
MA3 | MA4"

A mathematical waveform. Only math waveforms with lower number
are available.

Operand 2 ← Edit Equations
Defines the second operand for the mathematical operation, if required. The source can
be any active channel signal, a constant value, or a mathematical waveform with lower
number than the one to be defined.

"CH1 | CH2 |
CH3 | CH4"

An active channel waveform

"Const." A constant value

"MA1 | MA2 |
MA3 | MA4"

A mathematical waveform. Only math waveforms with lower number
are available.

Edit Constant ← Edit Equations
Provides functions to define a constant value to be used in a mathematical operation. In
addition to the value, a decimal point, the unit and an SI-prefix can be defined.

This softkey is only available if "Constant" is selected as one of the operands.

Constant ← Edit Constant ← Edit Equations
Specifies a pre-defined constant or a user-defined constant for a mathematical operation.
Either one of the following pre-defined constants can be selected, or one of 10 user-
defined constants.

● Pi
● 2*Pi
● 1/2*Pi
● e

Value ← Edit Constant ← Edit Equations
Specifies the value for a user-defined constant. This function is only available if one of
the user-defined constants is selected by the "Constant" softkey.

Decimal Point ← Edit Constant ← Edit Equations
Moves the decimal point within the user-defined constant value.

Prefix ← Edit Constant ← Edit Equations
Defines an SI-prefix for the unit of a user-defined constant value. The following prefixes
are available:

● None
● m (Milli, 10-3)
● μ (Mikro, 10-6)
● n (Nano, 10-9)
● p (Piko, 10-12)
● f (Femto, 10-15)
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● a (Atto, 10-18)
● z (Zepto, 10-21)
● y (Yokto, 10-24)
● K (Kilo, 103)
● M (Mega, 106)
● G (Giga, 109)
● T (Tera, 1012)
● P (Peta, 1015)
● E (Exa, 1018)
● Z (Zetta, 1021)
● Y (Yotta, 1024)

Unit ← Edit Constant ← Edit Equations
Defines the unit of the user-defined constant value. The selected unit only has an effect
on the displayed unit, not on the size of the values.

For a list of available units, see ​"Unit" on page 98.

Save ← Edit Constant ← Edit Equations
Saves the defined constant to the equation of the math waveform.

Equation Label ← Edit Equations
Defines a label for the current equation.

Eq. Set Label
Defines a label for the equation set.

Save
Opens the "Save" menu with basic functions to save the equation set.

See ​"Save Menu" on page 209.

Load
Displays the "Load" menu and a file explorer to select an equation set file.

See ​"Load Menu" on page 210.
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8 FFT
In addition to signal vs. time and signal vs. signal displays, the frequencies of a signal as
determined by FFT analysis can be displayed. FFT analysis is configured and activated
using the FFT key. Analysis is always performed on the signal channel that was most
recently activated, however you can change the channel source.

Various parameters concerning the time base, scaling and the waveform arithmetic can
be configured for the FFT display. You can configure FFT either numerically using the
softkeys, or graphically using the rotary knobs.

On the FFT display, you can perform frequency and level measurements by means of a
cursor measurement. Automatic measurements are not available.

8.1 FFT Display

When you activate FFT display, two windows are displayed: the signal vs. time at the top,
the result of the FFT analysis at the bottom.

The display can be restricted to the results for a certain time base extract and to a speci-
fied frequency range. The time range is indicated by white lines in the Y(t)-diagram (see
also ​figure 8-1).
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Move the focus between the Y(t)-window (Time Control), the FFT time base extract (Time
Section) and the FFT frequency range (FFT Control) by pressing the horizontal SCALE
rotary knob. The currently selected screen element is highlighted and displayed in the
information bar. Depending on the selection, the functions of the SCALE and
POSITION rotary knobs may change.

The usual channel parameters are displayed in the information bar above the Y(t)-window
(see the general display information described in the "Getting Started" manual).

In addition, FFT-specific parameters are indicated in the information bar above the FFT
window. The following information is given there:

 Description Setting

1 Width of the time base extract for which FFT is calculated YT-Window

2 Position of time base extract Position

3 Width of the displayed frequency range Span

4 Center of the displayed frequency range Center

5 Sample rate for FFT calculation  

6 FFT result mode Waveform Arithmetic

7 Signal source and vertical scaling factor per division CH1...CH4 / Y-Scale / Y-Scaling

8 Focus of the horizontal SCALE knob Press SCALE

When you deactivate the FFT display, the previous display is restored.

8.2 Configuring and Using FFT Calculations

● Setting Up the FFT Analysis.................................................................................107
● Configuring the Diagrams.....................................................................................108
● Measuring on FFT.................................................................................................111

8.2.1 Setting Up the FFT Analysis

To display an FFT diagram

► Press the FFT key.

The key lights up and two windows are displayed: the signal vs. time at the top, the
result of the FFT analysis at the bottom.

 

 

Configuring and Using FFT Calculations



FFTR&S®RTM

108User Manual 1305.0595.02 ─ 08

To deactivate the FFT display

► Press the FFT key again, or press the "FFT off" softkey in the "FFT" menu to deac-
tivate the FFT display.

The FFT key is no longer illuminated and the previous display is restored.

To configure the general FFT display

1. Press the FFT key to activate the FFT display and open the "FFT" menu.

2. If necessary, press one of the CH1...CH4 keys to change the signal source of the
FFT calculation.

3. Press "Waveform Arithmetic" to define the mode for FFT calculation and display. The
waveform arithmetic defines whether the values are updated regularly, or whether
values from previous spectra are included in the calculation and display.
For details see ​"Wfm. Arithmetic" on page 112.

4. If "Average" mode is selected, press "No. of Averages" to define how many spectra
are considered for the calculation.

5. Press "Window" to define which type of function is laid over the input values. If the
input values are to be used unaltered, use the "Rectangle" window. To reduce noise,
use a bell-shaped window.
For details see ​"Window" on page 113.

6. Press "Y-Scaling" to select logarithmic or linear scaling of the y-axis in the FFT win-
dow (see ​"Y-Scaling" on page 114).

7. Define the settings for the FFT window as described in ​"To configure the FFT diagram
numerically" on page 108.

8. Define the settings of the signal vs. time window as described in ​"To configure the
Y(t)-window numerically" on page 110. These settings are identical to the general
trigger and scaling settings defined for the channel (see also ​chapter 2.2.2, "Adjusting
the Signal Input Manually", on page 20).

8.2.2 Configuring the Diagrams

To configure the FFT diagram numerically

Alternatively to configuring the FFT window numerically via the softkeys, you can use the
rotary knobs to change the settings graphically, see ​"To configure the FFT diagram
graphically" on page 109.

1. Press "FFT-Setup" in the "FFT" menu.

2. Define the time base extract for which the FFT is to be calculated and displayed. The
extract is defined by its width and position (see ​figure 8-1).

a) Press "YT-Window" to define the width of the time base extract.
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b) Press "Position" to define the position of the time base extract. The position is
defined as an offset of the center of the extract range to the 0s reference point.

The time base extract is indicated by a white frame in the Y(t)-window. The width (W)
and position (P) are indicated in the information bar beneath the Y(t)-window.

Fig. 8-1: Width and position of the time base extract for FFT calculation

3. Press "Y-Scale" to define the scaling of the FFT amplitudes.

4. Define the frequency range to be displayed in the FFT window. The range is defined
as (Center - Span/2) to (Center + Span/2). For details see ​"Span" on page 115 and
​"Center" on page 115.

a) Press "Span" to define the width of the frequency range.
b) Press "Center" to define the center frequency of the range.

To configure the FFT diagram graphically

1. Define the time base extract for which the FFT is to be calculated and displayed. The
extract is defined by its width and position (see ​figure 8-1).

a) Press the horizontal SCALE rotary knob to select the FFT time base extract
("W"/"P" settings are highlighted).

b) Turn the horizontal SCALE rotary knob to define the width of the time base extract.
Turn the knob counter-clockwise to enlarge the extract, or clockwise to decrease
it.

c) Turn the horizontal POSITION rotary knob to define the position of the time base
extract. Turn the knob counter-clockwise to move the extract to the left, or clock-
wise to move it to the right.

2. Define the frequency range to be displayed in the FFT diagram. The range is defined
as (Center - Span/2) to (Center + Span/2). For details see ​"Span" on page 115 and
​"Center" on page 115.

a) Press the horizontal SCALE rotary knob to select the FFT frequency range
("Span"/"Center" settings are highlighted).

b) Turn the horizontal SCALE rotary knob to define the span of the frequency range.
Turn the knob counter-clockwise to enlarge the span, or clockwise to decrease
it.

c) Turn the horizontal POSITION rotary knob to define the center of the frequency
range. Turn the knob counter-clockwise to move the center to the left, or clock-
wise to move it to the right.

Configuring and Using FFT Calculations



FFTR&S®RTM

110User Manual 1305.0595.02 ─ 08

d) Turn the vertical SCALE rotary knob to define the scaling of the FFT amplitudes.
Turn the knob counter-clockwise to decrease the amplitudes, or clockwise to
enlarge them.

To configure the Y(t)-window numerically

Alternatively to configuring the Y(t)-window numerically via the softkeys, you can use the
rotary knobs to change the settings graphically, see ​"To configure the Y(t)-window graph-
ically" on page 110.

1. Press "Y(t)-Setup" in the "FFT" menu.

2. Press "Y-Scale" to define the scaling of the signal amplitudes in the Y(t)-window.

3. Press "Y-Position" to define the vertical position of the time axis in the Y(t)-window,
in divisions.

4. Press "Main Time Base" to define the scaling for the time base in the Y(t)-window in
seconds per division.
Note that when you change the scaling for the main time base, the width of the FFT
time base extract is also changed.

5. Press "Trigger Offset" to define the offset of the trigger point to the reference point
for 0s.
Note that when you change the trigger offset, the position of the FFT time base extract
is also changed.

The scaling factor for the time base (TB) and the trigger offset (T) are indicated in the
information bar above the Y(t)-window.

Fig. 8-2: Time base (per division) and trigger offset in Y(t)-window

To configure the Y(t)-window graphically

1. Press the horizontal SCALE rotary knob to select the Y(t)-window ("TB"/"T" settings
are highlighted).

2. Turn the vertical SCALE rotary knob to define the scaling of the signal amplitudes in
the Y(t)-window. Turn the knob counter-clockwise to decrease the amplitudes, or
clockwise to enlarge them.

Configuring and Using FFT Calculations



FFTR&S®RTM

111User Manual 1305.0595.02 ─ 08

3. Turn the vertical POSITION rotary knob to define the vertical position of the time axis
in the Y(t)-window. Turn the knob counter-clockwise to move the time axis down, or
clockwise to move it up.

4. Turn the horizontal SCALE rotary knob to define the scaling for the time base in the
Y(t)-window. Turn the knob counter-clockwise to increase the scaling, or clockwise
to decrease it (and thus spread the waveform).
Note that when you change the scaling for the main time base, the width of the FFT
time base extract is also changed.

5. Turn the horizontal POSITION rotary knob to define the offset of the trigger point to
the reference point for 0s. Turn the knob counter-clockwise to move the trigger point
to the left, or clockwise to move it to the right.
Note that when you change the trigger offset, the position of the FFT time base extract
is also changed.

8.2.3 Measuring on FFT

You can perform cursor measurements in FFT mode. Automatic measurements are not
available.

1. Press FFT, then set up and configure the FFT diagram.

2. Press CURSOR.

3. In the "Cursor" menu, set the cursor lines to the required positions. Use "Prev.
Peak" and "Next Peak" to set the selected cursor line to the level peaks.
See also: ​chapter 6.1.3, "Cursor Menu", on page 79.

The frequency and level results are shown in the results table.

8.3 Reference for FFT key

The FFT key enables the FFT mode and opens the FFT menu.

See also:
● ​chapter 8.2, "Configuring and Using FFT Calculations", on page 107
● ​chapter 8.1, "FFT Display", on page 106
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FFT..............................................................................................................................112
Wfm. Arithmetic...........................................................................................................112
No. of Averages..........................................................................................................113
Window.......................................................................................................................113
Y-Scaling.....................................................................................................................114
FFT-Setup...................................................................................................................114

└ Span..............................................................................................................115
└ Center...........................................................................................................115
└ Y-Scale.........................................................................................................115
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└ Position.........................................................................................................116
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Y(t)-Setup....................................................................................................................116
└ Y-Scale.........................................................................................................116
└ Y-Position......................................................................................................116
└ Main Time Base............................................................................................116
└ Trigger Offset................................................................................................117
└ Show Channels.............................................................................................117

FFT Off........................................................................................................................117

FFT
The FFT key activates and deactivates a Fast Fourier Transformation (FFT) for the most
recently selected channel and provides functions to configure and display FFTs.

If activated, the FFT key lights up. Two windows are displayed: the signal vs. time window
at the top, and the result window of the FFT analysis at the bottom.

When deactivated, the previous display is restored.

To display the FFT for a different channel, press the corresponding channel key.

Remote command: 
CALC:MATH:EXPR "FFTMAG(CHx)"; see also ​CALCulate: ​MATH<m>[: ​
EXPRession][: ​DEFine] ​ on page 331.

Wfm. Arithmetic
Defines the arithmetic mode for FFT calculation and display.

"None" The FFT is performed without any additional weighting or postprocess-
ing of the acquired data. The new input data is acquired and displayed,
and thus overwrites the previously saved and displayed data.
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"Envelope" In addition to the normal spectrum, the maximal oscillations are saved
separately and updated for each new spectrum. The maximum values
are displayed together with the newly acquired values and form an
envelope. This envelope indicates the range of all FFT trace values that
occurred.
If any signal parameters are changed, the envelope is reset.

"Average" The average of several spectrums is calculated. The number of spec-
trums used for the averaging is defined using the knob or the "No. of
Averages" softkey. This mode is useful for noise rejection.

Remote command: 
​CALCulate: ​MATH<m>: ​ARIThmetics ​ on page 334

No. of Averages
Defines the number of spectrums used for averaging.

This function is only available if "Average" mode is selected.

Remote command: 
​CALCulate: ​MATH<m>: ​FFT: ​AVERage: ​COUNt ​ on page 335

Window
Window functions are multiplied with the input values and thus can improve the FFT
display.

If discontinuities occur at the borders of the measurement interval, the algorithm interprets
such discontinuities as a sudden edge, which can distort the result. For bell-shaped func-
tions, the border values are multiplied with smaller values and thus have less influence
on the result.

"Hanning" The Hanning window is bell shaped. Unlike the Hamming window, its
value is zero at the borders of the measuring interval. Thus, the noise
level within the spectrum is reduced and the width of the spectral lines
enlarges. Use this window to measure amplitudes of a periodical signal
precisely.
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"Hamming" The Hamming window is bell shaped. Its value is not zero at the borders
of the measuring interval. Thus, the noise level inside the spectrum is
higher than Hanning or Blackman, but smaller than the rectangular
window. The width of the spectral lines is thinner than the other bell-
shaped functions. Use this window to measure amplitudes of a period-
ical signal precisely.

"Blackman" The Blackman window is bell shaped and has the steepest fall in its
wave shape of all other available functions. Its value is zero at both
borders of the measuring interval. In the Blackman window the ampli-
tudes can be measured very precisely. However, determining the fre-
quency is more difficult. Use this window to measure amplitudes of a
periodical signal precisely.

"Rectangle" The rectangular window multiplies all points by one. The result is a high
frequency accuracy with thin spectral lines, but also with increased
noise. Use this function preferably with pulse response tests where start
and end values are zero.

Remote command: 
​CALCulate: ​MATH<m>: ​FFT: ​WINDow: ​TYPE ​ on page 333

Y-Scaling
Defines the scaling unit for the y-axis. The display values are valid for 50Ω termination
impendance. To achieve this, the existing internal terminating resistor can be used, or an
external terminating resistor can be connected parallel to the high impedance input.

To set the scale value, use "FFT Setup" > "Y-Scale".

"dBm" logarithmic scaling; related to 1 mW

"dBV" logarithmic scaling; related to 1 Veff

"Veff" linear scaling; displays the RMS value of the voltage

Remote command: 
​CALCulate: ​MATH<m>: ​FFT: ​MAGNitude: ​SCALe ​ on page 335

FFT-Setup
Defines the settings for the FFT window. The display can be restricted to the results for
a certain time base extract and to a specified frequency range.
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Span ← FFT-Setup
The span is specified in Hertz and defines the width of the displayed frequency range,
which is (Center - Span/2) to (Center + Span/2). The position of the span is defined using
the "Center" function.

Note: If the FFT frequency range is selected ("Span"/"Center" is highlighted), the width
of the span can be adjusted using the horizontal SCALE rotary knob.

Remote command: 
​CALCulate: ​MATH<m>: ​FFT: ​SPAN ​ on page 337
​CALCulate: ​MATH<m>: ​FFT: ​FULLspan ​ on page 337
​CALCulate: ​MATH<m>: ​FFT: ​STARt ​ on page 338
​CALCulate: ​MATH<m>: ​FFT: ​STOP ​ on page 338

Center ← FFT-Setup
Defines the position of the displayed frequency domain, which is (Center - Span/2) to
(Center + Span/2). The width of the domain is defined using the "Span" function.

Note: If the FFT frequency range is selected ("Span"/"Center" is highlighted), the width
of the span can be adjusted using the horizontal POSITION rotary knob.

Remote command: 
​CALCulate: ​MATH<m>: ​FFT: ​CFRequency ​ on page 337
​CALCulate: ​MATH<m>: ​FFT: ​STARt ​ on page 338
​CALCulate: ​MATH<m>: ​FFT: ​STOP ​ on page 338

Y-Scale ← FFT-Setup
Changes the vertical scaling of the FFT display (in V/dBm) per division.

Note: If the FFT frequency range is selected ("Span"/"Center" is highlighted), the Y-Scale
can be defined using the vertical SCALE rotary knob.

See also ​"SCALE, Y-Scale" on page 29.

Remote command: 
​CALCulate: ​MATH<m>: ​SCALe ​ on page 330

YT-Window ← FFT-Setup
Defines the width of the time base extract from the Y(t)-window for which the FFT is
calculated. The extract is indicated by white lines in the Y(t)-window. The value is indi-
cated by "W" in the information bar above the FFT window.

Note: If the FFT time base extract is selected ("W"/"P" is highlighted), the width can be
adjusted using the horizontal SCALE rotary knob.
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See also ​figure 8-1.

Remote command: 
​CALCulate: ​MATH<m>: ​FFT: ​TIME: ​RANGe​ on page 338

Position ← FFT-Setup
Defines the position of the time base extract in the Y(t)-window for which the FFT is
calculated. The value is indicated by "P" in the information bar above the FFT window.

Note: If the FFT time base extract is selected ("W"/"P" is highlighted), the position can
be adjusted using the horizontal POSITION rotary knob.

See also ​figure 8-1.

Remote command: 
​CALCulate: ​MATH<m>: ​FFT: ​TIME: ​POSition ​ on page 339

Points ← FFT-Setup
Defines how many samples are used for FFT calculation

The value is changed in 2n steps from 2048 (211) to 65536 (216).

Remote command: 
​CALCulate: ​MATH<m>: ​FFT: ​BANDwidth[: ​RESolution]: ​RATio ​ on page 336

Y(t)-Setup
Defines the settings for the signal vs. time window.

Y-Scale ← Y(t)-Setup
Changes the vertical scaling of the Y(t)-window (channel scaling).

Note: If the Y(t)-window is selected (indicated by a white border), the Y-Scale can be
adjusted using the vertical SCALE rotary knob.

See ​"SCALE, Y-Scale" on page 29.

Remote command: 
​CHANnel<m>: ​SCALe ​ on page 279

Y-Position ← Y(t)-Setup
Defines the vertical position of the time axis in the Y(t)-window, in divisions.

Note: If the Y(t)-window is selected (indicated by a white border), the Y-Position can be
adjusted using the vertical POSITION rotary knob.

Remote command: 
​CHANnel<m>: ​POSition ​ on page 280

Main Time Base ← Y(t)-Setup
Defines the scaling for the time base in the (original) Y(t)-window in seconds per division.
The scaling is indicated by "TB" in the information bar above the window.
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Note: If "Time Control" is selected, the main time base can be adjusted using the hori-
zontal SCALE rotary knob.

See also ​"SCALE" on page 23, ​"To configure the original Y(t)-diagram" on page 65 and ​
figure 8-2.

Remote command: 
​TIMebase: ​SCALe​ on page 273

Trigger Offset ← Y(t)-Setup
Defines the horizontal position of the trigger point in relation to the reference point - to
the zero point of the grid. The value is indicated by "T" in the information bar above the
window.

The reference point is set with SETUP >"Time Reference".

Note: If a zoom or FFT window is displayed and "Time Control" is selected, the trigger
offset can be adjusted using the horizontal POSITION rotary knob.
See also:
● ​"POSITION" on page 23
● ​"Time Reference" on page 225
● ​"To configure the original Y(t)-diagram" on page 65

Remote command: 
​TIMebase: ​POSition​ on page 274

Show Channels ← Y(t)-Setup
Displays all active channels in the Y(t)-window. By default, only the selected channel is
visible, the channel used for FFT calculation.

FFT Off
Closes the FFT display and returns to the previous display.
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9 Masks
Masks are used to determine whether the amplitude of a signal remains within specified
limits, e.g. to detect errors or test compliance of digital signals.

9.1 About Masks

9.1.1 Masks

A mask is specified by an upper and a lower limit line. The signal must run inside these
limit lines, otherwise a mask violation occurs.

A new mask is created from an existing signal: Mask limits are created by copying the
waveform, and the limits are moved and stretched. The result is a tolerance tube around
the signal that is used as mask.

Once a mask has been defined, the copied waveform envelope is kept in the instrument
until the next mask is defined or loaded. The settings for stretch and move are not kept.
If you want to keep the complete mask definition, or you need more than one mask, you
can save the mask to and load from any storage device - internal memory or external
USB flash device.

It is also possible to copy the saved masks to another storage device with "Export/Import
Masks". In an export/import operation, the name of the target file can be changed, so you
can copy and rename the file in one operation. You can also change the target file format
and convert the data during export/import. To copy a mask, use FILE >"Import/Export
Masks".

See also:
● ​chapter 9.1.3, "File Formats for Masks", on page 119
● ​chapter 12.2.1.2, "Importing and Exporting Data", on page 207

9.1.2 Mask Testing

The mask test analyzes whether tested signal runs inside the mask. The overall test result
is shown in the results table:

left column = number of tested acquisitions and test duration
middle column = number of passed acquisitions (green) and number of failed acquisitions (red)
right column = percentage share of passed and failed acquisitions

During a mask test, various actions can be executed when mask violations occur: notifi-
cation by a sound, stop of acquisition, printout or saving a screenshot, saving the wave-
form data.
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SCPI commands for mask test results:
● ​MASK: ​COUNt?​ on page 342

● ​MASK: ​VCOunt? ​ on page 342

● ​MASK: ​RESet:​COUNter ​ on page 342

9.1.3 File Formats for Masks

Data of masks is always saved as a succession of pairs of values - lower and upper limit
- and the pairs are written as two consecutive single values. Depending on the file format,
only amplitude values are stored, or the amplitude values are stored together with their
sample index.

Amplitude values are not saved as voltage values but as division values. The minimum
value for evaluation is -5.12 DIV, the maximum is +5.12 DIV. The internal vertical range
of the instrument exceeds the visible vertical range of ±4 DIV.

With export, you can convert the MSK file to CSV, TXT, or BIN formats. Import is possible
for MSK and CSV files.

MSK Format

MSK is the specific binary format for masks of the R&S RTM. It contains pairs of amplitude
values (in divisions) , their sample indexes and current instrument settings. Thus, the
amplitude values are not related to time and voltage. The data can be loaded back to the
instrument for further use. The format is not intended for analysis outside the R&S RTM.

CSV Format

In a Comma Separated Values text file, the waveform is stored in a two-columned table.
Columns are separated by a comma, and the lines are separated by line breaks \r\n
(0x0D 0x0A).

The first column contains the sample indexes, and the second column contains the asso-
ciated amplitude values in divisions. The first line indicates the units of the values in each
column, and the name of the waveform. For each sample index, two values (minimum
and maximum) are written. The range of amplitude values is -5.12 to +5.12 divisions.

The data can be loaded back to the instrument for further use.

Example: CSV file

[Sa],MSK1[DIV]
0.000E+00,-3.273E+00
0.000E+00,-7.831E-01
1.000E+00,-3.313E+00
1.000E+00,-8.232E-01
2.000E+00,-3.273E+00
2.000E+00,-8.232E-01
3.000E+00,-3.273E+00
3.000E+00,-7.831E-01
4.000E+00,-3.273E+00
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4.000E+00,-7.831E-01
5.000E+00,-3.313E+00
5.000E+00,-8.232E-01
6.000E+00,-3.273E+00
6.000E+00,-8.232E-01
7.000E+00,-3.273E+00
7.000E+00,-7.831E-01
8.000E+00,-3.313E+00
8.000E+00,-7.831E-01
9.000E+00,-3.273E+00
9.000E+00,-7.831E-01
1.000E+01,-3.273E+00
1.000E+01,-8.232E-01
...

At export, the sample indexes are written in scientific notification.

If you create a mask manually in a CSV file, you can write the indexes simply as intergers.
The file should contain 1000 pairs of min-max values.

TXT Format

TXT files are ASCII files that contain only amplitude values in divisions but no time values.
Amplitude values are separated by commas. Pairs of values are listed as two subsequent
single values, without any identification. There is no comma at the end of the file.

Example: TXT file

4.00,4.20,4.05,4.25,4.08,4.28,....., -4.05,-4.25,-4.00,-4.20

BIN Format

BIN files contain binary amplitude values only but no time values. Each value has a word
size of 8, or 16, or 32 bit, the word size is the same throughout the file.

Words are given in Big Endian order - beginning with the MSB (Most Significant Byte)
and ending with the LSB (Least Significant Byte). Pairs of values are listed as two sub-
sequent single values, without any identification.

9.2 Working with Masks

Masks define a frame with which you can compare the signal values. You can load pre-
configured masks or define your own masks based on existing waveforms. When you
perform a test, you can define which actions are to be taken upon violation of the mask
limits.

Masks are displayed in the color used for reference waveforms.
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9.2.1 Creating New Masks

You create a new mask based on a channel waveform, then optimize it by changing its
position and proportions, and save it.

1. Select and adjust the channel waveform that will be used as basis for the mask, and
run continuous acquisition.

2. Press MASKS.

The selected waveform is displayed with its envelope, other waveforms are switched
off in masks mode.

3. Press "New Mask".

4. Press "Copy Channel" to create the new mask.
The mask is created from the envelope and displayed in the color used for reference
waveforms.

5. To change the width of the waveform in vertical direction, press "Width Y" and turn
the "Navigation" rotary knob.
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The specified factor in divisions is added to the y-values of the upper mask limit and
subtracted from the y-values of the lower mask limit. Thus, the upper half of the mask
is pulled upwards, the lower half is pulled down.

6. Similarly, to change the width of the waveform in horizontal direction, press "Width
X" and turn the "Navigation" rotary knob.
The left half of the mask is pulled to the left, the right half is pulled to the right.

7. To move the mask vertically on the screen, press "Y-Position" and turn the "Naviga-
tion" rotary knob to change the y-position.
The current position is indicated as an offset from the center in divisions; a positive
value indicates the waveform was moved upwards; a negative value indicates the
waveform was moved down.

8. To change the scaling of the mask in y-direction, press "Stretch Y" and turn the
"Navigation" rotary knob.
Turn the knob clockwise to increase the factor, or counterclockwise to decrease the
factor. A value over 100% stretches the amplitudes; a value less than 100% com-
presses the amplitudes.

9. Save the new mask:

a) Press "Save".
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b) Define the storage settings as described for waveforms in ​chapter 12.2.1.1,
"Configuring Storage Locations", on page 207.

c) Press "Save".

9.2.2 Loading Masks

You can load mask data from MSK or CSV files from any storage device.

To copy a mask, use FILE >"Import/Export Masks". For import/export procedure, see ​
chapter 12.2.1.2, "Importing and Exporting Data", on page 207.

1. Press MASKS to display the "Mask Test" menu.

2. Press "Load Mask".

The "Load" menu and a file explorer is displayed.

3. Press "Storage" and select the storage device (internal directory or USB flash drive
connected to front or rear panel).

4. Select the directory and then the file that contains the mask. Use the "Navigation"
knob to scroll through the directories. To change the directory, scroll to the name of
the directory and press the knob, or press "Change dir.".

5. Press "Load".

The selected mask is displayed on the screen.

9.2.3 Performing a Mask Test

Using a mask test you can detect limit violations of the measured signal compared to a
pre-defined mask.

To perform a mask test

1. Seet up the waveform as usual.

2. Press MASKS to display the "Mask Test" menu.

3. Create a mask, or load an existing mask.

See:

● ​chapter 9.2.1, "Creating New Masks", on page 121
● ​chapter 9.2.2, "Loading Masks", on page 123

4. Press "Actions" to define what happens when a violation occurs. Select one or more
of the available actions by pressing the corresponding softkey and define when the
action will be executed.
See: ​"Actions" on page 126.

5. Press "Test" to start the mask test.
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The mask test is performed, i.e. the data from the active channel is compared to the
mask.
If the mask limits are exceeded, the specified action is taken. The overall result is
shown in the results table:

6. Press "Pause" to stop testing temporarily without closing the "Masks" menu.
Press "Pause" again to continue the test.

7. Press "Masks Test Off" to turn off the mask test and exit the "Mask" menu.

9.3 Reference for MASKS key

The MASKS key opens the "Masks" menu. Masks are used for error detection and com-
pliance tests of digital signals.

You can:
● run mask tests.
● configure actions triggered by mask violation.
● configure new masks based on channel signals.

Test.............................................................................................................................124
Pause..........................................................................................................................125
New Mask...................................................................................................................125

└ Copy Channel...............................................................................................125
└ Y-Position......................................................................................................125
└ Stretch Y.......................................................................................................125
└ Width Y.........................................................................................................125
└ Width X.........................................................................................................126
└ Save..............................................................................................................126

Load Mask...................................................................................................................126
Actions........................................................................................................................126

└ Sound, Stop, Screenshot, Print, Waveform..................................................127
Masks Test Off............................................................................................................127

Test
Performs a mask test for the selected signal, i.e. the signal's amplitudes are compared
with the specified mask. If the amplitude exceeds the limits of the mask, a violation is
detected.
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Which action is to be taken when a violation is detected is defined using the ​Actions
softkey. See also: ​chapter 9.2.3, "Performing a Mask Test", on page 123.

Remote command: 
​MASK: ​TEST ​ on page 340

Pause
Temporarily stops the mask test without closing the "Masks" menu. Counts are not
deleted, and the actions cannot be changed during a pause.

Remote command: 
​MASK: ​TEST ​ on page 340

New Mask
Opens a submenu to define a new mask for testing.

See also: ​chapter 9.2.1, "Creating New Masks", on page 121

Copy Channel ← New Mask
Creates a new mask from the envelope waveform of the selected channel and stores it
in the instrument.

Remote command: 
​MASK: ​CHCopy​ on page 340

Y-Position ← New Mask
Moves the mask vertically within the display. Turn the "Navigation" rotary knob to change
the y-position.

The current position is indicated as an offset from the center in divisions; a positive value
indicates the waveform was moved upwards; a negative value indicates the waveform
was moved down.

Remote command: 
​MASK: ​YPOSition​ on page 341

Stretch Y ← New Mask
Changes the vertical scaling to stretch the mask in y-direction.

Turn the "Navigation" rotary knob clockwise to increase the factor, or counterclockwise
to decrease the factor. A value over 100% stretches the amplitudes; a value less than
100% compresses the amplitudes.

Remote command: 
​MASK: ​YSCale​ on page 341

Width Y ← New Mask
Changes the width of the mask in vertical direction.
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The specified number of divisions is added to the y-values of the upper mask limit and
subtracted from the y-values of the lower mask limit. Thus, the upper half of the mask is
pulled upwards, the lower half is pulled down, and the overall height of the mask is twice
the "Width Y".

Remote command: 
​MASK: ​YWIDth​ on page 341

Width X ← New Mask
Changes the width of the mask in horizontal direction.

The specified factor in divisions is added to the positive x-values and subtracted from the
negative x-values of the mask limits in relation to the mask center. Thus, the left half of
the mask is pulled to the left, the right half is pulled to the right.

Remote command: 
​MASK: ​XWIDth​ on page 341

Save ← New Mask
Opens a menu to save the mask in an instrument-specific format. The complete mask
definition - envelope waveform with width, stretch and position settings - is stored.

See ​"Save Menu" on page 209.

Remote command: 
​MASK: ​SAVE ​ on page 340

Load Mask
Opens a file explorer to select a previously stored mask. The selected mask is loaded
and can be used for a subsequent test.

Remote command: 
​MASK: ​LOAD ​ on page 340

Actions
Opens a submenu to select the actions to be taken when a violation against the mask
limits occurs. For each action, you can define when and how often the action will be
executed.

"Sound" Generates a beep sound.

"Stop" Stops the waveform acquisition.

"Screenshot" Saves a screenshot according to the settings in FILE > "Screenshots".

"Print" Prints a screenshot to a printer connected to the USB connector on the
front or rear panel.
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"Waveform" Saves the waveform data according to the settings in FILE > "Wave-
form".

Remote command: 
​MASK: ​ACTion: ​SOUNd:​EVENt: ​MODE ​ on page 342
​MASK: ​ACTion: ​STOP:​EVENt: ​MODE ​ on page 342
​MASK: ​ACTion: ​SCRSave: ​EVENt:​MODE ​ on page 342
​MASK: ​ACTion: ​PRINt:​EVENt: ​MODE ​ on page 342
​MASK: ​ACTion: ​WFMSave: ​EVENt:​MODE ​ on page 342

Sound, Stop, Screenshot, Print, Waveform ← Actions
For each action, you can define when and how often the action will be executed.

"Off" No action is executed.

"Each" The selected action is executed on each violation of the mask.

"After n / n" "Single": The selected action is executed once after the n-th violation.
"Cyclic": The selected action is executed repeatedly after each n-th
violation.
Set the execution interval with softkey "n".

Remote command: 
​MASK: ​ACTion: ​SOUNd:​EVENt: ​COUNt​ on page 343
​MASK: ​ACTion: ​STOP:​EVENt: ​COUNt ​ on page 343
​MASK: ​ACTion: ​SCRSave: ​EVENt:​COUNt ​ on page 343
​MASK: ​ACTion: ​PRINt:​EVENt: ​COUNt​ on page 343
​MASK: ​ACTion: ​WFMSave: ​EVENt:​COUNt ​ on page 343

Masks Test Off
Turns off the mask test and exits the "Mask" menu.

Remote command: 
​MASK: ​STATe​ on page 340
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10 Search

10.1 Search Conditions and Results

The search functions of R&S RTM allow to find all edges, pulse widths, peaks, or other
events in an acquisition that match the search conditions. For each search type, specific
settings are available. Searches can be performed on any channel, math or reference
waveform.

Searches can be performed online, that is repeatedly for each new data acquisition in a
running acquisition series, or only once after the acquisition has been stopped. In an
online search, only the displayed data is searched while the search on a stopped acqui-
sition analyzes the contents of the memory.

The searched time base range can be restricted by defining a gate.

10.1.1 Search Results

Search results are marked in the diagram and listed in a results table with their specific
measurement values. In the table, five results are shown. To navigate the search results,
turn the NAVIGATION knob. See also: ​"To analyze search results" on page 130.

Search result markers

For further analysis, for example, for cursor measurements, you can set up to 20 markers
to selected search results. Search result markers are different from usual timestamp
markers but they are set, navigated and deleted by means of the marker keys, too. As
long as a search is enabled, the search result markers are active. If search is off, usual
markers can be used.

See also:
● ​"To use markers on search results" on page 131
● ​chapter 4.4, "Markers", on page 67

 

 

 

Search Conditions and Results



SearchR&S®RTM

129User Manual 1305.0595.02 ─ 08

Fig. 10-1: Results of an edge search with R&S RTM

1 = Search results
2 = Marked search results
3 = Selected search result
4 = Search conditions
5 = Number of results, scope of results displayed in the results table
6 = Result values: result number, time value, optional value depending on the search type (voltage, width)

SCPI commands:
● ​SEARch: ​RCOunt? ​ on page 359

● ​SEARch: ​RESult: ​ALL? ​ on page 358

● ​SEARch: ​RESult<n>? ​ on page 358
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10.2 Configuring and Performing Searches

To configure and start a search

Prerequisite: Signal acquisition, reference or math waveform is configured.

1. Press the SEARCH MENU key.

The "Search" menu opens, and the search is enabled.

2. Press "Source" and select the waveform for analysis. All active channel, math, and
reference waveforms are available for selection.

3. Press "Search type" and select the event you want to search for: edge, width, peaks,
runts, specified rise/fall time, setup/hold time, pattern, or protocol-specific events.

4. Press "Setup" and configure the selected search type.

Details:

● ​chapter 10.3.2, "Edge Setup", on page 133
● ​chapter 10.3.3, "Width Setup", on page 134
● ​chapter 10.3.4, "Peak Setup", on page 135
● ​chapter 10.3.5, "Rise/Fall Time Setup", on page 135
● ​chapter 10.3.6, "Runt Setup", on page 137
● ​chapter 10.3.7, "Data2Clock Search", on page 138
● ​chapter 10.3.8, "Pattern Search", on page 140
● ​chapter 11.6.5.1, "CAN Search Setup", on page 189, requires option R&S RTM-

K3
● ​chapter 11.7.6.1, "LIN Search Setup", on page 201, requires option R&S RTM-

K3

5. To restrict the time base range of the source waveform to be searched, press
"Gate" and define the search area.

6. Start continuous acquisition with RUN CONT.

The online search is performed on the displayed data. Search results are updated
permanently and indicated at the top of the diagram.
Stop the acquisition to search the memory data of the latest acquisition.

To analyze search results

1. Stop the running continuous acquisition, or acquire one waveform with RUN N× SIN-
GLE.

2. Press "Events".

3. Press "View event table" in the "Events" menu.

The first five search results are listed in a table.

4. To select a search result, turn the NAVIGATION knob.
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The selected result is highlighted in the table and indicated in the diagram with a
magnifier symbol.

5. To see the selected event even if it is outside the display, press "Track event".

The waveform is moved on the display, and the selected result is shown at the time
reference point.

To use markers on search results

1. If the search results table is not visible, press "View event table".

2. To set markers to all results, press "Mark events". If more then 20 results are found,
the first 20 results are marked.

3. To set a marker to a selected result:

a) Select the result in the "Search Event Table" by turning the NAVIGATION knob.
b) Press the SET key.

4. To select a marker:

● Press the NEXT key to move to next marker to the right.
● Press the PREV key to move to previous marker to the left.

5. To delete a single marker, select it an press the CLEAR key.

6. To delete all markers, press "Clear all event markers".

To finish a search

1. To close the results table, press "View event table".

2. To stop the search, press "Search".

10.3 Reference for Search Menu

10.3.1 Main Search Menu

The SEARCH MENU key opens the same-named menu where you can search various
events, for example:
● edges
● peaks
● pulses with defined pulse width
● rise time or fall time
● ... and more
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Search
Enables and disables the search mode.

Remote command: 
​SEARch: ​STATe ​ on page 344

Search type
Selects the event you want to search for.

"Edge" Similar to the edge trigger, an edge search result is found when the
waveform passes the given level in the specified direction.
For settings, see ​chapter 10.3.2, "Edge Setup", on page 133.

"Width" Similar to the width trigger, a width search finds pulses with an exact
pulse width, or pulses shorter or longer than a given time, or pulses
inside or outside the allowable time range.
For settings, see ​chapter 10.3.3, "Width Setup", on page 134

"Peak" The peak search finds pulses exceeding a given amplitude.
For settings, see ​chapter 10.3.4, "Peak Setup", on page 135

"Rise/Fall time" The rise or fall time search finds slopes with an exact rise or fall time,
or rise/fall times shorter or longer than a given limit, or rise/fall times
inside or outside the allowable time range.
For settings, see ​chapter 10.3.5, "Rise/Fall Time Setup",
on page 135

"Runt" The runt search finds pulses lower than normal in amplitude. The ampli-
tude crosses the first threshold twice without crossing the second one.
In addition to the threshold amplitudes, you can define a time limit for
the runt in the same way as for width search: runts with exact width,
shorter or longer than a given time, or runts inside or outside the allow-
able time range.
For settings, see ​chapter 10.3.6, "Runt Setup", on page 137

"Data2Clock" The Data2Clock search - also known as setup/hold - finds violation of
setup and hold times. It analyzes the relative timing between two sig-
nals: a data signal and the synchronous clock signal.
Many systems require, that the data signal must be steady for some
time before and after the clock edge. Setup time is the time that the data
signal is steady before clock edge. Hold time is the time that the data
signal is steady after clock edge.
For settings, see ​chapter 10.3.7, "Data2Clock Search", on page 138.

"Pattern" The pattern search finds logical combinations of channel states inside
or outside a specified time range. For each channel, its state and
threshold level is defined. The states are combined logically, and the
time of true pattern results is compared with a specified time range.
For settings, see ​chapter 10.3.8, "Pattern Search", on page 140.
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"Protocol" The protocol search finds various events in decoded data of CAN and
LIN signals, for example, a specified frame type, identifier, data, and
errors.The protocol search requires option R&S RTM-K3.

For information on protocol search, see
● ​chapter 11.6.5, "Search on Decoded CAN Data", on page 189
● ​chapter 11.7.6, "Search on Decoded LIN Data", on page 200

Remote command: 
​SEARch: ​CONDition ​ on page 344

Setup
Opens a menu to define the specific search parameters.

Source
Selects the waveform to be analyzed with edge, width, peak, rise/fall time, or runt search.
All active channel, math, and reference waveforms are available for selection.

Remote command: 
​SEARch: ​SOURce​ on page 346

Source Setup
Opens a menu to define the source parameters for Data2Clock and Pattern search:
waveform, level, and hysteresis.

Gate
Opens a menu to restrict the time base range of the source waveform for search.

See ​chapter 10.3.9, "Gate Menu", on page 142

Events
Opens a menu with functions for result display and marker usage.

See: ​chapter 10.3.10, "Events Menu", on page 143

Remote command: 
​SEARch: ​RESDiagram: ​SHOW ​ on page 357

10.3.2 Edge Setup

Access: SEARCH MENU > "Search type = Edge" > "Setup"

Edge
Sets the slope to be found:

"Rising" Rising edge, a positive voltage change

"Falling" Falling edge, a negative voltage change
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"Both" Rising edge and falling edge

Remote command: 
​SEARch: ​TRIGger: ​EDGE: ​SLOPe​ on page 347

Level
Sets the voltage level for the search.

Remote command: 
​SEARch: ​TRIGger: ​EDGE: ​LEVel​ on page 347

Hysteresis
Sets a hysteresis range to the search level in order to avoid unwanted search results
caused by noise oscillation around the level. For a rising edge, the hysteresis is below
the search level. Otherwise, for a falling edge the hysteresis is above the level.

Remote command: 
​SEARch: ​TRIGger: ​EDGE: ​LEVel:​DELTa ​ on page 347

10.3.3 Width Setup

Access: SEARCH MENU > "Search type = Width" > "Setup"

Polarity
Indicates the polarity of the pulse to be searched for.

Remote command: 
​SEARch: ​TRIGger: ​WIDTh:​POLarity ​ on page 347

Level
Sets the voltage level on which the pulse width is measured.

Remote command: 
​SEARch: ​TRIGger: ​WIDTh:​LEVel ​ on page 348

Hysteresis
Sets a hysteresis range to the search level in order to avoid unwanted search results
caused by noise oscillation around the level. For a rising edge, the hysteresis is below
the search level. Otherwise, for a falling edge the hysteresis is above the level.

Remote command: 
​SEARch: ​TRIGger: ​WIDTh:​LEVel: ​DELTa​ on page 348

Comparison
Sets the condition how the measured pulse width is compared with the given limit(s).

"Greater than" Finds pulses longer than the given "Width".
See also: ​Width
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"Lower than" Finds pulses shorter than the given "Width".

"Equal" Finds pulses equal to the reference "Width" if "Variation" Δt = 0.
If "Variation" ≠ 0, the setting finds pulses within the range width ± Δt.
See also: ​Variation

"Not equal" Finds pulses unequal to the reference "Width" if "Variation" Δt = 0.
If "Variation" ≠ 0, the setting finds pulses outside the range width ± Δt.

Remote command: 
​SEARch: ​TRIGger: ​WIDTh:​RANGe ​ on page 348

Width
Sets the reference pulse width, the nominal value for comparisons.

Remote command: 
​SEARch: ​TRIGger: ​WIDTh:​WIDTh ​ on page 349

Variation
Sets a range Δt to the reference "Width" if comparison is set to "Equal" or "Not equal".
The instrument finds pulses inside or outside the range width ± Δt.

Remote command: 
​SEARch: ​TRIGger: ​WIDTh:​DELTa ​ on page 349

10.3.4 Peak Setup

Access: SEARCH MENU > "Search type = Peak" > "Setup"

Polarity
Indicates the polarity of the pulse to be searched for.

Remote command: 
​SEARch: ​MEASure: ​PEAK: ​POLarity ​ on page 349

Magnitude
Sets the amplitude limit.

Remote command: 
​SEARch: ​MEASure: ​LEVel:​PEAK: ​MAGNitude ​ on page 349

10.3.5 Rise/Fall Time Setup

Access: SEARCH MENU > "Search type = Rise/Fall time" > "Setup"
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Edge
Sets the slope to be found:
● "Rising" to search for rise time
● "Falling" to search for fall time
● "Both" to search for rise and fall time

Remote command: 
​SEARch: ​TRIGger: ​RISetime: ​SLOPe​ on page 350

Upper level
Sets the upper voltage threshold. When the signal crosses this level, the rise/fall time
measurement starts or stops depending on the selected slope.

Remote command: 
​SEARch: ​TRIGger: ​LEVel:​RISetime: ​UPPer ​ on page 350

Lower level
Sets the lower voltage threshold. When the signal crosses this level, the rise time mea-
surement starts or stops depending on the selected slope.

Remote command: 
​SEARch: ​TRIGger: ​LEVel:​RISetime: ​LOWer ​ on page 350

Comparison
Sets how the measured rise or fall time is compared with the given limit(s).

"Greater than" Finds rise/fall times longer than the given "Rise/Fall time".

"Lower than" Finds rise/fall times shorter than the given "Rise/Fall time".

"Equal" Finds rise/fall times equal to the reference "Rise/Fall time" if "Varia-
tion" Δt = 0.
If "Variation" ≠ 0, the setting finds rise/fall times within the range time
± Δt.
See also: ​Variation.

"Not equal" Finds rise/fall times unequal to the reference value if "Variation" Δt = 0.
If "Variation" ≠ 0, the setting finds rise/fall times outside the range time
± Δt.

Remote command: 
​SEARch: ​TRIGger: ​RISetime: ​RANGe​ on page 350

Rise/Fall time
Sets the reference rise or fall time, the nominal value for comparisons.

Remote command: 
​SEARch: ​TRIGger: ​RISetime: ​TIME ​ on page 351
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Variation
Sets a range Δt to the reference "Rise/Fall time" if comparison is set to "Equal" or "Not
equal". The instrument finds rise/fall times inside or outside the range width ± Δt.

Remote command: 
​SEARch: ​TRIGger: ​RISetime: ​DELTa​ on page 351

10.3.6 Runt Setup

Access: SEARCH MENU > "Search type = Runt" > "Setup"

Polarity
Indicates the polarity of the pulse to be searched for.

Remote command: 
​SEARch: ​TRIGger: ​RUNT: ​POLarity ​ on page 352

Upper level
Sets the upper voltage threshold for runt detection. A negative runt crosses the upper
level twice without crossing the lower level.

Remote command: 
​SEARch: ​TRIGger: ​LEVel:​RUNT: ​UPPer ​ on page 352

Lower level
Sets the lower voltage threshold for runt detection. A positive runt crosses the lower level
twice without crossing the upper level.

Remote command: 
​SEARch: ​TRIGger: ​LEVel:​RUNT: ​LOWer ​ on page 352

Comparison
Sets the condition how the measured runt width is compared with the given limit(s).

The same conditions as with width search are used, see ​"Comparison" on page 134.

Remote command: 
​SEARch: ​TRIGger: ​RUNT: ​RANGe​ on page 352

Width
Sets the reference runt pulse width, the nominal value for comparisons.

Remote command: 
​SEARch: ​TRIGger: ​RUNT: ​WIDTh​ on page 353
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Variation
Sets a range Δt to the reference "Width" if comparison is set to "Equal" or "Not equal".
The instrument finds pulses inside or outside the range width ± Δt.

Remote command: 
​SEARch: ​TRIGger: ​RUNT: ​DELTa​ on page 353

10.3.7 Data2Clock Search

The settings for Data2Clock search are provided in two menus: in the "Setup" menu you
define the clock polarity, setup and hold times; and in the "Source Setup" menu you define
the waveforms to be used, and the levels and hysteresis for each source.

10.3.7.1 Data2Clock Source Setup

Access: SEARCH MENU > "Search type = Data2Clock" > "Source Setup"

For Data2Clock search, two sources have to be defined: a clock and a data waveform.
For each waveform, the level and the hysteresis can be set individually.

Clock
Selects the input channel of the clock signal.

Remote command: 
​SEARch: ​TRIGger: ​DATatoclock: ​CSOurce ​ on page 353

Data
Selects the input channel of the data signal.

Remote command: 
​SEARch: ​SOURce​ on page 346

Level
Set the voltage levels for clock and data signals. Clock level and clock edge define the
reference point for setup and hold time. The data lavel defines the point of data transition.

Remote command: 
​SEARch: ​TRIGger: ​DATatoclock: ​CLEVel​ on page 354
​SEARch: ​TRIGger: ​DATatoclock: ​DLEVel​ on page 354
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Hysteresis
Sets a hysteresis range to the search level of the selected signal in order to avoid unwan-
ted search results caused by noise oscillation around the level. For a rising edge, the
hysteresis is below the search level. Otherwise, for a falling edge the hysteresis is above
the level.

Remote command: 
​SEARch: ​TRIGger: ​DATatoclock: ​CLEVel: ​DELTa ​ on page 354
​SEARch: ​TRIGger: ​DATatoclock: ​DLEVel: ​DELTa ​ on page 354

10.3.7.2 Data2Clock Setup

Access: SEARCH MENU > "Search type = Data2Clock" > "Setup"

Polarity
Sets the edge of the clock signal to define the time reference point for the setup and hold
time.

"Rising" Only positive clock edges are considered.

"Falling" Only negative clock edges are considered.

"Either" The clock edges next to the data edge are considered regardless of the
clock slope.

Remote command: 
​SEARch: ​TRIGger: ​DATatoclock: ​CEDGe​ on page 354

Setup Time
Sets the minimum time before the clock edge while the data signal must stay steady
above or below the data level. The setup time can be negative. In this case, the setup
interval starts after the clock edge, and the hold time must be positive and longer than
the absolute value of the setup time.

Remote command: 
​SEARch: ​TRIGger: ​DATatoclock: ​STIMe​ on page 355

 

Reference for Search Menu



SearchR&S®RTM

140User Manual 1305.0595.02 ─ 08

Hold Time
Sets the minimum time after the clock edge while the data signal must stay steady above
or below the data level. The hold time can be negative. In this case, the hold time ends
before the clock edge, and the setup time must be positive and longer than the absolute
value of the hold time.

Remote command: 
​SEARch: ​TRIGger: ​DATatoclock: ​HTIMe​ on page 354

10.3.8 Pattern Search

The settings for pattern search are provided in two menus: in the "Setup" menu you define
the channel states, their logical combination and the time range for keeping up the true
result of the state pattern condition; and in the "Source Setup" menu you define the
threshold levels and hysteresis for each channel.

10.3.8.1 Pattern Source Setup

Access: SEARCH MENU > "Search type = Pattern" > "Source Setup"

For pattern search, up to four channels can be used as source. For each channel, the
threshold level and the hysteresis can be set individually.

Source
Selects the channel for which the pattern search is defined.

Level
Sets the threshold value for the selected source channel. If the signal value is higher than
the trigger level, the signal state is high (1 or true for the boolean logic). Otherwise, the
signal state is considered low (0 or false) if the signal value is below the trigger level.

Remote command: 
​SEARch: ​TRIGger: ​PATTern: ​LEVel<n> ​ on page 356

Hysteresis
Sets a hysteresis range to the level of the selected source channel in order to avoid
unwanted search results caused by noise oscillation around the level. For a rising edge,
the hysteresis is below the search level. Otherwise, for a falling edge the hysteresis is
above the level.

Remote command: 
​SEARch: ​TRIGger: ​PATTern: ​LEVel<n>:​DELTa ​ on page 356

 

 

Reference for Search Menu



SearchR&S®RTM

141User Manual 1305.0595.02 ─ 08

10.3.8.2 Pattern Setup

Access: SEARCH MENU > "Search type = Pattern" > "Setup"

For pattern search, up to four channels can be used as source. For each channel, you
define the state. The states are combined logically, and the time of true pattern results is
compared with a specified time range. Thus you can find state transitions inside or outside
this time range.

Source
Selects the channel for which the pattern search is defined.

Remote command: 
​SEARch: ​TRIGger: ​PATTern: ​SOURce​ on page 355

State
Sets the state of the selected source channel. The states are:

"H" High: the signal voltage is higher than the threshold level.

"L" Low: the signal voltage is lower than the threshold level.

"X" Don't care: the channel does not affect the search.

Remote command: 
​SEARch: ​TRIGger: ​PATTern: ​SOURce​ on page 355

Combination
Sets the logical combination of the channel states.

"AND" The required states of all channels must appear in the input signal at
the same time.

"Or" At least one of the channels must have the required state.

"NAND" "Not and" operator, at least one of the channels does not have the
required state.

"NOR" "Not or" operator, none of the channels has the required state.

Remote command: 
​SEARch: ​TRIGger: ​PATTern: ​FUNCtion ​ on page 355
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Comparison
Sets the condition how the duration of a steady pattern is compared with the given limit(s).
The three settings "Width" "Variation" and "Comparison" define the time range for keeping
up the true result of the state pattern.

The same conditions as with width search are used, see ​"Comparison" on page 134.

Remote command: 
​SEARch: ​TRIGger: ​PATTern: ​WIDTh:​RANGe ​ on page 356

Width
Sets the limit time of a steady pattern, the nominal value for comparisons.

Remote command: 
​SEARch: ​TRIGger: ​PATTern: ​WIDTh[: ​WIDTh]​ on page 357

Variation
Sets a range Δt to the reference "Width" if comparison is set to "Equal" or "Not equal".
The instrument finds true results of the state pattern inside or outside the range width ±
Δt.

Remote command: 
​SEARch: ​TRIGger: ​PATTern: ​WIDTh:​DELTa ​ on page 357

10.3.9 Gate Menu

Access: SEARCH MENU > "Gate"

The gate restricts the time base of the source waveform to be searched.

Gate
Defines the search area. If the search is performed on a running acquisition series, the
instrument analyzes the displayed data. The search on a stopped acquisition analyzes
the contents of the memory.

"All" Running acquisition: all waveform samples that are displayed on the
screen.
Stopped acquisition: all data samples that are stored in the memory.

"Display" Search is restricted to the time range of the display.

"User" Search is restricted to the time range defined by "Start" and "Stop" val-
ues.

Remote command: 
​SEARch: ​GATE: ​MODE ​ on page 346
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Start
Sets the start time of the search area in relation to the trigger point.

Remote command: 
​SEARch: ​GATE: ​ABSolute:​START ​ on page 346

Stop
Sets the end time of the search area in relation to the trigger point.

Remote command: 
​SEARch: ​GATE: ​ABSolute:​STOP ​ on page 346

10.3.10 Events Menu

Access: SEARCH MENU > "Events"

Events are the search results which are marked in the waveform diagram and listed in
the event table. See also: ​chapter 10.1.1, "Search Results", on page 128.

View event table
Shows or hides the table of search results.

Remote command: 
​SEARch: ​RESDiagram: ​SHOW ​ on page 357

Mark events
Sets markers to the first search results. Up to 20 markers can be set at once.

Clear all event marks
Removes all markers from search results.

Track event
If enables, the selected result is moved to the reference point. Thus you can always see
the selected event in the diagram.
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11 Protocol Analysis
With the R&S RTM and some additional options, you can analyze the following parallel
and serial protocols:
● Parallel
● SPI (Serial Peripheral Interface with 3 lines) and SSPI (Serial Peripheral Interface

with 2 lines) - requires option R&S RTM-K1
● I²C (Inter-Integrated circuit bus) - requires option R&S RTM-K1
● UART/RS232 (EIA-232 serial interface) - requires option R&S RTM-K2
● CAN (Controller Area Network) - requires option R&S RTM-K3
● LIN (Local Interconnect Network) - requires option R&S RTM-K3

11.1 Basics of Protocol Analysis

The analysis of parallel and serial data consists of three main steps:
● Protocol configuration: Select the protocol type, and configure the input line as well

as the protocol-specific settings
● Decoding: Configure the display of the decoded data and enable decoding. As a

result, the digitized signal data is displayed on the screen together with the decoded
content of the messages.
You can scale the signal display and zoom into it to see it in more detail.
You can create and apply label lists for easier identification of the bus nodes on the
display.

● Triggering: You can trigger on various events that are typical for the configured bus
type, for example, on start and stop of messages, on specific addresses, or on serial
patterns.

11.1.1 Configuring Common Protocol Settings

Common settings for all bus types are the logic threshold and the decoding and display
settings.

To set the logic threshold

Before you start configuration and analysis, check and set the logic thresholds for all used
channels - the voltage values for digitization of analog signals. If the signal value is higher
than the threshold, the signal state is 1. Otherwise, the signal state is considered 0 if the
signal value is below the threshold.

If you want the instrument to set the thresholds based on the analysis of the signals, press
"Find level" in the protocol's "Configuration" menu.

1. Press the CH N key of the required channel.
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2. Press the "More" softkey.

3. Press "Threshold" and enter the voltage value.

4. Repeat step 1 to 3 for all channels that are used for protocol analysis.

To configure decoding and data display

1. Press the PROTOCOL key on the front panel.

2. Press the "Display" softkey and select the decoding format: Binary, Hexadecimal,
Decimal or ASCII.

3. Press "Decode" to display the content of the messages in an easily readable and
comprehensible form.

4. To adjust the position and size of decoded information on the screen, use the vertical
POSITION and SCALE rotary knobs.

5. To display the individual bit lines above the decoded data, press "Bits".

11.1.2 Reference for Protocol Decoding

The common settings in the "Protocol" menu define how the decoded signal is displayed.

Bus Type
Defines the bus or protocol type for analysis. For most types, a special option to the
instrument is required.

Remote command: 
​BUS: ​TYPE ​ on page 359

Decode
Decodes the signal according to the protocol configuration and displays the decoded
signal - the content of every message. The decoding format is set with "Display".

Remote command: 
​BUS: ​STATe ​ on page 359

Bits
Displays the individual bit lines above the decoded bus line.

Remote command: 
​BUS: ​DSIGnals ​ on page 360
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Display
Sets the decoding format: Binary, Hexadecimal, Decimal or ASCII.

Remote command: 
​BUS: ​FORMat​ on page 360

Label List
Opens the "Label list" menu to load, sort, and display a name for each bus node instead
of the address or ID on the decoded results display. So it is easy to identify the messages
of the different bus nodes.

See: ​chapter 11.1.3, "Label List", on page 146

Frame Table
Opens the "Frame table" menu to configure and display the frame table with detailed
decoded data for each frame of the acquisition.

See: ​chapter 11.1.4, "Frame Table: Decode Results", on page 148

11.1.3 Label List

For all protocols using ID or address identification, it is possible to create label lists con-
taining addresses or IDs, a symbolic name for each node (symbolic label), and some
protocol-specific information. You can load label lists, and activate its usage for decoding.
As a result, an additional "Label" column appears in the "Frame Table", containing the
symbolic label. The frame captions of the decoded signal show the symbolic label instead
of the ID or address values so it is easy to identify the messages of the different bus
nodes.

11.1.3.1 Content and Format of the PTT File

Label lists are stored as PTT (protocol translation table) files. The PTT file format is an
extension of the CSV format (comma separated values). You can edit it with standard
editors, for example, with MS Excel or a text editor.

The PTT file has three types of lines:
● Comment lines begin with a hash character #. A hash character at any other position

in the line is treated like a standard character.
● Command lines begin with a commercial at character @. An @ character at any other

position in the line is treated like a standard character.
● Standard lines are the lines that not qualify as comment or command lines. They build

the core of the label list.

Command lines

Command lines define the version of the PTT file and the protocol name:
● @FILE_VERSION: must appear exactly once in the file
● @PROTOCOL_NAME: must appear at least once in the file. Thus, one file can con-

tain several label lists for different protocols.
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# --- Start of PTT file
@FILE_VERSION  = 1.0 
@PROTOCOL_NAME = i2c
[... Label list for I2C]
@PROTOCOL_NAME = can
[... Label list for CAN]
# --- End of PTT file

Standard lines

Standard lines define the contents of the label list. The rules for standard lines follow the
csv convention, they are:
● Values are separated by commas
● Space characters following a delimiter are ignored
● Values with a special character (comma, newline, or double quote) must be enclosed

in double quotes
● Text in double quotes must be escaped by double quote characters

Additionally, numeric values may be decimal integer (default) or hexadecimal integer
(with prefix "0x")

# --- Start of PTT file
@FILE_VERSION  = 1.0 
@PROTOCOL_NAME = i2c
#    Following two lines are equal:
7,0x01,Temperature
7,0x01, Temperature
#    A comma must be enclosed in double quotes:
7,0x01,"Temperature, Pressure, and Volume"
#    A double quote must also be enclosed in double quotes:
7,0x7F,"Highspeed ""Master"" 01"
#    Following lines yield the same result:
7,0x11,Pressure
0x7,0x11,Pressure
0x7,17,Pressure
1,17,Pressure

Label lists are protocol-specific. Their contents are described in the corresponding pro-
tocol chapters:
● ​chapter 11.4.4, "I2C Label List", on page 167
● ​chapter 11.6.3, "CAN Label List", on page 186
● ​chapter 11.7.4, "LIN Label List", on page 198

11.1.3.2 Label List Menu

Access: PROTOCOL > "Bus Type" = "I2C | CAN | LIN" > "Label List"
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Apply...........................................................................................................................148
Load............................................................................................................................148
Show...........................................................................................................................148
Sort..............................................................................................................................148
Remove.......................................................................................................................148

Apply
Shows the labels from the label list in the display of decode results instead of the ID or
address.

Load
Opens a menu to select and load a PTT file from an USB flash drive. The PTT file contains
one or more label lists.

The function is only available if an USB flash drive is connected to the instrument.

Alternatively, you can load a label list together with the device settings, if both were saved
with FILE > "Device Settings > Save > Setup & Label".

See also: ​"Setup & Label" on page 215

Show
Diplays the label list for the selected protocol type. Before, the label list must be loaded
from a PTT file.

Sort
Displays the label list in alphanumerical order or sorted by ID or address.

Remove
Deletes the label list from the instrument.

11.1.4 Frame Table: Decode Results

Access: PROTOCOL > "Frame Table"

The frame table shows the detailed decoded data for each frame of the acquisition. The
table content is protocol-specific, and the display of the table can be enabled for each
individual bus type.

Decode results shown in the frame table can be saved in a CSV file.

To navigate in the frame table

1. Stop the acquisition.

2. Turn the NAVIGATION knob to select a frame.
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3. Press the NAVIGATION knob to display the selected frame in the center of the wave-
form display.

If a search on decoded data was performed, the search results are marked in the frame
table.

Frame Table
Displays or hides the table of decode results.

Track frame
Defines the automatic synchronization of the selected frame in the frame table and the
waveform display.

The function is only available if the acquisition has been stopped.

"Off" Frame table and waveform display are not synchronized.

"Frame Index" The waveform display is connected to the frame that is selected in the
frame table. The selected frame is shown in the center of the display.
If you select another frame, the waveform display is adjusted automat-
ically.

"Hori. Position" The frame selection in the frame table is connected to the waveform
display. The frame in the center of the display is selected in the frame
table. When you change the horizontal position of the waveform, the
selection in the frame table is adjusted automatically.

Frame time difference
If selected, the time shown in the frame table is the time difference to the previous frame.
The column is indicated with "Time diff.". If the setting is disabled, the absolute time in
releation to the trigger point is shown in the "Start time" column.

Position
Defines the position of the frame table on the screen: top right, bottom right, or full screen.
With full screen setting, the frame table covers nearly the complete righthand half of the
screen.

Save
Opens the "Save" menu to save the decoded data in a CSV file (comma-separated list).

Remote command: 
​BUS: ​LIST: ​SAVE​ on page 361
​BUS: ​LIST? ​ on page 360
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11.2 Parallel Bus

The R&S RTM can display up to four lines of a parallel bus depending on the number of
input channels. Specific trigger settings are not available. To trigger on parallel buses,
use the pattern trigger. See: ​chapter 3.3.2.5, "Pattern", on page 47.

11.2.1 Analyzing Parallel Buses

As all protocols, the parallel bus needs configuration to decode and display the signal.

To configure parallel buses

1. Press the PROTOCOL key on the front panel.

2. Press the "Bus Type" softkey and select "Parallel".

3. Press "Configuration".

4. Select the "Bus Width".

5. Set the threshold for each channel.
See: ​"To set the logic threshold" on page 144

6. Press "Back" and configure the data display.
See: ​"To configure decoding and data display" on page 145

11.2.2 Reference for Parallel Bus

You can configure up to four parallel bit lines depending on the number of input channels.

Bus width
Sets the number of lines to be analyzed. The maximum number is the number of input
channels.

Remote command: 
​BUS: ​PARallel:​WIDTh ​ on page 361

11.3 SPI/SSPI Bus (Option R&S RTM-K1)

11.3.1 The SPI Protocol

A 4-channel instrument is required for full support of the SPI protocol.

The Serial Peripheral Interface SPI is used for communication with slow peripheral devi-
ces, in particular, for transmission of data streams.
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Main characteristics of SPI are:
● Master-slave communication
● No device addressing; The slave is accessed by a chip select, or slave select line.
● No acknowledgement mechanism to confirm receipt of data
● Duplex capability

Most SPI buses have four lines, two data and two control lines:
● Clock line to all slaves (SCLK)
● Slave Select or Chip Select line (SS or CS)
● Master data output, slave data input (MOSI or SDI)
● Master data input, slave data output (MISO or SDO)

When the master generates a clock and selects a slave device, data may be transferred
in either or both directions simultaneously.

As SPI is very simple and efficient for single master - single slave applications, the
R&S RTM provides also an SSPI (simple SPI) configuration that does not have a chip
select line.

Fig. 11-1: Simple configuration of SPI bus

The data bits of a message are grouped by following criteria:
● A word contains a number of successive bits. The word length is defined in the pro-

tocol configuration.
● A frame contains a number of successive words, at least one word.

For SPI buses, the R&S RTM provides the following trigger possibilities:
● On frame start or frame end
● On a specified bit in the message
● On a serial pattern

11.3.2 SPI/SSPI Bus Configuration

● Configuring SPI Buses..........................................................................................151
● SPI/SSPI Configuration Settings...........................................................................152

11.3.2.1 Configuring SPI Buses

You define the input channels for the lines and some bit information on the message.

1. Press the PROTOCOL key on the front panel.

2. Press the "Bus Type" softkey and select "SPI" or "SSPI".
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3. Press "Configuration".

4. Press "Source" and select "Clk".

5. Press "Clock" and select the input channel of the clock. Select the "Slope".

6. Press "Source" and select "MOSI".

7. Press "MOSI" and select the input channel. With "Active", select the active state of
the data - high or low.

8. If required, repeat steps 6 and 7 for the optiona MISO line.

9. For SPI, press "Source" and select "CS". Enter the input channel with "Chip Select"
and set the "Active" state.

10. For SSPI, press "Source" and select "Time". Enter the "Idle Time".

11. Set the "First Bit" and the "Symbol Size".

12. Press "Find level", or set the threshold manually for each channel.
See: ​"To set the logic threshold" on page 144

Now you can disply the decoded signal and the frame table with results.

The display of the decoded data is described in ​"To configure decoding and data dis-
play" on page 145.

11.3.2.2 SPI/SSPI Configuration Settings

Access: PROTOCOL > "Bus type" = "SPI or SSPI" "Configuration"

Source.........................................................................................................................153
Chip Select, Clock, MOSI, MISO................................................................................153
Active..........................................................................................................................153
Slope...........................................................................................................................153
Time Out.....................................................................................................................154
First Bit........................................................................................................................154
Symbol Size................................................................................................................154
Find Level....................................................................................................................154
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Source
Toggles the lines of the SPI bus. Each line has to be configured. Select a line and adjust
the settings:

● Chip Select (SPI only): Select the input channel and the "Active" state.
● Time Out (SSPI only): Set the "Time Out" (instead if chip select).
● Clock: Select the input channel and the "Slope".
● MOSI, MISO: Select the input channel and the "Active" state for each data line.

Chip Select, Clock, MOSI, MISO
Select the input channels of the corresponding line. Make sure to select the "Source"
before you assign the channel. MISO is optional and can be set to "None".

Remote command: 
​BUS: ​SPI: ​CS:​SOURce​ on page 362
​BUS: ​SPI: ​CLOCk:​SOURce ​ on page 362
​BUS: ​SPI: ​DATA:​SOURce ​ on page 362
​BUS: ​SPI: ​MOSI:​SOURce ​ on page 362
​BUS: ​SPI: ​MISO:​SOURce ​ on page 363
​BUS: ​SSPI: ​CLOCk:​SOURce​ on page 369
​BUS: ​SSPI: ​DATA:​SOURce ​ on page 370
​BUS: ​SSPI: ​MOSI:​SOURce ​ on page 370
​BUS: ​SSPI: ​MISO:​SOURce ​ on page 370

Active
Selects whether transmitted data or the chip select signal is high active (high = 1) or low
active (low = 1).

For CS, the default is low active.

For data, the default is high active.

Remote command: 
​BUS: ​SPI: ​DATA:​POLarity ​ on page 363
​BUS: ​SPI: ​MOSI:​POLarity ​ on page 363
​BUS: ​SPI: ​MISO:​POLarity ​ on page 363
​BUS: ​SPI: ​CS:​POLarity ​ on page 362
​BUS: ​SSPI: ​DATA:​POLarity ​ on page 370
​BUS: ​SSPI: ​MOSI:​POLarity ​ on page 370
​BUS: ​SSPI: ​MISO:​POLarity ​ on page 370

Slope
Selects if data is stored with the rising or falling slope of the clock. The slope marks the
begin of a new bit.

Remote command: 
​BUS: ​SPI: ​CLOCk:​POLarity ​ on page 362
​BUS: ​SSPI: ​CLOCk:​POLarity ​ on page 369
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Time Out
Sets the minimum idle time between two data packets. If the time interval between the
data packets is shorter, the packets are part of the same frame. Within the time out, the
data and clock lines are low. A new frame begins when the time out has expired.

Time out is only relevant for SSPI that has no chip select.

Remote command: 
​BUS: ​SSPI: ​BITime​ on page 370

First Bit
Defines if the data of the messages starts with MSB (most significant bit) or LSB (least
significant bit).

Remote command: 
​BUS: ​SPI: ​BORDer​ on page 363
​BUS: ​SSPI: ​BORDer​ on page 371

Symbol Size
Sets the word length, the number of bits in a message.

Remote command: 
​BUS: ​SPI: ​SSIZe​ on page 363
​BUS: ​SSPI: ​SSIZe​ on page 371

Find Level
The instrument analyzes all channels that are configured for the selected bus and sets
the threshold for digitization of analog signals for each channel. If no level can be found,
the existing value remains unchanged, and you can set the thresholds manually in the
channel menu: CH N > "More" (page 2) > "Threshold".

See: ​"Threshold" on page 31

Remote command: 
​CHANnel<m>: ​THReshold: ​FINDlevel ​ on page 364

11.3.3 SPI/SSPI Trigger

● Triggering on SPI Buses.......................................................................................154
● SPI/SSPI Trigger Settings.....................................................................................155

11.3.3.1 Triggering on SPI Buses

Prerequisites: The SPI or SSPI bus is configured. After configuration, the trigger type
"Protocol (SPI)" or "Protocol (SSPI)" is available. See: ​chapter 11.3.2.1, "Configuring SPI
Buses", on page 151.

Triggers are only available if "Decode" is enabled.

1. Press the SETUP key in the trigger area of the front panel.
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2. Select the "Trigger Type": "Protocol (SPI)" or "Protocol (SSPI)"

3. Press "Setup".

4. Press the softkey of the required trigger condition:

● "Frame Start": begin of the message
● "Frame End": message end
● "Bit<x>": a specified bit inside the message
● "Ser. Pattern": a bit pattern in the message

5. If "Bit<x>" is selected, enter the bit number.

6. If "Ser. Pattern" is selected, press the softkey again and define the pattern:

a) Set the "Bit Offset", the number of bits before the pattern starts.
b) Set the "Number of Bits" contained in the pattern.
c) Enter the pattern, either as binary input, or as hexadecimal input:

● For binary input, press "Select Bit" and enter the bit number to be set. The
bits are counted from the message start, the selected bit is highlighted in the
pattern bit line. Then enter the "State" of this bit: 0, 1, or X (don't care).
Repeat these settings until all bit states are defined.

● For hexadecimal input, press "Select Nibble" and select the four bits (half
byte) to be set. The selected nibble is highlighted in the lower pattern line.
Then press "Value" and turn the navigation knob to change the bits.
Repeat these settings until all nibbles are defined.

11.3.3.2 SPI/SSPI Trigger Settings

The complete SPI/SSPI trigger is configured in the "Source" and "Setup" menus.

 

SPI/SSPI Bus (Option R&S RTM-K1)



Protocol AnalysisR&S®RTM

156User Manual 1305.0595.02 ─ 08

Triggers are only available if "Decode" is enabled.

● SPI/SSPI Trigger Source......................................................................................156
● SPI/SSPI Trigger Setup........................................................................................156

SPI/SSPI Trigger Source

Access: TRIGGER SETUP > "Trigger Type" = "Protocol (SPI or SSPI)" > "Source"

MOSI, MISO
Select one of the lines as trigger source.

Remote command: 
​TRIGger: ​A:​SOURce: ​SPI ​ on page 364

SPI/SSPI Trigger Setup

Access: TRIGGER SETUP > "Trigger Type" = "Protocol (SPI or SSPI)" > "Setup"

Frame Start.................................................................................................................156
Frame End..................................................................................................................157
Bit<x>..........................................................................................................................157
Ser. Pattern.................................................................................................................157

└ Bit Offset.......................................................................................................157
└ Number of Bits..............................................................................................157
└ Select Bit.......................................................................................................157
└ State..............................................................................................................157
└ Select Nibble.................................................................................................157
└ Value.............................................................................................................158

Frame Start
Sets the trigger to the start of the message. For SPI, the frame starts when the chip select
signal CS changes to the active state. For SSPI, the frame starts when the idle time has
expired.

Remote command: 
​TRIGger: ​A:​SPI: ​MODE ​ on page 364 (BSTart)
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Frame End
Sets the trigger to the end of the message. For SPI, the frame ends when the chip select
signal CS changes to the inactive state. For SSPI, the frame ends when the idle time has
expired after the last clock and no new clock appeared during that time.

Remote command: 
​TRIGger: ​A:​SPI: ​MODE ​ on page 364 (BEND)

Bit<x>
Sets the trigger to the specified bit number.

Remote command: 
​TRIGger: ​A:​SPI: ​MODE ​ on page 364 (NTHBit)

Ser. Pattern
Sets the trigger to a specified bit pattern that is configured in the submenu.

Remote command: 
​TRIGger: ​A:​SPI: ​MODE ​ on page 364 (PATTern)
​TRIGger: ​A:​SPI: ​PATTern ​ on page 365

Bit Offset ← Ser. Pattern
Sets the number of bits before the first bit of the pattern. These bits are ignored. The first
bit after CS is Bit 0.

For example, with bit offset = 2, Bit 0 and Bit 1 after CS are ignored, and the pattern starts
with Bit 2.

Remote command: 
​TRIGger: ​A:​SPI: ​POFFset ​ on page 365

Number of Bits ← Ser. Pattern
Defines the length of the serial pattern in bit.

Remote command: 
​TRIGger: ​A:​SPI: ​PLENgth ​ on page 365

Select Bit ← Ser. Pattern
Selects the bit number for binary pattern setting. For the selected bit, "State" is to be set.
The bits are counted from the message start, the selected bit is highlighted in the pattern
bit line.

State ← Ser. Pattern
Toggles the logic state of the selected bit: 0 (low), 1 (high), or X (don't care).

Select Nibble ← Ser. Pattern
Selects four bits (half byte) for hexadecimal entry with "Value". The selected nibble is
highlighted in the lower pattern line.
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Value ← Ser. Pattern
Sets the hexadecimal value for the selected nibble.

11.3.4 SPI/SSPI Decode Results

You can enable the decoding in the "Protocol" main menu. "Decode" shows the decoded
values below the waveforms in the format selected with "Display". Additionally, you can
display the binary signal with "Bits".

See also: ​chapter 11.1.2, "Reference for Protocol Decoding", on page 145

Fig. 11-2: Decoded SPI signal

C1 = Clock (Clk)
C2 = Data
C3 = Chip Select (Cs)
blue results = completely decoded words
grey brackets = start and end of complete frame
red results = Incomplete word that is not completely contained in the acquisition. Change the horizontal

scale, or move the"Time Reference" to get a longer acquisition.

Additionally, you can display and save a "Frame Table" containing decoded data: frame
number, start time of the frame, source (line), data and state of the frame.
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See also: ​chapter 11.1.4, "Frame Table: Decode Results", on page 148

Fig. 11-3: Decoded SSPI signal with frame table

Table 11-1: Content of the SPI/SSPI frame table

Column Description

Start time Time of the frame start in relation to the trigger point

Source MISO or MOSI line

Length Number of words in the frame

Data Hexadecimal values of the data words

State Overall state of the frame

Example: 
In the figure above, the first two frames have four words each, the following two frames
contain 6 words each. The fifth frame is incomplete.

SCPI commands:
● ​BUS: ​SPI: ​FCOunt? ​ on page 366

● ​BUS: ​SPI: ​FRAME<n>: ​STATus? ​ on page 366

● ​BUS: ​SPI: ​FRAME<n>: ​STARt?​ on page 366

● ​BUS: ​SPI: ​FRAME<n>: ​STOP? ​ on page 366

● ​BUS: ​SPI: ​FRAME<n>: ​DATA: ​MISO?​ on page 367
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● ​BUS: ​SPI: ​FRAME<n>: ​DATA: ​MOSI?​ on page 367

● ​BUS: ​SPI: ​FRAME<n>: ​WCOunt? ​ on page 367

● ​BUS: ​SPI: ​FRAME<n>: ​WORD<o>: ​STARt?​ on page 368

● ​BUS: ​SPI: ​FRAME<n>: ​WORD<o>: ​STOP?​ on page 368

● ​BUS: ​SPI: ​FRAME<n>: ​WORD<o>: ​MOSI?​ on page 368

● ​BUS: ​SPI: ​FRAME<n>: ​WORD<o>: ​MISO?​ on page 369

11.4 I²C (Option R&S RTM-K1)

The Inter-Integrated Circuit is a simple, lowbandwidth, low-speed protocol used for com-
munication between on-board devices, for example, in LCD and LED drivers, RAM,
EEPROM, and others.

11.4.1 The I²C Protocol

This chapter provides an overview of protocol characteristics, data format, address types
and trigger possibilities. For detailed information, read the "I2C-bus specification and user
manual" available on the NXP manuals web page at http://www.nxp.com/.

I²C characteristics

Main characteristics of I²C are:
● Two-wire design: serial clock (SCL) and serial data (SDA) lines
● Master-slave communication: the master generates the clock and addresses the

slaves. Slaves receive the address and the clock. Both master and slaves can trans-
mit and receive data.

● Addressing scheme: each slave device is addressable by a unique address. Multiple
slave devices can be linked together and can be addressed by the same master.

● Read/write bit: specifies if the master will read (=1) or write (=0) the data.
● Acknowledge: takes place after every byte. The receiver of the address or data sends

the acknowledge bit to the transmitter.

The R&S RTM supports all operating speed modes: high-speed, fast mode plus, fast
mode, and standard mode.

Data transfer

The format of a simple I²C message (frame) with 7 bit addressing consists of the following
parts:
● Start condition: a falling slope on SDA while SCL is high
● 7-bit address of the slave device that either will be written to or read from
● R/W bit: specifies if the data will be written to or read from the slave
● ACKnowledge bits: is issued by the receiver of the previous byte if the transfer was

successful
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Exception: At read access, the master terminates the data transmission with a NACK
bit after the last byte.

● Data: a number of data bytes with an ACK bit after every byte
● Stop condition: a rising slope on SDA while SCL is high

Fig. 11-4: I2C write access with 7-bit address

Address types: 7-bit and 10-bit

Slave addresses can be 7 or 10 bits long. A 7-bit address requires one byte, 7 bits for
the address followed by the R/W bit.

A 10-bit address for write access requires two bytes: the first byte starts with the reserved
sequence 11110, followed by the two MSB of the address and the write bit. The second
byte contains the remaining 8 LSB of the address. The slave acknowledges each address
byte.

Fig. 11-5: 10-bit address, write access

A 10-bit address for read access requires three bytes. The first two bytes are identical to
the write access address. The third byte repeats the address bits of the first byte and sets
the read bit.

Fig. 11-6: 10-bit address, read access

Trigger

The R&S RTM can trigger on various parts of I²C messages. The data and clock lines
must be connected to the input channels, triggering on math and reference waveforms
is not possible.

You can trigger on:
● Start or stop condition
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● Repeated start condition
● Transfer direction (read or write)
● Bytes with missing acknowledge bit
● Specific slave address
● Specific data pattern in the message

11.4.2 I²C Configuration

11.4.2.1 Configuring I²C

The configuration of the I²C is simple - only assign the two lines to input channels.

1. Press the PROTOCOL key on the front panel.

2. Press the "Bus Type" softkey and select "I2C".

3. Press "Configuration".

4. Press "Clock SCL" and select the channel connected to the clock line.

5. Press "Data SDA" and select the channel connected to the data line.

6. Press "Find level", or set the threshold manually for each channel.
See: ​"To set the logic threshold" on page 144

Now you can disply the decoded signal and the frame table with results.

The display of the decoded data is described in ​"To configure decoding and data dis-
play" on page 145.

11.4.2.2 I²C Configuration Settings

Clock SCL...................................................................................................................162
Data SDA....................................................................................................................162
Find Level....................................................................................................................163

Clock SCL
Sets the input channel to which the clock line is connected.

Remote command: 
​BUS: ​I2C: ​CLOCk:​SOURce ​ on page 371

Data SDA
Sets the input channel to which the data line is connected.

Remote command: 
​BUS: ​I2C: ​DATA:​SOURce ​ on page 372
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Find Level
The instrument analyzes all channels that are configured for the selected bus and sets
the threshold for digitization of analog signals for each channel. If no level can be found,
the existing value remains unchanged, and you can set the thresholds manually in the
channel menu: CH N > "More" (page 2) > "Threshold".

See: ​"Threshold" on page 31

Remote command: 
​CHANnel<m>: ​THReshold: ​FINDlevel ​ on page 364

11.4.3 I²C Trigger

● Triggering on I²C ..................................................................................................163
● I²C Trigger Settings...............................................................................................164

11.4.3.1 Triggering on I²C

Prerequisites: The I²C interface is configured. After configuration, the trigger type "Pro-
tocol (I2C)" is available. See: ​chapter 11.4.2.1, "Configuring I²C ", on page 162.

Triggers are only available if "Decode" is enabled.

1. Press the SETUP key in the trigger area of the front panel.

2. Select the "Trigger Type": "Protocol (I2C)".

3. Press "Setup".

4. Press the softkey of the required trigger condition:

● "Start": begin of the message
● "Stop": end of the message
● "Restart": repeated start condition
● "Acknowledge": transfer of a data byte is not acknowledged
● "Read/Write": complex trigger condition containing read or write access of the

master, slave address, or/and a bit pattern in the message

5. If "Read/Write" is selected, press the softkey again and define the condition:

a) Press "Master" and select read or write access of the master.
b) Configure the "Address" of the slave:

● Select the "Address Length", 7 bit or 10 bit.
● Press "Slave Address" and turn the navigation knob to set the address.

If the address is not relevant for your trigger condition, set it to "0xX" (any
address).

c) Press "Data Setup" to specify data bytes of the message, and/or to a serial pat-
tern.
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d) Set the "Byte Offset", the number of bytes to be ignored before the first byte of
interes.t

e) Set the "Number of Bytes" contained in the pattern.
f) Enter the pattern, either as binary input, or as hexadecimal input:

● For binary input, press "Bit" and enter the bit number to be set. The bits are
counted inside the selected bytes, the selected bit is highlighted in the pattern
bit line. Then enter the "State" of this bit: 0, 1, or X (don't care).
Repeat these settings until all bit states are defined.

● For hexadecimal input, press "Byte" and select the byte to be set. The
selected byte is highlighted in the lower pattern line. Then press "Value" and
turn the navigation knob to change the bits.
Repeat these settings until all bytes are defined.

If the data is not relevant for your trigger condition, set all data bytes to "0xXX".

11.4.3.2 I²C Trigger Settings

Triggers are only available if "Decode" is enabled.

Start.............................................................................................................................165
Stop.............................................................................................................................165
Restart.........................................................................................................................165
~Acknowledge.............................................................................................................165
Read/Write..................................................................................................................165

└ Master...........................................................................................................166
└ Symbolic ID...................................................................................................166
└ Address Length.............................................................................................166
└ Slave Address...............................................................................................166
└ Data Setup....................................................................................................166
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└ Byte Offset..........................................................................................166
└ Number of Bytes.................................................................................166
└ Bit........................................................................................................167
└ State...................................................................................................167
└ Byte.....................................................................................................167
└ Value...................................................................................................167

Start
Sets the trigger to the start of the message. The start condition is a falling slope on SDA
while SCL is high.

Remote command: 
​TRIGger: ​A:​I2C: ​PATTern ​ on page 374 (STARt)

Stop
Sets the trigger to the end of the message. The stop condition is a rising slope on SDA
while SCL is high.

Remote command: 
​TRIGger: ​A:​I2C: ​PATTern ​ on page 374 (STOP)

Restart
Sets the trigger to a repeated start - when the start condition occurs without previous stop
condition. This can happen when a master sends multiple messages without releasing
the bus.

Remote command: 
​TRIGger: ​A:​I2C: ​PATTern ​ on page 374 (RESTart)

~Acknowledge
Missing acknowledge: the instrument triggers if the slave does not send the acknowledge
bit. Acknowledging takes place after every byte. If the transfer failed, at the moment of
the acknowledge bit the SDA line is on high level during the high period of the clock pulse.

Remote command: 
​TRIGger: ​A:​I2C: ​PATTern ​ on page 374 (MACKnowledge)

Read/Write
Sets the trigger to a read or write access of the master, to an address, or/and to a bit
pattern in the message. The trigger condition is specified in the submenus. All submenu
settings together create the trigger condition. If you want to trigger on a specific param-
eter, make sure to set all other settings to "any".

If a label list with node names was loaded and applied in the bus configuration, you can
select simply the "Symbolic ID" from the list instead of entering the numeric identifier.

Remote command: 
​TRIGger: ​A:​I2C: ​PATTern ​ on page 374 (PATTern)
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Master ← Read/Write
Toggles the trigger condition between Read and Write access of the master. The R/W
bit is 8th bit of the first address byte of a frame. The selected condition is displayed in the
I2C Settings: "Trigger On".

Remote command: 
​TRIGger: ​A:​I2C: ​ACCess ​ on page 373

Symbolic ID ← Read/Write
If a label list with node names was loaded and applied in the bus configuration, you can
select simply the node name from the list instead of entering the numeric identifier.

The instrument trriggers on the identifier of the selected node.

Address Length ← Read/Write
Toggles the lenght of the slave address: 7 bit or 10 bit.

Remote command: 
​TRIGger: ​A:​I2C: ​AMODe ​ on page 373

Slave Address ← Read/Write
Sets the address of the slave device in hex. You can set a precise address, or trigger on
any address with "0xXX" (7Bit address) or "0xXXX" (10Bit address). X cannot be assigned
to a specified bit

Remote command: 
​TRIGger: ​A:​I2C: ​ADDRess ​ on page 373

Data Setup ← Read/Write
Opens a submenu to set the trigger on specified data bytes of the message, and/or to a
serial pattern.

Remote command: 
​TRIGger: ​A:​I2C: ​PATTern ​ on page 374

Byte Offset ← Data Setup ← Read/Write
Sets the number of bytes before the first byte of interest, relating to the end of the address
bytes. These offset bytes are ignored.

Remote command: 
​TRIGger: ​A:​I2C: ​POFFset ​ on page 375

Number of Bytes ← Data Setup ← Read/Write
Sets the number of bytes you want to trigger on. Maximum 3 bytes are possible.

Remote command: 
​TRIGger: ​A:​I2C: ​PLENgth ​ on page 374
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Bit ← Data Setup ← Read/Write
Selects the bit number inside the selected bytes for binary pattern input. For the selected
bit, "State" is to be set. the selected bit is highlighted in the "Data" bit line.

State ← Data Setup ← Read/Write
Toggles the logic state of the selected bit: 0 (low), 1 (high), or X (don't care).

Byte ← Data Setup ← Read/Write
Selects a byte for hex input with "Value". The selected byte is highlighted in the "Data"
hex line.

Value ← Data Setup ← Read/Write
Sets the hexadecimal value for the selected byte.

If the data is not relevant for your trigger condition, set all data bytes to "0xXX".

11.4.4 I2C Label List

Label lists are protocol-specific. An I2C PTT file contains three values for each address:
● "Type": address type, 7-bit or 10-bit long
● "ID / Addr": hexadecimal address value
● "Symbolic label": name of the address, specifiing its function in the bus network.

Example: I2C PTT file

# ---------------------------------------------------------------------------- 
@FILE_VERSION  = 1.00
@PROTOCOL_NAME = i2c
# ---------------------------------------------------------------------------
# Labels for I2C protocol
#   Column order: Identifier type, Identifier value, Label
# ---------------------------------------------------------------------------
7,0x1E,Voltage
7,0x38,Pressure
7,0x2A,Temperature
7,0x16,Speed
7,0x76,Acceleration
7,0x07,HighSpeed_Master_0x3
7,0x51,EEPROM
10,0x3A2,DeviceSetup
10,0x1A3,GatewayStatus
10,0x06E,LeftSensor
# ---------------------------------------------------------------------------- 

 

I²C (Option R&S RTM-K1)



Protocol AnalysisR&S®RTM

168User Manual 1305.0595.02 ─ 08

Fig. 11-7: Label list for I²C

For general information, see ​chapter 11.1.3, "Label List", on page 146.

11.4.5 I2C Decode Results

You can enable the decoding in the "Protocol" main menu. "Decode" shows the decoded
values below the waveforms in the format selected with "Display". Additionally, you can
display the binary signal with "Bits".

See also: ​chapter 11.1.2, "Reference for Protocol Decoding", on page 145

Additionally, you can display and save a "Frame Table" containing decoded data: frame
number, start time of the frame, access type. ID, data and state of the frame.

See also: ​chapter 11.1.4, "Frame Table: Decode Results", on page 148
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Fig. 11-8: Decoded and binary I2C signal, and frame table with decode results

gray brackets = start and end of the frame
violet = address
blue = correct data words
green = acknowledge bit, ok
red = missing acknowledge bit, or other error

Table 11-2: Content of the I2C frame table

Column Description

Start time Time of the frame start in relation to the trigger point

Type Value of the R/W bit, read or write access

ID Hexadecimal value of the address

Label Symbolic label, available if a label list was loaded and applied

Length Number of words in the frame

Data Hexadecimal values of the data words

State Overall state of the frame
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SCPI commands:
● ​BUS: ​I2C: ​FCOunt? ​ on page 375

● ​BUS: ​I2C: ​FRAMe<n>: ​DATA? ​ on page 375

● ​BUS: ​I2C: ​FRAMe<n>: ​STATus? ​ on page 376

● ​BUS: ​I2C: ​FRAMe<n>: ​STARt?​ on page 376

● ​BUS: ​I2C: ​FRAMe<n>: ​STOP? ​ on page 376

● ​BUS: ​I2C: ​FRAMe<n>: ​AACCess? ​ on page 378

● ​BUS: ​I2C: ​FRAMe<n>: ​ACCess? ​ on page 377

● ​BUS: ​I2C: ​FRAMe<n>: ​ACOMplete? ​ on page 377

● ​BUS: ​I2C: ​FRAMe<n>: ​ADBStart?​ on page 379

● ​BUS: ​I2C: ​FRAMe<n>: ​ADDRess? ​ on page 377

● ​BUS: ​I2C: ​FRAMe<n>: ​ADEVice? ​ on page 378

● ​BUS: ​I2C: ​FRAMe<n>: ​AMODe?​ on page 377

● ​BUS: ​I2C: ​FRAMe<n>: ​ASTart? ​ on page 378

● ​BUS: ​I2C: ​FRAMe<n>: ​BCOunt? ​ on page 379

● ​BUS: ​I2C: ​FRAMe<n>: ​BYTE<o>: ​ACCess? ​ on page 380

● ​BUS: ​I2C: ​FRAMe<n>: ​BYTE<o>: ​ACKStart?​ on page 380

● ​BUS: ​I2C: ​FRAMe<n>: ​BYTE<o>: ​COMPlete?​ on page 381

● ​BUS: ​I2C: ​FRAMe<n>: ​BYTE<o>: ​STARt?​ on page 380

● ​BUS: ​I2C: ​FRAMe<n>: ​BYTE<o>: ​VALue?​ on page 379

11.5 UART/RS-232 Interface (Option R&S RTM-K2)

11.5.1 The UART / RS232 Interface

The Universal Asynchronous Receiver/Transmitter UART converts a word of data into
serial data, and vice versa. It is the base of many serial protocols like of RS-232. The
UART uses only one line, or two lines for transmitter and receiver.

Data transfer

The data is transmitted in symbols, also referred to as words or characters. Each symbol
consists of a start bit, several data bits, an optional parity bit, and one or more stop bits.
Several symbols can form a frame, or package. The end of a frame is marked by a pause
between two symbols.

[Data8] [Parity] Stop[Data7][Data6][Data5]Data4Data3Data2Data1Data0Start

Fig. 11-9: Bit order in a UART word (symbol)
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● The start bit is a logic 0.
● The stop bits and the idle state are always logic 1.

The UART protocol has no clock for synchronization. The receiver synchronizes by
means of the start and stop bits, and the bit rate that must be known to the receiver.

Trigger

The R&S RTM can trigger on specified parts of UART serial signals:
● Start bit
● Frame start
● A specified symbol
● Parity errors, and breaks
● Frame errors
● A serial pattern at any or a specified position

11.5.2 UART/RS-232 Configuration

11.5.2.1 Configuring UART/RS-232 Interfaces

To configure the UART interface, you assign the channels to the RX an (optionally) TX
lines, set the active state for each line and set some protocol-specific parameters.

1. Press the PROTOCOL key on the front panel.

2. Press the "Bus Type" softkey and select "UART".

3. Press "Configuration".

4. Press "RX" and select the channel connected to the receiver line.

5. Press "TX" and select the channel connected to the transmitter line.

6. Set the "Active" state, "Parity" bit and the number of "Stop Bits".

7. Press "More".

8. Enter the "Symbol size".

9. Enter the bit rate:

● For a standard bit rate, select the "Defined Bit Rate".
● For a user-defined bit rate, press "User Bit Rate" and enter the value

10. Set the "Idle Time" between two frames.
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11. Press "Find level", or set the threshold manually for each channel.
See: ​"To set the logic threshold" on page 144

Now you can disply the decoded signal and the frame table with results.

The display of the decoded data is described in ​"To configure decoding and data dis-
play" on page 145.

11.5.2.2 UART Configuration Settings

Access: PROTOCOL > "Bus type" = "UART" "Configuration"

RX, TX.........................................................................................................................172
Active..........................................................................................................................173
Parity...........................................................................................................................173
Stop Bits......................................................................................................................173
Symbol Size................................................................................................................173
Bit Rate.......................................................................................................................173
Idle Time.....................................................................................................................173
Find Level....................................................................................................................174

RX, TX
Select the input channels of the RX and TX lines.

Remote command: 
​BUS: ​UART: ​DATA:​SOURce ​ on page 381
​BUS: ​UART: ​RX:​SOURce​ on page 381
​BUS: ​UART: ​TX:​SOURce​ on page 382
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Active
Defines the logic levels of the bus. The idle state corresponds to a logic 1, and the start
bit to a logic 0. Active-high (high=1) is used, for example, for control signals, while active-
low (low=1) is defined for data lines (RS-232).

Remote command: 
​BUS: ​UART: ​DATA:​POLarity ​ on page 382
​BUS: ​UART: ​POLarity​ on page 382

Parity
Defines the optional parity bit that is used for error detection.

"None" No parity bit is used.

"Even" The parity bit is set to "1" if the number of "1"s in a given set of bits is
odd (not including the parity bit).

"Odd" The parity bit is set to "1" if the number of "1"s in a given set of bits is
even (not including the parity bit).

Remote command: 
​BUS: ​UART: ​PARity​ on page 382

Stop Bits
Sets the number of stop bits: 1; 1.5 or 2 stop bits are possible.

Remote command: 
​BUS: ​UART: ​SBIT​ on page 383

Symbol Size
Sets the number of data bits in a word (symbol) in a range from 5 to 9 bits.

Remote command: 
​BUS: ​UART: ​SSIZe​ on page 382

Bit Rate
Sets the number of transmitted bits per second.

"Defined Bit
Rate"

Select a standard bit rate value from the list.

"User Bit Rate" Enter a user defined value.

Remote command: 
​BUS: ​UART: ​BAUDrate​ on page 383

Idle Time
Sets the minimal time between two frames – between the stop bit of the last word in a
frame and the start bit of the first word in the next frame.

Remote command: 
​BUS: ​UART: ​BITime​ on page 383
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Find Level
The instrument analyzes all channels that are configured for the selected bus and sets
the threshold for digitization of analog signals for each channel. If no level can be found,
the existing value remains unchanged, and you can set the thresholds manually in the
channel menu: CH N > "More" (page 2) > "Threshold".

See: ​"Threshold" on page 31

Remote command: 
​CHANnel<m>: ​THReshold: ​FINDlevel ​ on page 364

11.5.3 UART/RS-232 Trigger

● Triggering on UART/RS-232 Interfaces................................................................174
● UART Trigger Settings..........................................................................................175

11.5.3.1 Triggering on UART/RS-232 Interfaces

Prerequisites: The UART interface is configured. After configuration, the trigger type
"Protocol (UART)" is available. See: ​chapter 11.5.2.1, "Configuring UART/RS-232 Inter-
faces", on page 171.

Triggers are only available if "Decode" is enabled.

1. Press the SETUP key in the trigger area of the front panel.

2. Select the "Trigger Type": "Protocol (UART)".

3. Press "Source" and select RX or TX as trigger source.

4. Press "Back".

5. Press "Setup".

6. Press the softkey of the required trigger condition:

● "Start Bit", or "Frame Start": next start bit, or first start bit after idle time
● "Symbol<n>": frame number in a data stream
● "Any Symbol": pattern of the data bits anywhere in the data stream
● "Pattern": serial pattern of one, two or three symbols at a defined position in the

data stream
● "Parity Error"
● "Frame Errror"
● "Break"

7. If "Any Symbol" is selected, press the softkey again and define the symbol pattern,
either as binary input, or as hexadecimal input:

● For hex entry, select "Value" and turn the navigation knob to change the bits.
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● For binary input, press "Select Bit" and enter the data bit number to be set. Enter
the "State" of this bit: 0, 1, or X (don't care).
Repeat these settings until all bit states are defined.

8. If "Pattern" is selected, press the softkey again and define the pattern:

a) Set the "Symbol Offset", the number of symbols to be ignored before the pattern
starts.

b) Set the "Number of Symbols" contained in the pattern.
c) Enter the pattern, either as binary input, or as hexadecimal input:

● For hexadecimal input, press "Select Symbol" repeatedly to select the symbol
to be set. The selected symbol is highlighted in the hex pattern line. Then
press "Value" and turn the navigation knob to change the bits.
Repeat these settings until all symbols are defined.

● For binary input, press "Select Symbol" until the required symbol is marked
in the pattern hex line. Then press "Select Bit" and enter the data bit number
to be set. Enter the "State" of this bit: 0, 1, or X (don't care).
Repeat these settings until all bit states of all symbols are defined.

11.5.3.2 UART Trigger Settings

The complete UART trigger is configured in the "Source" and "Setup" menus.

Triggers are only available if "Decode" is enabled.

● UART Trigger Source............................................................................................176
● UART Trigger Setup..............................................................................................176
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UART Trigger Source

Access: TRIGGER SETUP > "Trigger Type" = "Protocol (UART)" > "Source"

RX, TX
Select one of the lines as trigger source.

Remote command: 
​TRIGger: ​A:​SOURce: ​UART ​ on page 384

UART Trigger Setup

Access: TRIGGER SETUP > "Trigger Type" = "Protocol (UART)" > "Setup"

Start Bit.......................................................................................................................176
Frame Start.................................................................................................................177
Symbol <n>.................................................................................................................177
Any Symbol.................................................................................................................177
Pattern.........................................................................................................................177

└ Symbol Offset...............................................................................................177
└ Number of Symb...........................................................................................177
└ Select Bit.......................................................................................................177
└ State..............................................................................................................177
└ Select Symbol...............................................................................................178
└ Value.............................................................................................................178

Parity Error..................................................................................................................178
Frame Error.................................................................................................................178
Break...........................................................................................................................178

Start Bit
Triggers on a start bit. The start bit is the first logical 0 after a stop bit.

Remote command: 
​TRIGger: ​A:​UART: ​MODE ​ on page 384 (SBIT)
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Frame Start
Triggers on the begin of a frame. The frame start is the first start bit after the idle time.

Remote command: 
​TRIGger: ​A:​UART: ​MODE ​ on page 384 (BSTart)

Symbol <n>
Sets the trigger to the specified symbol - the n-th word - in a frame (package).

Remote command: 
​TRIGger: ​A:​UART: ​MODE ​ on page 384 (NTHSymbol)

Any Symbol
Opens a submenu to trigger if a pattern occurs in a symbol at any position in a frame.

You can enter the pattern in binary or hex, the functions are the same as for "Pattern"
setting:
● ​"Select Bit" on page 177
● ​"State" on page 177
● ​"Value" on page 178

Remote command: 
​TRIGger: ​A:​UART: ​MODE ​ on page 384 (SYMBol)

Pattern
Opens a submenu to set the trigger on a serial pattern at a defined position in the frame.
The pattern can include several subsequent symbols.

Remote command: 
​TRIGger: ​A:​UART: ​MODE ​ on page 384 (PATTern)
​TRIGger: ​A:​UART: ​PATTern ​ on page 385

Symbol Offset ← Pattern
Sets the number of symbols to be ignored before the serial pattern.

Remote command: 
​TRIGger: ​A:​UART: ​POFFset ​ on page 385

Number of Symb. ← Pattern
Defines the length of the pattern - how many symbols build it up.

Remote command: 
​TRIGger: ​A:​UART: ​PLENgth ​ on page 385

Select Bit ← Pattern
Selects the bit number inside the selected symbol for binary pattern input.

State ← Pattern
Toggles the logic state of the selected bit: 0 (low), 1 (high), or X (don't care).
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Select Symbol ← Pattern
Selects the symbol for binary or hex input.

Value ← Pattern
Sets the hexadecimal value for the selected symbol by turning the navigation knob.

Parity Error
Triggers on a parity error indicating a transmission error.

Remote command: 
​TRIGger: ​A:​UART: ​MODE ​ on page 384 (PERRor)

Frame Error
Triggers on a frame error.

Remote command: 
​TRIGger: ​A:​UART: ​MODE ​ on page 384 (FERRor)

Break
Triggers if a start bit is not followed by a stop bit, the data line remains at logic 0 for longer
than a UART word.

Remote command: 
​TRIGger: ​A:​UART: ​MODE ​ on page 384 (BREak)

11.5.4 UART/RS-232 Decode Results

You can enable the decoding results in the "Protocol" main menu. "Decode" shows the
decoded values below the waveforms in the format selected with "Display". Additionally,
you can display the binary signal with "Bits".

See also: ​chapter 11.1.2, "Reference for Protocol Decoding", on page 145

Additionally, you can display and save a "Frame Table" containing decoded data: frame
number, start time of the frame, data and state of the frame.

See also: ​chapter 11.1.4, "Frame Table: Decode Results", on page 148
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Fig. 11-10: Decoded UART signal

C1 = Data source
blue results = completely decoded words
grey brackets = start and end of complete frames
green results = correct parity bits
red results = Errors or incomplete word that is not completely contained in the acquisition. Change the hor-

izontal scale, or move the"Time Reference" to get a longer acquisition.

Example: 
The figure above shows five frames of a UART signal with one source line.

Table 11-3: Content of the UART frame table

Column Description

Start time Time of the frame start in relation to the trigger point

Data Hexadecimal values of the data words

State Overall state of the frame

SCPI commands:
● ​BUS: ​UART: ​RX:​FCOunt? ​ on page 385
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● ​BUS: ​UART: ​TX:​FCOunt? ​ on page 385

● ​BUS: ​UART: ​RX:​FRAMe<n>: ​WCOunt? ​ on page 386

● ​BUS: ​UART: ​TX:​FRAMe<n>: ​WCOunt? ​ on page 386

● ​BUS: ​UART: ​RX:​FRAMe<n>: ​WORD<o>: ​STATe?​ on page 386

● ​BUS: ​UART: ​TX:​FRAMe<n>: ​WORD<o>: ​STATe?​ on page 386

● ​BUS: ​UART: ​RX:​FRAMe<n>: ​WORD<o>: ​STARt?​ on page 386

● ​BUS: ​UART: ​TX:​FRAMe<n>: ​WORD<o>: ​STARt?​ on page 386

● ​BUS: ​UART: ​RX:​FRAMe<n>: ​WORD<o>: ​STOP?​ on page 387

● ​BUS: ​UART: ​TX:​FRAMe<n>: ​WORD<o>: ​STOP?​ on page 387

● ​BUS: ​UART: ​RX:​FRAMe<n>: ​WORD<o>: ​VALue?​ on page 387

● ​BUS: ​UART: ​TX:​FRAMe<n>: ​WORD<o>: ​VALue?​ on page 387

11.6 CAN (Option R&S RTM-K3)

11.6.1 CAN Configuration

Access: PROTOCOL > "Bus type" = "CAN" > "Configuration"

Data.............................................................................................................................180
Type............................................................................................................................180
Sample point...............................................................................................................181
Bit rate.........................................................................................................................181
Find Level....................................................................................................................181

Data
Sets the source of the data line. All channel waveforms can be used.

Remote command: 
​BUS: ​CAN: ​DATA:​SOURce ​ on page 388

Type
Selects the CAN-High or CAN-Low line. CAN uses both lines for differential signal trans-
mission.

If you measure with a differential probe, connect the probe to both CAN-H and CAN-L
lines, and select the data "Type" "CAN-H".
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If you use a single-ended probe, connect the probe to either CAN_L or CAN_H, and select
the data type accordingly.

Remote command: 
​BUS: ​CAN: ​TYPE ​ on page 388

Sample point
Sets the position of the sample point within the bit in percent of the nominal bit time. The
sample point divides the nominal bit period into two distinct time segments, which are
used for resynchronization of the clock.

The CAN bus interface uses an asynchronous transmission scheme. The standard
specifies a set of rules to resynchronize the local clock of a CAN node to the message.

Remote command: 
​BUS: ​CAN: ​SAMPlepoint ​ on page 388

Bit rate
Sets the number of transmitted bits per second. The maximum bit rate for High Speed
CAN is 1 Mbit/s. The bit rate is uniform and fixed for a given CAN bus.

To select a bit rate from the list of predefined values, set "Bit rate" to "Defined Bit Rate",
and then select the value with "Predefined".

To set another value, set "Bit rate" to "User Bit Rate", and then enter the value with
"User".

Remote command: 
​BUS: ​CAN: ​BITRate ​ on page 388

Find Level
The instrument analyzes all channels that are configured for the selected bus and sets
the threshold for digitization of analog signals for each channel. If no level can be found,
the existing value remains unchanged, and you can set the thresholds manually in the
channel menu: CH N > "More" (page 2) > "Threshold".

See: ​"Threshold" on page 31

Remote command: 
​CHANnel<m>: ​THReshold: ​FINDlevel ​ on page 364

11.6.2 CAN Trigger Settings

Access: SETUP (Trigger) > "Trigger type" = "Protocol (CAN)" > "Setup"
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Start of frame..............................................................................................................182
End of frame................................................................................................................182
Frame <type>..............................................................................................................182

└ Error..............................................................................................................183
└ Overload.......................................................................................................183
└ Data..............................................................................................................183
└ Remote.........................................................................................................183
└ Data or remote..............................................................................................183

Error <type>................................................................................................................183
└ Stuff bit..........................................................................................................183
└ Form..............................................................................................................183
└ Acknowledge.................................................................................................183
└ CRC..............................................................................................................184

Identifier......................................................................................................................184
└ Frame type....................................................................................................184
└ Symbolic ID...................................................................................................184
└ Identifier Setup..............................................................................................184

└ ID type................................................................................................185
└ Compare.............................................................................................185
└ Bit........................................................................................................185
└ State...................................................................................................185
└ Byte.....................................................................................................185
└ Value...................................................................................................185

Identifier and data.......................................................................................................185
└ Data Setup....................................................................................................185

└ Data Length........................................................................................186

Start of frame
Triggers on the first edge of the dominant SOF bit (synchronization bit).

Remote command: 
​TRIGger: ​A:​CAN: ​TYPE ​ on page 389 (STOFrame)

End of frame
Triggers on the end of the frame (7 recessive bits).

Remote command: 
​TRIGger: ​A:​CAN: ​TYPE ​ on page 389 (EOFrame)

Frame <type>
Selects the frame type to be triggered on. The selected frame type is indicated in the
softkey name.

Remote command: 
​TRIGger: ​A:​CAN: ​TYPE ​ on page 389 (FTYPe)
​TRIGger: ​A:​CAN: ​FTYPe ​ on page 389
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Error ← Frame <type>
An error frame is sent by a node that has detected an error.

Overload ← Frame <type>
An overload frame is sent by a node that needs a delay between data and/or remote
frames.

Data ← Frame <type>
Frame for data transmission.

The identifier format is also considered, see ​"ID type" on page 185.

Remote ← Frame <type>
Data: Frame for data transmission.

A remote frame initiates the transmission of data by another node. The frame format is
the same as of data frames but without the data field.

The identifier format is also considered, see ​"ID type" on page 185.

Data or remote ← Frame <type>
Triggers on remote frames and on data frames.

The identifier format is also considered, see ​"ID type" on page 185.

Error <type>
Identifies various errors in the frame. You can select one or more error types as trigger
condition.

The first key press enables the "Error" trigger type, the second opens the "Error" menu.

Remote command: 
​TRIGger: ​A:​CAN: ​TYPE ​ on page 389 (ERRCondition)

Stuff bit ← Error <type>
The frame segments Start Of Frame, Arbitration Field, Control Field, Data Field and CRC
Sequence are coded by the bit stuffing method. The transmitter automatically inserts a
complementary bit into the bit stream when it detects five consecutive bits of identical
value in the bit stream to be transmitted. A stuff error occurs when the 6th consecutive
equal bit level in the mentioned fields is detected.

Remote command: 
​TRIGger: ​A:​CAN: ​BITSterror ​ on page 391

Form ← Error <type>
A form error occurs when a fixed-form bit field contains one or more illegal bits.

Remote command: 
​TRIGger: ​A:​CAN: ​FORMerror ​ on page 392

Acknowledge ← Error <type>
An acknowledgement error occurs when the transmitter does not receive an acknowl-
edgment - a dominant bit during the Ack Slot.

Remote command: 
​TRIGger: ​A:​CAN: ​ACKerror ​ on page 391
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CRC ← Error <type>
CAN uses the Cyclic Redundancy Check, which is a complex checksum calculation
method. The transmitter calculates the CRC and sends the result in the CRC sequence.
The receiver calculates the CRC in the same way. A CRC error occurs when the calcu-
lated result differs from the received value in the CRC sequence.

Remote command: 
​TRIGger: ​A:​CAN: ​CRCerror ​ on page 391

Identifier
Sets the trigger to a specific message identifier or an identifier range.

The first key press enables the "Identifier" trigger type, the second one opens the "Iden-
tifier" menu.

If a label list with node names was loaded and applied in the bus configuration, you can
select simply the "Symbolic ID" from the list instead of entering the numeric identifier.

Remote command: 
​TRIGger: ​A:​CAN: ​TYPE ​ on page 389 (ID | IDDT)

Frame type ← Identifier
Data frames and remote frames contain an identifier. Select the frame type to be triggered
on, or select "Data and remote" if the frame type is not relevant.

Remote command: 
​TRIGger: ​A:​CAN: ​FTYPe ​ on page 389

Symbolic ID ← Identifier
If a label list with node names was loaded and applied in the bus configuration, you can
select simply the node name from the list instead of entering the numeric identifier.

The instrument trriggers on the identifier of the selected node.

Identifier Setup ← Identifier
Opens the menu to set the identifier pattern. After setting the "ID type" and the "Com-
pare" condition, you can enter the value bit-by-bit by setting the state high, low, or don't
care for each single bit. Alternatively, you can enter a hexadecimal value for each byte.

Remote command: 
​TRIGger: ​A:​CAN: ​IDENtifier ​ on page 390
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ID type ← Identifier Setup ← Identifier
Selects the length of the identifier: 11 bit for CAN base frames, or 29 bits for CAN exten-
ded frames.

Remote command: 
​TRIGger: ​A:​CAN: ​ITYPe ​ on page 390

Compare ← Identifier Setup ← Identifier
Sets the comparison condition: If the pattern contains at least one X (don't care), you can
trigger on values equal or not equal to the specified value. If the pattern contains only 0
and 1, you can also trigger on a range greater than or lower than the specified value.

Remote command: 
​TRIGger: ​A:​CAN: ​ICONdition ​ on page 390

Bit ← Identifier Setup ← Identifier
Selects the number of the bit in the pattern for bit-by-bit input. For each selected bit, enter
the "State".

State ← Identifier Setup ← Identifier
Toggles the logic state of the selected bit: 0 (low), 1 (high), or X (don't care).

Byte ← Identifier Setup ← Identifier
Selects the byte for input of the pattern. For each selected byte, enter the hexadecimal
value, or set the "State" for each selected "Bit".

Value ← Identifier Setup ← Identifier
Sets the hexadecimal value for the selected byte by turning the navigation knob.

Identifier and data
Sets the trigger to a combination of identifier and data condition. The instrument triggers
at the end of the last byte of the specified data pattern.

The identifier conditions are the same as for the "Identifier" trigger type, see ​"Identifier"
on page 184.

The first key press enables the trigger type, the second one opens the "Identifier and
data" menu.

Remote command: 
​TRIGger: ​A:​CAN: ​TYPE ​ on page 389 (IDDT)

Data Setup ← Identifier and data
Opens a menu to set the data pattern to be triggered on. After setting the "Data length"
and the "Compare" condition, you can enter the value bit-by-bit by setting the state high,
low, or don't care for each single bit. Alternatively, you can enter a hexadecimal value for
each byte.
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Most settings are the same as for identifier input. See:
● ​"Compare" on page 185
● ​"Bit" on page 185
● ​"State" on page 185
● ​"Byte" on page 185
● ​"Value" on page 185

Remote command: 
​TRIGger: ​A:​CAN: ​DCONdition ​ on page 391
​TRIGger: ​A:​CAN: ​DATA ​ on page 391

Data Length ← Data Setup ← Identifier and data
Defines the length of the data pattern - the number of bytes in the pattern.

Remote command: 
​TRIGger: ​A:​CAN: ​DLC​ on page 390

11.6.3 CAN Label List

Label lists are protocol-specific. A PTT file for CAN contains three values for each iden-
tifier:
● "Type": identifier type, 11-bit or 29-bit long
● "ID / Addr": hexadecimal identifier value
● "Symbolic label": symbolic name of the identifier, specifiing its function in the bus

network.

Example: CAN PTT file

# ---------------------------------------------------------------------------- 
@FILE_VERSION  = 1.00
@PROTOCOL_NAME = can
# ---------------------------------------------------------------------------
# Labels for CAN protocol
#   Column order: Identifier type, Identifier value, Label
# ---------------------------------------------------------------------------
11,0x064,Diag_Response
11,0x1E5,EngineData
11,0x0A2,Ignition_Info
11,0x1BC,TP_Console
11,0x333,ABSdata
11,0x313,Door_Left
11,0x314,Door_Right
29,0x01A54321,Throttle
29,0x13A00FA2,LightState
29,0x0630ABCD,Engine_Status
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29,0x03B1C002,Airbag_Status
29,0x01234ABC,NM_Gateway
# ---------------------------------------------------------------------------- 

Fig. 11-11: Label list for CAN

For general information, see ​chapter 11.1.3, "Label List", on page 146.

11.6.4 CAN Decode Results

You can enable the decoding in the "Protocol" main menu. "Decode" shows the decoded
values below the waveforms in the format selected with "Display". Additionally, you can
display the binary signal with "Bits".

See also: ​chapter 11.1.2, "Reference for Protocol Decoding", on page 145

Additionally, you can display and save a "Frame Table" containing decoded data: frame
number, start time of the frame, frame type, identifier, data length code, data, checksum,
and state of the frame.

See also: ​chapter 11.1.4, "Frame Table: Decode Results", on page 148
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Fig. 11-12: Decoded CAN signal with frame table and applied label list

violet = identifier
gray = DLC, data length code
blue = data words
red = error occured, error frame

Table 11-4: Content of the CAN frame table

Column Description

Start time Time of frame start in relation to the trigger point

Type Frame type: Data, Remote, Error, or Overload

ID Identifier value, hexadecimal value

Label Symbolic label, available if a label list was loaded and applied

DLC Data length code, number of data bytes

Data Hexadecimal values of the data bytes

CRC Hexadecimal value of the Cyclic Redundance Check (checksum)

State Overall state of the frame.
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SCPI commands:
● ​BUS: ​CAN: ​FCOunt? ​ on page 392

● ​BUS: ​CAN: ​FRAMe<n>: ​DATA? ​ on page 394

● ​BUS: ​CAN: ​FRAMe<n>: ​STATus? ​ on page 393

● ​BUS: ​CAN: ​FRAMe<n>: ​STARt?​ on page 393

● ​BUS: ​CAN: ​FRAMe<n>: ​STOP? ​ on page 393

● ​BUS: ​CAN: ​FRAMe<n>: ​TYPE? ​ on page 392

● ​BUS: ​CAN: ​FRAMe<n>: ​IDTYpe? ​ on page 396

● ​BUS: ​CAN: ​FRAMe<n>: ​IDSTate? ​ on page 396

● ​BUS: ​CAN: ​FRAMe<n>: ​IDValue? ​ on page 396

● ​BUS: ​CAN: ​FRAMe<n>: ​ACKState?​ on page 394

● ​BUS: ​CAN: ​FRAMe<n>: ​ACKValue?​ on page 394

● ​BUS: ​CAN: ​FRAMe<n>: ​CSSTate? ​ on page 395

● ​BUS: ​CAN: ​FRAMe<n>: ​CSValue? ​ on page 395

● ​BUS: ​CAN: ​FRAMe<n>: ​DLCState?​ on page 395

● ​BUS: ​CAN: ​FRAMe<n>: ​DLCValue?​ on page 395

● ​BUS: ​CAN: ​FRAMe<n>: ​BSEPosition? ​ on page 396

● ​BUS: ​CAN: ​FRAMe<n>: ​BCOunt? ​ on page 397

● ​BUS: ​CAN: ​FRAMe<n>: ​BYTE<o>: ​STATe?​ on page 397

● ​BUS: ​CAN: ​FRAMe<n>: ​BYTE<o>: ​VALue?​ on page 397

11.6.5 Search on Decoded CAN Data

Using the search functionality, you can find various events in the decoded data, the same
events which you also can trigger on. Before you can start the search, you have to con-
figure the bus correctly and acquire decoded data.

To search on decoded data, use the search type "Protocol". The source is automatically
set to the configured protocol.

See also: ​chapter 10, "Search", on page 128.

11.6.5.1 CAN Search Setup
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Event
Sets the event or combination of events to be searched for. Depending on the selected
event, the appropriate settings in the softkey menu are activated.

Remote command: 
​SEARch: ​PROTocol: ​CAN: ​CONDition​ on page 398

Frame Setup
Selects the frame type to be searched for.

If you search for remote or data frames, the search consideres also the ID type, the length
of the identifier.

The setting is only available if "Event" = "Frame" is selected.

Remote command: 
​SEARch: ​PROTocol: ​CAN: ​FRAMe​ on page 398

Error Setup
Selects the error type to be searched for. You can select one or more error types as
search condition.

The error types are the same as in the CAN trigger setup, see ​"Error <type>"
on page 183.

The setting is only available if "Event" = "Error" or "ID & Error" is selected.

Remote command: 
​SEARch: ​PROTocol: ​CAN: ​ACKerror ​ on page 399
​SEARch: ​PROTocol: ​CAN: ​BITSterror ​ on page 399
​SEARch: ​PROTocol: ​CAN: ​CRCerror ​ on page 399
​SEARch: ​PROTocol: ​CAN: ​FORMerror​ on page 400

Symbolic ID
If a label list with node names was loaded and applied in the bus configuration, you can
select simply the node name from the list instead of entering the numeric identifier.

The instrument trriggers on the identifier of the selected node.

Frame type
Selects the frame type to be searched for, if "Event" = "Identifier" is selected. You can
search for data and or remote frames.

Remote command: 
​SEARch: ​PROTocol: ​CAN: ​FTYPe​ on page 400

Identifier Setup
Opens the menu to set the identifier pattern, if "Event" = "Identifier" or "ID & Data" or "ID
& Error" is selected.

After setting the "ID type" and the "Comparison" condition, you can enter the value bit-
by-bit by setting the state high, low, or don't care for each single bit. Alternatively, you
can enter a hexadecimal value for each byte.
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The settings are the same as for the setup of the identifier trigger, see ​"Identifier
Setup" on page 184.

Remote command: 
​SEARch: ​PROTocol: ​CAN: ​ITYPe​ on page 400
​SEARch: ​PROTocol: ​CAN: ​ICONdition ​ on page 400
​SEARch: ​PROTocol: ​CAN: ​IDENtifier ​ on page 400

Data Setup
Opens the menu to set the data pattern to be searched, if "Event" = "ID & Data" is
selected.

After setting the "Data length" and the "Comparison" condition, you can enter the value
bit-by-bit by setting the state high, low, or don't care for each single bit. Alternatively, you
can enter a hexadecimal value for each byte.

The settings are the same as for the setup of the data trigger, see ​"Data Setup"
on page 185.

Remote command: 
​SEARch: ​PROTocol: ​CAN: ​DLENgth ​ on page 401
​SEARch: ​PROTocol: ​CAN: ​DCONdition ​ on page 401
​SEARch: ​PROTocol: ​CAN: ​DATA ​ on page 401

11.6.5.2 CAN Search Results

Search results (events) are marked on the waveform and listed in the event table as usual.
Instead of the event table, you can display the frame table, where the search results are
also marked. The event flags are not saved in the csv file of the frame table.
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Fig. 11-13: Search for data frames with 11 bit identifier, search results are marked in frame table and
on the decoded data

11.7 LIN (Option R&S RTM-K3)

11.7.1 The LIN Protocol

This chapter provides an overview of protocol characteristics, frame format, identifiers
and trigger possibilities. For detailed information, order the LIN specification on http://
www.lin-subbus.org/ (free of charge).

LIN characteristics

Main characteristics of LIN are:
● Single-wire serial communications protocol, based on the UART byte-word interface
● Single master, multiple slaves - usually up to 12 nodes
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● Master-controlled communication: master coordinates communication with the LIN
schedule and sends identifier to the slaves

● Synchronization mechanism for clock recovery by slave nodes without crystal or
ceramics resonator

The R&S RTM supports several versions of the LIN standard: v1.3, v2.0, v2.1 and the
american SAE J2602.

Data transfer

Basic communication concept of LIN:
● Communication in an active LIN network is always initiated by the master.
● Master sends a message header including the synchronization break, the synchro-

nization byte, and the message identifier.
● The identified node sends the message response: one to eight data bytes and one

checksum byte.
● Header and response form the message frame.

The data is transmitted in bytes using the UART byte-word interface without the parity
bit. Each byte consists of a start bit, 8 bits and a stop bit.

Fig. 11-14: Structure of a byte field

Data bytes are transmitted LSB first.

The identifier byte consists of 6 bits for the frame identifier and two parity bits. This com-
bination is known as protected identifier.

Trigger

The R&S RTM can trigger on various parts of LIN frames. The data line must be con-
nected to an input channel, triggering on math and reference waveforms is not possible.

You can trigger on:
● Frame start (synchronization field)
● Specific slave identifier or identifier range
● Data pattern in the message
● Wake up signal
● Checksum error (error in data), parity error (error in identifier)

11.7.2 LIN Configuration Settings

Access: PROTOCOL > "Bus type" = "LIN" "Configuration"
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Data.............................................................................................................................194
Polarity........................................................................................................................194
Version........................................................................................................................194
Bit rate.........................................................................................................................194
Find Level....................................................................................................................194

Data
Sets the source of the data line. All channel waveforms can be used.

Remote command: 
​BUS: ​LIN: ​DATA:​SOURce ​ on page 402

Polarity
Defines the idle state of the bus. The idle state is the rezessive state and corresponds to
a logic 1.

Remote command: 
​BUS: ​LIN: ​POLarity ​ on page 402

Version
Selects the version of the LIN standard that is used in the DUT. The setting mainly defines
the checksum version used during decoding.

The most common version is LIN 2.x. For mixed networks, or if the standard is unknown,
set the LIN standard to "Auto".

Remote command: 
​BUS: ​LIN: ​STANdard ​ on page 402

Bit rate
Sets the number of transmitted bits per second. The maximum bit rate is 20 kbit/s.

To select a bit rate from the list of predefined values, set "Bit rate" to "Defined Bit Rate",
and then select the value with "Predefined".

To set another value, set "Bit rate" to "User Bit Rate", and then enter the value with
"User".

Remote command: 
​BUS: ​LIN: ​BITRate ​ on page 402

Find Level
The instrument analyzes all channels that are configured for the selected bus and sets
the threshold for digitization of analog signals for each channel. If no level can be found,
the existing value remains unchanged, and you can set the thresholds manually in the
channel menu: CH N > "More" (page 2) > "Threshold".

See: ​"Threshold" on page 31

Remote command: 
​CHANnel<m>: ​THReshold: ​FINDlevel ​ on page 364
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11.7.3 LIN Trigger Settings

Access: SETUP (Trigger) > "Trigger type" = "Protocol (LIN)" "Setup"

Start of Frame.............................................................................................................195
Wake Up.....................................................................................................................195
Error <type>................................................................................................................195

└ Checksum.....................................................................................................196
└ Parity.............................................................................................................196
└ Synchronization............................................................................................196

Identifier......................................................................................................................196
└ Symbolic ID...................................................................................................196
└ Compare.......................................................................................................196
└ Bit..................................................................................................................197
└ State..............................................................................................................197
└ Byte...............................................................................................................197
└ Value.............................................................................................................197

Identifier and data.......................................................................................................197
└ Identifier Setup..............................................................................................197
└ Data Setup....................................................................................................197

└ No. of Bytes........................................................................................198

Start of Frame
Triggers on the stop bit of the sync field.

Remote command: 
​TRIGger: ​A:​LIN: ​TYPE ​ on page 403 (SYNC)

Wake Up
Triggers after a wakeup frame.

Remote command: 
​TRIGger: ​A:​LIN: ​TYPE ​ on page 403 (WKFRame)

Error <type>
Identifies various errors in the frame. You can select one or more error types as trigger
condition.

The first key press enables the "Error" trigger type, the second opens the "Error" menu.

Remote command: 
​TRIGger: ​A:​LIN: ​TYPE ​ on page 403 (ERRCondition)
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Checksum ← Error <type>
Triggers on a checksum error. The checksum verifies the correct data transmission. It is
the last byte of the frame response. The checksum includes not only the data but also
the protected identifier (PID).

Remote command: 
​TRIGger: ​A:​LIN: ​CHKSerror ​ on page 404

Parity ← Error <type>
Triggers on a parity error. Parity bits are the bits 6 and 7 of the identifier. They verify the
correct transmission of the identifier.

Remote command: 
​TRIGger: ​A:​LIN: ​IPERror ​ on page 404

Synchronization ← Error <type>
Triggers if synchronization caused an error.

Remote command: 
​TRIGger: ​A:​LIN: ​SYERror ​ on page 404

Identifier
Sets the trigger to a specific identifier or an identifier range. Only the 6 bit identifier without
parity bits is considered, not the protected identifier.

The first key press enables the "Identifier" trigger type, the second opens the "Identi-
fier" menu.

After setting the "Compare" condition, you can enter the value bit-by-bit by setting the
state high, low, or don't care for each single bit. Alternatively, you can enter a hexadecimal
value for each byte.

If a label list with node names was loaded and applied in the bus configuration, you can
select simply the "Symbolic ID" from the list instead of entering the numeric identifier.

Remote command: 
​TRIGger: ​A:​LIN: ​TYPE ​ on page 403 (ID | IDDT)
​TRIGger: ​A:​LIN: ​ICONdition ​ on page 404
​TRIGger: ​A:​LIN: ​IDENtifier ​ on page 404

Symbolic ID ← Identifier
If a label list with node names was loaded and applied in the bus configuration, you can
select simply the node name from the list instead of entering the numeric identifier.

The instrument trriggers on the identifier of the selected node.

Compare ← Identifier
Sets the comparison condition: If the pattern contains at least one X (don't care), you can
trigger on values equal or not equal to the specified value. If the pattern contains only 0
and 1, you can also trigger on a range greater than or lower than the specified value.
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Bit ← Identifier
Selects the number of the bit in the pattern for bit-by-bit input. For each selected bit, enter
the "State".

State ← Identifier
Toggles the logic state of the selected bit: 0 (low), 1 (high), or X (don't care).

Byte ← Identifier
Selects the byte for input of the data pattern. For each selected byte, enter the hexadec-
imal value, or set the "State" for each selected "Bit".

For the identifier pattern, byte selection is not relevant, as only the 6 bit identifier without
parity bits is considered.

Value ← Identifier
Sets the hexadecimal value for the selected byte by turning the navigation knob.

Identifier and data
Sets the trigger to a combination of identifier and data condition. The instrument triggers
at the end of the last byte of the specified data pattern.

The first key press enables the trigger type, the second one opens the "Identifier and
data" menu.

Identifier Setup ← Identifier and data
Opens the "Identifier" menu.

The identifier conditions are the same as for the "Identifier" trigger type, see ​"Identifier"
on page 196.

Data Setup ← Identifier and data
Opens a menu to set the data pattern. After setting the "No. of Bytes" and the "Com-
pare" condition, you can enter the value bit-by-bit by setting the state high, low, or don't
care for each single bit. Alternatively, you can enter a hexadecimal value for each byte.

The method is the same as for identifier input. See:
● ​"Compare" on page 196
● ​"Bit" on page 197
● ​"State" on page 197
● ​"Byte" on page 197
● ​"Value" on page 197

Remote command: 
​TRIGger: ​A:​LIN: ​TYPE ​ on page 403 (IDDT)
​TRIGger: ​A:​LIN: ​DCONdition ​ on page 405
​TRIGger: ​A:​LIN: ​DATA ​ on page 405
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No. of Bytes ← Data Setup ← Identifier and data
Defines the length of the data pattern - the number of bytes in the pattern.

Remote command: 
​TRIGger: ​A:​LIN: ​DLENgth ​ on page 405

11.7.4 LIN Label List

Label lists are protocol-specific. A LIN PTT file contains two values for each identifier:
● "ID / Addr": hexadecimal identifier value
● "Symbolic label": symbolic name for the identifier

Example: LIN PTT file

# ---------------------------------------------------------------------------- 

@FILE_VERSION = 1.0
@PROTOCOL_NAME = lin 
# ---------------------------------------------------------------------------- 
# Labels for LIN protocol
#   Column order: Identifier, Label
# ---------------------------------------------------------------------------- 
# Labels for standard addresses
0x06,Dashboard
0x13,Gateway
0x1C,Temperature
0x21,Mirror
0x37,Indoor lights
# Labels for reserved addresses
0x3C,Master_Request_Frame
0x3D,Slave_Response_Frame
# ---------------------------------------------------------------------------- 

Fig. 11-15: Label list for CAN

For general information, see ​chapter 11.1.3, "Label List", on page 146.
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11.7.5 LIN Decode Results

You can enable the decoding in the "Protocol" main menu. "Decode" shows the decoded
values below the waveforms in the format selected with "Display". Additionally, you can
display the binary signal with "Bits".

See also: ​chapter 11.1.2, "Reference for Protocol Decoding", on page 145

Additionally, you can display and save a "Frame Table" containing decoded data: frame
number, start time of the frame, identifier, data length, data, checksum, and state of the
frame.

See also: ​chapter 11.1.4, "Frame Table: Decode Results", on page 148

Fig. 11-16: Decoded LIN signal with frame table and applied label list

gray = synchronization break, synchronization byte, correct checksum
yellow = identifier
green = parity bits
blue = data words (UART words)
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Table 11-5: Content of the LIN frame table

Column Description

Start time Time of frame start in relation to the trigger point

ID Identifier value, hexadecimal value

Label Symbolic label, available if a label list was loaded and applied

Length Number of data bytes

Data Hexadecimal values of the data bytes

Chks Checksum value

State Overall state of the frame.

SCPI commands:
● ​BUS: ​LIN: ​FCOunt? ​ on page 406

● ​BUS: ​LIN: ​FRAMe<n>: ​DATA? ​ on page 406

● ​BUS: ​LIN: ​FRAMe<n>: ​STARt?​ on page 407

● ​BUS: ​LIN: ​FRAMe<n>: ​STOP? ​ on page 408

● ​BUS: ​LIN: ​FRAMe<n>: ​VERSion? ​ on page 409

● ​BUS: ​LIN: ​FRAMe<n>: ​CSSTate? ​ on page 406

● ​BUS: ​LIN: ​FRAMe<n>: ​CSValue? ​ on page 406

● ​BUS: ​LIN: ​FRAMe<n>: ​IDSTate? ​ on page 407

● ​BUS: ​LIN: ​FRAMe<n>: ​IDValue? ​ on page 407

● ​BUS: ​LIN: ​FRAMe<n>: ​IDPValue?​ on page 407

● ​BUS: ​LIN: ​FRAMe<n>: ​SYSTate? ​ on page 408

● ​BUS: ​LIN: ​FRAMe<n>: ​SYValue? ​ on page 408

● ​BUS: ​LIN: ​FRAMe<n>: ​BCOunt? ​ on page 409

● ​BUS: ​LIN: ​FRAMe<n>: ​BYTE<o>: ​STATe?​ on page 409

● ​BUS: ​LIN: ​FRAMe<n>: ​BYTE<o>: ​VALue?​ on page 409

11.7.6 Search on Decoded LIN Data

Using the search functionality, you can find various events in the decoded data, the same
events which you also can trigger on. Before you can start the search, you have to con-
figure the bus correctly and acquire decoded data.

To search on decoded data, use the search type "Protocol". The source is automatically
set to the configured protocol.

See also: ​chapter 10, "Search", on page 128.
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11.7.6.1 LIN Search Setup

Event
Sets the event or combination of events to be searched for. Depending on the selected
event, the appropriate settings in the softkey menu are activated.

Remote command: 
​SEARch: ​PROTocol: ​LIN: ​CONDition​ on page 410

Frame Setup
Selects the frame type to be searched for: Start of frame or wakeup frame.

The setting is only available if "Event" = "Frame" is selected.

Remote command: 
​SEARch: ​PROTocol: ​LIN: ​FRAMe​ on page 411

Error Setup
Selects the error type to be searched for. You can select one or more error types as
search condition.

The error types are the same as in the LIN trigger setup, see ​"Error <type>"
on page 195.

The setting is only available if "Event" = "Error" or "ID & Error" is selected.

Remote command: 
​SEARch: ​PROTocol: ​LIN: ​CHKSerror​ on page 412
​SEARch: ​PROTocol: ​LIN: ​IPERror ​ on page 411
​SEARch: ​PROTocol: ​LIN: ​SYERror ​ on page 412

Symbolic ID
If a label list with node names was loaded and applied in the bus configuration, you can
select simply the node name from the list instead of entering the numeric identifier.

The instrument trriggers on the identifier of the selected node.

Identifier Setup
Opens the menu to set the identifier pattern, if "Event" = "Identifier" or "ID & Data" or "ID
& Error" is selected.

The settings are the same as for the setup of the identifier trigger, see ​"Identifier"
on page 196.

Remote command: 
​SEARch: ​PROTocol: ​LIN: ​ICONdition ​ on page 412
​SEARch: ​PROTocol: ​LIN: ​IDENtifier ​ on page 412
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Data Setup
Opens the menu to set the data pattern to be searched, if "Event" = "ID & Data" is
selected.

After setting the "No. of Bytes" and the "Comparison" condition, you can enter the value
bit-by-bit by setting the state high, low, or don't care for each single bit. Alternatively, you
can enter a hexadecimal value for each byte.

The settings are the same as for the setup of the data trigger, see ​"Data Setup"
on page 197.

Remote command: 
​SEARch: ​PROTocol: ​LIN: ​DLENgth ​ on page 412
​SEARch: ​PROTocol: ​LIN: ​DCONdition ​ on page 413
​SEARch: ​PROTocol: ​LIN: ​DATA ​ on page 413

11.7.6.2 LIN Search Results

Search results (events) are marked on the waveform and listed in the event table as usual.
Instead of the event table, you can display the frame table, where the search results are
also marked. The event flags are not saved in the csv file of the frame table.
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Fig. 11-17: Search for data frames with 11 bit identifier, search results are marked in frame table and
on the decoded data
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12 Data and File Management
This chapter describes how to print screenshots and how to manage measurement set-
tings and data.

● Printing..................................................................................................................204
● Saving and Loading..............................................................................................206

12.1 Printing

You can create a sceenshot of the current display of your waveforms and measurement
results and print it on a printer. To optimize the output, you can configure different color
modes. The printer has to be connected to a Type A USB port. Alternatively, you can
save screenshots to files, see also: ​chapter 12.2.5, "Screenshots", on page 219.

If you want to print many screenshots, you can assign the printout function to the
PRINT key. This key is a shortcut key that initiates the assigned action at a single key-
press. Infrequent printouts can be started from the "File" menu, see also: ​chap-
ter 12.1.1.3, "Quick Printing with the PRINT Key", on page 205.

12.1.1 Printing a Screenshot

Before you can print, you have to:
● Connect and configure the printer
● Configure the PRINT key if you need quick printout

Then you can start the printout from the "File" menu or with the PRINT key.

12.1.1.1 Configuring the Printer Output

For the printout, you configure the format and colors. The individual settings are described
in ​chapter 12.1.2, "Printer Settings", on page 205.

1. Connect the printer to a Type A USB port on the front or rear panel of the instrument.

2. Press SETUP > "Printer" to open the "Printer" menu.

3. Press "Paper Format" and select the required format using the "Navigation" knob.

4. In the "Printer" menu, press "Color Mode".

5. Select the required color format using the "Navigation" knob.

6. Most printers support PCL (Printer Command Language). If your printer does not,
select the appropriate "Command Set".
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12.1.1.2 Starting the Printout

Infrequent printouts can be started from the "File" menu.

1. Make sure that the printer is configured correctly.
See: ​chapter 12.1.1.1, "Configuring the Printer Output", on page 204

2. Press the FILE key.

3. Press "Screenshots > Print".

12.1.1.3 Quick Printing with the PRINT Key

You assign the print function to the PRINT key. After this configuration a screenshot will
be printed on the connected printer whenever you press the PRINT key.

See also: ​chapter 12.2.2, "Quick Access with PRINT key", on page 212.

1. Configure the PRINT key:

a) Press FILE > "Print-Key".
b) Press  "(Print) Screenshots".

2. Make sure that the printer is configured correctly.
See: ​chapter 12.1.1.1, "Configuring the Printer Output", on page 204

3. Press the PRINT key.

12.1.2 Printer Settings

Access: SETUP key > "More" (switch to page 2/3) > "Printer"

Paper Format
Defines the paper format and the orientation (portrait or landscape) for printing.

Remote command: 
​HCOPy:​PAGE: ​SIZE ​ on page 415
​HCOPy:​PAGE: ​ORIentation ​ on page 415

Color Mode
Defines the color mode for output on printer.

"Grayscale" Black and white output

"Color" Color output
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"Inverted" Inverts the colors of the output, i.e. a dark waveform is printed on a white
background.

Remote command: 
​HCOPy:​COLor: ​SCHeme​ on page 415

Command Set
Sets the printer language that is supported by the printer. When you connect a printer,
the supported command set is shown in the "Device Information" window.

12.2 Saving and Loading

With R&S RTM, you can save and recall your measurement data: device settings, mask
definitions, equation sets, waveform data, and screenshots. Data can be stored in the
instrument or on external device, it can be copied and converted (depending on the
available formats).

● Storage Locations.................................................................................................206
● Quick Access with PRINT key...............................................................................212
● Device Settings.....................................................................................................214
● Waveforms............................................................................................................216
● Screenshots..........................................................................................................219
● References, Masks, and Equation Sets: Import/Export........................................221

12.2.1 Storage Locations

The R&S RTM provides three basic storage locations to store any data. In the following,
these locations are refered to as storage devices:
● The "Internal" storage device is a flash memory in the instrument with about 8 MB

memory size.
● The "Front USB" storage device indicates a USB flash drive that is connected to the

USB connector on the front panel of the instrument.
● The "Rear USB" storage device indicates a USB flash drive that is connected to the

USB connector on the rear panel of the instrument.

On each storage device, data can be organized in folders as usual. Therefore, the
R&S RTM allows you to create folders or remove them wherever you need.

Device settings, reference waveforms, masks, and equations sets can be directly saved
to and loaded from any storage device. Waveforms and screenshots can be saved to
USB storage devices only.

To copy data from one storage device to another, the "Import/Export" functions are used.
The name of the target file can be changed, so you can copy and rename in one operation.
For references and masks, you can also change the target file format and convert the
data during export/import.

This chapter describes the general procedures and settings to save, load, and export/
import data.
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12.2.1.1 Configuring Storage Locations

You must configure the storage settings for the various data types initially: select the
storage location and the storage directory, and define the file name. For some data types,
further storage settings are available. Then you can save data simply by pressing the
"Save" softkey in the FILE menu or, if configured accordingly, by pressing the PRINT key
on the front panel.

To select the storage directory

Whenever you want to save, copy or load data, you have to set the directory where the
data will be stored or loaded from.

1. Press "Storage" to open the storage directory menu and display the file explorer for
the currently selected storage location.
See also: ​"Storage Directory Menu" on page 210.

2. Press "Storage (Internal/Front/Rear)" until the required storage device is highlighted.
For waveforms and screenshots, only a USB flash drive can be selected as a storage
location. If no USB flash drive is connected to the instrument, this function is not
available.

3. Use the "Navigation" knob to scroll through the directories. To change the directory,
scroll to the name of the directory and press the knob, or press "Change dir.".

4. Press "Create dir." to create a new subdirectory under the selected directory. Enter
a name for the subdirectory as described in ​"To define a new file or directory
name" on page 207.

5. Press "Remove dir." to remove a directory that you no longer need.

6. Press "Accept" to confirm the selected storage directory.

To define a new file or directory name

When you create a new directory or press "File name" to define the name of the storage
file, a text editor is displayed in which you can enter the new name.

1. Use the "Navigate" knob to select a character.

2. Press "Character Set", if available, to display additional characters.

3. Press "Backspace" to delete the character to the left of the cursor.

4. Press the "Cursor →" and "Cursor←" softkeys to scroll through the characters of the
name.

5. Press "Default name" to restore the default name.

6. Press "Accept" to save the defined name.

12.2.1.2 Importing and Exporting Data

To copy data from one storage device to another, the "Import/Export" functions are used.
The procedures is the same for all data types.
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The name of the target file can be changed, so you can copy and rename in one operation.
For references and masks, you can also change the target file format and convert the
data during export/import.

1. In the FILE menu, press the "Import/Export" softkey for the required data type.

2. Define the source file for the copy operation.

a) Press "Source".
A file explorer is displayed.

b) If necessary, switch to the storage location that contains the source file by press-
ing "Storage (Internal/Front/Rear)".

c) Select the source file. Use the "Navigation" knob to scroll through the directories.
To change the directory, scroll to the name of the directory and press the knob,
or press "Change dir.".

d) Press "Load".
The source file is selected, but not yet loaded to the R&S RTM.

3. Define the destination directory for the copy operation. The source file will be copied
here.

a) Press "Destination".
A file explorer is displayed.

b) If necessary, switch to the storage location that contains the storage directory by
pressing "Storage (Internal/Front/Rear)".

c) Select the storage directory. Use the "Navigation" knob to scroll through the
directories. To change the directory, scroll to the name of the directory and press
the knob, or press "Change dir.".
Press "Create dir." to create a new subdirectory under the selected directory.
Enter a name for the subdirectory as described in ​"To define a new file or directory
name" on page 207.

d) Press "Accept" to confirm the selection.

4. Change the "File Name" of the destination file if necessary.

Note: If a file with the same file name already exists in the destination directory, it will
be overwritten without notification.

5. If you want to change the file format for references or masks, press "Format" and
select the target format.

6. Press "Import/Export".

The source file is copied to the destination directory.

Imported data is not loaded to the instrument automatically. You must explicitly load it
after import with the "Load" function in the relevant menu (Masks, Reference, Math menu,
or File menu for instrument settings).

Saving and Loading
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12.2.1.3 General Storage Settings

This chapter describes the general settings to save, load, and export/import data.

● Save Menu............................................................................................................209
● Load Menu............................................................................................................210
● Storage Directory Menu........................................................................................210
● Import/Export Menu...............................................................................................211

Save Menu

The "Save" menu provides functions to configure how the data is saved and to start the
save process. Its main functions are displayed whenever some data has to be stored.
Depending on the data type, additional specific functions may be provided. These func-
tions are described in the relevant chapters.

Storage........................................................................................................................209
File name....................................................................................................................209
Comment.....................................................................................................................209
Save............................................................................................................................210

Storage
Opens the storage directory submenu, see ​"Storage Directory Menu" on page 210.

File name
Opens on-screen keyboard to define a new file name to which the data is stored.

Note: If a file with the same file name already exists in the destination directory, it will be
overwritten without notification.
Turn the NAVIGATION knob to mark a character and press the knob to select it. Press
"Backspace" to delete the character to the left of the cursor. Press the "Cursor →" and
"Cursor ←" softkeys to scroll through the characters of the name. Press "Default name"
to restore the standard file name.

Press "Accept" to save the defined name.

Remote command: 
​MMEMory: ​NAME ​ on page 414

Comment
Opens an on-screen keyboard to insert a comment to the stored data. Comments are
available for all file formats that can be read by the R&S RTM: device settings, reference
waveforms (trf format), masks, equation sets.
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Save
Saves the data to the selected storage directory. The used file name is displayed when
storage is completed.

Remote command: 
Device settings: ​MMEMory: ​STORe:​STATe ​ on page 422
Other data: ​MMEMory: ​DATA ​ on page 421

Load Menu

The "Load" menu provides functions and a file explorer to select data files and to load it
for usage. It is displayed whenever some data has to be loaded.

Storage........................................................................................................................210
Remove File................................................................................................................210
Load............................................................................................................................210

Storage
Opens the storage directory submenu, see ​"Storage Directory Menu" on page 210.

Remove File
Deletes the selected file.

Remote command: 
​MMEMory: ​DELete​ on page 421

Load
Loads the selected file to the instrument.

During an import/export operation, this command confirms the selection of a file and loads
it temporarily. In order to actually copy the file to the selected destination, press "Import/
Export".

Remote command: 
Device settings: ​MMEMory: ​LOAD:​STATe ​ on page 422

Storage Directory Menu

The storage directory menu is opened with the "Storage" softkey that is available in all
"Save" and "Load" menus. Here you define the storage device and the directory where
the file will be saved or loaded from. If appropriate, you can also create new directories
or delete existing ones.
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Waveforms and screenshots can only be stored on a USB stick connected to the front or
rear panel, not to an internal directory. If you want to store a waveform or scrrenshot, and
no USB stick is currently connected, the "Storage" softkey is not available.

See also: ​chapter 12.2.1, "Storage Locations", on page 206.

Storage (Internal/Front/Rear)......................................................................................211
Change Directory........................................................................................................211
Create Directory..........................................................................................................211
Remove Directory.......................................................................................................211

Storage (Internal/Front/Rear)
Defines the storage device.

Waveforms and screenshots can only be stored on a USB stick connected to the front or
rear panel, not to an internal directory. In this case, the softkey is only available if a USB
stick is connected to the rear or front panel.

"Internal" Directly in the internal memory of the instrument

"Front" On a USB stick connected to the front panel

"Rear" On a USB stick connected to the rear panel

Remote command: 
​MMEMory: ​MSIS ​ on page 417

Change Directory
Switches to the selected directory.

See also: ​"To select the storage directory" on page 207.

Remote command: 
​MMEMory: ​CDIRectory ​ on page 417

Create Directory
Creates a new subdirectory of the currently selected storage directory.

See also: ​"To define a new file or directory name" on page 207.

Remote command: 
​MMEMory: ​MDIRectory ​ on page 417

Remove Directory
Removes the currently selected directory.

Remote command: 
​MMEMory: ​RDIRectory ​ on page 418

Import/Export Menu

The "Import/Export" menu provides functions to copy data between the instrument and
a USB flash device.

See also: ​chapter 12.2.1.2, "Importing and Exporting Data", on page 207
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Source.........................................................................................................................212
Destination..................................................................................................................212
Import/Export...............................................................................................................212

Source
Opens the "Load" menu and a file explorer to select the source file of the import/export
operation.

See ​"Load Menu" on page 210.

Destination
Opens the "Storage" menu and a file explorer to select the destination of the import/export
operation.

See ​"Storage Directory Menu" on page 210.

Import/Export
Copies the selected source file to the specified file in the selected destination directory.

Note: If a file with the same file name already exists in the destination directory, it will be
overwritten without notification.

Remote command: 
​MMEMory: ​COPY ​ on page 420

12.2.2 Quick Access with PRINT key

The PRINT key is a shortcut key that initiates the associated action. With this key it is
easy to save, for example, a series of waveform data or screenshots.

You can assign one of the following actions to the PRINT key:
● Save device settings
● Save a waveform
● Save a screenshot
● Save a screenshot and the device settings
● Print a screenshot

Saving data
You also can save data without changing the behavior of the PRINT key by pressing
"Save" for the selected data type in the FILE menu.
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12.2.2.1 Configuring the PRINT-Key Behavior

The PRINT key can either be used to print screenshots to a connected printer, or to save
data to a specified storage location just by pressing a single key.

1. Press FILE > "Print Key".

2. Press the softkey of the action that you want to assign to the PRINT key.

3. Configure the settings for the selected action:

● Save device settings: FILE > "Device Settings > Save"
● Save a waveform: FILE > "Waveforms"
● Save a screenshot: FILE > "Screenshots"
● Save a screenshot and the device settings: FILE > "Screenshots" and FILE >

"Device Settings > Save"
● Print screenshots: SETUP > "More > Printer"

After this configuration the selected action is started whenever you press the
PRINT key.

12.2.2.2 PRINT-Key Settings

With FILE > "Print Key" you define an action that will be executed by pressing the
PRINT key.

Device Settings...........................................................................................................213
Waveforms..................................................................................................................213
(Save) Screenshots.....................................................................................................213
Screen & Setup...........................................................................................................214
(Print) Screenshots.....................................................................................................214

Device Settings
If selected, the device settings are stored when you press the PRINT key. Storage set-
tings are configured with FILE > "Device Settings".

See also: ​chapter 12.2.3.2, "Device Settings Menu", on page 215.

Waveforms
If selected, the current waveform is stored when you press the PRINT key. Storage set-
tings are configured with FILE > "Waveforms".

See also: ​chapter 12.2.4.3, "Waveform Storage Settings", on page 218.

(Save) Screenshots
If selected, a screenshot of the current display is stored when you press the PRINT key.
Storage settings are configured with FILE > "Screenshots".

See also: ​chapter 12.2.5.2, "Screenshot Storage Settings", on page 220.
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Screen & Setup
If selected, the device settings and a screenshot of the current display are stored when
you press the PRINT key. Storage settings are configured with FILE > "Screenshots" and
FILE > "Device Settings".

See also: ​chapter 12.2.5.2, "Screenshot Storage Settings", on page 220

(Print) Screenshots
If selected, a screenshot of the current display is sent to the USB printer when you press
the PRINT key. Printer settings are configured with SETUP > "Printer".

See also: ​chapter 12.1, "Printing", on page 204

12.2.3 Device Settings

In order to repeat measurements at different times or perform similar measurements with
different test data, it is useful to save the used instrument settings and load them again
later. Furthermore, it can be helpful to refer to the instrument settings of a particular
measurement when analyzing the results. Therefore, functions are provided so you can
easily save the instrument settings of a measurement, with or without the corresponding
screenshot.

The instrument settings can be saved to and loaded from any storage device - internal
memory or external USB flash device. It is also possible to copy the stored settings to
another storage device with "Export/Import". The file format is always .SET, and the file
size is about 2.76 kB.

You can exchange stored device settings between R&S RTM instruments, also between
2-channel and 4-channel instruments.

The default instrument settings can be restored with PRESET or FILE > "Device Settings
> Default sett.".

12.2.3.1 Saving and Loading Device Settings

● ​"To save device settings" on page 214
● ​"To load device settings" on page 215

To save device settings

1. Press FILE > "Device Settings > Save".

2. Configure the storage location as described in ​"To select the storage directory"
on page 207.

3. Enter the file name as described in ​"To define a new file or directory name"
on page 207.

4. Optionally, press "Comment" and enter a description of the settings.

5. Press "Save".
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Note: To save the device settings several times by pressing simply the PRINT key,
assign the "Device Settings" to the PRINT key as described in ​chapter 12.2.2.1,
"Configuring the PRINT-Key Behavior", on page 213.

To load device settings

1. Press FILE > "Device Settings > Load".

A file explorer is displayed.

2. If necessary, select the storage device and directory described in ​"To select the stor-
age directory" on page 207.

3. Select the file that contains the device settings. Use the "Navigation" knob to scroll
through the files.

4. Press "Load".

The saved settings are loaded to the R&S RTM.

12.2.3.2 Device Settings Menu

With FILE > "Device Settings" you open a menu to manage instrument configuration files.

Save............................................................................................................................215
└ Setup & Label...............................................................................................215

Load............................................................................................................................215
Import/Export Device Settings.....................................................................................216
Memory Usage............................................................................................................216
Default sett..................................................................................................................216

Save
Opens the "Save" menu, see ​"Save Menu" on page 209.

In addition to the common save functions, specific functions are available.

Setup & Label ← Save
Saves the the device settings together with the label list to the selected storage directory
in one file. The used file name is displayed when storage is completed.

This function is available if option R&S RTM-K1 or K3 is installed (protocols I2C, LIN,
CAN), and a label list was loaded and applied to the protocol data.

When you load a setting file with label list to an instrument, the label list is loaded together
with the instrument settings. A previously loaded label list will be overwritten.

Load
Opens the "Load" menu, see ​"Load Menu" on page 210.
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Import/Export Device Settings
Opens the "Import/Export" menu, see ​"Import/Export Menu" on page 211.

Memory Usage
Displays information on the instrument and information on used and available memory
space on all available storage devices.

Default sett.
Restores the default device settings. These settings, among others, are also restored
with the PRESET key.

12.2.4 Waveforms

A waveform can be saved in two ways:
● As a reference waveform for later use with R&S RTM: REF key

See: ​chapter 5, "Reference Waveforms", on page 71
● As data in various formats directly to a USB flash drive for analysis by other means:

FILE > "Waveforms".
This way is described in the current chapter.
If you want to save many waveforms, you can assign the function to the PRINT key.
Infrequent save operations can be started from the "File" menu. See also: ​chap-
ter 12.2.2, "Quick Access with PRINT key", on page 212.

12.2.4.1 Waveform File Formats

Data of all waveforms - channel, reference, and math waveforms - is saved as a suc-
cession of values or pairs of values. Pairs of values are written as two consecutive single
values. Depending on the file format, only amplitude values are stored, or the amplitude
values are stored together with their time value, or frequency value in FFT mode.

With export/import, you can change the target file format and convert the data.

In order to reload waveform data as a reference waveform, it must be stored in TRF or
CSV format.

TRF Format

TRF is the specific binary format for reference waveforms of the R&S RTM. It contains
amplitude values or pairs of values, time information (time of the first sample and the
sample interval) and current instrument settings. The data can be loaded as reference
waveform for further use on the instrument. It is not intended for analysis outside the
R&S RTM.

CSV Format

In a Comma Separated Values text file, the waveform is stored in a two-columned table.
Columns are separated by a comma, and the lines are separated by line breaks \r\n
(0x0D 0x0A). Values are listed in scientific notation.
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The first column contains the time values of the samples in relation to the trigger point,
and the second column contains the associated amplitude values. The first line indicates
the units of the values in each column, and the name of the waveform. Pairs of values
are listed as two single values with the same time value (minimum and maximum).

The data can be loaded back to the instrument for further use.

Example CSV1: Waveform of channel 1, single values

[s],CH1[V]
-1.1996E-02,1.000E-02
-1.1992E-02,1.000E-02
-1.1988E-02,1.000E-02
-1.1984E-02,1.000E-02

Example CSV2: Waveform of channel 1, pairs of values

[s],CH1[V]
-2.9980E+00,2.000E-05
-2.9980E+00,1.400E-04
-2.9960E+00,-1.800E-04
-2.9960E+00,1.400E-04
-2.9940E+00,-1.800E-04
-2.9940E+00,1.400E-04

Example CSV3: FFT

[Hz],FFT[dBm]
0.000000E+00,1.03746E+01
1.525879E+02,7.49460E+00
3.051758E+02,-1.19854E+01
4.577637E+02,-1.56854E+01

Import of CSV files: If you import a CSV file as reference waveform from a USB flash
drive to the instrument, the import converts the data to TRF format. The instrument reads
the first and the last time value and calculates the total time of the waveform, and it counts
the number of values. Then all amplitude values are read one by one and written with an
equidistant time distribution to the TRF file. If the first two time values are identical, the
waveform is considered to consist of pairs of values.

TXT Format

TXT files are ASCII files that contain only amplitude values in scientific notation but no
time values. Amplitude values are separated by commas. Pairs of values are listed as
two subsequent single values, without any identification. There is no comma at the end
of the file.

Example: TXT file

1.000E-02,1.000E-02,1.000E-02,1.000E-02,3.000E-02

BIN Format

BIN files contain binary amplitude values only but no time values. Each value has a word
size of 8, or 16, or 32 bit, the word size is the same throughout the file.

Saving and Loading



Data and File ManagementR&S®RTM

218User Manual 1305.0595.02 ─ 08

Words are given in Big Endian order - beginning with the MSB (Most Significant Byte)
and ending with the LSB (Least Significant Byte). Pairs of values are listed as two sub-
sequent single values, without any identification.

12.2.4.2 Saving a Waveform to USB flash drive

If you want to save many waveforms, you can assign the function to the PRINT key.
Infrequent savings can be started from the "File" menu. Before you can save the wave-
form, you have to configure the storage location and file format.

1. Press FILE > "Waveforms".

2. Configure the storage location as described in ​"To select the storage directory"
on page 207.

3. Press "Waveform" and select the waveform to be stored. All active waveforms are
listed.

4. Enter the file name as described in ​"To define a new file or directory name"
on page 207.

5. Select the "Format".
For details, see ​chapter 12.2.4.1, "Waveform File Formats", on page 216.

6. Press "Data" and select whether to save the displayed data or the data stored in the
memory.
For details, see ​"Data" on page 219.

7. Press "Save".

To save waveforms several times by pressing simply the PRINT key, assign the "Wave-
forms" to the PRINT key as described in ​chapter 12.2.2.1, "Configuring the PRINT-Key
Behavior", on page 213.

12.2.4.3 Waveform Storage Settings

With FILE > "Waveforms" you open a menu to store one of the active waveforms to a
USB flash drive.

For a description of the common save functions "Storage", "File Name", and "Save", see
​chapter 12.2.1.3, "General Storage Settings", on page 209. Specific settings for saving
waveforms are described below.
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Waveform....................................................................................................................219
Format.........................................................................................................................219
Data.............................................................................................................................219

Waveform
Selects the waveform to be stored. Turn the "Navigation" knob to select one of the avail-
able waveforms (channel, reference, and math waveforms).

Format
Defines the format of the waveform storage file: BIN, CSV, TXT, or TRF. For details, see
​chapter 12.2.4.1, "Waveform File Formats", on page 216.

Data
Selects the amount of data points to be saved in the waveform file.

"Display Data" All waveform samples that are displayed on the screen will be saved.
Exception: The "Waveform Rate" ist set to maximum sample rate, and
the acquisition is stopped. In this case, the memory can contain more
data samples than the display shows (decimation). To save the wave-
form with maximum resolution, the instrument stores the samples that
are saved in the memory.

"Acq. Memory" All data samples that are stored in the memory will be saved.
This setting takes effect only for stopped acquisitions and it is not avail-
able for math waveforms. For running acquisitions, always display data
is stored.

Remote command: 
​CHANnel<m>: ​DATA: ​POINts​ on page 285

12.2.5 Screenshots

You can create a screenshot of the current display of your waveforms and measurement
results and save it to a file. To optimize the output, you can configure different color modes
and file formats. Alternatively, you can print screenshots to a printer.

See also: ​chapter 12.1, "Printing", on page 204.

If you want to save many screenshots - together with the instrument or the image only -
you can assign the function to the PRINT key. Infrequent save operations can be started
from the "File" menu.

See also: ​chapter 12.2.2, "Quick Access with PRINT key", on page 212.

12.2.5.1 Saving a Screenshot

Before you can save the screenshot, you have to configure the storage location and file
format.

1. Press FILE > "Screenshots".
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2. Configure the storage location as described in ​"To select the storage directory"
on page 207.

3. Enter the file name as described in ​"To define a new file or directory name"
on page 207.

4. Select the "Format" and the "Color mode".
For details, see ​chapter 12.2.5.2, "Screenshot Storage Settings", on page 220.

5. Press "Save".

See also: ​chapter 12.2.2, "Quick Access with PRINT key", on page 212.

12.2.5.2 Screenshot Storage Settings

With FILE > "Screenshots" you open a menu to save or print screenshots of the current
display.

For a description of the common save functions "Storage", "File Name", and "Save", see
​chapter 12.2.1.3, "General Storage Settings", on page 209. Specific settings for saving
screenshots are described below.

Format.........................................................................................................................220
Color mode..................................................................................................................220
Print.............................................................................................................................221

Format
Defines the format of the screenshot file. The following formats are available:

● BMP
BitMaP is an uncompressed format, files are large and saving might take some time.

● PNG
Portable Network Graphics is a graphic format with lossless data compression.

Remote command: 
​HCOPy:​LANGuage ​ on page 415

Color mode
Defines the color mode for saved screenshots.

"Grayscale" Black and white output

"Color" Color output

"Inverted" Inverts the colors of the output, i.e. a dark waveform is printed on a white
background

Remote command: 
​HCOPy:​COLor: ​SCHeme​ on page 415
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Print
Prints the screenshot on a printer connected to the USB connector on the front or rear
panel. The printer output is configured with SETUP > "Printer".

The function is only available if a printer is connected.

Remote command: 
​HCOPy[: ​IMMediate] ​ on page 414

12.2.6 References, Masks, and Equation Sets: Import/Export

The "File" menu provides the functions to copy mask files, equation sets, and reference
waveform files from one storage device to another.

For details, refer to the relevant chapters:
● Reference waveforms: ​chapter 5, "Reference Waveforms", on page 71
● Masks: ​chapter 9, "Masks", on page 118
● Equation sets: ​chapter 7, "Mathematics", on page 94
● Export/Import procedure: ​chapter 12.2.1.2, "Importing and Exporting Data",

on page 207
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13 General Instrument Setup
This chapter describes the firmware update, the activation of new options, and all softkeys
of the "Setup" menu.

The usage of the functions except of update is described in other chapters depending on
the usage context:
● chapter "Defining General Instrument Settings" in the "Getting Started" manual: con-

figuring date, time, interface and help language, and sounds;
● ​chapter 14.1.2, "Setting Up a LAN Connection", on page 233.

13.1 Firmware and Options

● Updating Firmware................................................................................................222
● Activating Options.................................................................................................223

13.1.1 Updating Firmware

This chapter describes how to update the instrument's firmware and the interface firm-
ware.

You should update the instrument and interface firmware in regular intervals to take
advantage of new functions and solve possible problems.

To update the instrument's firmware

1. Download the current firmware package from the instrument's Web page: http://
www.scope-of-the-art.com/product/rtm.html under "Downloads > Firmware".

The zip package contains the firmware (.fwu) and help/languages (.hmg) for all
R&S RTM types.

2. Extract the zip package and copy the required firmware and help/languages files to
a USB stick.

3. Insert the USB flash drive in the instrument.

4. Press SETUP.

5. Press "More".
Press "Update > Firmware".

The currently installed firmware version as well as all available update versions are
displayed.

6. Press "Execute" to start the firmware update.
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7. Update the online help as well as softkey labels and display texts of additional lan-
guages: SETUP > "[More >] Update > Language > Language (select) > Update". See
the "Getting Started" Manual for further information.

To update the interface firmware

1. Insert a USB flash drive containing an update in the instrument.

2. Press SETUP > "Update > Interface".

The currently installed firmware version as well as all available update versions are
displayed.

3. Press "Execute" to install the available firmware updates.

13.1.2 Activating Options

New R&S RTM options must be activated using the license key supplied by Rohde &
Schwarz. The license key can be read from a license file or entered manually.

1. Press SETUP > "Update > Upgrade".

2. To load the key from a file:

a) Connect the USB flash drive to the instrument.
b) Press "Read keys from license file".
c) Select the "Storage" location, change directory, if needed, and select the license

file.
d) Press "Load".

3. To enter the license key manually:

a) Press "Input key manually".
b) Enter the license key with the on-screen keyboard and press "Accept".

The option is enabled and can be used immediately.

13.2 Reference for Setup

The SETUP key provides functions for basic instrument settings and allows you to update
the instrument's firmware and help files:
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Time Reference...........................................................................................................225
Menu Off.....................................................................................................................225
Language....................................................................................................................225
Date & Time................................................................................................................225

└ Year/Month/Day/Hour/Minute.......................................................................225
Interface......................................................................................................................225

└ USB...............................................................................................................225
└ LAN...............................................................................................................226
└ IEEE488........................................................................................................226
└ Parameter.....................................................................................................226

└ DHCP..................................................................................................226
└ Next....................................................................................................226
└ Up.......................................................................................................226
└ Down...................................................................................................226
└ Default................................................................................................226
└ Save....................................................................................................226

Device Information......................................................................................................226
Update.........................................................................................................................226

└ Firmware.......................................................................................................227
└ Execute...............................................................................................227

└ Interface........................................................................................................227
└ Execute...............................................................................................227

└ Language......................................................................................................227
└ Language............................................................................................227
└ Add.....................................................................................................227
└ Remove..............................................................................................228
└ Update................................................................................................228

└ Upgrade........................................................................................................228
└ Read keys from license file.................................................................228
└ Input key manually..............................................................................228

Printer..........................................................................................................................228
Sound..........................................................................................................................228

└ Control Beep.................................................................................................228
└ Error Beep.....................................................................................................228
└ Trigger Beep.................................................................................................228

Self Alignment.............................................................................................................228
└ Self Test & Self Alignment............................................................................228
└ Self Alignment...............................................................................................229
└ Start..............................................................................................................229
└ Abort.............................................................................................................229
└ Log File.........................................................................................................229

Probe Adjust................................................................................................................229
└ 1kHz..............................................................................................................229
└ 1MHz.............................................................................................................229
└ Automatic......................................................................................................229
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Secure Erase..............................................................................................................229
Device Name...............................................................................................................230
LED Intensity...............................................................................................................230

Time Reference
Defines the time reference point in the diagram, i.e. the point at which the trigger is 0s.
The reference point is defined as an offset of divisions from the center in the diagram. By
default, the reference point 0s is displayed in the center of the window, which corresponds
to 0 divisions.

The scaling of the waveform depends on this reference point.

Remote command: 
​TIMebase: ​REFerence​ on page 274

Menu Off
Defines how long a selection menu for a softkey is displayed before it automatically closes
again.

Language
Provides different languages in which the softkey labels, help and other screen informa-
tion can be displayed. Currently only an English interface is available for the instrument.

Remote command: 
​DISPlay: ​LANGuage ​ on page 423

Date & Time
Provides softkeys to set the current date and time in the instrument.

Year/Month/Day/Hour/Minute ← Date & Time
Change the date and time settings individually. Changes are only adopted by the instru-
ment after you press "Save and Back".

Remote command: 
​SYSTem: ​DATE ​ on page 424
​SYSTem: ​TIME ​ on page 424

Interface
Activates or deactivates additional instrument interfaces. Using these interfaces you can
communicate with the instrument, for example to read out data or automate the meas-
uring station. Various interfaces are available as options for the instrument and are
installed in a specific slot at the rear. Depending on the installed interface, additional
parameters may be definable via the "Parameter" softkey after the interface has been
activated.

USB ← Interface
Activates the (Type B) USB interface for remote control. The USB interface provides a
simple way to connect the instrument to a PC. The USB 2.0 standard is supported. Use
a connection cable that is suitable for a "Type B" USB interface.

No settings are available for the USB interface.

Note: You cannot connect a printer via the Type B USB interface. Use one of the Type
A USB interfaces on the rear or front panel to connect a printer.
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LAN ← Interface
Activates the LAN interface which allows you to connect the instrument to various other
devices. Access to the instrument is controlled via its IP address.

By default, the instrument is set to use DHCP. If the instrument cannot find a DHCP
server, it takes about two minutes until the LAN menu is available.

The interface is configured using the ​Parameter softkey. See also: ​chapter 14.1.2, "Set-
ting Up a LAN Connection", on page 233.

IEEE488 ← Interface
Activates the IEEE488 interface, also known as a "General Purpose Interface Bus"
(GPIB). Using this interface, up to 15 devices can be connected to the instrument. Each
device is identified by a unique number, which is defined within the device.

The interface is configured using the ​Parameter softkey. For details see ​chapter 14.1.2,
"Setting Up a LAN Connection", on page 233.

Parameter ← Interface
Provides a settings dialog to configure the active additional interface. Changes are only
adopted by the instrument after you press "Save".

DHCP ← Parameter ← Interface
Activates or deactivates usage of the Dynamic Host Configuration Protocol (DHCP). If
the network supports dynamic TCP/IP configuration using DHCP, all address information
can be assigned automatically.

Next ← Parameter ← Interface
For settings that require several entries in one row, "Next" selects the next entry.

To select the next setting in the dialog, press "Down", to select the previous setting, press
"Up".

Up ← Parameter ← Interface
Selects the previous setting in the dialog.

Down ← Parameter ← Interface
Selects the next setting in the dialog.

Default ← Parameter ← Interface
Restores the default interface settings.

Save ← Parameter ← Interface
Saves the changes to the instrument and closes the dialog.

Device Information
Displays insformation on the instrument, such as its serial number, the installed software
version and hardware information. This information is required in case of a support
request.

Update
Provides functions to update the help files or firmware of the instrument or interfaces.
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Firmware ← Update
Allows you to update the instrument firmware. The currently installed firmware version is
displayed, as well as all available update versions if a USB flash drive containing an
update is identified. The instrument is only updated when you press "Execute".

Note: You should update the instrument firmware in regular intervals to take advantage
of new functions and solve possible problems.
The online help is not included in the firmware update package. Update the online help
separately to get the latest information.

Execute ← Firmware ← Update
The instrument firmware is updated.

Interface ← Update
Some interfaces are provided with their own instrument-independant firmware. This
interface firmware can also be updated. The currently installed firmware version is dis-
played, as well as all available update versions, if a USB flash drive containing an update
is identified. The instrument is only updated when you press "Execute".

Note: You should update the interface firmware in regular intervals to take advantage of
new functions and solve possible problems.

Execute ← Interface ← Update
The interface firmware is updated.

Language ← Update
Displays the installed and available languages. For each language, softkey labels, display
texts, and - if available - the online help are provided. To install or update a language or
online help, the language file RTM10xx.HMG is required on a USB flash drive. The lan-
guage file contains all available languages and online helps. Up to four languages can
be installed on the instrument.

See the "Getting Started" Manual for further information.

Language ← Language ← Update
Selects the language to be added, removed or updated. Supported languages are listed
in the data sheet.

Add ← Language ← Update
Adds the language selected with the "Language" softkey to the instrument.

To change the displayed language, use the "Language" softkey in the "Setup" menu..

Remote command: 
​DISPlay: ​LANGuage:​ADD ​ on page 423
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Remove ← Language ← Update
Removes the language selected with the "Language" softkey from the instrument.

Remote command: 
​DISPlay: ​LANGuage:​REMove ​ on page 423

Update ← Language ← Update
Updates the language selected with the "Language" softkey on the instrument.

Upgrade ← Update
Provides functions to activate options.

Read keys from license file ← Upgrade ← Update
Select the storage and directory where your license file is stored, and press "Load" to
activate the options.

Input key manually ← Upgrade ← Update
Opens the on-screen keyboard to enter the license key of the option.

Printer
Opens a menu to configure the output on the printer: paper format, orientation, color, and
printer language. The printer has to be connected to a (Type A) USB port.

For details, see ​chapter 12.1.2, "Printer Settings", on page 205.

Sound
Defines the event types for which a sound is to be generated by the instrument. Switch
the sound for a particular event type on or off by selecting the corresponding softkey.
Active sounds are highlighted.

Control Beep ← Sound
Generates a sound for general control events, e.g. reaching the rotary encoder end or
changing the measuring mode in the "Automeasure" menu.

Error Beep ← Sound
Generates a a sound if an error occurs in the instrument, e.g. when the input exceeds 50
 Ω or a false value is entered in a dialog.

Trigger Beep ← Sound
Generates a sound when the trigger condition is fulfilled.

Self Alignment
Opens a submenu to perform selftest and self-alignment of the instrument and to check
the results.

Self Test & Self Alignment ← Self Alignment
Checks if a self-alignment has been executed successfully. If not, the self-alignment is
executed. To start the process, press the "Start" softkey.
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Self Alignment ← Self Alignment
Allows you to execute an internal self-alignment of the instrument. Alignment is only exe-
cuted when you press the "Start" softkey.

When data from several input channels is displayed at the same time, it may be necessary
to align the data in order to synchronize the time bases, amplitudes, and positions. This
is the case, for example, when strong temperature changes occur.

Start ← Self Alignment
Starts the internal self-calibration of the instrument. Status information is displayed on
the screen.

Abort ← Self Alignment
Aborts the internal self-calibration of the instrument.

Log File ← Self Alignment
The log file records the results of the self-alignment. You can set et the extend of the log
file and export it.

"No Log File" No log file is written

"Standard Log
File"

Default logging

"Extended Log
File"

Complete log results are written

"Export" Opens the submenu to store the log file on USB stick.
See also: ​"Storage Directory Menu" on page 210.

Probe Adjust
A R&S RTM allows you to adjust a probe without further devices. Two connector pins are
located on the front panel. The left pin is on ground level. The right pin supplies a square
wave signal for the adjustment. In this menu you can choose between two frequencies
(1 kHz, 1 MHz) or allow the detection of an automatic setting by the instrument. The rise
time does not differ between the settings.

1kHz ← Probe Adjust
A square wave with a frequency of f = 1 kHz is generated at the "Probe Adjust" pin. Use
this setting to adjust the LF band of the probe.

1MHz ← Probe Adjust
A square wave with a frequency of f = 1 MHz is generated at the "Probe Adjust" pin. Use
this setting to adjust the HF band of the probe.

Automatic ← Probe Adjust
A square wave is generated at the "Probe Adjust" pin. The frequency of the square wave
depends on the defined time base. If the time base becomes too small to display the 1
kHz wave, it is automatically switched to a 1 MHz wave.

Secure Erase
Deletes current instrument configuration data and user data (for example, reference files,
equation sets, masks) from the internal storage. Calibration data remains in the storage.
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Use this function before you send the instrument to the service. If the instrument is used
in a secured environment, the function ensures that all sensitive data is removed before
the instrument leaves the secured area.

To start secure erase, select "OK". Do not turn off the instrument before the process has
been completed!

See also: document "Resolving Security Issues When Working in Secure Areas" that is
delivered on the documentation CD-ROM and on the R&S RTM internet web page.

Device Name
Enter the name of the instrument.

LED Intensity
Defines the luminosity of illuminated front panel keys and rotary knobs.

Reference for Setup
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14 Remote Control

14.1 Basics

This chapter provides basic information on operating an instrument via remote control.

14.1.1 Remote Control Interfaces

For remote control, the LAN, USB or the GPIB interface can be used. The GPIB interface
(Option RTM-B10) replaces the LAN / USB type B interface module on the rear panel.

Table 14-1: Remote control interfaces and protocols

Interface Protocols, address string Remarks

Local Area
Network
(LAN)

VXI-11 protocol:
TCPIP::<IP_address>[::inst0]::INSTR

Raw socket mode:
TCPIP::<IP_address>::<IP_port>::SO
CKET

The LAN connector is located on the rear panel of
the instrument.
See also:
● ​chapter 14.1.1.1, "LAN Interface",

on page 232
● ​chapter 14.1.2, "Setting Up a LAN Connec-

tion", on page 233

USB The instrument is addressed by the
COM port number.

A USB type B connector is located on the rear panel
of the instrument. Connection requires installation of
an USB driver. Contact your Rohde & Schwarz ser-
vice center to get the driver.
See also:
● ​chapter 14.1.1.2, "USB Interface",

on page 232

GPIB (IEC/
IEEE Bus
Interface)

GPIB::primary address[::INSTR]

(no secondary address)

An optional GPIB bus interface according to stand-
ard IEC 625.1/IEEE 488.1 can be mounted on the
rear panel of the instrument.

See also: ​chapter 14.1.1.3, "GPIB Interface (IEC/
IEEE Bus Interface)", on page 232.

Within this interface description, the term GPIB is used as a synonym for the IEC/IEEE
bus interface.

SCPI compatibility

SCPI commands (Standard Commands for Programmable Instruments) are used for
remote control. The SCPI standard is based on standard IEEE 488.2 and aims at the
standardization of device-specific commands, error handling and the status registers.
The tutorial "Automatic Measurement Control - A tutorial on SCPI and IEEE 488.2" from
John M. Pieper (R&S order number 0002.3536.00) offers detailed information on con-
cepts and definitions of SCPI. The instrument supports the SCPI version 1999.
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SCPI-confirmed commands are explicitly marked in the command reference chapters.
Commands without SCPI label are device-specific, however, their syntax follows SCPI
rules.

14.1.1.1 LAN Interface

The R&S RTM is equipped with a network interface and can be connected to an Ethernet
LAN (local area network) for remote control of the instrument. The instrument accepts
remote commands via the LAN interface using the VISA library. VISA must be installed
on the control computer.

The R&S RTM supports two ways of LAN communication:
● VXI-11 protocol: a protocol that has been specifically developed for test and mea-

surement instruments. It is the recommended protocol for remote control via LAN.
● Raw socket mode: a synchronous, streaming oriented protocol. Consequently, raw

socket communication does not support asynchronous events like Service Request
(SRQ) or Device Clear (DCL).

See also: ​chapter 14.1.2, "Setting Up a LAN Connection", on page 233.

VXI-11 Protocol

The VXI-11 standard is based on the ONC RPC (Open Network Computing Remote
Procedure Call) protocol which in turn relies on TCP/IP as the network/transport layer.
The TCP/IP network protocol and the associated network services are preconfigured.
TCP/IP ensures connection-oriented communication, where the order of the exchanged
messages is adhered to and interrupted links are identified. With this protocol, messages
cannot be lost.

14.1.1.2 USB Interface

For remote control via the USB connection, the PC and the instrument must be connected
via the USB type B interface. The USB connection requires the VISA library and the USB
driver to be installed. VISA detects the R&S instrument at the assigned serial port when
the USB connection is established. You do not have to enter an address string.

Contact your Rohde & Schwarz service center to get the USB driver.

14.1.1.3 GPIB Interface (IEC/IEEE Bus Interface)

The GBIP interface is optional (option RTM-B10). It replaces the LAN / USB type B inter-
face module on the rear panel. Thus, remote control is possible either with LAN or USB
connection, or with GBIP.

To be able to control the instrument via the GPIB bus, the instrument and the controller
must be linked by a GPIB bus cable. A GPIB bus card, the card drivers and the program
libraries for the programming language must be provided in the controller. The controller
must address the instrument with the GPIB instrument address.
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Characteristics

The GPIB interface is described by the following characteristics:

● Up to 15 instruments can be connected
● The total cable length is restricted to a maximum of 15 m; the cable lenth between

two instruments should not exceed 2m.
● A wired "OR"-connection is used if several instruments are connected in parallel.

GPIB Instrument Address

In order to operate the instrument via remote control, it must be addressed using the
GPIB address. The remote control address is factory-set to 20, but it can be changed in
the network environment settings or in the "Setup" menu under "Interface > Parameter".
For remote control, addresses 0 through 30 are allowed. The GPIB address is maintained
after a reset of the instrument settings.

14.1.2 Setting Up a LAN Connection

14.1.2.1 Connecting the Instrument to the Network

The network card can be operated with a 10 Mbps Ethernet IEEE 802.3 or a 100 Mbps
Ethernet IEEE 802.3u interface.

Risk of network failure
Before connecting the instrument to the network or configuring the network, consult your
network administrator. Errors may affect the entire network.

► To establish a network connection, connect a commercial RJ-45 cable to one of the
LAN ports of the instrument and to a PC.

14.1.2.2 Configuring LAN Parameters

Depending on the network capacities, the TCP/IP address information for the instrument
can be obtained in different ways.
● If the network supports dynamic TCP/IP configuration using the Dynamic Host Con-

figuration Protocol (DHCP), and a DHCP server is available, all address information
can be assigned automatically.

● Otherwise, the address must be set manually. Automatic Private IP Addressing
(APIPA) is not supported.
See: ​"Configuring LAN parameters manually (no DHCP)" on page 234
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By default, the instrument is configured to use dynamic TCP/IP configuration and obtain
all address information automatically. This means that it is safe to establish a physical
connection to the LAN without any previous instrument configuration.

Risk of network errors
Connection errors can affect the entire network. If your network does not support DHCP,
or if you choose to disable dynamic TCP/IP configuration, you must assign valid address
information before connecting the instrument to the LAN. Contact your network admin-
istrator to obtain a valid IP address.

Configuring LAN parameters manually (no DHCP)

1. Disconnect the R&S RTM from the LAN.

2. Restart the instrument.

3. Press the SETUP key and then the "Interface" softkey.

4. Wait about two minutes until the LAN menu is available. Press the "LAN" softkey.

Note: By default, the instrument is set to use DHCP. If the instrument cannot find a
DHCP server, it takes some time until the LAN settings can be accessed.

5. Press the "Parameter" softkey.

The "LAN settings" dialog box is displayed.
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Some data is displayed for information only and cannot be edited. This includes the
"MAC" (physical) address of the connector and the "Link" status information.

6. If the LAN does not support DHCP, or the instrument is directly connected with a
computer, disable DHCP: Press the "DHCP" softkey so that it is not highlighted (off).

7. Define the IP address of the instrument by entering each of the four blocks individu-
ally.

a) Define the first block number using the Navigation knob.
b) Press "Next" to move to the next block and define the number.
c) When the IP address is complete, press "Down" to continue with the next setting.

8. Define the "Subnetmask" and "Gateway" in the same way as the IP address.

9. Select the "IP Port" - the port number for raw socket communication.

10. Select the "HTTP Port" used by the instrument.

11. Select the "Transfer" mode. This mode can either be determined automatically
("Auto" setting), or you can select a combination of a transfer rate and half or full
duplex manually.
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12. Press "Save" to save the LAN parameters on the instrument.

The "Link" status information at the bottom of the dialog box indicates whether a LAN
connection was established successfully.

Checking LAN and SCPI connection

1. Check the LAN connection using ping: ping xxx.yyy.zzz.xxx.

2. If the computer can access the instrument, enter the IP address of the R&S RTM in
the address line of the internet browser on your computer: http//:xxx.yyy.zzz.xxx

The "Instrument Home" page appears. It provides information on the instrument and
the LAN connection.

3. On the "Screen Data" page, a copy of the instrument screen is shown. To get the
current screen content from the instrument, click "Update".
To save the screen copy, right-click the picture and select "Save picture as".

4. On the "SCPI Device Control" page, you can check if the transfer of remote com-
mands is working. You can enter a single command, for example; *IDN?, and trans-
mit it with "Send". Do not press the Enter key.
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14.1.2.3 Connecting with the Instrument: VISA Address String

Only the IP address of the instrument is required to set up the connection. It identifies the
instrument in the network and is part of the resource string used by the programs to
identify and control the instrument. Depending on the communication mode - VXI-11
protocol or raw socket mode - the resource string has different forms.

IP address and port number are listed in the "Ethernet Settings" of R&S RTM, see also:
​chapter 14.1.2.2, "Configuring LAN Parameters", on page 233.

If the LAN is supported by a DNS server, the host name can be used instead of the IP
address. The DNS server (Domain Name System server) translates the host name to the
IP address. To assign a host name to the R&S RTM, select SETUP > "More" > "Device
Name".

VXI-11 protocol

TCPIP::<IP address>[::inst0]::INSTR
where:
● inst0 is the LAN device name. VISA supports several devices running on the instru-

ment. On R&S RTM, only one device is configured, so the LAN device name can be
omitted.

● INSTR indicates that the VXI-11 protocol is used

Example: If the instrument has the IP address 192.1.2.3, the valid resource string is:
TCPIP::192.1.2.3::INSTR
With host name instead of IP address:

TCPIP::<host name>[::inst0]::INSTR
Example: If the computer name is RSRT1, the valid resource string is:
TCPIP::RSRT1::INSTR.
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Raw socket mode

TCPIP::<IP_address>::<IP_port>::SOCKET
The default port number for SCPI socket communication is 5025.

Example: If the instrument has the IP address 192.1.2.3; the valid resource string is:
TCPIP::192.1.2.3::5025::SOCKET
With host name instead of IP address:

TCPIP::<host_name>::<IP_port>::SOCKET
Example: If the host name is RSRT1; the valid resource string is: TCPIP::RSRT1::
5025::SOCKET

The end character must be set to linefeed.

14.1.3 Switching to Remote Control

When you switch on the instrument, it is always in manual operation state ("local" state)
and can be operated via the front panel.

When you send a command from the control computer, it is received and executed by
the R&S RTM. The display remains on, manual operation via the front panel is always
possible.

14.1.4 Messages and Command Structure

14.1.4.1 Messages

Instrument messages are employed in the same way for all interfaces, if not indicated
otherwise in the description.

See also:
● Structure and syntax of the instrument messages: ​chapter 14.1.4.2, "SCPI Command

Structure", on page 241
● Detailed description of all messages: ​chapter 14.2, "Command Reference",

on page 263

There are different types of instrument messages, depending on the direction they are
sent:
● Commands
● Instrument responses
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Commands

Commands (program messages) are messages the controller sends to the instrument.
They operate the instrument functions and request information. The commands are sub-
divided according to two criteria:
● According to the effect they have on the instrument:

– Setting commands cause instrument settings such as a reset of the instrument
or setting the frequency.

– Queries cause data to be provided for remote control, e.g. for identification of the
instrument or polling a parameter value. Queries are formed by directly appending
a question mark to the command header.

● According to their definition in standards:
– Common commands: their function and syntax are precisely defined in standard

IEEE 488.2. They are employed identically on all instruments (if implemented).
They refer to functions such as management of the standardized status registers,
reset and self test.

– Instrument control commands refer to functions depending on the features of
the instrument such as frequency settings. Many of these commands have also
been standardized by the SCPI committee. These commands are marked as
"SCPI compliant" in the command reference chapters. Commands without this
SCPI label are device-specific, however, their syntax follows SCPI rules as per-
mitted by the standard.

Instrument responses

Instrument responses (response messages and service requests) are messages the
instrument sends to the controller after a query. They can contain measurement results,
instrument settings and information on the instrument status.

LAN Interface Messages

In the LAN connection, the interface messages are called low–level control messages.
These messages can be used to emulate interface messages of the GPIB bus.

Command Long term Effect on the instrument

&ABO Abort Aborts processing of the commands just received.

&DCL Device Clear Aborts processing of the commands just received and sets
the command processing software to a defined initial state.
Does not change the instrument setting.

&GTL Go to Local Transition to the "local" state (manual control).

&GTR Go to Remote Transition to the "remote" state (remote control).

&GET Group Execute Trigger Triggers a previously active instrument function (e.g. a
sweep). The effect of the command is the same as with that
of a pulse at the external trigger signal input.

&LLO Local Lockout Disables switchover from remote control to manual control
by means of the front panel keys.
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Command Long term Effect on the instrument

&NREN Not Remote Enable Enables switchover from remote control to manual opera-
tion by means of the front panel keys

&POL Serial Poll Starts a serial poll.

GPIB Interface Messages

Interface messages are transmitted to the instrument on the data lines, with the attention
line (ATN) being active (LOW). They are used for communication between the controller
and the instrument and can only be sent by a computer which has the function of a GPIB
bus controller. GPIB interface messages can be further subdivided into:

● Universal commands: act on all instruments connected to the GPIB bus without
previous addressing

● Addressed commands: only act on instruments previously addressed as listeners

Universal Commands

Universal commands are encoded in the range 10 through 1F hex. They affect all instru-
ments connected to the bus and do not require addressing.

Command Effect on the instrument

DCL (Device Clear) Aborts the processing of the commands just received and sets the command
processing software to a defined initial state. Does not change the instrument
settings.

IFC (Interface Clear) *) Resets the interfaces to the default setting.

LLO (Local Lockout) The LOC/IEC ADDR key is disabled.

SPE (Serial Poll Enable) Ready for serial poll.

SPD (Serial Poll Disable) End of serial poll.

PPU (Parallel Poll Unconfig-
ure)

End of the parallel-poll state.

*) IFC is not a real universal command, it is sent via a separate line; however, it also affects all instruments
connected to the bus and does not require addressing

Addressed Commands

Addressed commands are encoded in the range 00 through 0F hex. They only affect
instruments addressed as listeners.

Command Effect on the instrument

GET (Group Execute Trigger) Triggers a previously active instrument function (e.g. a sweep). The
effect of the command is the same as with that of a pulse at the
external trigger signal input.

GTL (Go to Local) Transition to the "local" state (manual control).

GTR (Go to Remote) Transition to the "remote" state (remote control).
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Command Effect on the instrument

PPC (Parallel Poll Configure) Configures the instrument for parallel poll.

SDC (Selected Device Clear) Aborts the processing of the commands just received and sets the
command processing software to a defined initial state. Does not
change the instrument setting.

14.1.4.2 SCPI Command Structure

SCPI commands consist of a so-called header and, in most cases, one or more param-
eters. The header and the parameters are separated by a "white space" (ASCII code 0
to 9, 11 to 32 decimal, e.g. blank). The headers may consist of several mnemonics (key-
words). Queries are formed by appending a question mark directly to the header.

The commands can be either device-specific or device-independent (common com-
mands). Common and device-specific commands differ in their syntax.

Syntax for Common Commands

Common (=device-independent) commands consist of a header preceded by an asterisk
(*) and possibly one or more parameters.

Examples:

*RST RESET Resets the instrument.

*ESE EVENT STATUS ENABLE Sets the bits of the event status enable
registers.

*ESR? EVENT STATUS QUERY Queries the contents of the event status
register.

*IDN? IDENTIFICATION QUERY Queries the instrument identification
string.
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Syntax for Device-Specific Commands

Not all commands used in the following examples are necessarily implemented in the
instrument.
For demonstration purposes only, assume the existence of the following commands for
this section:
● DISPlay[:WINDow<1...4>]:MAXimize <Boolean>
● FORMat:READings:DATA <type>[,<length>]
● HardCOPy:DEVice:COLor <Boolean>
● HardCOPy:DEVice:CMAP:COLor:RGB <red>,<green>,<blue>
● HardCOPy[:IMMediate]
● HardCOPy:ITEM:ALL
● HardCOPy:ITEM:LABel <string>
● HardCOPy:PAGE:DIMensions:QUADrant[<N>]
● HardCOPy:PAGE:ORIentation LANDscape | PORTrait
● HardCOPy:PAGE:SCALe <numeric value>
● MMEMory:COPY <file_source>,<file_destination>
● SENSE:BANDwidth|BWIDth[:RESolution] <numeric_value>
● SENSe:FREQuency:STOP <numeric value>
● SENSe:LIST:FREQuency <numeric_value>{,<numeric_value>}

Long and short form

The mnemonics feature a long form and a short form. The short form is marked by upper
case letters, the long form corresponds to the complete word. Either the short form or the
long form can be entered; other abbreviations are not permitted.

Example: 
HardCOPy:DEVice:COLor ON is equivalent to HCOP:DEV:COL ON.

Case-insensitivity
Upper case and lower case notation only serves to distinguish the two forms in the man-
ual, the instrument itself is case-insensitive.

Numeric suffixes

If a command can be applied to multiple instances of an object, e.g. specific channels or
sources, the required instances can be specified by a suffix added to the command.
Numeric suffixes are indicated by angular brackets (<1...4>, <n>, <i>) and are replaced
by a single value in the command. Entries without a suffix are interpreted as having the
suffix 1.
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Example: 
Definition: HardCOPy:PAGE:DIMensions:QUADrant[<N>]
Command: HCOP:PAGE:DIM:QUAD2
This command refers to the quadrant 2.

Different numbering in remote control
For remote control, the suffix may differ from the number of the corresponding selection
used in manual operation. SCPI prescribes that suffix counting starts with 1. Suffix 1 is
the default state and used when no specific suffix is specified.

Optional mnemonics

Some command systems permit certain mnemonics to be inserted into the header or
omitted. These mnemonics are marked by square brackets in the description. The instru-
ment must recognize the long command to comply with the SCPI standard. Some com-
mands are considerably shortened by these optional mnemonics.

Example: 
Definition: HardCOPy[:IMMediate]
Command: HCOP:IMM is equivalent to HCOP

Optional mnemonics with numeric suffixes
Do not omit an optional mnemonic if it includes a numeric suffix that is relevant for the
effect of the command.
Example:
Definition:DISPlay[:WINDow<1...4>]:MAXimize <Boolean>
Command: DISP:MAX ON refers to window 1.

In order to refer to a window other than 1, you must include the optional WINDow param-
eter with the suffix for the required window.
DISP:WIND2:MAX ON refers to window 2.

Parameters

Parameters must be separated from the header by a "white space". If several parameters
are specified in a command, they are separated by a comma (,). For a description of the
parameter types, refer to ​"SCPI Parameters" on page 244.

Example: 
Definition:HardCOPy:DEVice:CMAP:COLor:RGB <red>,<green>,<blue>
Command:HCOP:DEV:CMAP:COL:RGB 3,32,44
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Special characters

| Parameters

A vertical stroke in parameter definitions indicates alternative possibilities in the sense of "or". The effect
of the command differs, depending on which parameter is used.

Example:

Definition:HardCOPy:PAGE:ORIentation LANDscape | PORTrait
Command HCOP:PAGE:ORI LAND specifies landscape orientation

Command HCOP:PAGE:ORI PORT specifies portrait orientation

Mnemonics

A selection of mnemonics with an identical effect exists for several commands. These mnemonics are
indicated in the same line; they are separated by a vertical stroke. Only one of these mnemonics needs
to be included in the header of the command. The effect of the command is independent of which of the
mnemonics is used.

Example:

DefinitionSENSE:BANDwidth|BWIDth[:RESolution] <numeric_value>
The two following commands with identical meaning can be created:

SENS:BAND:RES 1
SENS:BWID:RES 1

[ ] mnemonics in square brackets are optional and may be inserted into the header or omitted.

Example: HardCOPy[:IMMediate]
HCOP:IMM is equivalent to HCOP

{ } Parameters in curly brackets are optional and can be inserted once or several times, or omitted.

Example: SENSe:LIST:FREQuency <numeric_value>{,<numeric_value>}
The following are valid commands:

SENS:LIST:FREQ 10
SENS:LIST:FREQ 10,20
SENS:LIST:FREQ 10,20,30,40

SCPI Parameters

Many commands are supplemented by a parameter or a list of parameters. The param-
eters must be separated from the header by a "white space" (ASCII code 0 to 9, 11 to 32
decimal, e.g. blank). Allowed parameters are:

● Numeric values
● Special numeric values
● Boolean parameters
● Text
● Character strings
● Block data

The parameters required for each command and the allowed range of values are speci-
fied in the command description.
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Numeric values

Numeric values can be entered in any form, i.e. with sign, decimal point and exponent.
Values exceeding the resolution of the instrument are rounded up or down. The mantissa
may comprise up to 255 characters, the exponent must lie inside the value range -32000
to 32000. The exponent is introduced by an "E" or "e". Entry of the exponent alone is not
allowed. In the case of physical quantities, the unit can be entered. Allowed unit prefixes
are G (giga), MA (mega), MOHM and MHZ are also allowed), K (kilo), M (milli), U (micro)
and N (nano). If the unit is missing, the basic unit is used.

Example: SENSe:FREQ:STOP 1.5GHz = SENSe:FREQ:STOP 1.5E9

Units

For physical quantities, the unit can be entered. Allowed unit prefixes are:

● G (giga)
● MA (mega), MOHM, MHZ
● K (kilo)
● M (milli)
● U (micro)
● N (nano)

If the unit is missing, the basic unit is used.

Example: 
SENSe:FREQ:STOP 1.5GHz = SENSe:FREQ:STOP 1.5E9

Some settings allow relative values to be stated in percent. According to SCPI, this unit
is represented by the PCT string.

Example: 
HCOP:PAGE:SCAL 90PCT

Special numeric values

The texts listed below are interpreted as special numeric values. In the case of a query,
the numeric value is provided.

● MIN/MAX
MINimum and MAXimum denote the minimum and maximum value.

Example: 
Setting command: SENSe:LIST:FREQ MAXimum
Query: SENS:LIST:FREQ?, Response: 3.5E9
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Queries for special numeric values
The numeric values associated to MAXimum/MINimum can be queried by adding the
corresponding mnemonics to the command. They must be entered following the quota-
tion mark.
Example: SENSe:LIST:FREQ? MAXimum
Returns the maximum numeric value as a result.

Boolean Parameters

Boolean parameters represent two states. The "ON" state (logically true) is represented
by "ON" or a numeric value 1. The "OFF" state (logically untrue) is represented by
"OFF" or the numeric value 0. The numeric values are provided as the response for a
query.

Example: 
Setting command: HCOPy:DEV:COL ON
Query: HCOPy:DEV:COL?
Response: 1

Text parameters

Text parameters observe the syntactic rules for mnemonics, i.e. they can be entered
using a short or long form. Like any parameter, they have to be separated from the header
by a white space. In the case of a query, the short form of the text is provided.

Example: 
Setting command: HardCOPy:PAGE:ORIentation LANDscape
Query: HCOP:PAGE:ORI?
Response: LAND

Character strings

Strings must always be entered in quotation marks (' or ").

Example: 
HCOP:ITEM:LABel "Test1" or HCOP:ITEM:LABel 'Test1'

Block data

Block data is a format which is suitable for the transmission of large amounts of data. A
command using a block data parameter has the following structure:
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Example: 
FORMat:READings:DATA  #45168xxxxxxxx
The ASCII character # introduces the data block. The next number indicates how many
of the following digits describe the length of the data block. In the example the 4 following
digits indicate the length to be 5168 bytes. The data bytes follow. During the transmission
of these data bytes all end or other control signs are ignored until all bytes are transmitted.
#0 specifies a data block of indefinite length. The use of the indefinite format requires a
NL^END message to terminate the data block. This format is useful when the length of
the transmission is not known or if speed or other considerations prevent segmentation
of the data into blocks of definite length.

Overview of Syntax Elements

The following table provides an overview of the syntax elements:

: The colon separates the mnemonics of a command. In a command line the separating semicolon
marks the uppermost command level.

; The semicolon separates two commands of a command line. It does not alter the path.

, The comma separates several parameters of a command.

? The question mark forms a query.

* The asterisk marks a common command.

" Quotation marks introduce a string and terminate it.

# The hash symbol introduces binary, octal, hexadecimal and block data.
● Binary: #B10110
● Octal: #O7612
● Hexa: #HF3A7
● Block: #21312

A "white space" (ASCII-Code 0 to 9, 11 to 32 decimal, e.g. blank) separates the header from the
parameters.

Structure of a command line

A command line may consist of one or several commands. It is terminated by one of the
following:

● a <New Line>
● a <New Line> with EOI
● an EOI together with the last data byte

Several commands in a command line must be separated by a semicolon ";". If the next
command belongs to a different command system, the semicolon is followed by a colon.

Example: 
MMEM:COPY "Test1","MeasurementXY";:HCOP:ITEM ALL
This command line contains two commands. The first command belongs to the MMEM
system, the second command belongs to the HCOP system.
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If the successive commands belong to the same system, having one or several levels in
common, the command line can be abbreviated. To this end, the second command after
the semicolon starts with the level that lies below the common levels. The colon following
the semicolon must be omitted in this case.

Example: 
HCOP:ITEM ALL; HCOP:IMM
This command line is represented in its full length and contains two commands separated
from each other by the semicolon. Both commands are part of the HCOP command sys-
tem, i.e. they have one level in common.
When abbreviating the command line, the second command begins with the level below
HCOP. The colon after the semicolon is omitted. The abbreviated form of the command
line reads as follows:
HCOP:ITEM ALL;IMM

However, a new command line always begins with the complete path.

Example: 
HCOP:ITEM ALL
HCOP:IMM

Responses to Queries

A query is defined for each setting command unless explicitly specified otherwise. It is
formed by adding a question mark to the associated setting command. According to
SCPI, the responses to queries are partly subject to stricter rules than in standard IEEE
488.2.

● The requested parameter is transmitted without a header.
Example: HCOP:PAGE:ORI?, Response: LAND

● Maximum values, minimum values and all other quantities that are requested via a
special text parameter are returned as numeric values.
Example: SENSe:FREQuency:STOP? MAX, Response: 3.5E9

● Numeric values are output without a unit. Physical quantities are referred to the basic
units or to the units set using the Unit command. The response 3.5E9 in the pre-
vious example stands for 3.5 GHz.

● Truth values (Boolean values) are returned as 0 (for OFF) and 1 (for ON).
Example:
Setting command: HCOPy:DEV:COL ON
Query: HCOPy:DEV:COL?
Response: 1

● Text (character data) is returned in a short form.
Example:
Setting command: HardCOPy:PAGE:ORIentation LANDscape
Query: HCOP:PAGE:ORI?
Response: LAND
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14.1.5 Command Sequence and Synchronization

IEEE 488.2 defines a distinction between overlapped and sequential commands:

● A sequential command is one which finishes executing before the next command
starts executing. Commands that are processed quickly are usually implemented as
sequential commands.

● An overlapping command is one which does not automatically finish executing before
the next command starts executing. Usually, overlapping commands take longer to
process and allow the program to do other tasks while being executed. If overlapping
commands do have to be executed in a defined order, e.g. in order to avoid wrong
measurement results, they must be serviced sequentially. This is called synchroni-
zation between the controller and the instrument.

Setting commands within one command line, even though they may be implemented as
sequential commands, are not necessarily serviced in the order in which they have been
received. In order to make sure that commands are actually carried out in a certain order,
each command must be sent in a separate command line.

Example: Commands and queries in one message
The response to a query combined in a program message with commands that affect the
queried value is not predictable.
The following commands always return the specified result:
:FREQ:STAR 1GHZ;SPAN 100 :FREQ:STAR?
Result:
1000000000 (1 GHz)

Whereas the result for the following commands is not specified by SCPI:
:FREQ:STAR 1GHz;STAR?;SPAN 1000000
The result could be the value of STARt before the command was sent since the instru-
ment might defer executing the individual commands until a program message terminator
is received. The result could also be 1 GHz if the instrument executes commands as they
are received.

As a general rule, send commands and queries in different program messages.
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Example: Overlapping command with *OPC
The instrument implements SINGle as an overlapped (asynchronous) command.
Assuming that SINGle takes longer to execute than *OPC, sending the following com-
mand sequence results in initiating a sweep and, after some time, setting the OPC bit in
the ESR:
SINGle; *OPC.
Sending the following commands still initiates a sweep:
SINGle; *OPC; *CLS
However, since the operation is still pending when the instrument executes *CLS, forcing
it into the "Operation Complete Command Idle" State (OCIS), *OPC is effectively skipped.
The OPC bit is not set until the instrument executes another *OPC command.

14.1.5.1 Preventing Overlapping Execution

To prevent an overlapping execution of commands, one of the commands *OPC, *OPC?
or *WAI can be used. All three commands cause a certain action only to be carried out
after the hardware has been set. By suitable programming, the controller can be forced
to wait for the corresponding action to occur.

Table 14-2: Synchronization using *OPC, *OPC? and *WAI

Com-
mand

Action Programming the controller

*OPC Sets the Operation Complete bit in the ESR
after all previous commands have been execu-
ted.

● Setting bit 0 in the ESE
● Setting bit 5 in the SRE
● Waiting for service request (SRQ)

*OPC? Stops command processing until 1 is returned.
This is only the case after the Operation Com-
plete bit has been set in the ESR. This bit indi-
cates that the previous setting has been com-
pleted.

Sending *OPC? directly after the command
whose processing should be terminated before
other commands can be executed.

*WAI Stops further command processing until all
commands sent before *WAI have been exe-
cuted.

Sending *WAI directly after the command
whose processing should be terminated before
other commands are executed.

Command synchronization using *WAI or *OPC? appended to an overlapped command
is a good choice if the overlapped command takes only little time to process. The two
synchronization techniques simply block overlapped execution of the command.

For time consuming overlapped commands it is usually desirable to allow the controller
or the instrument to do other useful work while waiting for command execution. Use one
of the following methods:

*OPC with a service request

1. Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

2. Set bit no. 5 in the SRE: *SRE 32 to enable ESB service request.

3. Send the overlapped command with *OPC
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4. Wait for a service request

The service request indicates that the overlapped command has finished.

*OPC? with a service request

1. Set bit no. 4 in the SRE: *SRE 16 to enable MAV service request.

2. Send the overlapped command with *OPC?

3. Wait for a service request

The service request indicates that the overlapped command has finished.

Event Status Register (ESE)

1. Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

2. Send the overlapped command without *OPC, *OPC? or *WAI

3. Poll the operation complete state periodically (by means of a timer) using the
sequence: *OPC; *ESR?

A return value (LSB) of 1 indicates that the overlapped command has finished.

*OPC? with short timeout

1. Send the overlapped command without *OPC, *OPC? or *WAI

2. Poll the operation complete state periodically (by means of a timer) using the
sequence: <short timeout>; *OPC?

3. A return value (LSB) of 1 indicates that the overlapped command has finished. In
case of a timeout, the operation is ongoing.

4. Reset timeout to former value

5. Clear the error queue with SYStem:ERRor? to remove the "-410, Query interrupted"
entries.

Using several threads in the controller application

As an alternative, provided the programming environment of the controller application
supports threads, separate threads can be used for the application GUI and for controlling
the instrument(s) via SCPI.

A thread waiting for a *OPC? thus will not block the GUI or the communication with other
instruments.

14.1.6 Status Reporting System

The status reporting system stores all information on the current operating state of the
instrument, and on errors which have occurred. This information is stored in the status
registers and in the error queue. Both can be queried via GPIB bus or LAN interface
(STATus... commands).
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14.1.6.1 Structure of a SCPI Status Register

Each standard SCPI register consists of 5 parts. Each part has a width of 16 bits and has
different functions. The individual bits are independent of each other, i.e. each hardware
status is assigned a bit number which is valid for all five parts. Bit 15 (the most significant
bit) is set to zero for all parts. Thus the contents of the register parts can be processed
by the controller as positive integers.

Fig. 14-1: The status-register model

Description of the five status register parts

The five parts of a SCPI register have different properties and functions:

● CONDition
The CONDition part is written into directly by the hardware or the sum bit of the next
lower register. Its contents reflect the current instrument status. This register part can
only be read, but not written into or cleared. Its contents are not affected by reading.

● PTRansition / NTRansition
The two transition register parts define which state transition of the CONDition part
(none, 0 to 1, 1 to 0 or both) is stored in the EVENt part.
The Positive-TRansition part acts as a transition filter. When a bit of the
CONDition part is changed from 0 to 1, the associated PTR bit decides whether the
EVENt bit is set to 1.
– PTR bit =1: the EVENt bit is set.

– PTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.
The Negative-TRansition part also acts as a transition filter. When a bit of the
CONDition part is changed from 1 to 0, the associated NTR bit decides whether the
EVENt bit is set to 1.
– NTR bit =1: the EVENt bit is set.

– NTR bit =0: the EVENt bit is not set.
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This part can be written into and read as required. Its contents are not affected by
reading.

● EVENt
The EVENt part indicates whether an event has occurred since the last reading, it is
the "memory" of the condition part. It only indicates events passed on by the transition
filters. It is permanently updated by the instrument. This part can only be read by the
user. Reading the register clears it. This part is often equated with the entire register.

● ENABle
The ENABle part determines whether the associated EVENt bit contributes to the
sum bit (see below). Each bit of the EVENt part is "ANDed" with the associated
ENABle bit (symbol '&'). The results of all logical operations of this part are passed
on to the sum bit via an "OR" function (symbol '+').
ENABle bit = 0: the associated EVENt bit does not contribute to the sum bit
ENABle bit = 1: if the associated EVENt bit is "1", the sum bit is set to "1" as well.
This part can be written into and read by the user as required. Its contents are not
affected by reading.

Sum bit

The sum bit is obtained from the EVENt and ENABle part for each register. The result is
then entered into a bit of the CONDition part of the higher-order register.

The instrument automatically generates the sum bit for each register. Thus an event can
lead to a service request throughout all levels of the hierarchy.

14.1.6.2 Hierarchy of status registers

As shown in the following figure, the status information is of hierarchical structure.
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Fig. 14-2: Overview of the status registers hierarchy

● STB, SRE
The STatus Byte (STB) register and its associated mask register Service Request
Enable (SRE) form the highest level of the status reporting system. The STB provides
a rough overview of the instrument status, collecting the information of the lower-level
registers.

● ESR, SCPI registers
The STB receives its information from the following registers:
– The Event Status Register (ESR) with the associated mask register standard

Event Status Enable (ESE).

– The STATus:OPERation and STATus:QUEStionable registers which are
defined by SCPI and contain detailed information on the instrument.

● Output buffer
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The output buffer contains the messages the instrument returns to the controller. It
is not part of the status reporting system but determines the value of the MAV bit in
the STB and thus is represented in the overview.

All status registers have the same internal structure.

SRE, ESE
The service request enable register SRE can be used as ENABle part of the STB if the
STB is structured according to SCPI. By analogy, the ESE can be used as the ENABle
part of the ESR.

14.1.6.3 Contents of the Status Registers

In the following sections, the contents of the status registers are described in more detail.

Status Byte (STB) and Service Request Enable Register (SRE)

The STatus Byte (STB) is already defined in IEEE 488.2. It provides a rough overview
of the instrument status by collecting the pieces of information of the lower registers. A
special feature is that bit 6 acts as the sum bit of the remaining bits of the status byte.

The STB can thus be compared with the CONDition part of an SCPI register and
assumes the highest level within the SCPI hierarchy.

The STB is read using the command ​*STB?​ or a serial poll.

The STatus Byte (STB) is linked to the Service Request Enable (SRE) register.
Each bit of the STB is assigned a bit in the SRE. Bit 6 of the SRE is ignored. If a bit is set
in the SRE and the associated bit in the STB changes from 0 to 1, a service request
(SRQ) is generated. The SRE can be set using the command ​*SRE ​ and read using the
command *SRE?.

Table 14-3: Meaning of the bits used in the status byte

Bit No. Meaning

0...1 Not used

2 Error Queue not empty

The bit is set when an entry is made in the error queue. If this bit is enabled by the SRE, each
entry of the error queue generates a service request. Thus an error can be recognized and speci-
fied in greater detail by polling the error queue. The poll provides an informative error message.
This procedure is to be recommended since it considerably reduces the problems involved with
remote control.

3 QUEStionable status register summary bit

The bit is set if an EVENt bit is set in the QUEStionable status register and the associated
ENABle bit is set to 1. A set bit indicates a questionable instrument status, which can be specified
in greater detail by querying the STATus:QUEStionable status register.

4 MAV bit (message available)

The bit is set if a message is available in the output queue which can be read. This bit can be used
to enable data to be automatically read from the instrument to the controller.
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Bit No. Meaning

5 ESB bit

Sum bit of the event status register. It is set if one of the bits in the event status register is set and
enabled in the event status enable register. Setting of this bit indicates a serious error which can
be specified in greater detail by polling the event status register.

6 MSS bit (master status summary bit)

The bit is set if the instrument triggers a service request. This is the case if one of the other bits of
this registers is set together with its mask bit in the service request enable register SRE.

7 STATus:OPERation status register summary bit

The bit is set if an EVENt bit is set in the OPERation status register and the associated
ENABle bit is set to 1. A set bit indicates that the instrument is just performing an action. The type
of action can be determined by querying the STATus:OPERation status register.

Event Status Register (ESR) and Event Status Enable Register (ESE)

The ESR is defined in IEEE 488.2. It can be compared with the EVENt part of a SCPI
register. The event status register can be read out using command ​*ESR?.

The ESE corresponds to the ENABle part of a SCPI register. If a bit is set in the ESE and
the associated bit in the ESR changes from 0 to 1, the ESB bit in the STB is set. The ESE
register can be set using the command ​*ESE ​ and read using the command *ESE?.

Table 14-4: Meaning of the bits used in the event status register

Bit No. Meaning

0 Operation Complete

This bit is set on receipt of the command *OPC exactly when all previous commands have been
executed.

1 Not used

2 Query Error

This bit is set if either the controller wants to read data from the instrument without having sent a
query, or if it does not fetch requested data and sends new instructions to the instrument instead.
The cause is often a query which is faulty and hence cannot be executed.

3 Device-dependent Error

This bit is set if a device-dependent error occurs. An error message with a number between -300
and -399 or a positive error number, which denotes the error in greater detail, is entered into the
error queue.

4 Execution Error

This bit is set if a received command is syntactically correct but cannot be performed for other
reasons. An error message with a number between -200 and -300, which denotes the error in
greater detail, is entered into the error queue.

5 Command Error

This bit is set if a command is received, which is undefined or syntactically incorrect. An error
message with a number between -100 and -200, which denotes the error in greater detail, is
entered into the error queue.
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Bit No. Meaning

6 User Request

This bit is set when the instrument is switched over to manual control.

7 Power On (supply voltage on)

This bit is set on switching on the instrument.

STATus:OPERation Register

In the CONDition part, this register contains information on which actions the instrument
is being executing. In the EVENt part, it contains information on which actions the instru-
ment has executed since the last reading. It can be read using the commands
STATus:OPERation:CONDition? or STATus:OPERation[:EVENt]?.

See also: ​figure 14-2

The remote commands for the STATus:OPERation register are described in ​chap-
ter 14.2.16.1, "STATus:OPERation Register", on page 426.

Table 14-5: Bits in the STATus:OPERation register

Bit No. Meaning

0 ALIGnment
This bit is set as long as the instrument is performing a self alignment.

1 SELFtest
This bit is set while the selftest is running.

2 AUToset
This bit is set while the instrument is performing an auto setup.

3 WTRIgger
This bit is set while the instrument is waiting for the trigger.

4 to 14 Not used

15 This bit is always 0.

STATus:QUEStionable Register

This register contains information about indefinite states which may occur if the unit is
operated without meeting the specifications. It can be read using the commands ​
STATus: ​QUEStionable: ​CONDition? ​ on page 428 and ​STATus: ​
QUEStionable[: ​EVENt]? ​ on page 429

Basics



Remote ControlR&S®RTM

258User Manual 1305.0595.02 ─ 08

Fig. 14-3: Overview of the STATus:QUEStionable register

Table 14-6: Bits in the STATus:QUEStionable register

Bit No. Meaning

0 to 2 not used

3 COVerload
This bit is set if a questionable channel overload occurs (see ​"STATus:QUEStionable:COVerload
register" on page 259).

4 TEMPerature
This bit is set if a questionable temperature occurs (see ​"STATus:QUEStionable:TEMPerature
register" on page 259).

5 to 7 Not used
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Bit No. Meaning

8 NOALigndata
This bit is set if no alignment data is available - the instrument is uncalibrated.

9 LIMit
This bit is set if a limit value is violated (see ​"STATus:QUEStionable:LIMit register"
on page 259).

10 to 11 Not used

12 MASK
This bit is set if a mask value is violated (see ​"STATus:QUEStionable:MASK register"
on page 260

13 to 14 Not used

15 This bit is always 0.

STATus:QUEStionable:COVerload register

This register contains all information about overload of the channels. The bit is set if the
assigned channel is overloaded.

Table 14-7: Bits in the STATus:QUEStionable:COVerload register

Bit No. Meaning

0 CHANnel1

1 CHANnel2

2 CHANnel3

3 CHANnel4

STATus:QUEStionable:TEMPerature register

This register contains information about the instrument's temperature.

Table 14-8: Bits in the STATus:QUEStionable:TEMPerature register

Bit No. Meaning

0 TEMP WARN
This bit is set if a temperature warning on channel 1, 2, 3 or 4 occured.

1 TEMP ERRor
This bit is set if a temperature error on channel 1, 2, 3 or 4 occured.

STATus:QUEStionable:LIMit register

This register contains information about the observance of the limits of measurements.
This bit is set if the limits of the main or additional measurement of the assigned mea-
surement are violated.
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Table 14-9: Bits in the STATus:QUEStionable:LIMit register

Bit No. Meaning

0 MEAS1

1 MEAS2

2 MEAS3

3 MEAS4

STATus:QUEStionable:MASK register

This register contains information about the violation of masks. This bit is set if the
assigned mask is violated.

Table 14-10: Bits in the STATus:QUEStionable:MASK register

Bit No. Meaning

0 MASK1

14.1.6.4 Application of the Status Reporting System

The purpose of the status reporting system is to monitor the status of one or several
devices in a measuring system. To do this and react appropriately, the controller must
receive and evaluate the information of all devices. The following standard methods are
used:

● Service request (SRQ) initiated by the instrument
● Serial poll of all devices in the bus system, initiated by the controller in order to find

out who sent a SRQ and why
● Parallel poll of all devices
● Query of a specific instrument status by means of commands
● Query of the error queue

Service Request

Under certain circumstances, the instrument can send a service request (SRQ) to the
controller. Usually this service request initiates an interrupt at the controller, to which the
control program can react appropriately. As evident from ​figure 14-2, an SRQ is always
initiated if one or several of bits 2, 3, 4, 5 or 7 of the status byte are set and enabled in
the SRE. Each of these bits combines the information of a further register, the error queue
or the output buffer. The ENABle parts of the status registers can be set such that arbitrary
bits in an arbitrary status register initiate an SRQ. In order to make use of the possibilities
of the service request effectively, all bits should be set to "1" in enable registers SRE and
ESE.

The SRQ is the only possibility for the instrument to become active on its own. Each
controller program should cause the instrument to initiate a service request if errors occur.
The program should react appropriately to the service request.
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Serial Poll

In a serial poll, just as with command *STB, the status byte of an instrument is queried.
However, the query is realized via interface messages and is thus clearly faster.

The serial poll method is defined in IEEE 488.1 and used to be the only standard possi-
bility for different instruments to poll the status byte. The method also works for instru-
ments which do not adhere to SCPI or IEEE 488.2.

The serial poll is mainly used to obtain a fast overview of the state of several instruments
connected to the controller.

Query of an instrument status

Each part of any status register can be read using queries. There are two types of com-
mands:

● The common commands *ESR?, *IDN?, *IST?, *STB? query the higher-level reg-
isters.

● The commands of the STATus system query the SCPI registers
(STATus:QUEStionable...)

The returned value is always a decimal number that represents the bit pattern of the
queried register. This number is evaluated by the controller program.

Queries are usually used after an SRQ in order to obtain more detailed information on
the cause of the SRQ.

Decimal representation of a bit pattern

The STB and ESR registers contain 8 bits, the SCPI registers 16 bits. The contents of a
status register are specified and transferred as a single decimal number. To make this
possible, each bit is assigned a weighted value. The decimal number is calculated as the
sum of the weighted values of all bits in the register that are set to 1.

Example: 
The decimal value 40 = 32 + 8 indicates that bits no. 3 and 5 in the status register (e.g.
the QUEStionable status summary bit and the ESB bit in the STatus Byte ) are set.

Error Queue

Each error state in the instrument leads to an entry in the error queue. The entries of the
error queue are detailed plain text error messages that can be looked up in the Error Log
or queried via remote control using SYSTem:ERRor[:NEXT]? or
SYSTem:ERRor:ALL?. Each call of SYSTem:ERRor[:NEXT]? provides one entry from
the error queue. If no error messages are stored there any more, the instrument responds
with 0, "No error".
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The error queue should be queried after every SRQ in the controller program as the
entries describe the cause of an error more precisely than the status registers. Especially
in the test phase of a controller program the error queue should be queried regularly since
faulty commands from the controller to the instrument are recorded there as well.

14.1.6.5 Reset Values of the Status Reporting System

The following table contains the different commands and events causing the status
reporting system to be reset. None of the commands, except *RST and
SYSTem:PRESet, influence the functional instrument settings. In particular, DCL does
not change the instrument settings.

Table 14-11: Resest of the status reporting system

Event Switching on supply
voltage

Power-On-Status-
Clear

DCL, SDC

(Device
Clear,
Selected
Device
Clear)

*RST or
SYS-
Tem:PRE-
Set

STA-
Tus:PRE-
Set

*CLS

Effect 0 1

Clear STB, ESR - yes - - - yes

Clear SRE, ESE - yes - - - -

Clear EVENt parts of the regis-
ters

- yes - - - yes

Clear ENABle parts of all
OPERation and QUEStionable
registers;

Fill ENABle parts of all other reg-
isters with "1".

- yes - - yes -

Fill PTRansition parts with "1";

Clear NTRansition parts

- yes - - yes -

Clear error queue yes yes - - - yes

Clear output buffer yes yes yes 1) 1) 1)

Clear command processing and
input buffer

yes yes yes - - -

1) The first command in a command line that immediately follows a <PROGRAM MESSAGE TERMINATOR>
clears the output buffer.

14.1.7 General Programming Recommendations

Initial instrument status before changing settings

Manual operation is designed for maximum possible operating convenience. In contrast,
the priority of remote control is the "predictability" of the instrument status. Thus, when a
command attempts to define incompatible settings, the command is ignored and the
instrument status remains unchanged, i.e. other settings are not automatically adapted.
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Therefore, control programs should always define an initial instrument status (e.g. using
the *RST command) and then implement the required settings.

Command sequence

As a general rule, send commands and queries in different program messages. Other-
wise, the result of the query may vary depending on which operation is performed first
(see also Preventing Overlapping Execution).

Reacting to malfunctions

The service request is the only possibility for the instrument to become active on its own.
Each controller program should instruct the instrument to initiate a service request in case
of malfunction. The program should react appropriately to the service request.

Error queues

The error queue should be queried after every service request in the controller program
as the entries describe the cause of an error more precisely than the status registers.
Especially in the test phase of a controller program the error queue should be queried
regularly since faulty commands from the controller to the instrument are recorded there
as well.

14.2 Command Reference

This chapter provides the description of all remote commands available for R&S RTM.
The commands are sorted according to the menu structure of the instrument. A list of
commands in alphabetical order ist given in the "List of Commands" at the end of this
documentation.

14.2.1 Conventions used in Remote Command Description

Note the following conventions used in the remote command descriptions:
● Command usage

If not specified otherwise, commands can be used both for setting and for querying
parameters.
If a command can be used for setting or querying only, or if it initiates an event, the
usage is stated explicitely.

● Parameter usage
If not specified otherwise, a parameter can be used to set a value and it is the result
of a query.
Parameters required only for setting are indicated as Setting parameters.
Parameters required only to refine a query are indicated as Query parameters.
Parameters that are only returned as the result of a query are indicated as Return
values.

● Conformity
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Commands that are taken from the SCPI standard are indicated as SCPI con-
firmed. All commands used by the R&S RTM follow the SCPI syntax rules.

● Asynchronous commands
A command which does not automatically finish executing before the next command
starts executing (overlapping command) is indicated as an Asynchronous com-
mand.

● Reset values (*RST)
Default parameter values that are used directly after resetting the instrument (*RST
command) are indicated as *RST values, if available.

14.2.2 Common Commands

Common commands are described in the IEEE 488.2 (IEC 625-2) standard. These com-
mands have the same effect and are employed in the same way on different devices.
The headers of these commands consist of "*" followed by three letters. Many common
commands are related to the Status Reporting System.

Available common commands:

*CAL? ​...........................................................................................................................264
*CLS ​.............................................................................................................................264
*ESE ​.............................................................................................................................265
*ESR? ​...........................................................................................................................265
*IDN? ​............................................................................................................................265
*OPC ​............................................................................................................................265
*OPT? ​...........................................................................................................................265
*PSC ​............................................................................................................................266
*RST ​.............................................................................................................................266
*SRE ​............................................................................................................................266
*STB? ​...........................................................................................................................266
*TRG​............................................................................................................................267
*TST? ​...........................................................................................................................267
*WAI ​.............................................................................................................................267

*CAL?

Calibration Query

Initiates a calibration of the instrument and subsequently queries the calibration status.
Responses > 0 indicate errors.

Usage: Query only

*CLS

CLear Status

Sets the status byte (STB), the standard event register (ESR) and the EVENt part of the
QUEStionable and the OPERation registers to zero. The command does not alter the
mask and transition parts of the registers. It clears the output buffer.
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Usage: Setting only

*ESE <Value>

Event Status Enable

Sets the event status enable register to the specified value. The query returns the con-
tents of the event status enable register in decimal form.

Parameters:
<Value> Range: 0 to 255

*ESR?

Event Status Read

Returns the contents of the event status register in decimal form and subsequently sets
the register to zero.

Return values: 
<Contents> Range: 0  to  255

Usage: Query only

*IDN?

IDeNtification: returns the instrument identification.

Return values: 
<ID> "Rohde&Schwarz,<device type>,<serial number>,<firmware ver-

sion>"

Example: Rohde&Schwarz,RTO,1316.1000k14/200153,1.30.0.25
Usage: Query only

*OPC

OPeration Complete

Sets bit 0 in the event status register when all preceding commands have been executed.
This bit can be used to initiate a service request. The query form writes a "1" into the
output buffer as soon as all preceding commands have been executed. This is used for
command synchronization.

*OPT?

OPTion identification query

Queries the options included in the instrument. For a list of all available options and their
description refer to the CD-ROM.

Command Reference



Remote ControlR&S®RTM

266User Manual 1305.0595.02 ─ 08

Return values: 
<Options> The query returns a list of options. The options are returned at

fixed positions in a comma-separated string. A zero is returned for
options that are not installed.

Usage: Query only

*PSC <Action>

Power on Status Clear

Determines whether the contents of the ENABle registers are preserved or reset when
the instrument is switched on. Thus a service request can be triggered when the instru-
ment is switched on, if the status registers ESE and SRE are suitably configured. The
query reads out the contents of the "power-on-status-clear" flag.

Parameters:
<Action> 0 | 1

0
The contents of the status registers are preserved.
1
Resets the status registers.

*RST

ReSeT

Sets the instrument to a defined default status. The default settings are indicated in the
description of commands.

Usage: Setting only

*SRE <Contents>

Service Request Enable

Sets the service request enable register to the indicated value. This command determines
under which conditions a service request is triggered.

Parameters:
<Contents> Contents of the service request enable register in decimal form.

Bit 6 (MSS mask bit) is always 0.
Range: 0  to  255

*STB?

STatus Byte query

Reads the contents of the status byte in decimal form.

Usage: Query only
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*TRG

TRiGger

Triggers all actions waiting for a trigger event. In particular, *TRG generates a manual
trigger signal (Manual Trigger). This common command complements the commands of
the TRIGger subsystem.

Usage: Event

*TST?

self TeST query

Triggers selftests of the instrument and returns an error code in decimal form (see Service
Manual supplied with the instrument). "0" indicates no errors occured.

Usage: Query only

*WAI

WAIt to continue

Prevents servicing of the subsequent commands until all preceding commands have
been executed and all signals have settled (see also command synchronization and ​
*OPC ​).

Usage: Event

14.2.3 General Remote Settings and Queries

This chapter describes commands that have effect on many other commands in different
applications of the instrument.

FORMat[:​DATA] ​.............................................................................................................268
FORMat: ​BORDer ​...........................................................................................................269
CHANnel<m>: ​DATA: ​XORigin? ​........................................................................................269
CHANnel<m>: ​DATA: ​ENVelope:​XORigin? ​........................................................................269
CALCulate: ​MATH<m>:​DATA: ​XORigin? ​............................................................................269
REFCurve<m>: ​DATA:​XORigin? ​......................................................................................269
CHANnel<m>: ​DATA: ​XINCrement?​..................................................................................270
CHANnel<m>: ​DATA: ​ENVelope:​XINCrement? ​...................................................................270
CALCulate: ​MATH<m>:​DATA: ​XINCrement? ​......................................................................270
REFCurve<m>: ​DATA:​XINCrement? ​.................................................................................270
CHANnel<m>: ​DATA: ​YORigin? ​........................................................................................270
CHANnel<m>: ​DATA: ​ENVelope:​YORigin? ​........................................................................270
CALCulate: ​MATH<m>:​DATA: ​YORigin? ​............................................................................270
REFCurve<m>: ​DATA:​YORigin? ​......................................................................................270
CHANnel<m>: ​DATA: ​YINCrement?​..................................................................................270
CHANnel<m>: ​DATA: ​ENVelope:​YINCrement? ​...................................................................270
CALCulate: ​MATH<m>:​DATA: ​YINCrement? ​......................................................................270
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REFCurve<m>: ​DATA:​YINCrement? ​.................................................................................270
CHANnel<m>: ​DATA: ​YRESolution? ​..................................................................................271
CHANnel<m>: ​DATA: ​ENVelope:​YRESolution? ​..................................................................271
CALCulate: ​MATH<m>:​DATA: ​YRESolution? ​.....................................................................271
REFCurve<m>: ​DATA:​YRESolution? ​................................................................................271

FORMat[:DATA] <DataFormat>,<Accuracy>

Defines the format for data export with
● ​CHANnel<m>: ​DATA? ​ on page 283

● ​CHANnel<m>: ​DATA: ​ENVelope? ​ on page 284

● ​CALCulate: ​MATH<m>: ​DATA?​ on page 332

● ​REFCurve<m>: ​DATA? ​ on page 311

Parameters:
<DataFormat> ASCii | REAL | UINTeger

ASCii
List of values, for example, 1.23,1.22,1.24,..
<Accuracy> is 0 which means that the instrument selects the num-
ber of digits to be returned. The query returns ASC,0.
REAL
Binary format. <Accuracy> is 32. The query returns REAL,32.
The data is stored as binary data (Definite Length Block Data
according to IEEE 488.2). Each waveform value is formatted in 32
Bit IEEE 754 Floating-Point-Format.
The schema of the result string is as follows:
#41024<value1><value2>…<value n> with:
#4 = number of digits (= 4 in the example) of the following number
1024 = number of following data bytes (= 1024 in the example)
<value> = 4-byte floating point values

UINTeger
Unsigned integer format, binary values with length 8 bit (1 byte per
sample), 16 bit (2 bytes per sample) or 32 bit (4 bytes per sample):
UINT,8 or UINT,16 or UINT,32.
The data range for UINT,8 is 0 to 255, the data range for
UINT,16 is 0 to 65.535 and for UINT,16 is 232 - 1.
For data conversion, you need the results of following commands:
...:DATA:XORigin?; ...:DATA:XINCrement?; ..:DATA:
Yorigin?; ...:DATA:YINCrement?; ...:DATA:
YRESolution?. They are described below in this chapter. The
way of data conversion is described in ​chapter 14.3.1.2, "Reading
Waveform Data in Unsigned Integer Format", on page 431.
32 bit data is relevant for average waveforms if averaging 512 or
1024 waveforms. The resulting data is 17 bits long (512 wave-
forms) or 18 bit (1024 waveforms).
*RST: ASC
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<Accuracy> 0 | 8 | 16 | 32
Length of a data value in bit
0 - for ASC only
32 - for REAL
8 | 16 | 32 - for UINT
*RST: 0

Example: Set the ASCII data format:
FORM ASC

Example: Query for data format:
FORM?
-> ASC,0

Example: Set the unsigned integer format, 16 bit data length:
FORM UINT,16

FORMat:BORDer <ByteOrder>

Defines the byte order for binary data export if ​FORMat[: ​DATA] ​ is set to REAL or
UINT,16|32.

Parameters:
<ByteOrder> MSBFirst | LSBFirst

MSBFirst
Big endian, most significant byte first
LSBFirst
Little endian, least significant byte first
*RST: MSBF

Example: See ​chapter 14.3.1.1, "Reading Waveform Data from Memory",
on page 430

ByteOrder 8 bit 16 bit 32 bit

MSBF 0xab 0xAB CD 0xAB CD 00 00

LSBF not relevant 0xCD AB 0x00 00 CD AB

CHANnel<m>:DATA:XORigin?
CHANnel<m>:DATA:ENVelope:XORigin?
CALCulate:MATH<m>:DATA:XORigin?
REFCurve<m>:DATA:XORigin?
Return the time of the first sample of the indicated waveform.

The commands are relevant for data conversion if binary data format is defined             
( ​FORM UINT, 8|16|32).

Return values: 
<Xorigin> Time in s

Command Reference



Remote ControlR&S®RTM

270User Manual 1305.0595.02 ─ 08

Example: See ​chapter 14.3.1.2, "Reading Waveform Data in Unsigned Inte-
ger Format", on page 431

Usage: Query only

CHANnel<m>:DATA:XINCrement?
CHANnel<m>:DATA:ENVelope:XINCrement?
CALCulate:MATH<m>:DATA:XINCrement?
REFCurve<m>:DATA:XINCrement?
Return the time difference between two adjacent samples of the indicated waveform.

The commands are relevant for data conversion if binary data format is defined             
( ​FORM UINT, 8|16|32).

Return values: 
<Xincrement> Time in s

Example: See ​chapter 14.3.1.2, "Reading Waveform Data in Unsigned Inte-
ger Format", on page 431

Usage: Query only

CHANnel<m>:DATA:YORigin?
CHANnel<m>:DATA:ENVelope:YORigin?
CALCulate:MATH<m>:DATA:YORigin?
REFCurve<m>:DATA:YORigin?
Return the voltage value for binary value 0 of the indicated waveform.

The commands are relevant for data conversion if binary data format is defined             
( ​FORM UINT, 8|16|32).

Return values: 
<Yorigin> Voltage in V

Example: See ​chapter 14.3.1.2, "Reading Waveform Data in Unsigned Inte-
ger Format", on page 431

Usage: Query only

CHANnel<m>:DATA:YINCrement?
CHANnel<m>:DATA:ENVelope:YINCrement?
CALCulate:MATH<m>:DATA:YINCrement?
REFCurve<m>:DATA:YINCrement?
Return the voltage value per bit of the indicated waveform.

The commands are relevant for data conversion if binary data format is defined             
( ​FORM UINT, 8|16|32).

Return values: 
<Yincrement> Voltage in V
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Example: See ​chapter 14.3.1.2, "Reading Waveform Data in Unsigned Inte-
ger Format", on page 431

Usage: Query only

CHANnel<m>:DATA:YRESolution?
CHANnel<m>:DATA:ENVelope:YRESolution?
CALCulate:MATH<m>:DATA:YRESolution?
REFCurve<m>:DATA:YRESolution?
Return the vertical bit resolution of the indicated waveform.

The commands are relevant for data conversion if binary data format is defined             
( ​FORM UINT, 8|16|32).

Return values: 
<Yresolution> For default waveforms, the resolution is 8 bit.

If high resolution, average or filter are set for the waveform, the
resolution is 16 bit.

Example: See ​chapter 14.3.1.2, "Reading Waveform Data in Unsigned Inte-
ger Format", on page 431

Usage: Query only

14.2.4 Acquisition and Setup

● Starting and Stopping Acquisition.........................................................................271
● Time Base.............................................................................................................272
● Acquisition.............................................................................................................274
● Vertical..................................................................................................................278
● Waveform Data.....................................................................................................283
● Probes...................................................................................................................286

14.2.4.1 Starting and Stopping Acquisition

RUN​.............................................................................................................................271
RUNContinous ​...............................................................................................................272
SINGle ​..........................................................................................................................272
RUNSingle ​....................................................................................................................272
ACQuire: ​NSINgle: ​COUNt​................................................................................................272
STOP​...........................................................................................................................272

RUN

Starts the continuous acquisition.

Usage: Event
Asynchronous command
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RUNContinous

Same as RUN.

Usage: Event
Asynchronous command

SINGle

Starts a defined number of acquisitions. The number of acquisitions is set with ​
ACQuire: ​NSINgle: ​COUNt​.

Usage: Event
Asynchronous command

RUNSingle

Same as SINGle.

Usage: Event
Asynchronous command

ACQuire:NSINgle:COUNt <NSingleCount>

Sets the number of waveforms acquired with ​RUNSingle​.

Parameters:
<NSingleCount> Number of waveforms

Range: 1  to  10
Increment: 1
*RST: 1

STOP

Stops the running acquistion.

Usage: Event
Asynchronous command

14.2.4.2 Time Base

TIMebase:​SCALe ​...........................................................................................................273
TIMebase:​RATime? ​.......................................................................................................273
TIMebase:​ACQTime ​.......................................................................................................273
TIMebase:​RANGe ​..........................................................................................................273
TIMebase:​DIVisions? ​.....................................................................................................273
TIMebase:​POSition ​........................................................................................................274
TIMebase:​REFerence ​.....................................................................................................274
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TIMebase:SCALe <TimeScale>

Sets the horizontal scale for all channel and math waveforms.

Parameters:
<TimeScale> Range: 1e-9  to  50; lower limits are possible if zoom or FFT

is enabled.
Increment: 1, 2, 5 progression, for example, 1 ms/div, 2 ms/div,

5 ms/div, 10, 20, 50...
*RST: 100e-6
Default unit: s/div

TIMebase:RATime?

Queries the real acquisition time used in the hardware. If FFT analysis is performed, the
value can differ from the adjusted acquisition time ( ​TIMebase: ​ACQTime ​).

Return values: 
<HWAcqTime> Range: Depends on various settings

Default unit: s

Usage: Query only

TIMebase:ACQTime <AcquisitionTime>

Defines the time of one acquisition, that is the time across the 10 divisions of the diagram:
Timebase Scale*10.

Parameters:
<AcquisitionTime> *RST: 1 ms

Default unit: s

TIMebase:RANGe <AcquisitionTime>

Defines the time of one acquisition, that is the time across the 10 divisions of the diagram:
Timebase Scale*10.

Parameters:
<AcquisitionTime> Range and increment depend on time base and other settings

*RST: 1 ms
Default unit: s

TIMebase:DIVisions?

Queries the number of horizontal divisions on the screen.

Return values: 
<HorizDivCount> Range: 10  to  10

Increment: 0
*RST: 10
Default unit: div
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Usage: Query only

TIMebase:POSition <Offset>

Defines the trigger position (trigger offset) - the time interval between trigger point and
reference point to analize the signal some time before or after the trigger event.

See also: ​TIMebase: ​REFerence ​ on page 274

Parameters:
<Offset> Range: Depends on time base setting

*RST: 0
Default unit: s

TIMebase:REFerence <ReferencePoint>

Sets the reference point of the time scale (Time Reference) in % of the display. The
reference point defines which part of the waveform is shown. If the trigger position is zero,
the trigger point matches the reference point.

See also: ​TIMebase: ​POSition ​ on page 274

Parameters:
<ReferencePoint> Range: 10  to  90

Increment: 10
*RST: 50
Default unit: %

14.2.4.3 Acquisition

AUToscale ​....................................................................................................................274
ACQuire: ​MODE​.............................................................................................................275
ACQuire: ​INTerpolate ​......................................................................................................275
ACQuire: ​AVERage:​COUNt​.............................................................................................275
ACQuire: ​WRATe​............................................................................................................276
CHANnel<m>: ​TYPE​.......................................................................................................276
CHANnel<m>: ​ARIThmetics ​.............................................................................................277
TIMebase:​ROLL: ​ENABle ​................................................................................................277
ACQuire: ​FILTer:​FREQuency ​...........................................................................................277
ACQuire: ​POINts:​ARATe? ​...............................................................................................278
ACQuire: ​SRATe? ​...........................................................................................................278

AUToscale

Performs an autoset process: analyzes the enabled channel signals, and obtains appro-
priate horizontal, vertical, and trigger settings to display stable waveforms.

Usage: Event
Asynchronous command
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ACQuire:MODE <AcquisitionMode>

Selects the method of adding waveform points to the samples of the ADC in order to fill
the record length.

Parameters:
<AcquisitionMode> RTIMe | ETIMe

RTIMe
Real Time Mode: At slow time base settings the sampled points
of the input signal are used to build the waveform, no waveform
points are added. With fast time base settings, the sample rate is
higher than the ADC sample rate. Waveform samples are added
to the ADC samples with sin(x)/x interpolation.
ETIMe
Equivalent time: The waveform points are taken from several
acquisitions of a repetive signal at a different time in relation to the
trigger point.
*RST: RTIME

ACQuire:INTerpolate <Interpolation>

Defines the interpolation mode.

See also: ​"Interpolation" on page 26

Parameters:
<Interpolation> SINX

LINear
Linear interpolation between two adjacent sample points.
SINX
Interpolation by means of a sin(x)/x curve.
SMHD
Sample & Hold causes a histogram-like interpolation.
*RST: SINX

ACQuire:AVERage:COUNt <AverageCount>

Defines the number of waveforms used to calculate the average waveform. The higher
the number, the better the noise is reduced.

Parameters:
<AverageCount> Only numbers from the 2n progression are permitted (2, 4, 8, ...)

Range: 2  to  1024
*RST: 2
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ACQuire:WRATe <WaveformRate>

Defines the mode to set the sample rate (samples per second saved in the memory) and
the waveform acquisition rate (waveforms per second).

Parameters:
<WaveformRate> AUTO | MWAVeform | MSAMples

AUTO
To display the best waveform, the instrument selects the optimum
combination of waveform acquisition rate and sample rate using
the full memory depth.
MWAVeform
Maximum waveform rate: The instrument combines sample rate
and memory depth to acquire at maximum waveform acquisition
rate. In connection with persistence, the mode can display rare
signal anomalies.
MSAMples
Maximum sample rate: The instrument acquires the signal at max-
imum sample rate and uses the full memory depth. The result is a
waveform with maximum number of waveform samples, high
degree of accuracy, and low risk of aliasing.
*RST: AUTO

CHANnel<m>:TYPE <DecimationMode>

Selects the method to reduce the data stream of the ADC to a stream of waveform points
with lower sample rate.

Suffix: 
<m>

.
The command affects all channels regardless of the indicated
channel number. The suffix can be omitted.

Parameters:
<DecimationMode> SAMPle | PDETect | HRESolution

SAMPle
Input data is acquired with a sample rate which is aligned to the
time base (horizontal scale) and the record length.
PDETect
Peak Detect: the minimum and the maximum of n samples in a
sample interval are recorded as waveform points.
HRESolution
High resolution: The average of n sample points is recorded as
waveform point.
*RST: SAMPle
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CHANnel<m>:ARIThmetics <TrArithmetic>

Selects the method to build the resulting waveform from several consecutive acquisitions
of the signal.

Suffix: 
<m>

.
The command affects all channels regardless of the indicated
channel number. The suffix can be omitted.

Parameters:
<TrArithmetic> OFF | ENVelope | AVERage | SMOoth | FILTer

OFF
The data of the current acquisition is recorded according to the
decimation settings.
ENVelope
Detects the minimum and maximum values in an sample interval
over a number of acquisitions.
AVERage
Calculates the average from the data of the current acquisition and
a number of acquisitions before. The number of used acquisitions
is set with ​ACQuire: ​AVERage: ​COUNt ​.
SMOoth
Calculates a mean value of several adjacent sample points. Thus,
smoothing is a moving average that uses the full data and can be
used for non-periodic signals. It works like a low-pass, and increa-
ses the vertical resolution at the expense of bandwidth reduction.
FILTer
Sets a low-pass filter with 3 db attenuation at a configurable limit
frequency set with ​ACQuire: ​FILTer: ​FREQuency​. The filter
removes higher frequencies from the channel signals.
*RST: OFF

TIMebase:ROLL:ENABle <Roll>

Enables the roll mode.

Parameters:
<Roll> ON | OFF

*RST: OFF

ACQuire:FILTer:FREQuency <FilterFrequency>

Sets the limit frequency for ​CHANnel<m>: ​ARIThmetics ​ is set to FILTer.

Parameters:
<FilterFrequency> Limit frequency with 3 dB attenuation

Default unit: Hz
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ACQuire:POINts:ARATe?

Retrieves the sample rate of the ADC, that is the number of points that are sampled by
the ADC in one second.

Return values: 
<AcquisitionRate> ADC sample rate

Range: 2.5E3  to  5E9
Increment: 1E3
*RST: 5E9
Default unit: Hz

Usage: Query only

ACQuire:SRATe?

Returns the sample rate, that is the number of recorded waveform samples per second.

Return values: 
<SampleRate> Range: 2  to  1E11

Increment: depends on time base, waveform rate, number of
active channels

*RST: 1E7
Default unit: Sa/s

Usage: Query only

14.2.4.4 Vertical

CHANnel<m>: ​STATe​.....................................................................................................278
CHANnel<m>: ​COUPling ​.................................................................................................279
CHANnel<m>: ​SCALe ​.....................................................................................................279
CHANnel<m>: ​RANGe ​....................................................................................................279
CHANnel<m>: ​POSition​...................................................................................................280
CHANnel<m>: ​OFFSet​....................................................................................................280
CHANnel<m>: ​BANDwidth ​...............................................................................................280
CHANnel<m>: ​POLarity ​...................................................................................................281
CHANnel<m>: ​OVERload ​................................................................................................281
CHANnel<m>: ​SKEW ​......................................................................................................281
CHANnel<m>: ​THReshold ​...............................................................................................282
CHANnel<m>: ​LABel ​.......................................................................................................282
CHANnel<m>: ​LABel:​STATe ​............................................................................................282

CHANnel<m>:STATe <State>

Switches the channel signal on or off.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.
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Parameters:
<State> ON | OFF

CHANnel<m>:COUPling <Coupling>

Selects the connection of the indicated channel signal.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Coupling> DC | DCLimit | AC | ACLimit

DC
Direct connection with 50 Ω termination.
DCLimit
Direct connection with 1 MΩ termination.
AC
Connection through DC capacitor that removes the DC offset volt-
age from the input signal.
ACLimit
Connection through DC capacitor with 1 MΩ termination. The
capacitor removes the DC offset voltage from the input signal.
*RST: DCLimit

CHANnel<m>:SCALe <Scale>

Sets the vertical scale for the indicated channel.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Scale> Scale value, given in Volts per division.

Range: 1e-3  to  10; without probe attenuation
*RST: 5e-3
Default unit: V/div

CHANnel<m>:RANGe <Range>

Sets the voltage range across the 10 vertical divisions of the diagram. Use the command
alternativly instead of ​CHANnel<m>: ​SCALe​.

Suffix: 
<m>

.
Selects the input channel. The maximum channel number is
instrument-dependent.
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Parameters:
<Range> Voltage range value

Range: 8e-3  to  80; without probe attenuation
*RST: 40e-3
Default unit: V

CHANnel<m>:POSition <Position>

Sets the vertical position of the indicated channel and its horizontal axis in the window.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Position> Position value, given in divisions.

Range: -5  to  5
*RST: 0
Default unit: div

CHANnel<m>:OFFSet <Offset>

The offset voltage is subtracted to correct an offset-affected signal.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Offset> Offset value

Range: Values depend on vertical scale and probe attenua-
tion.

Increment: Value depends on vertical scale and probe attenua-
tion.

Default unit: V

CHANnel<m>:BANDwidth <BandwidthLimit>

Selects the bandwidth limit for the indicated channel.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.
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Parameters:
<BandwidthLimit> FULL | B400 | B200 | B20

FULL
Use full bandwidth.
B400 | B200 | B20
Limit to 400MHz, 200 MHz, or 20 MHz respectively.
*RST: FULL

CHANnel<m>:POLarity <Polarity>

Turns the inversion of the signal amplitude on or off. To invert means to reflect the voltage
values of all signal components against the ground level. Inversion affects only the display
of the signal but not the trigger.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Polarity> NORMal | INVerted

*RST: NORM

CHANnel<m>:OVERload <Overload>

Retrieves the overload status of the specified channel from the status bit. When the
overload problem is solved, the command resets the status bit.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Overload> ON | OFF

Use OFF to reset the overload status bit.
*RST: OFF

Example: CHANnel2:OVERload?
Queries the overload status of channel 2.
CHANnel2:OVERload OFF
Resets the overload status bit.

CHANnel<m>:SKEW <Skew>

Skew or deskew compensates delay differences between channels caused by the dif-
ferent length of cables, probes, and other sources. Correct deskew values are important
for accurate triggering.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.
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Parameters:
<Skew> Deskew value

Default unit: s

CHANnel<m>:THReshold <Threshold>

Threshold value for digitization of analog signals. If the signal value is higher than the
threshold, the signal state is high (1 or true for the boolean logic). Otherwise, the signal
state is considered low (0 or false) if the signal value is below the threshold.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Threshold> Default values are:

TTL: 1,4 V
ECL: -1,3 V
CMOS: 2,5 V
*RST: 1.4
Default unit: V

CHANnel<m>:LABel <Label>

Specifies a name for the selected channel.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Label> String value

String with max. 8 characters, only ASCII characters can be used

CHANnel<m>:LABel:STATe

Shows or hides the channel name.

Suffix: 
<m>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<State> ON | OFF

*RST: OFF
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14.2.4.5 Waveform Data

Consider also the following commands:
● ​FORMat[: ​DATA] ​ on page 268

● ​CHANnel<m>: ​DATA: ​XINCrement? ​ on page 270

● ​CHANnel<m>: ​DATA: ​XORigin? ​ on page 269

● ​CHANnel<m>: ​DATA: ​YINCrement? ​ on page 270

● ​CHANnel<m>: ​DATA: ​YORigin? ​ on page 270

● ​CHANnel<m>: ​DATA: ​YRESolution? ​ on page 271

● ​CHANnel<m>: ​DATA: ​ENVelope: ​XINCrement? ​ on page 270

● ​CHANnel<m>: ​DATA: ​ENVelope: ​XORigin? ​ on page 269

● ​CHANnel<m>: ​DATA: ​ENVelope: ​YINCrement? ​ on page 270

● ​CHANnel<m>: ​DATA: ​ENVelope: ​YORigin? ​ on page 270

● ​CHANnel<m>: ​DATA: ​ENVelope: ​YRESolution? ​ on page 271

CHANnel<m>: ​DATA? ​.....................................................................................................283
CHANnel<m>: ​DATA: ​HEADer? ​........................................................................................284
CHANnel<m>: ​DATA: ​ENVelope?​.....................................................................................284
CHANnel<m>: ​DATA: ​ENVelope:​HEADer? ​.........................................................................284
CHANnel<m>: ​DATA: ​POINts​...........................................................................................285

CHANnel<m>:DATA?

Returns the data of the channel waveform points for transmission from the instrument to
the controlling computer. The waveforms data can be used in MATLAB, for example.

To set the export format, use ​FORMat[: ​DATA] ​ on page 268.

To set the range of samples to be returned, use ​CHANnel<m>: ​DATA? ​.

For envelope waveforms, use the ​CHANnel<m>: ​DATA: ​ENVelope? ​ command.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<Data> List of values according to the format settings - the voltages of

recorded waveform samples.

Example: FORM ASC
CHAN1:DATA?
-0.125000,-0.123016,-0.123016,-0.123016,
-0.123016,-0.123016,...

Example: See ​chapter 14.3.1, "Data Export", on page 430

Usage: Query only
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CHANnel<m>:DATA:HEADer?

Returns information on the channel waveform. For envelope waveforms, use the ​
CHANnel<m>: ​DATA: ​ENVelope:​HEADer? ​ command.

Table 14-12: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Record length of the waveform in Samples 200000

4 Number of values per sample interval, usually 1. 1

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<DataHeader> Comma-separated value list

Example: -9.477E-008,9.477E-008,200000,1
Usage: Query only

CHANnel<m>:DATA:ENVelope?

Returns the data of the envelope. The envelope consists of two waveforms. The wave-
forms data can be used in MATLAB, for example.

Use this command only for envelope waveforms. For other channel waveforms use ​
CHANnel<m>: ​DATA? ​.

To set the export format, use ​FORMat[: ​DATA] ​ on page 268.

To set the range of samples to be returned, use ​CHANnel<m>: ​DATA? ​.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<Data> List of values according to the format settings - the voltages of the

envelope points. The list contains two values for each sample
interval.

Usage: Query only

CHANnel<m>:DATA:ENVelope:HEADer?

Returns information on the envelope waveform.

Use this command only for envelope waveforms. for all other channel waveforms use ​
CHANnel<m>: ​DATA: ​HEADer? ​.
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Table 14-13: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Number of samples 200000

4 Number of values per sample interval. For envelope
waveforms the value is 2.

2

Suffix: 
<m>

.

Return values: 
<DataHeader> Comma-separated value list

Example: -9.477E-008,9.477E-008,200000,2
Usage: Query only

CHANnel<m>:DATA:POINts <Points>

As a setting, the command selects a range of samples that will be returned with ​
CHANnel<m>: ​DATA? ​ and ​CHANnel<m>: ​DATA: ​ENVelope? ​. As a query, it returns the
number of returned samples for the selected range.

If ​ACQuire:​WRATe ​ is set to MSAMples (maximum sample rate), the memory usually
contains more data samples than the screen can display. In this case, you can decide
which data will be saved: samples stored in the memory or only the displayed samples.

Note: The sample range can be change only in STOP mode. If the acquisition is running,
DEF is always used automatically. If the acquisition has been stopped, data can be read
from the memory, and all settings are available.

Suffix: 
<m>

.
The command affects all channels, and the suffix is irrelevant.
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Setting parameters: 
<Points> DEFault | MAXimum | DMAXimum

Sets the range for data queries.
DEFault
Waveform samples that are visible as waveform points on the
screen.
MAXimum
All waveform samples that are stored in the memory. Only avail-
able if acquisition is stopped.
DMAXimum
Display maximum: Waveform samples stored in the current wave-
form record but only for the displayed time range. At maximum
waveform rate, the instrument stores more samples than visible
on the screen, and DMAX returns more values than DEF. Only
available if acquisition is stopped.
*RST: DEFault

Return values: 
<Points> Number of data points in the selected range.

Default unit: Samples

Example: CHAN:DATA:POIN DEF
CHAN:DATA:POIN?;:CHAN2:DATA:POIN?
Returned values: 10416;10416
CHAN:DATA:POIN DMAX
CHAN:DATA:POIN?;:CHAN2:DATA:POIN?
Returned values: 124992;124992
CHAN:DATA:POIN MAX
CHAN:DATA:POIN?;:CHAN2:DATA:POIN?
Returned values: 4194302;4194302

Example: See ​chapter 14.3.1.1, "Reading Waveform Data from Memory",
on page 430

14.2.4.6 Probes

PROBe<m>:​SETup:​ATTenuation[: ​AUTO]? ​.......................................................................287
PROBe<m>:​SETup:​ATTenuation: ​UNIT​............................................................................287
PROBe<m>:​SETup:​ATTenuation: ​MANual ​........................................................................287
PROBe<m>:​SETup:​BANDwidth? ​.....................................................................................287
PROBe<m>:​SETup:​CAPacitance? ​...................................................................................288
PROBe<m>:​SETup:​DCOFfset? ​.......................................................................................288
PROBe<m>:​SETup:​IMPedance? ​.....................................................................................288
PROBe<m>:​SETup:​MODE ​............................................................................................289
PROBe<m>:​SETup:​NAME? ​............................................................................................289
PROBe<m>:​SETup:​OFFSwitch ​.......................................................................................289
PROBe<m>:​SETup:​TYPE? ​.............................................................................................289
PROBe<m>:​SETup:​UOFFset ​..........................................................................................290
PROBe<m>:​ID: ​BUILd? ​...................................................................................................290
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PROBe<m>:​ID: ​PARTnumber? ​........................................................................................290
PROBe<m>:​ID: ​PRDate? ​.................................................................................................291
PROBe<m>:​ID: ​SRNumber? ​............................................................................................291
PROBe<m>:​ID: ​SWVersion? ​............................................................................................291

PROBe<m>:SETup:ATTenuation[:AUTO]?

Returns the attenuation of an automatically detected probe.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<ProbeAttenuation> Range: 0.001  to  1000

Usage: Query only

PROBe<m>:SETup:ATTenuation:UNIT <Unit>

Selects the unit that the probe can measure.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Unit> V | A

Firmware/Software: FW 03.700

PROBe<m>:SETup:ATTenuation:MANual <ManualAttenuation>

Sets the attenuation or gain of the probe if the probe was not detected by the instrument.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<ManualAttenuation> Range: 0.001  to  10000

*RST: 1

Firmware/Software: FW 03.700

PROBe<m>:SETup:BANDwidth?

Queries the bandwidth of the probe.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.
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Return values: 
<Bandwidth> Range: 10e5  to  20e8

Increment: 10
Default unit: Hz

Usage: Query only

PROBe<m>:SETup:CAPacitance?

Queries the input capacity of the probe.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<InputCapacitance> Range: 0.1e-12  to  1.0e-9

Increment: 1.0e-12
Default unit: F

Usage: Query only

PROBe<m>:SETup:DCOFfset?

Retrieves the DC voltage that is measured by the integrated voltmeter of R&S active
probes. Switch the voltmeter on before, see ​PROBe<m>: ​SETup:​OFFSwitch ​
on page 289.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<Offset> Range: -1.0e26  to  1.0e-26

Increment: 1e-3
Default unit: V

Usage: Query only

PROBe<m>:SETup:IMPedance?

Queries the termination of the probe.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<Termination> 50OHm | 1MOHm | UNKNown

Usage: Query only
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PROBe<m>:SETup:MODE  <Mode>

Select the action that is started with the probe button.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<Mode> RCONtinuous | RSINgle | AUToset | NOACtion

RCONtinuous
Run continuous: The acquisition is running as long as the probe
button is pressed.
RSINgle
Run single: starts one acquisition.
AUTOSET
Starts the autoset procedure.
NOACtion
Nothing is started on pressing the micro button.
*RST: RCONtinuous

PROBe<m>:SETup:NAME?

Queries the name of the probe.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<Name> string

Usage: Query only

PROBe<m>:SETup:OFFSwitch <DCOffsetOnOff>

Switches the integrated voltmeter of an R&S active probe on or off.

The command is only available if an R&S active probe with R&S ProbeMeter is used.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<DCOffsetOnOff> ON | OFF

*RST: OFF

PROBe<m>:SETup:TYPE?

Queries the type of the probe.
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Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<Type> NONE | ACTive | PASSive

NONE
not detected
ACTive
active probe
PASSive
passive probe

Usage: Query only

PROBe<m>:SETup:UOFFset <UserOffset>

Sets an additional probe offset.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<UserOffset> Range: Depends on the probe characteristics.

*RST: 0
Default unit: V

PROBe<m>:ID:BUILd?

Queries the build number of the probe software.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<BuildNumber> 32 bit number

Range: 0  to  4294967295
Increment: 1

Usage: Query only

PROBe<m>:ID:PARTnumber?

Queries the R&S part number of the probe.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.
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Return values: 
<PartNumber> string

Returns the part number in a string.

Usage: Query only

PROBe<m>:ID:PRDate?

Queries the production date of the probe.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<ProductionDate> string

Returns the date in a string.

Usage: Query only

PROBe<m>:ID:SRNumber?

Queries the serial number of the probe.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<SerialNumber> string

Usage: Query only

PROBe<m>:ID:SWVersion?

Queries the version of the probe firmware.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Return values: 
<SoftwareVersion> string

Returns the version number in a string.

Usage: Query only

14.2.5 Trigger

● General A Trigger Settings....................................................................................292
● Edge Trigger.........................................................................................................294
● Width Trigger.........................................................................................................295
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● Video/TV Trigger...................................................................................................296
● Pattern Trigger......................................................................................................298
● B-Trigger...............................................................................................................299

14.2.5.1 General A Trigger Settings

TRIGger:​A: ​MODE​..........................................................................................................292
TRIGger:​A: ​LEVel<n>[: ​VALue]​.........................................................................................292
TRIGger:​A: ​FINDlevel ​......................................................................................................292
TRIGger:​A: ​SOURce ​.......................................................................................................293
TRIGger:​EXTern: ​COUPling ​.............................................................................................293
TRIGger:​A: ​TYPE ​...........................................................................................................293
TRIGger:​A: ​HYSTeresis ​...................................................................................................293
TRIGger:​A: ​HOLDoff: ​TIME​...............................................................................................294

TRIGger:A:MODE <TriggerMode>

Sets the trigger mode. The trigger mode determines the behaviour of the instrument if no
trigger occurs.

Parameters:
<TriggerMode> AUTO | NORMal

AUTO
The instrument triggers repeatedly after a time interval if the trigger
conditions are not fulfilled. If a real trigger occurs, it takes prece-
dence.
NORMal
The instrument acquires a waveform only if a trigger occurs.
*RST: AUTO

TRIGger:A:LEVel<n>[:VALue] <Level>

Sets the trigger treshold voltage for all A trigger types that require a trigger level.

Suffix: 
<n>

.
Selects the trigger input. 1...4 select the corresponding channel,
5 is the external trigger input. The number of channels depends
on the instrument.

Parameters:
<Level> Range: Depends on vertical scale.

Default unit: V

TRIGger:A:FINDlevel

Sets the trigger level of the A-trigger event to 50% of the signal amplitude.

Usage: Event
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TRIGger:A:SOURce <Source>

Sets the trigger source for the selected A trigger type.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | EXTernanalog | LINE | SBUS

CH1 | CH2 | CH3 | CH4
One of the input channels is the trigger source. Available channels
depend on the instrument type.
EXTernanalog
External Trigger Input on the rear panel
LINE
AC line for the edge trigger
SBUS
Serial bus

TRIGger:EXTern:COUPling <ExternCoupling>

Sets the coupling for the external trigger input. The command is relevant if ​TRIGger: ​
B:​SOURce ​ is set to EXTernanalog.

Parameters:
<ExternCoupling> AC | DC

*RST: AC

TRIGger:A:TYPE <Type>

Sets the trigger type for the A trigger.

Parameters:
<Type> EDGE | WIDTh | TV | BUS | LOGic

EDGE: edge trigger
WIDTh: width trigger
TV: video trigger
BUS: only available if at least one option R&S RTM-K1 or R&S
RTM-K2 is installed.
LOGic: pattern trigger, logic trigger
See: ​chapter 11, "Protocol Analysis", on page 144

TRIGger:A:HYSTeresis <Hysteresis>

Sets a hysteresis range around the trigger level of the A trigger event. If the signal jitters
inside this range and crosses the trigger level thereby, no trigger event occurs.

Hysteresis is available for edge and width trigger.

Parameters:
<Hysteresis> AUTO | SMALl | MEDium | LARGE

*RST: AUTO
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TRIGger:A:HOLDoff:TIME <HoldOffTime>

Defines the holdoff time. The next trigger occurs only after the holdoff time has passed.

Parameters:
<HoldOffTime> Default unit: s

14.2.5.2 Edge Trigger

TRIGger:​A: ​EDGE: ​SLOPe​...............................................................................................294
TRIGger:​A: ​EDGE: ​COUPling ​...........................................................................................294
TRIGger:​A: ​EDGE: ​FILTer:​LPASs ​.....................................................................................295
TRIGger:​A: ​EDGE: ​FILTer:​NREJect ​...................................................................................295

TRIGger:A:EDGE:SLOPe <Slope>

Sets the slope for the edge trigger (A trigger).

Parameters:
<Slope> POSitive | NEGative | EITHer

POSitive
Rising edge, a positive voltage change
NEGative
Falling edge, a negative voltage change
EITHer
Rising as well as the falling edge
*RST: POSitive

TRIGger:A:EDGE:COUPling <Coupling>

Sets the coupling for the trigger source.

Parameters:
<Coupling> DC | AC | HF

DC
Direct Current coupling. The trigger signal remains unchanged.
AC
Alternating Current coupling. A 5 Hz high pass filter removes the
DC offset voltage from the trigger signal.
HF
High frequency coupling. A 15 kHz high-pass filter removes lower
frequencies from the trigger signal. Use this mode only with very
high frequency signals.
*RST: DC
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TRIGger:A:EDGE:FILTer:LPASs <State>

Turns an additional 5 kHz low-pass filter in the trigger path on or off. This filter removes
higher frequencies and is available with AC and DC coupling.

Parameters:
<State> ON | OFF

*RST: OFF

TRIGger:A:EDGE:FILTer:NREJect <State>

Turns an additional 100 MHz low-pass filter in the trigger path on or off. This filter removes
higher frequencies and is available with AC and DC coupling.

Parameters:
<State> ON | OFF

*RST: OFF

14.2.5.3 Width Trigger

TRIGger:​A: ​WIDTh: ​POLarity ​............................................................................................295
TRIGger:​A: ​WIDTh: ​RANGe ​..............................................................................................295
TRIGger:​A: ​WIDTh: ​DELTa ​...............................................................................................296
TRIGger:​A: ​WIDTh: ​WIDTh​...............................................................................................296

TRIGger:A:WIDTh:POLarity <Polarity>

Sets the polarity of the pulse.

Parameters:
<Polarity> POSitive | NEGative

POSitive
Positive going pulse, the width is defined from the rising to the
falling slopes.
NEGative
Negative going pulse, the width is defined from the falling to the
rising slopes.
*RST: POSitive

TRIGger:A:WIDTh:RANGe <RangeMode>

Defines how the measured pulse width is compared with the given limit(s).
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Parameters:
<RangeMode> WITHin | OUTSide | SHORter | LONGer

WITHin | OUTSide
Triggers on pulses inside or outside a range defined by time ±
delta. The time is specified with ​TRIGger: ​A: ​WIDTh:​WIDTh ​, the
range around is defined with ​TRIGger: ​A:​WIDTh: ​DELTa​.
SHORter | LONGer
Triggers on pulses shorter or longer than a time set with ​
TRIGger: ​A:​WIDTh: ​WIDTh​.
*RST: LONGer

TRIGger:A:WIDTh:DELTa <Delta>

Defines a range around the width value specified using ​TRIGger: ​A:​WIDTh: ​WIDTh​.

Parameters:
<Delta> Range ±Δt ("Variation" softkey)

Range: Depends on the defined pulse width
(TRIG:A:WIDTH:WITDH)

TRIGger:A:WIDTh:WIDTh <Time1>

For the ranges WITHin and OUTSide (defined using ​TRIGger: ​A:​WIDTh:​RANGe ​), the
<Time1> defines the center of a range which is defined by the limits ±<Delta> (set with ​
TRIGger: ​A:​WIDTh: ​DELTa​).

For the ranges SHORter and LONGer, the width defines the maximum and minimum
pulse width, respectively.

Parameters:
<Time1> Center value, maximum value or minimum value depending on the

defined range type.
Range: 20E-9  to  6.87194685440
Increment: Depends on the <Time1> value
*RST: 20E-9

14.2.5.4 Video/TV Trigger

TRIGger:​A: ​TV: ​STANdard ​................................................................................................296
TRIGger:​A: ​TV: ​POLarity​..................................................................................................297
TRIGger:​A: ​TV: ​FIELd​......................................................................................................297
TRIGger:​A: ​TV: ​LINE ​........................................................................................................297

TRIGger:A:TV:STANdard <Standard>

Selects the color television standard.
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Parameters:
<Standard> PAL | NTSC | SECam | PALM | I576 | P720 | P1080 | I1080

PALM = PAL-M
I576 = SDTV 576i (PAL and SECAM)
P720 | P1080 = HDTV 720/1080p (progressive scanning)
I1080 = HDTV 1080i (interlaced scanning)
*RST: PAL

TRIGger:A:TV:POLarity <Polarity>

Selects the polarity of the signal. Note that the sync pulse has the opposite polarity. The
edges of the sync pulses are used for triggering,

See also: ​"Signal" on page 45

Parameters:
<Polarity> POSitive | NEGative

POSitive
If the video modulation is positive, the sync pulses are negative.
NEGative
If the modulation is negative, sync pulses are positive.
*RST: NEGative

TRIGger:A:TV:FIELd <Field>

Sets the trigger on the beginning of the video signal fields, or on the beginning of video
signal lines.

Parameters:
<Field> EVEN | ODD | ALL | LINE | ALINe

EVEN | ODD
Triggers only on the field start of even or odd fields. Only available
for interlaced scanning.
ALL
All fields, triggers on the frame start (progressive scanning) or any
field start (interlaced scanning).
LINE
Triggers on the beginning of a specified line in any field. The line
number is set with ​TRIGger: ​A:​TV: ​LINE ​.
ALINe
Triggers on the beginning of all video signal lines.
*RST: ALL

TRIGger:A:TV:LINE <Line>

Sets an exact line number if ​TRIGger: ​A: ​TV:​FIELd ​ is set to LINE.
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Parameters:
<Line> Range: 1  to  525 (NTSC, PAL-M); 625 (PAL, SECAM, SDTV

I-576); 750 (HDTV P720); 1125 (HDTV I1080, HDTV
P1080)

Increment: 1
*RST: 1

14.2.5.5 Pattern Trigger

TRIGger:A:PATTern:SOURce <SourceString>

Select the state for each digital channel.

Parameters:
<SourceString> string containing 0, 1, or X for each channel

1: high, the signal voltage is higher than the trigger level.
0: low, the signal voltage is lower than the trigger level.
X: Don't care. the channel does not affect the trigger.

Example: TRIG:A:PATT:SOUR "1X10"
CH1, CH3, and NOT CH4 are logically combined with ​
TRIGger: ​A:​PATTern: ​FUNCtion ​, CH2 does not matter (don't
care).

TRIGger:A:PATTern:FUNCtion <Function>

Sets the logical combination of the trigger states of the channels.

Parameters:
<Function> AND | OR

AND
The required states of all channels must appear in the input signal
at the same time.
OR
At least one of the channels must have the required state.
*RST: AND

TRIGger:A:PATTern:CONDition <ConditionString>

Sets the trigger point depending on the result of the logical combination of the channel
states.

Parameters:
<ConditionString> "TRUE" | "FALSE"

*RST: "TRUE"
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14.2.5.6 B-Trigger

TRIGger:​B: ​ENABle ​.........................................................................................................299
TRIGger:​B: ​SOURce ​.......................................................................................................299
TRIGger:​B: ​EDGE: ​SLOPe​...............................................................................................299
TRIGger:​B: ​LEVel ​...........................................................................................................299
TRIGger:​B: ​FINDlevel ​......................................................................................................299
TRIGger:​B: ​MODE​..........................................................................................................300
TRIGger:​B: ​DELay ​..........................................................................................................300
TRIGger:​B: ​EVENt: ​COUNt​...............................................................................................300
TRIGger:​B: ​HYSTeresis ​...................................................................................................300

TRIGger:B:ENABle <State>

Activates or deactivates the second trigger. The instrument triggers if both trigger event
conditions (A and B) are fulfilled.

Parameters:
<State> ON | OFF

*RST: OFF

TRIGger:B:SOURce <Source>

Selects one of the input channels as B-trigger source. Available channels depend on the
instrument type.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

*RST: CH1

TRIGger:B:EDGE:SLOPe <Slope>

Sets the edge for the B-trigger.

Parameters:
<Slope> POSitive | NEGative | EITHer

*RST: POSitive

TRIGger:B:LEVel <Level>

Sets the trigger level for the B-trigger event.

Parameters:
<Level> *RST: 0

Default unit: V

TRIGger:B:FINDlevel

Sets the trigger level of the B-trigger event to 50% of the signal amplitude.
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Usage: Event

TRIGger:B:MODE <Mode>

Defines the delay type of the B-trigger.

Parameters:
<Mode> DELay | EVENts

DELay
Time delay, set with ​TRIGger: ​B: ​DELay​
EVENts
Event count delay, set with ​TRIGger:​B: ​EVENt:​COUNt ​
*RST: DELay

TRIGger:B:DELay <DelayTime>

Sets the time the instrument waits after an A-event until it recognizes B-events.

Before setting the dalay time, ​TRIGger:​B: ​MODE ​ must be set to DELAy.

Parameters:
<DelayTime> Range: 20e-9  to  6,871946854

Increment: Depends on the <DelayTime> value. The longer the
<DelayTime>, the longer is the increment value.

*RST: 20e-9
Default unit: s

TRIGger:B:EVENt:COUNt <EventCnt>

Sets a number of B-trigger events that fulfill all B-trigger conditions but do not cause the
trigger. The oscilloscope triggers on the n-th event (the last of the specified number of
events).

Before setting the event number, ​TRIGger: ​B:​MODE ​ must be set to EVENts.

Parameters:
<EventCnt> Number of B-events

Range: 1  to  65535
Increment: 1
*RST: 1

TRIGger:B:HYSTeresis <Hysteresis>

Sets a hysteresis range around the trigger level of the B trigger event. If the signal jitters
inside this range and crosses the trigger level thereby, no trigger event occurs.

Parameters:
<Hysteresis> AUTO | SMALl | MEDium | LARGE

*RST: AUTO
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14.2.6 Display

14.2.6.1 Basic Display Settings

This chapter describes commands that configure the screen display.

General Display Settings

DISPlay: ​MODE​..............................................................................................................301
DISPlay: ​PALette​............................................................................................................301

DISPlay:MODE <Mode>

Sets the diagram mode.

Parameters:
<Mode> YT | XY

YT
Default time diagram with a time axis in x-direction and the signal
amplitudes displayed in y-direction.
XY
XY-diagram, combines the voltage levels of two waveforms in one
diagram.
*RST: YT

DISPlay:PALette <Palette>

Sets the color and brightness of the displayed waveform samples depending on their
cumulative occurance.

Parameters:
<Palette> NORMal | INVerse | FCOLor | IFColor

NORMal
Values that occur frequently are brighter than rare values.
INVerse
Rare values are brighter than frequent values, inverse to the NOR-
Mal brightness.
FColor
Rare values are displayed in blue, while more frequent values are
red and very frequent values are displayed in yellow or white, with
various colors inbetween.
IFColor
Inverses the FColor setting: rare values are yellow or white while
frequent values are blue.
*RST: NORMal
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XYZ-Setup

DISPlay: ​XY:​XSOurce ​.....................................................................................................302
DISPlay: ​XY:​Y1Source ​....................................................................................................302
DISPlay: ​XY:​Y2Source ​....................................................................................................302
DISPlay: ​XY:​ZMODe​.......................................................................................................302
DISPlay: ​XY:​ZTHReshold ​................................................................................................303
DISPlay: ​XY:​ZSOurce ​.....................................................................................................303

DISPlay:XY:XSOurce <Source>

Defines the source to be displayed in x direction in an XY-diagram, replacing the usual
time base.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

CH3 and CH4 are only available with 4-channel R&S RTM oscil-
loscopes.
*RST: CH1

DISPlay:XY:Y1Source <Source>

Defines the (first) source to be displayed in y direction in an XY-diagram.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

CH3 and CH4 are only available with 4-channel R&S RTM oscil-
loscopes.
*RST: CH2

DISPlay:XY:Y2Source <Source>

Defines an optional second source to be displayed in y direction in an XY-diagram. The
command is only relevant for 4-channel R&S RTM instruments.

Parameters:
<Source> NONE | CH1 | CH2 | CH3 | CH4

*RST: NONE

DISPlay:XY:ZMODe <Mode>

Activates or deactivates the intensity control of the waveform via an additional signal
source and sets the intensity mode.
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Parameters:
<Mode> ANALog | DIGital | OFF

ANALog
Modulated intensity; Intensity is modulated continuously accord-
ing to the selected Source Z.
DIGital
Intensity is determined by a threshold value defined with ​
DISPlay: ​XY:​ZTHReshold ​. If the Z signal value is below the
selected threshold, the corresponding x/y point is not displayed. If
the Z signal value is above the threshold, the x/y point is displayed
with the defined intensity level.
OFF
Intensity control is deactivated.
*RST: OFF

DISPlay:XY:ZTHReshold <Zthreshold>

Defines the threshold for intensity with a two-state modulation, if ​DISPlay: ​XY:​ZMODe ​
is set to DIGital.

Parameters:
<Zthreshold> Threshold for visibility on the screen

Range: -10  to  10
Increment: depends on the scaling of the channel that is

assigned to Z
*RST: 0
Default unit: V

DISPlay:XY:ZSOurce <Source>

Defines the source to be used to determine the intensity of the xy-waveform.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

CH3 and CH4 are only available with 4-channel R&S RTM oscil-
loscopes.
*RST: CH1

Intensities

DISPlay: ​INTensity:​WAVeform ​.........................................................................................304
DISPlay: ​INTensity:​BACKlight ​..........................................................................................304
DISPlay: ​INTensity:​GRID​.................................................................................................304
DISPlay: ​PERSistence:​STATe ​..........................................................................................304
DISPlay: ​PERSistence:​TIME ​............................................................................................305
DISPlay: ​PERSistence:​INFinite ​.........................................................................................305
DISPlay: ​PERSistence:​TIME: ​AUTO​..................................................................................305
DISPlay: ​PERSistence:​CLEar ​..........................................................................................305
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DISPlay:INTensity:WAVeform <Intensity>

Defines the strength of the waveform line in the diagram.

Parameters:
<Intensity> Value in percent

Range: 0  to  100
Increment: 1
*RST: not available, *RST does not change the intensity
Default unit: %

DISPlay:INTensity:BACKlight <Intensity>

Defines the intensity of the background lighting of the display.

Parameters:
<Intensity> Value in percent

Range: 10  to  100
Increment: 1
*RST: not available, *RST does not change the intensity
Default unit: %

DISPlay:INTensity:GRID <Intensity>

Defines the intensity of the grid on the screen.

Parameters:
<Intensity> Value in percent

Range: 0  to  100
Increment: 1
*RST: not available, *RST does not change the intensity
Default unit: %

DISPlay:PERSistence:STATe <State>

Defines whether the waveform persists on the screen or whether the screen is refreshed
continuously.

Parameters:
<State> ON | OFF

ON
The waveform persists for the time defined using ​DISPlay: ​
PERSistence: ​TIME ​.
OFF
The waveform does not persist on the screen. Only the currently
measured values are displayed at any time.
*RST: OFF
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DISPlay:PERSistence:TIME <Time>

Persistence time if persistence is active (see ​DISPlay: ​PERSistence: ​STATe​
on page 304).

Each new data point in the diagram area remains on the screen for the duration defined
here. To set infinite persistence, use ​DISPlay: ​PERSistence:​INFinite ​.

Parameters:
<Time> Range: 50E-3  to  Infinite

Increment: minimum 50E-3 s, increasing increment with increas-
ing persistence time

*RST: 50E-3
Default unit: s

DISPlay:PERSistence:INFinite <InfPersistence>

Sets the persistence time to infinite if ​DISPlay: ​PERSistence:​STATe ​ is ON. each new
data point remains on the screen infinitely until this setting is changed or the persistence
is cleared.

Parameters:
<InfPersistence> ON | OFF

*RST: OFF

DISPlay:PERSistence:TIME:AUTO <Auto>

The optimal persistence time is determined automatically by the instrument.

Parameters:
<Auto> ON | OFF

*RST: OFF

DISPlay:PERSistence:CLEar

Removes the displayed persistent waveform from the screen.

Usage: Event

Waveform, Auxilary Cursors and Grid Settings

DISPlay: ​STYLe​..............................................................................................................305
DISPlay: ​GRID:​STYLe ​.....................................................................................................306

DISPlay:STYLe <Style>

Defines how the waveform data is displayed
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Parameters:
<Style> VECTors | DOTS

VECTors
Individual data points are connected by a line.
DOTS
Only the data points are displayed.
*RST: VECT

DISPlay:GRID:STYLe <Style>

Defines how the grid is displayed.

Parameters:
<Style> LINes | RETicle | NONE

LINes
Displays the grid as horizontal and vertical lines.
RETicle
Displays crosshairs instead of a grid.
NONE
No grid is displayed.
*RST: LIN

14.2.6.2 Zoom

TIMebase:​ZOOM: ​STATe​................................................................................................306
TIMebase:​ZOOM: ​SCALe ​................................................................................................306
TIMebase:​ZOOM: ​TIME ​...................................................................................................307
TIMebase:​ZOOM: ​POSition​..............................................................................................307

TIMebase:ZOOM:STATe <ZoomState>

Switches the zoom window on or off.

Parameters:
<ZoomState> ON | OFF

*RST: OFF

TIMebase:ZOOM:SCALe <ZoomScale>

Defines the time base in the zoom diagram in seconds per division.

Parameters:
<ZoomScale> Range: Depends on various other settings

Default unit: s/div
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TIMebase:ZOOM:TIME <Time>

Defines the offset of the trigger point to the reference point of the zoom diagram.

Parameters:
<Time> *RST: 0

Default unit: s

TIMebase:ZOOM:POSition <Position>

Defines the position of the zoom reference point (the reference point of the zoom window)
in relation to the reference point of original time base.

Parameters:
<Position> Range: Depends on the zoom time base, nearly 0 to 100 %

for large zoom
*RST: 50
Default unit: %

14.2.6.3 Markers (Timestamps)

TSTamp:​SET ​.................................................................................................................307
TSTamp:​NEXT ​..............................................................................................................307
TSTamp:​PREVious ​........................................................................................................307
TSTamp:​CLEar ​..............................................................................................................308
TSTamp:​ACLear ​............................................................................................................308

TSTamp:SET

Sets a new marker (timestamp) at the reference point of the display, unless an existing
marker is already set there. The reference point is set with ​TIMebase:​REFerence ​.

Usage: Event

TSTamp:NEXT

Usage: Event

Moves the next marker (timestamp, to the right) to the reference point of the display or
zoom area.

TSTamp:PREVious

Moves the previous marker (timestamp, to the left) to the reference point of the display
or zoom area.

Usage: Event
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TSTamp:CLEar

Deletes the marker (timestamp) at the reference point. The reference point is set with ​
TIMebase: ​REFerence​.

Usage: Event

TSTamp:ACLear

Deletes all markers (timestamps).

Usage: Event

14.2.7 Reference Waveforms

For data queries and conversion, consider also the following commands:
● ​FORMat[: ​DATA] ​ on page 268

● ​REFCurve<m>: ​DATA: ​XINCrement? ​ on page 270

● ​REFCurve<m>: ​DATA: ​XORigin? ​ on page 269

● ​REFCurve<m>: ​DATA: ​YINCrement? ​ on page 270

● ​REFCurve<m>: ​DATA: ​YORigin? ​ on page 270

● ​REFCurve<m>: ​DATA: ​YRESolution? ​ on page 271

REFCurve<m>: ​STATe​....................................................................................................308
REFCurve<m>: ​SOURce ​.................................................................................................309
REFCurve<m>: ​SOURce:​CATalog? ​..................................................................................309
REFCurve<m>: ​UPDate​..................................................................................................309
REFCurve<m>: ​SAVE​.....................................................................................................309
REFCurve<m>: ​LOAD​.....................................................................................................310
REFCurve<m>: ​LOAD:​STATe ​..........................................................................................310
REFCurve<m>: ​HORizontal: ​SCALe​..................................................................................310
REFCurve<m>: ​HORizontal: ​POSition​................................................................................310
REFCurve<m>: ​VERTical: ​SCALe​.....................................................................................311
REFCurve<m>: ​VERTical: ​POSition​...................................................................................311
REFCurve<m>: ​DATA?​...................................................................................................311
REFCurve<m>: ​DATA:​HEADer? ​.......................................................................................311

REFCurve<m>:STATe

Displays or hides the selected reference waveform.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Parameters:
<State> ON | OFF

*RST: OFF
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REFCurve<m>:SOURce <Source>

Defines the source of the reference waveform.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4 | MA1 | MA2 | MA3 | MA4 | RE1 | RE2 |

RE3 | RE4
Any active channel, math, or reference waveform. Available chan-
nels depend on the instrument type.
*RST: CH1

REFCurve<m>:SOURce:CATalog?

Returns the source waveform - channel, math or reference waveform.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Return values: 
<Catalog> CH1 | CH2 | CH3 | CH4 | MA1 | MA2 | MA3 | MA4 | RE1 | RE2 |

RE3 | RE4

Usage: Query only

REFCurve<m>:UPDate

Updates the selected reference by the waveform defined with ​REFCurve<m>: ​SOURce ​.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Usage: Event

REFCurve<m>:SAVE <FileName>

Stores the reference waveform the specified file.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Setting parameters: 
<FileName> String with path and file name

Usage: Setting only
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REFCurve<m>:LOAD <FileName>

Loads the waveform data from the indicated reference file to the reference storage.

To load the instrument settings, use ​REFCurve<m>: ​LOAD:​STATe ​.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Setting parameters: 
<FileName> String with path and file name

Usage: Setting only

REFCurve<m>:LOAD:STATe

Loads the instrument settings in addition to the reference waveform data. The waveform
data must be loaded before the settings, see ​REFCurve<m>: ​LOAD ​ on page 310.

The settings are only available if the file was stored to the internal storage /INT/
REFERENCE and never written to an external storage (USB stick).

Suffix: 
<m>

.
1..4
Selects the reference waveform.

Usage: Event

REFCurve<m>:HORizontal:SCALe <Scale>

Changes the horizontal scale (timebase) of the reference waveform independent of the
channel waveform settings.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Parameters:
<Scale> *RST: 100e-6

Default unit: s/div

REFCurve<m>:HORizontal:POSition <Position>

Changes the horizontal position of the reference waveform independent of the channel
waveform settings.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Parameters:
<Position> *RST: 0

Default unit: s
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REFCurve<m>:VERTical:SCALe <Scale>

Changes the vertical scale of the reference waveform.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Parameters:
<Scale> *RST: 1

Default unit: V/div

REFCurve<m>:VERTical:POSition <Position>

Changes the vertical position of the reference waveform.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Parameters:
<Position> *RST: 0

Default unit: div

REFCurve<m>:DATA?

Returns the data of the reference waveform for transmission from the instrument to the
controlling computer. The waveforms data can be used in MATLAB, for example.

To set the export format, use ​FORMat[: ​DATA] ​ on page 268.

Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Return values: 
<Data> List of values according to the format settings.

Usage: Query only

REFCurve<m>:DATA:HEADer?

Returns information on the reference waveform.

Table 14-14: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Record length of the waveform in Samples 200000

4 Number of values per sample interval, usually 1. 1
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Suffix: 
<m>

.
1..4
Selects the reference waveform, the internal reference storage.

Parameters:
<Header> Comma-separated value list

Example: -9.477E-008,9.477E-008,200000,1
Usage: Query only

14.2.8 Measurements

This chapter describes functions that configure or perform cursor and automatic meas-
urements.

● Cursor Measurements...........................................................................................312
● Quick Measurements............................................................................................320
● Automatic Measurements.....................................................................................321
● Reference Level....................................................................................................325
● Automatic Measurements - Statistic......................................................................326

14.2.8.1 Cursor Measurements

CURSor<m>: ​AOFF​........................................................................................................313
CURSor<m>: ​STATe​.......................................................................................................313
CURSor<m>: ​SOURce ​....................................................................................................313
CURSor<m>: ​FUNCtion ​...................................................................................................313
CURSor<m>: ​TRACking[: ​STATe]​.....................................................................................315
CURSor<m>: ​X1Position ​.................................................................................................315
CURSor<m>: ​X2Position ​.................................................................................................315
CURSor<m>: ​X3Position ​.................................................................................................315
CURSor<m>: ​Y1Position ​.................................................................................................315
CURSor<m>: ​Y2Position ​.................................................................................................315
CURSor<m>: ​Y3Position ​.................................................................................................315
CURSor<m>: ​YCOupling ​.................................................................................................316
CURSor<m>: ​XCOupling ​.................................................................................................316
CURSor<m>: ​SWAVe​.....................................................................................................316
CURSor<m>: ​SSCReen ​..................................................................................................316
CURSor<m>: ​SPPeak​.....................................................................................................316
CURSor<m>: ​SNPeak ​.....................................................................................................317
CURSor<m>: ​TRACking: ​SCALe[:​STATe] ​..........................................................................317
CURSor<m>: ​RESult? ​.....................................................................................................317
CURSor<m>: ​XDELta:​INVerse? ​.......................................................................................317
CURSor<m>: ​XDELta[:​VALue]?​.......................................................................................318
CURSor<m>: ​YDELta:​SLOPe? ​.........................................................................................318
CURSor<m>: ​YDELta[:​VALue]?​.......................................................................................318
CURsor<m>: ​XRATio: ​UNIT​..............................................................................................318
CURSor<m>: ​XRATio[:​VALue]? ​.......................................................................................319
CURSor<m>: ​YRATio: ​UNIT​.............................................................................................319
CURSor<m>: ​YRATio[:​VALue]? ​.......................................................................................319
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CURSor<m>:AOFF

Switches the cursor off.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Usage: Event

CURSor<m>:STATe <State>

Activates or deactivates the cursor measurement.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Parameters:
<State> ON | OFF

*RST: OFF

CURSor<m>:SOURce <Source>

Defines the source of the cursor measurement.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Parameters:
<Source> NONE | CH1 | CH2 | CH3 | CH4 | MA1 | MA2 | MA3 | MA4 | MA5 |

RE1 | RE2 | RE3 | RE4 | XY1
CH1 | CH2 | CH3 | CH4
Active channel waveform 1 to 4
MA1 | MA2 | MA3 | MA4 | MA5
Active math channels 1 to 5
RE1 | RE2 | RE3 | RE4
Active reference channels 1 to 4
XY1
Active XY-waveform
*RST: CH1

CURSor<m>:FUNCtion <Type>

Defines the cursor measurement type.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.
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Parameters:
<Type> HORizontal | VERTical | PAIRed | HRATio | VRATio | PPCount |

NPCount | RECount | FECount | MEAN | RMS | RTIMe | FTIMe |
PEAK | UPEakvalue | LPEakvalue | BWIDth
*RST: VERT

Value Description Queries for results

HORizontal Sets two horizontal cursor lines and measures the vol-
tages at the two cursor positions and the delta of the two
values.

​CURSor<m>: ​Y1Position ​

​CURSor<m>: ​Y2Position ​

​CURSor<m>: ​YDELta[: ​VALue]? ​

​CURSor<m>: ​YDELta:​SLOPe? ​

VERTical Sets two vertical cursor lines and measures the time
from the trigger point to each cursor, the time between
the two cursors and the frequency calculated from that
time.

​CURSor<m>: ​X1Position ​

​CURSor<m>: ​X2Position ​

​CURSor<m>: ​XDELta[: ​VALue]? ​

​CURSor<m>: ​XDELta:​INVerse? ​

PAIRed V-Marker

same as ​CURSor<m>: ​TRACking[: ​STATe] ​
​CURSor<m>: ​Y1Position ​

​CURSor<m>: ​Y2Position ​

​CURSor<m>: ​XDELta[: ​VALue]? ​

​CURSor<m>: ​YDELta[: ​VALue]? ​

HRATio Sets three horizontal cursor lines. Queries return the
ratio of the y-values (e.g. overshooting) between the first
and second cursors and the first and third cursors.

​CURSor<m>: ​YRATio:​UNIT ​

​CURSor<m>: ​YRATio[: ​VALue]? ​

​CURSor<m>: ​Y1Position ​

​CURSor<m>: ​Y2Position ​

​CURSor<m>: ​Y3Position ​

VRATio Sets three vertical cursor lines. Queries return the ratio
of the x-values (e.g. a duty cycle) between the first and
second cursors and the first and third cursors.

​CURsor<m>: ​XRATio:​UNIT ​

​CURSor<m>: ​XDELta[: ​VALue]? ​

​CURSor<m>: ​X1Position ​

​CURSor<m>: ​X2Position ​

​CURSor<m>: ​X3Position ​

PPCount

NPCount

RECount

FECount

Count positive pulses

Count negative pulses

Count rising edges

Count falling edges

Sets two vertical and one horizontal cursor line. The time
base is defined by the vertical cursors, the horizontal
cursor defines the threshold value.

​CURSor<m>: ​RESult?​

MEAN

RMS

Mean value

Root mean square

Values are measured between two vertical cursor lines.

​CURSor<m>: ​RESult?​
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Value Description Queries for results

RTIMe

FTIMe

Rise time, tr

Fall time, tf

Measures the rise or fall time of the first edge after the
first vertical cursor between the upper and lower refer-
ence levels. The reference level for rise and fall time
measurement is set with ​REFLevel: ​RELative: ​
MODE ​.

​CURSor<m>: ​RESult?​

PEAK

UPEakvalue

LPEakvalue

Vpp, absolute difference between the two peak values

Vp+, upper peak value

Vp-, lower peak value

Values are measured between two vertical cursor lines.

​CURSor<m>: ​RESult?​

BWIDth Burst width, the duration of a burst. Two vertical cursors
mark the beginning and the end of the burst. The hori-
zontal cursor sets the threshold value, and the time
between the first and the last edge of the burst is
returned.

​CURSor<m>: ​RESult?​

CURSor<m>:TRACking[:STATe] <State>

If set to ON, the V-Marker cursor measurement is enabled.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Parameters:
<State> ON | OFF

*RST: OFF

CURSor<m>:X1Position <Xposition1>
CURSor<m>:X2Position <Xposition2>
CURSor<m>:X3Position <Xposition3>

The commands specify the x-positions of vertical cursor lines on the time axis. The third
cursor is only used for Ratio X measurement.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Parameters:
<Position> Range: Depends on horizontal settings.

CURSor<m>:Y1Position <Yposition1>
CURSor<m>:Y2Position <Yposition2>
CURSor<m>:Y3Position <Yposition3>

The commands specify the positions of horizontal cursor lines on the y-axis. The third
cursor is only used for Ratio Y measurements.

Command Reference



Remote ControlR&S®RTM

316User Manual 1305.0595.02 ─ 08

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Parameters:
<Position> Range: Depends on various other settings.

CURSor<m>:YCOupling <Coupling>
CURSor<m>:XCOupling <Coupling>

If enabled, the cursors of a set are coupled so that the distance between the two remains
the same if one cursor is moved.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Parameters:
<Coupling> ON | OFF

*RST: OFF

CURSor<m>:SWAVe

Autoset for cursor lines, sets the cursor lines to typical points of the waveform depending
on the selected measurement type. For example, for voltage measurement, the cursor
lines are set to the upper and lower peaks of the waveform. For time measurement, the
cursor lines are set to the edges of two consecutive positive or two consecutive negative
pulses.

Usage: Event

Firmware/Software: FW 03.700

CURSor<m>:SSCReen

Resets the cursors to their initial positions. This is helpful if the cursors have disappeared
from the display or need to be moved for a larger distance.

Usage: Event

Firmware/Software: FW 03.700

CURSor<m>:SPPeak

For FFT analysis only: sets the selected cursor to the previous (left) level peak.

Usage: Event

Firmware/Software: FW 03.700
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CURSor<m>:SNPeak

For FFT analysis only: sets the selected cursor to the next (right) level peak.

Usage: Event

Firmware/Software: FW 03.700

CURSor<m>:TRACking:SCALe[:STATe] <State>

Enables the adjustment of cursor lines if the vertical or horizontal scales are changed.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Parameters:
<State> ON | OFF

ON
Cursor lines keep their relative position to the waveform.
OFF
Cursor lines remain on their position on the display if the scaling
is changed.
*RST: OFF

CURSor<m>:RESult?

Returns the measurement result for count, mean, RMS, rise and fall time, peak meas-
urements, and burst width. Make sure to set ​CURSor<m>: ​FUNCtion​ correctly.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Return values: 
<Value> Measurement result

Usage: Query only

CURSor<m>:XDELta:INVerse?

Returns the inverse time difference between the two cursors (1/Δt).

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Return values: 
<DeltaInverse> Range: -100e24  to  100e24

Increment: 0.1
*RST: 0
Default unit: 1/s
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Usage: Query only

CURSor<m>:XDELta[:VALue]?

Returns the time difference between the two cursors (Δt).

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Return values: 
<Delta> Range: -100e24  to  100e24

Increment: 0.1
*RST: 0
Default unit: s

Usage: Query only

CURSor<m>:YDELta:SLOPe?

Returns the inverse value of the voltage difference - the reciprocal of the vertical distance
of two horizontal cursor lines: 1/ΔV.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Return values: 
<DeltyYslope> Inverse value

Usage: Query only

CURSor<m>:YDELta[:VALue]?

Queries the delta of the values in y-direction at the two cursors.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Return values: 
<DeltaY> Delta value in V

Usage: Query only

CURsor<m>:XRATio:UNIT <Unit>

Sets the unit for X Ratio measurements with ​CURSor<m>: ​XRATio[: ​VALue]? ​.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Command Reference



Remote ControlR&S®RTM

319User Manual 1305.0595.02 ─ 08

Parameters:
<Unit> RATio | PCT | GRD | PI

RATio - floating value
PCT - percent
GRD - degree
PI - radian
*RST: RAT

CURSor<m>:XRATio[:VALue]?

Returns the ratio of the x-values (e.g. a duty cycle) between the first and second cursors
and the first and third cursors: (x2-x1)/(x3-x1).

Set the unit of the result with ​CURsor<m>: ​XRATio: ​UNIT ​.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Return values: 
<Ratio> Numeric value corresponding to the specified unit.

Usage: Query only

CURSor<m>:YRATio:UNIT <Unit>

Sets the unit for Y Ratio measurements with ​CURSor<m>: ​YRATio[: ​VALue]? ​
on page 319.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.

Parameters:
<Unit> RATio | PCT

RATio - floating value
PCT - percent
*RST: RAT

CURSor<m>:YRATio[:VALue]?

Returns the ratio of the y-values (e.g. overshooting) between the first and second cursors
and the first and third cursors: (y2-y1)/(y3-y1).

For this measurement, set the cursor measurement type ​CURSor<m>: ​FUNCtion ​ to
HRATio.

Set the unit of the result with ​CURSor<m>: ​YRATio: ​UNIT ​.

Suffix: 
<m>

.
1
The numeric suffix is irrelevant.
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Return values: 
<Ratio> Numeric value corresponding to the specified unit.

Usage: Query only

14.2.8.2 Quick Measurements

MEASurement<m>: ​ALL[:​STATe] ​.....................................................................................320
MEASurement<m>: ​AON ​.................................................................................................320
MEASurement<m>: ​AOFF​...............................................................................................320
MEASurement<m>: ​ARESult? ​..........................................................................................320

MEASurement<m>:ALL[:STATe]

Starts or stops the quick measurement and sets the status bit.

Parameters:
<State> ON | OFF

*RST: OFF

Firmware/Software: FW 03.800

MEASurement<m>:AON

Starts the quick measurement.

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.

Usage: Event

MEASurement<m>:AOFF

Stops the quick measurement.

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.

Usage: Event

MEASurement<m>:ARESult?

Returns the results of the quick measurement.

Suffix: 
<m>

.
1..4
Selects the measurement.
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Return values: 
<QuickMeasData> List of values

Quick measurement results are listed in the following order: PEAK,
UPE, LPE, CYCR, CYCM, PER, FREQ, RTIM , FTIM

Usage: Query only

14.2.8.3 Automatic Measurements

MEASurement<m>[: ​ENABle]​...........................................................................................321
MEASurement<m>: ​MAIN​................................................................................................321
MEASurement<m>: ​SOURce ​...........................................................................................323
MEASurement<m>: ​DELay: ​SLOPe​...................................................................................324
MEASurement<m>: ​RESult[:​ACTual]? ​..............................................................................324
MEASurement<m>: ​CATegory? ​.......................................................................................325

MEASurement<m>[:ENABle] <State>

Activates or deactivates the selected measurement (1-4). Only the results of active
measurements are displayed in the result table.

Suffix: 
<m>

.
1..4
Selects the measurement.

Parameters:
<State> ON | OFF

*RST: OFF

MEASurement<m>:MAIN <MeasType>

Defines the measurement type to be performed on the selected source. To query the
results, use ​MEASurement<m>: ​RESult[: ​ACTual]?​.

Suffix: 
<m>

.
1..4
Selects the measurement.
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Parameters:
<MeasType> FREQuency | PERiod | PEAK | UPEakvalue | LPEakvalue |

PPCount | NPCount | RECount | FECount | HIGH | LOW |
AMPLitude | MEAN | RMS | RTIMe | FTIMe | PDCYcle | NDCYcle |
PPWidth | NPWidth | CYCMean | CYCRms | STDDev |
CYCStddev | TFRequency | TPERiode | DELay | PHASe |
BWIDth | POVershoot | NOVershoot | TBFRequency | TBPeriod
For a detailed description, see ​"Meas. Type" on page 92.
FREQuency
Frequency of the signal. The result is based on the length of the
left-most signal period within the displayed section of the wave-
form of the selected channel.
PERiod
Length of the left-most signal period within the displayed section
of the waveform of the selected channel.
PEAK
Peak-to-peak value within the displayed section of the waveform
of the selected channel.
UPEakvalue
Maximum value within the displayed section of the waveform of
the selected channel.
LPEakvalue
Minimum value within the displayed section of the waveform of the
selected channel.
PPCount
Counts positive pulses.
NPCount
Counts negative pulses.
RECount
Counts the number of rising edges.
FECount
Counts the number of falling edges.
HIGH
Mean value of the high level of a square wave.
LOW
Mean value of the low level of a square wave.
AMPLitude
Amplitude of a square wave.
MEAN
Mean value of the complete displayed waveform of the selected
channel.
RMS
RMS (Root Mean Square) value of the voltage of the complete
displayed waveform of the selected channel.
RTIMe | FTIMe
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Rise or falling time of the left-most rising edge within the displayed
section of the waveform of the selected channel. The reference
level for this mesurement is set with ​REFLevel:​RELative: ​
MODE ​.
PDCycle | NDCycle
Measure the positive or negative duty cycle.
PPWidth | NPWidth
Measure the width of positive or negative pulses.
CYCMean
Mean value of the left-most signal period of the waveform of the
selected channel.
CYCRms
RMS (Root Mean Square) value of the voltage of the left-most
signal period of the waveform of the selected channel.
STDDev
Measures the standard deviation of the waveform.
CYCStddev
Measures the standard deviation of one cycle, usually of the first,
left-most signal period.
TFRequency | TPERiode
Measure the frequency of the trigger signal and the length of the
its periods (hardware counter).
DELay
Time difference between two edges of the same or different wave-
forms. The waveforms are selected with ​MEASurement<m>: ​
SOURce​, and the edges with ​MEASurement<m>: ​DELay: ​SLOPe​.
PHASe
Phase difference between two waveforms (time difference/period
* 360). The waveforms are selected with ​MEASurement<m>: ​
SOURce​.
BWIDth
Burst width, the duration of one burst, measured from the first edge
to the last edge that cross the middle reference level.
POVershoot | NOVershoot
Positive and negative overshoot of a square wave.
TBFRequency | TBPeriod
Measures the frequency of the B-trigger signal and the length of
the B-trigger signal periods.
*RST: NONE (measurement is off)

MEASurement<m>:SOURce <SignalSource>[,<ReferenceSource>]

Selects one of the active signal, reference or math channels as the source(s) of the
selected measurement.
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Suffix: 
<m>

.
1..4
Selects the measurement place.

Parameters:
<SignalSource> NONE | CH1 | CH2 | CH3 | CH4 | MA1 | MA2 | MA3 | MA4 | MA5 |

RE1 | RE2 | RE3 | RE4 | TRIGger
Waveform to be measured, required for all measurement types
CH1 | CH2 | CH3 | CH4
Active signal channels 1 to 4
MA1 | MA2 | MA3 | MA4 | MA5
Active math channels 1 to 5
RE1 | RE2 | RE3 | RE4
Active reference channels 1 to 4
TRIGger
Trigger source if the measurement type is a trigger measurement:
TFRequency | TPERiode measure the A-trigger source, TBFRe-
quency | TBPeriod measure the B-trigger source.
*RST: CH1

<ReferenceSource> NONE | CH1 | CH2 | CH3 | CH4 | MA1 | MA2 | MA3 | MA4 | MA5 |
RE1 | RE2 | RE3 | RE4
Second waveform, reference source that is required for delay and
phase mesurements.

MEASurement<m>:DELay:SLOPe <SignalSlope>,<ReferenceSlope>

Sets the edges to be used for delay measurement. The associated waveforms are
defined with ​MEASurement<m>: ​SOURce​

Parameters:
<SignalSlope> POSitive | NEGative

Slope of source 1 ( first waveform)
*RST: POS

<ReferenceSlope> POSitive | NEGative
Slope of source 2 (second waveform)
*RST: POS

Firmware/Software: 03.400

MEASurement<m>:RESult[:ACTual]? [<MeasType>]

Returns the result of the specified measurement type.

Suffix: 
<m>

.
1..4
Selects the measurement place.

Command Reference



Remote ControlR&S®RTM

325User Manual 1305.0595.02 ─ 08

Query parameters: 
<MeasType> FREQuency | PERiod | PEAK | UPEakvalue | LPEakvalue |

PPCount | NPCount | RECount | FECount | HIGH | LOW |
AMPLitude | MEAN | RMS | RTIMe | FTIMe | PDCYcle | NDCYcle |
PPWidth | NPWidth | CYCMean | CYCRms | STDDev |
CYCStddev | TFRequency | TPERiode | DELay | PHASe |
BWIDth | POVershoot | NOVershoot | TBFRequency | TBPeriod
Specifies the measurement type. See ​MEASurement<m>: ​MAIN ​
on page 321.

Return values: 
<Value> Measurement result. If no measurement was executed, no value

(NAN) is returned.

Usage: Query only

MEASurement<m>:CATegory?

Returns the measurement category. Currently, the instrument supports only yt-meas-
urements.

Suffix: 
<m>

.
1..4
Selects the measurement.

Return values: 
<Category> AMPTime

AMPtime: yt-measurements
*RST: AMPT

Usage: Query only

14.2.8.4 Reference Level

REFLevel: ​RELative:​MODE​.............................................................................................325
REFLevel: ​RELative:​LOWer ​.............................................................................................326
REFLevel: ​RELative:​UPPer ​..............................................................................................326
REFLevel: ​RELative:​MIDDle ​............................................................................................326

REFLevel:RELative:MODE <RelativeMode>

Sets the lower and upper reference levels for rise and fall time mesurements (cursor and
automatic mesurements) as well as the middle reference level for phase and delay
measurements. The levels are defined as percentages of the high signal level. The setting
is valid for all measurement places.
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Parameters:
<RelativeMode> TEN | TWENty | FIVE | USER

TEN: 10, 50 and 90%
TWENty: 20, 50 and 80%
FIVE: 5, 50 and 95 %
USER: levels are defined with ​REFLevel:​RELative: ​LOWer​, ​
REFLevel: ​RELative:​MIDDle ​, and ​REFLevel:​RELative: ​
UPPer ​.
*RST: TEN

Example: REFL:REL:MODE TWENty
MEAS2:MAIN RTIM
Sets the reference levels for all measurement places and meas-
ures the rise time between these levels for measurement place 2:
lower reference level = 20% of high signal level
upper reference level = 80% of high signal level

REFLevel:RELative:LOWer <LowerLevel>
REFLevel:RELative:UPPer <UpperLevel>

Set the lower and upper reference levels for rise and fall time mesurements (cursor and
automatic mesurements) if ​REFLevel:​RELative: ​MODE ​ is set to USER. The levels are
defined as percentages of the high signal level. They are valid for all measurement pla-
ces.

Parameters:
<LowerLevel> *RST: 10

Default unit: %

<UpperLevel> *RST: 90
Default unit: %

Firmware/Software: 03.400

REFLevel:RELative:MIDDle <MiddleLevel>

Set the middle reference level used for phase and delay measurements, if ​REFLevel: ​
RELative: ​MODE​ is set to USER. The level is defined as percentages of the high signal
level. The setting is valid for all measurement places.

Parameters:
<MiddleLevel> *RST: 50

Default unit: %

Firmware/Software: 03.400

14.2.8.5 Automatic Measurements - Statistic

MEASurement<m>: ​STATistics[:​ENABle] ​..........................................................................327
MEASurement<m>: ​STATistics: ​WEIGht​............................................................................327
MEASurement<m>: ​STATistics: ​RESet​..............................................................................327
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MEASurement<m>: ​RESult: ​AVG?​....................................................................................328
MEASurement<m>: ​RESult: ​STDDev? ​...............................................................................328
MEASurement<m>: ​RESult: ​NPEak?​.................................................................................328
MEASurement<m>: ​RESult: ​PPEak?​.................................................................................328
MEASurement<m>: ​RESult: ​WFMCount?​...........................................................................329
MEASurement<m>: ​STATistics: ​VALue:​ALL? ​.....................................................................329
MEASurement<m>: ​STATistics: ​VALue<n>?​......................................................................329

MEASurement<m>:STATistics[:ENABle] <StatisticEnable>

Activates or deactivates the statistical evaluation for the selected measurement.

Suffix: 
<m>

.
1..4
Selects the measurement place.

Parameters:
<StatisticEnable> ON | OFF

*RST: OFF

Firmware/Software: FW 03.700

MEASurement<m>:STATistics:WEIGht <AverageCount>

Sets the number of measured waveforms used for calculation of average and standard
deviation.

Suffix: 
<m>

.
1..4
Selects the measurement place.

Parameters:
<AverageCount> Range: 2  to  1000

Increment: 1
*RST: 1000

Firmware/Software: FW 03.700

MEASurement<m>:STATistics:RESet

Deletes the statistical results for the selected measurement, and starts a new statistical
evaluation if the acquisition is running. The waveform count is set to 0 and all measure-
ment values are set to NAN.

Suffix: 
<m>

.
1..4
Selects the measurement place.

Usage: Event

Firmware/Software: FW 03.700
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MEASurement<m>:RESult:AVG? <AverageValue>

Returns the average value of the current mesurement series.

The number of waveforms used for calculation is defined with ​MEASurement<m>: ​
STATistics: ​WEIGht​.

Suffix: 
<m>

.
1..4
Selects the measurement place.

Query parameters: 
<AverageValue> Statistic value

Usage: Query only

Firmware/Software: FW 03.700

MEASurement<m>:RESult:STDDev? <StandardDeviation>

Returns the statistical standard deviation of the current mesurement series.

The number of waveforms used for calculation is defined with ​MEASurement<m>: ​
STATistics: ​WEIGht​.

Suffix: 
<m>

.
1..4
Selects the measurement place.

Query parameters: 
<StandardDeviation> Statistic value

Usage: Query only

Firmware/Software: FW 03.700

MEASurement<m>:RESult:NPEak? <NegativePeak>

Returns the minimum measurement value of the current measurement series.

Suffix: 
<m>

.
1..4
Selects the measurement place.

Query parameters: 
<NegativePeak> Minimum measurement value

Usage: Query only

Firmware/Software: FW 03.700

MEASurement<m>:RESult:PPEak? <PositivePeak>

Returns the maximum measurement value of the current measurement series.
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Suffix: 
<m>

.
1..4
Selects the measurement place.

Query parameters: 
<PositivePeak> Maximum measurement value

Usage: Query only

Firmware/Software: FW 03.700

MEASurement<m>:RESult:WFMCount? <WaveformCount>

Returns the current number of measured waveforms.

Suffix: 
<m>

.
1..4
Selects the measurement place.

Query parameters: 
<WaveformCount> Number of measured waveforms

Usage: Query only

Firmware/Software: FW 03.700

MEASurement<m>:STATistics:VALue:ALL?

Returns all values from the statistics buffer.

Suffix: 
<m>

.
1..4
Selects the measurement place.

Return values: 
<ValueList> Comma-separated list of statistical values

Usage: Query only

MEASurement<m>:STATistics:VALue<n>?

Returns one statistical value from the indicated buffer place.

Suffix: 
<m>

.
1..4
Selects the measurement place.

<n> *
Buffer place. The buffer size is limited by ​MEASurement<m>: ​
STATistics: ​WEIGht ​.

Return values: 
<StatisticValue> Statistical value

Usage: Query only
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14.2.9 Mathematics

This chapter describes commands that configure or perform mathematical functions.

For data queries and conversion, consider also the following commands:
● ​FORMat[: ​DATA] ​ on page 268

● ​CALCulate: ​MATH<m>: ​DATA:​XINCrement? ​ on page 270

● ​CALCulate: ​MATH<m>: ​DATA:​XORigin? ​ on page 269

● ​CALCulate: ​MATH<m>: ​DATA:​YINCrement? ​ on page 270

● ​CALCulate: ​MATH<m>: ​DATA:​YORigin? ​ on page 270

● ​CALCulate: ​MATH<m>: ​DATA:​YRESolution? ​ on page 271

CALCulate: ​MATH<m>:​STATe ​.........................................................................................330
CALCulate: ​MATH<m>:​SCALe ​.........................................................................................330
CALCulate: ​MATH<m>:​POSition ​......................................................................................331
CALCulate: ​MATH<m>[:​EXPRession][:​DEFine] ​..................................................................331
CALCulate: ​MATH<m>:​DATA? ​.........................................................................................332
CALCulate: ​MATH<m>:​DATA: ​HEADer? ​............................................................................332

CALCulate:MATH<m>:STATe <State>

Defines whether the selected mathematical channel is active or not. Only if a channel is
active it is visible on the screen and can be selected as a source for analysis and display
functions.

Suffix: 
<m>

.
1..4
Selects the math waveform.

Parameters:
<State> ON | OFF

*RST: OFF

CALCulate:MATH<m>:SCALe <Scale>

Sets the vertical scale for the specified math waveform.

In FFT mode, the command sets the vertical scale of the FFT window. The scale unit for
FFT is set with ​CALCulate: ​MATH<m>: ​FFT: ​MAGNitude: ​SCALe​.

Suffix: 
<m>

.
1..4
Selects the math waveform.
IN FFT mode, the numeric suffix is irrelevant.
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Parameters:
<Scale> Scale value

Range: -1.0E-24  to  5.0E+25
Increment: 1, 2, 5 progression, for example, 1mV/div, 2mV/div,

5mV/div, 10, 20, 50...
*RST: 1

CALCulate:MATH<m>:POSition <Position>

Sets the vertical position of the specified math waveform in the window.

Suffix: 
<m>

.
1..4
Selects the math waveform.

Parameters:
<Position> Position value, given in divisions.

Range: -1.880E+02  to  2.120E+02
Increment: 0.01 in reset state
*RST: 2

CALCulate:MATH<m>[:EXPRession][:DEFine] <RemComplExpr>

Defines the equation to be calculated for the selected math waveform as a regular
expression.

For details on available operators, see ​"Operator" on page 99.

Suffix: 
<m>

.
1..4
Selects the math waveform.

Parameters:
<RemComplExpr> String parameter, consisting of the mathematical operation and

the source(s) written in parenthesis.

Example: CALC:MATH<2>:EXPR:DEF "CH1+CH2"

Operation Expression string Comment

Addition "ADD(CH1,CH2)" "CH1+CH2" is also possible

Subtraction "SUB(CH1,CH2)" "CH1-CH2" is also possible

Multiplication "MUL(CH1,CH2)" "CH1*CH2" is also possible

Division "DIV(CH1,CH2)" "CH1/CH2" is also possible

Maximum amplitude "MAX(CH1,CH2)"  

Minimum amplitude "MIN(CH1,CH2)"  

Square "SQR(CH1)"  

Square Root "SQRT(CH1)"  
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Operation Expression string Comment

Absolute value "ABS(CH1)"  

Positive wave "POS(CH1)"  

Negative wave "NEG(CH1)"  

Reciprocal "REC(CH1)"  

Inverse "INV(CH1)"  

Common logarithm (basis 10) "LOG(CH1)"  

Natural logarithm (basis e) "LN(CH1)"  

Derivative "DERI(CH1)"  

Integral "INT(CH1)"  

IIR low pass "IIRL(CH1,1E6)" CH1 – Source waveform

1e6 – constant value, cut-off frequency
of the low or high pass

IIR high pass "IIRH(CH1,1E6)"

FFT "FFTMAG(CH1)" FFT function of the source waveform

See also: ​chapter 14.2.10, "FFT",
on page 333

CALCulate:MATH<m>:DATA?

Returns the data of the math waveform points for transmission from the instrument to the
controlling computer. The waveforms data can be used in MATHLAB, for example.

To set the export format, use ​FORMat[: ​DATA] ​ on page 268.

Suffix: 
<m>

.
1..4
Selects the math waveform.

Return values: 
<Data> List of values according to the format settings - voltages, or mag-

nitudes of a spectrum.

Usage: Query only

CALCulate:MATH<m>:DATA:HEADer?

Returns information on the math waveform.

Table 14-15: Header data

Position Meaning Example

1 XStart in s -9.477E-008 = - 94,77 ns

2 XStop in s 9.477E-008 = 94,77 ns

3 Record length of the waveform in Samples 200000

4 Number of values per sample interval, usually 1. 1
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Suffix: 
<m>

.
1..4
Selects the math waveform.

Return values: 
<Header> Comma-separated value list

Example: -9.477E-008,9.477E-008,200000,1
Usage: Query only

14.2.10 FFT

To define an FFT for a channel waveform, use CALC:MATH:EXPR "FFTMAG(CHx)".

CALCulate: ​MATH<m>:​FFT:​WINDow:​TYPE ​......................................................................333
CALCulate: ​MATH<m>:​ARIThmetics ​.................................................................................334
CALCulate: ​MATH<m>:​FFT:​AVERage:​COUNt ​...................................................................335
CALCulate: ​MATH<m>:​FFT:​MAGNitude: ​SCALe​................................................................335
CALCulate: ​MATH<m>:​FFT:​BANDwidth[: ​RESolution]:​ADJusted? ​........................................336
CALCulate: ​MATH<m>:​FFT:​BANDwidth[: ​RESolution]:​AUTO ​...............................................336
CALCulate: ​MATH<m>:​FFT:​BANDwidth[: ​RESolution]:​RATio ​...............................................336
CALCulate: ​MATH<m>:​FFT:​BANDwidth[: ​RESolution][:​VALue]​............................................337
CALCulate: ​MATH<m>:​FFT:​CFRequency ​.........................................................................337
CALCulate: ​MATH<m>:​FFT:​FULLspan ​.............................................................................337
CALCulate: ​MATH<m>:​FFT:​SPAN ​...................................................................................337
CALCulate: ​MATH<m>:​FFT:​STARt ​...................................................................................338
CALCulate: ​MATH<m>:​FFT:​STOP​...................................................................................338
CALCulate: ​MATH<m>:​FFT:​TIME:​RANGe ​........................................................................338
CALCulate: ​MATH<m>:​FFT:​TIME:​POSition ​.......................................................................339
CALCulate: ​MATH<m>:​FFT:​SRATe? ​................................................................................339

CALCulate:MATH<m>:FFT:WINDow:TYPE <WindowType>

Window functions are multiplied with the input values and thus can improve the FFT
display.

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.
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Parameters:
<WindowType> RECTangular | HAMMing | HANNing | BLACkmanharris

RECTangular
The rectangular window multiplies all points by one. The result is
a high frequency accuracy with thin spectral lines, but also with
increased noise. Use this function preferably with pulse response
tests where start and end values are zero.
HAMMing
The Hamming window is bell shaped. Its value is not zero at the
borders of the measuring interval. Thus, the noise level inside the
spectrum is higher than Hanning or Blackman, but smaller than
the rectangular window. The width of the spectral lines is thinner
than the other bell-shaped functions. Use this window to measure
amplitudes of a periodical signal precisely.
HANNing
The Hanning window is bell shaped. Unlike the Hamming window,
its value is zero at the borders of the measuring interval. Thus, the
noise level within the spectrum is reduced and the width of the
spectral lines enlarges. Use this window to measure amplitudes
of a periodical signal precisely.
BLACkmanharris
The Blackman window is bell shaped and has the steepest fall in
its wave shape of all other available functions. Its value is zero at
both borders of the measuring interval. In the Blackman window
the amplitudes can be measured very precisely. However, deter-
mining the frequency is more difficult. Use this window to measure
amplitudes of a periodical signal precisely.
*RST: HANNing

CALCulate:MATH<m>:ARIThmetics <Arithmetics>

Defines the mode for FFT calculation and display.

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.
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Parameters:
<Arithmetics> OFF | ENVelope | AVERage

OFF
The FFT is performed without any additional weighting or post-
processing of the acquired data. The new input data is acquired
and displayed, and thus overwrites the previously saved and dis-
played data.
ENVelope
In addition to the normal spectrum, the maximal oscillations are
saved separately and updated for each new spectrum. The max-
imum values are displayed together with the newly acquired val-
ues and form an envelope. This envelope indicates the range of
all FFT trace values that occurred.
AVERage
The average of several spectrums is calculated. The number of
spectrums used for the averaging is defined using the command.
This mode is useful for noise rejection.
*RST: OFF

CALCulate:MATH<m>:FFT:AVERage:COUNt

Defines the number of spectrums used for averaging if ​CALCulate: ​MATH<m>: ​
ARIThmetics ​ is set to AVERage.

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.

Parameters:
<AverageCount> Integer value

Range: 2  to  512
Increment: 2^n
*RST: 2

CALCulate:MATH<m>:FFT:MAGNitude:SCALe

Defines the scaling unit of the y-axis.

To set the scale value, use ​CALCulate: ​MATH<m>: ​SCALe​.

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.
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Parameters:
<Magnitude Scale> LINear | DBM | DBV

LINear
linear scaling; displays the RMS value of the voltage.
DBM
logarithmic scaling; related to 1 mW
DBV
logarithmic scaling; related to 1 Veff
*RST: DBM

Example: CALC:MATH:FFT:MAGN:SCAL DBM
CALC:MATH:SCAL 20
Set the Y-scale of the FFT window to 20 dBm.

CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:ADJusted?

Queries the effective resolution bandwidth.

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.

Return values: 
<AdjResBW> Range: Depends on various other settings.

Default unit: Hz

Usage: Query only

CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:AUTO <SpanRBWCoupling>

Couples the frequency span to the RBW.

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.

Parameters:
<SpanRBWCoupling> ON | OFF

CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:RATio <SpanRBWRatio>

Defines the ratio of span (Hz) / resolution bandwidth (Hz). The span/RBW ratio is half the
number of points used for FFT which is defined with manual operation in the menu.

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.

Parameters:
<SpanRBWRatio> Range: The value is changed in 2^n steps from 2^10 to 2^15

(1024, 2048,4096,8192,16384, 32768).
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Example: CALC:MATH:FFT:BAND:RAT 32768
Sets the number of points to 65536.

CALCulate:MATH<m>:FFT:BANDwidth[:RESolution][:VALue] <ResolutionBW>

Defines the resolution bandwidth - the minimum frequency step at which the individual
components of a spectrum can be distinguished

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.

Parameters:
<ResolutionBW> Range: Depends on various other settings.

Default unit: Hz

CALCulate:MATH<m>:FFT:CFRequency <CenterFreq>

Defines the position of the displayed frequency domain, which is (Center - Span/2) to
(Center + Span/2). The width of the domain is defined using the ​CALCulate: ​
MATH<m>: ​FFT: ​SPAN ​ command.

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.

Parameters:
<CenterFreq> Range: Limited by the first data point (minimum) and last data

point (maximum) of the FFT curve.
Increment: Depends on the span and the number of data points

(span/RBW ratio).
Default unit: Hz

CALCulate:MATH<m>:FFT:FULLspan

Performs FFT calculation for the full frequency span.

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.

Usage: Event

CALCulate:MATH<m>:FFT:SPAN <FreqSpan>

The span is specified in Hertz and defines the width of the displayed frequency range,
which is (Center - Span/2) to (Center + Span/2). The position of the span is defined using
the ​CALCulate: ​MATH<m>: ​FFT: ​CFRequency ​ command.
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Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.

Parameters:
<FreqSpan> Range: Depends on various other settings, mainly on time

base and span/RBW ratio.
Increment: Only 1 | 2 | 5 in first digit
Default unit: Hz

CALCulate:MATH<m>:FFT:STARt <StartFreq>

Defines the start frequency of the displayed frequency domain at the left display edge:
Center - Span/2

You can set start and stop frequency instead of defining a center frequency and span.

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.

Parameters:
<StartFreq> Range: Depends on various other settings, mainly on time

base, span/RBW ratio, and center frequency.
Default unit: Hz

CALCulate:MATH<m>:FFT:STOP <StopFreq>

Defines the stop frequency of the displayed frequency domain at the right display edge:
Center + Span/2

You can set start and stop frequency instead of defining a center frequency and span.

Suffix: 
<m>

.
1..4
The numeric suffix is irrelevant.

Parameters:
<StopFreq> Range: Depends on various other settings, mainly on time

base, span/RBW ratio, and center frequency.
Default unit: Hz

CALCulate:MATH<m>:FFT:TIME:RANGe

Defines the width of the time base extract from the Y(t)-window for which the FFT is
calculated.

Parameters:
<WindowWidth> Range: depends on the time base

Default unit: s

Firmware/Software: FW 03.800
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CALCulate:MATH<m>:FFT:TIME:POSition

Defines the position of the time base extract in the Y(t)-window for which the FFT is
calculated.

Parameters:
<WindowPosition> Range: depends on the time base and the width of the FFT

time base extract
Default unit: s

Firmware/Software: FW 03.800

CALCulate:MATH<m>:FFT:SRATe?

Returns the sample rate of data used in an FFT analysis.

Return values: 
<SampleRate> Default unit: Sa/s

Usage: Query only

14.2.11 Masks

MASK:​STATe ​................................................................................................................340
MASK:​TEST ​..................................................................................................................340
MASK:​LOAD ​.................................................................................................................340
MASK:​SAVE ​..................................................................................................................340
MASK:​SOURce ​.............................................................................................................340
MASK:​CHCopy ​..............................................................................................................340
MASK:​YPOSition ​...........................................................................................................341
MASK:​YSCale ​...............................................................................................................341
MASK:​YWIDth ​...............................................................................................................341
MASK:​XWIDth ​...............................................................................................................341
MASK:​COUNt? ​..............................................................................................................342
MASK:​VCOunt? ​.............................................................................................................342
MASK:​RESet: ​COUNter​...................................................................................................342
MASK:​ACTion: ​SOUNd: ​EVENt: ​MODE​..............................................................................342
MASK:​ACTion: ​STOP: ​EVENt:​MODE​................................................................................342
MASK:​ACTion: ​SCRSave: ​EVENt: ​MODE​...........................................................................342
MASK:​ACTion: ​PRINt: ​EVENt:​MODE​.................................................................................342
MASK:​ACTion: ​WFMSave: ​EVENt:​MODE​..........................................................................342
MASK:​ACTion: ​SOUNd: ​EVENt: ​COUNt​.............................................................................343
MASK:​ACTion: ​STOP: ​EVENt:​COUNt​................................................................................343
MASK:​ACTion: ​SCRSave: ​EVENt: ​COUNt​..........................................................................343
MASK:​ACTion: ​PRINt: ​EVENt:​COUNt ​................................................................................343
MASK:​ACTion: ​WFMSave: ​EVENt:​COUNt ​.........................................................................343
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MASK:STATe <State>

Turns the mask test mode on or off. When turning off, any temporarily stored new masks
are deleted.

Parameters:
<State> ON | OFF

*RST: OFF

MASK:TEST <Test>

Starts, finishes or interrupts a mask test.

Parameters:
<Test> RUN | STOP | PAUSe

*RST: STOP

MASK:LOAD <FileName>

Loads a stored mask from the specified file.

Setting parameters: 
<FileName> String parameter

Path and file name

Usage: Setting only

MASK:SAVE <FileName>

Saves the current mask in the specified file.

Setting parameters: 
<FileName> String parameter

Path and file name

Usage: Setting only

MASK:SOURce <Source>

Defines the channel to be compared with the mask.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

CH3 and CH4 are only available on 4-channel R&S RTM models.
*RST: CH1

MASK:CHCopy

Creates a mask from the envelope waveform of the test source set with ​MASK: ​SOURce ​.

Command Reference



Remote ControlR&S®RTM

341User Manual 1305.0595.02 ─ 08

Usage: Event

MASK:YPOSition <Yposition>

Moves the mask vertically within the display.

Parameters:
<Yposition> Mask offset from the vertical center

Range: -200  to  200
Increment: 0,02
*RST: 0
Default unit: div

MASK:YSCale <Yscale>

Changes the vertical scaling to stretch or compress the mask in y-direction.

Parameters:
<Yscale> A value over 100% stretches the amplitudes; a value less than

100% compresses the amplitudes.
Range: 10  to  1000
Increment: 1
*RST: 100
Default unit: %

MASK:YWIDth <Yaddition>

Changes the width of the mask in vertical direction.

Parameters:
<Yaddition> The value is added to the y-values of the upper mask limit and

subtracted from the y-values of the lower mask limit.
Range: 0  to  5,12
Increment: 0,04
*RST: 0
Default unit: div

MASK:XWIDth <Xaddition>

Changes the width of the mask in horizontal direction.

Parameters:
<Xaddition> The value is added to the positive x-values and subtracted from

the negative x-values of the mask limits in relation to the mask
center.
Range: 0  to  10
Increment: 0,01
*RST: 0
Default unit: div
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MASK:COUNt?

Returns the number of tested acquisitions.

Return values: 
<TotalCount> Total number of tested acquisitions

Usage: Query only

MASK:VCOunt?

Returns the number of acquistions that hit the mask.

Return values: 
<ViolationCount> Acquisition count

Usage: Query only

MASK:RESet:COUNter

Sets the counters of passed and failed acquisitions to Zero.

Usage: Event

Firmware/Software: FW 03.800

MASK:ACTion:SOUNd:EVENt:MODE <EventMode>
MASK:ACTion:STOP:EVENt:MODE <EventMode>
MASK:ACTion:SCRSave:EVENt:MODE <EventMode>
MASK:ACTion:PRINt:EVENt:MODE <EventMode>
MASK:ACTion:WFMSave:EVENt:MODE <EventMode>

Defines when and how often the action will be executed.

● SOUNd: Generates a beep sound.
● STOP: Stops the waveform acquisition.
● PRINt: Prints a screenshot to a printer connected to the USB connector on the front

or rear panel.
● SCRSave: Saves a screenshot according to printer output settings.
● WFMSave: Saves the waveform data according to the screenshot output settings.

For output settings, see ​chapter 14.2.14.1, "Screenshots", on page 413.
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Parameters:
<EventMode> OFF | EACH | SINGle | CYCLic

OFF
No action is executed.
EACH
The selected action is executed on each violation of the mask.
SINGle
The selected action is executed once after the n-th violation.
CYCLic
The selected action is executed repeatedly after each n-th viola-
tion.
The number of violations <n> is set with the relevant ​
MASK:ACTion:...:EVENt:COUNt command.
*RST: OFF

Firmware/Software: FW 03.800

MASK:ACTion:SOUNd:EVENt:COUNt <EventCount>
MASK:ACTion:STOP:EVENt:COUNt <EventCount>
MASK:ACTion:SCRSave:EVENt:COUNt <EventCount>
MASK:ACTion:PRINt:EVENt:COUNt <EventCount>
MASK:ACTion:WFMSave:EVENt:COUNt <EventCount>

Sets the number of mask violations after which the action is executed. The command is
only relevant if the associated ​MASK:ACTion:...:EVENt:MODE is set to SINGle or
CYCLic.

Parameters:
<EventCount> Integer value, number of mask violations

Firmware/Software: FW 03.800

14.2.12 Search

● General Search Configuration...............................................................................344
● Edge Search Configuration...................................................................................347
● Width Search Configuration..................................................................................347
● Peak Search Configuration...................................................................................349
● Rise/Fall Time Search Configuration....................................................................350
● Runt Search Configuration....................................................................................351
● Data2Clock Search Configuration.........................................................................353
● Pattern Search Configuration................................................................................355
● Search Results......................................................................................................357
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14.2.12.1 General Search Configuration

SEARch:​STATe ​.............................................................................................................344
SEARch:​CONDition ​........................................................................................................344
SEARch:​SOURce ​..........................................................................................................346
SEARch:​GATE: ​MODE​....................................................................................................346
SEARch:​GATE: ​ABSolute:​START ​....................................................................................346
SEARch:​GATE: ​ABSolute:​STOP ​......................................................................................346

SEARch:STATe <SearchState>

Enables and disables the search mode.

Parameters:
<SearchState> ON | OFF

*RST: OFF

Example: ​chapter 14.3.2.1, "Searching for a Pulse of Specified Width",
on page 432

Firmware/Software: FW 03.400

SEARch:CONDition <SearchCondition>

Selects the event you want to search for.
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Parameters:
<SearchCondition> EDGE | WIDTh | PEAK | RUNT | RTIMe | DATatoclock | PATTern |

PROTocol
EDGE
An edge search result is found when the waveform passes the
given level in the specified direction.
WIDTH
A width search finds pulses with an exact pulse width, or pulses
shorter or longer than a given time, or pulses inside or outside the
allowable time range.
PEAK
The peak search finds pulses exceeding a given amplitude.
RUNT
The runt search finds pulses lower than normal in amplitude. The
amplitude crosses the first threshold twice without crossing the
second one. In addition to the threshold amplitudes, you can
define a time limit for the runt in the same way as for width search:
runts with exact width, shorter or longer than a given time, or runts
inside or outside the allowable time range.
RTIMe
The rise or fall time search finds slopes with an exact rise or fall
time, or rise/fall times shorter or longer than a given limit, or rise/
fall times inside or outside the allowable time range.
DATatoclock
The Data2Clock search - also known as setup/hold - finds violation
of setup and hold times. It analyzes the relative timing between
two signals: a data signal and the synchronous clock signal. Setup
time is the time that the data signal is steady before clock edge.
Hold time is the time that the data signal is steady after clock edge.
PATTern
The pattern search finds logical combinations of channel states
inside or outside a specified time range. For each channel, its state
and threshold level is defined. The states are combined logically,
and the time of true pattern results is compared with a specified
time range.
PROTocol
The protocol search finds various events in decoded data of CAN
or LIN signals, for example, a specified frame type, identifier, data,
and errors. Available search settings depend on the configured
bus type ​BUS: ​TYPE ​. For bus types PARallel, I2C, SPI, SSPI, and
UART you can set the PROTocol search condition, but no search
is available.
*RST: EDGE

Example: ​chapter 14.3.2.1, "Searching for a Pulse of Specified Width",
on page 432

Firmware/Software: FW 03.400
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SEARch:SOURce <SearchSource>

Selects the waveform to be analyzed. One of the active channel, math, and reference
waveforms can be searched.

Parameters:
<SearchSource> CH1 | CH2 | CH3 | CH4 | MA1 | MA2 | MA3 | MA4 | RE1 | RE2 |

RE3 | RE4
*RST: CH1

Example: ​chapter 14.3.2.1, "Searching for a Pulse of Specified Width",
on page 432

Firmware/Software: FW 03.400

SEARch:GATE:MODE

Defines the search area. If the search is performed on a running acquisition series, the
instrument analyzes the displayed data. The search on a stopped acquisition analyzes
the contents of the memory.

Parameters:
<GateMode> OFF | DISPlay | ABSolute

OFF
Running acquisition: all waveform samples that are displayed on
the screen.
Stopped acquisition: all data samples that are stored in the mem-
ory.
DISPlay
Search is restricted to the time range of the display.
ABSolute
Search is restricted to the time range defined by ​SEARch: ​
GATE: ​ABSolute:​START ​ and ​SEARch: ​GATE:​ABSolute: ​STOP ​
.

SEARch:GATE:ABSolute:START <StartTime>

Sets the start time of the search area in relation to the trigger point if ​SEARch: ​GATE: ​
MODE ​ on page 346 is set to ABSolute.

Parameters:
<StartTime> Default unit: s

SEARch:GATE:ABSolute:STOP <StopTime>

Sets the end time of the search area in relation to the trigger point if ​SEARch: ​GATE:​
MODE ​ on page 346 is set to ABSolute.

Parameters:
<StopTime> Default unit: s
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14.2.12.2 Edge Search Configuration

SEARch:​TRIGger: ​EDGE: ​SLOPe​.....................................................................................347
SEARch:​TRIGger: ​EDGE: ​LEVel​.......................................................................................347
SEARch:​TRIGger: ​EDGE: ​LEVel:​DELTa ​............................................................................347

SEARch:TRIGger:EDGE:SLOPe <Slope>

Sets the slope to be found.

Parameters:
<Slope> POSitive | NEGative | EITHer

*RST: POS

Firmware/Software: FW 03.400

SEARch:TRIGger:EDGE:LEVel <Level>

Sets the voltage level for the edge search.

Parameters:
<Level> *RST: 0.6 V

Firmware/Software: FW 03.400

SEARch:TRIGger:EDGE:LEVel:DELTa <DeltaLevel>

Sets a hysteresis range above and below the search level to avoid unwanted search
results caused by noise oscillation around the level.

Parameters:
<DeltaLevel> Range: Lower limit depends on vertical scale and other set-

tings, no upper limit
*RST: 0.2 V

Firmware/Software: FW 03.400

14.2.12.3 Width Search Configuration

SEARch:​TRIGger: ​WIDTh: ​POLarity​..................................................................................347
SEARch:​TRIGger: ​WIDTh: ​LEVel ​......................................................................................348
SEARch:​TRIGger: ​WIDTh: ​LEVel:​DELTa ​...........................................................................348
SEARch:​TRIGger: ​WIDTh: ​RANGe ​....................................................................................348
SEARch:​TRIGger: ​WIDTh: ​WIDTh​.....................................................................................349
SEARch:​TRIGger: ​WIDTh: ​DELTa ​.....................................................................................349

SEARch:TRIGger:WIDTh:POLarity <Polarity>

Indicates the polarity of the pulse to be searched for.
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Parameters:
<Polarity> POSitive | NEGative

*RST: POS

Example: ​chapter 14.3.2.1, "Searching for a Pulse of Specified Width",
on page 432

Firmware/Software: FW 03.400

SEARch:TRIGger:WIDTh:LEVel <Level>

Sets the voltage level on which the pulse width is measured.

Parameters:
<Level> *RST: 500 mV

Firmware/Software: FW 03.400

SEARch:TRIGger:WIDTh:LEVel:DELTa <DeltaLevel>

Sets a hysteresis range above and below the search level to avoid unwanted search
results caused by noise oscillation around the level.

Parameters:
<DeltaLevel> Range: Lower limit depends on vertical scale and other set-

tings, no upper limit
*RST: 200 mV

Firmware/Software: FW 03.400

SEARch:TRIGger:WIDTh:RANGe <Range>

Sets how the measured pulse width is compared with the given limit(s).

To set the width, use ​SEARch: ​TRIGger: ​WIDTh:​WIDTh ​.

To set the range ± Δt, use ​SEARch: ​TRIGger: ​WIDTh:​DELTa ​.

Parameters:
<Range> WITHin | OUTSide | SHORter | LONGer

WITHin
Finds pulses inside the range width ± Δt.
OUTSide
Finds pulses outside the range width ± Δt.
SHORter
Finds pulses shorter than the given width.
LONGer
Finds pulses longer than the given width.
*RST: WITH

Example: ​chapter 14.3.2.1, "Searching for a Pulse of Specified Width",
on page 432
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Firmware/Software: FW 03.400

SEARch:TRIGger:WIDTh:WIDTh <Width>

Sets the reference pulse width, the nominal value for comparisons.

Parameters:
<Width> Default unit: s

Example: ​chapter 14.3.2.1, "Searching for a Pulse of Specified Width",
on page 432

Firmware/Software: FW 03.400

SEARch:TRIGger:WIDTh:DELTa <DeltaWidth>

Sets a range Δt to the reference pulse width set with ​SEARch: ​TRIGger: ​WIDTh:​
WIDTh ​ if ​SEARch: ​TRIGger: ​WIDTh: ​RANGe​ is set to WITHin or OUTSide
Parameters:
<DeltaWidth> Range: Lower limit depends on the resolution, practically no

upper limit

Example: ​chapter 14.3.2.1, "Searching for a Pulse of Specified Width",
on page 432

Firmware/Software: FW 03.400

14.2.12.4 Peak Search Configuration

SEARch:​MEASure: ​PEAK:​POLarity ​..................................................................................349
SEARch:​MEASure: ​LEVel: ​PEAK:​MAGNitude ​.....................................................................349

SEARch:MEASure:PEAK:POLarity <Polarity>

Indicates the polarity of a the pulse to be searched for a peak.

Parameters:
<Polarity> POSitive | NEGative | EITHer

*RST: POS

Firmware/Software: FW 03.400

SEARch:MEASure:LEVel:PEAK:MAGNitude <Magnitude>

Sets the amplitude limit.

Parameters:
<Magnitude> Default unit: V

Firmware/Software: FW 03.400
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14.2.12.5 Rise/Fall Time Search Configuration

SEARch:​TRIGger: ​RISetime: ​SLOPe​.................................................................................350
SEARch:​TRIGger: ​LEVel: ​RISetime:​LOWer ​........................................................................350
SEARch:​TRIGger: ​LEVel: ​RISetime:​UPPer ​........................................................................350
SEARch:​TRIGger: ​RISetime: ​RANGe ​................................................................................350
SEARch:​TRIGger: ​RISetime: ​TIME​....................................................................................351
SEARch:​TRIGger: ​RISetime: ​DELTa ​.................................................................................351

SEARch:TRIGger:RISetime:SLOPe <Polarity>

Sets the slope to be found.

Parameters:
<Polarity> POSitive | NEGative | EITHer

POSitive: to search for rise time.
NEGative to search for fall time.
EITHer: to search for rise and fall time
*RST: POS

Firmware/Software: FW 03.700

SEARch:TRIGger:LEVel:RISetime:LOWer <LowerLevel>

Sets the lower voltage threshold. When the signal crosses this level, the rise time mea-
surement starts or stops depending on the selected slope.

Parameters:
<LowerLevel> *RST: 400 mV

Default unit: V

Firmware/Software: FW 03.700

SEARch:TRIGger:LEVel:RISetime:UPPer <UpperLevel>

Sets the upper voltage threshold. When the signal crosses this level, the rise/fall time
measurement starts or stops depending on the selected slope.

Parameters:
<UpperLevel> *RST: 600 mV

Default unit: V

Firmware/Software: FW 03.700

SEARch:TRIGger:RISetime:RANGe <Range>

Sets how the measured rise or fall time is compared with the given limit(s).

To set the rise/fall time, use ​SEARch: ​TRIGger: ​RISetime: ​TIME ​.

To set the range ± Δt, use ​SEARch: ​TRIGger: ​RISetime:​DELTa ​.
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Parameters:
<Range> LONGer | SHORter | WITHin | OUTSide

LONGer
Finds rise/fall times longer than the given time.
SHORter
Finds rise/fall times shorter than the given time.
WITHin
Finds rise/fall times inside the range time ± Δt.
OUTSide
Finds rise/fall times outside the range time ± Δt.
*RST: LONG

Firmware/Software: FW 03.700

SEARch:TRIGger:RISetime:TIME <Time>

Sets the reference rise or fall time, the nominal value for comparisons.

Parameters:
<Time> Range: Depends on various settings, mainly time base and

sample rate
*RST: 200e-6
Default unit: s

Firmware/Software: FW 03.700

SEARch:TRIGger:RISetime:DELTa <DeltaTime>

Sets a range Δt to the reference rise/fall time set with ​SEARch: ​TRIGger: ​RISetime:​
TIME ​ if ​SEARch: ​TRIGger: ​RISetime:​RANGe ​ on page 350 is set to Within or
Outside. The instrument finds rise/fall times inside or outside the range time ± Δt.

Parameters:
<DeltaTime> Range: Depends on various settings, mainly time base and

sample rate
*RST: 50e-6
Default unit: s

Firmware/Software: FW 03.700

14.2.12.6 Runt Search Configuration

SEARch:​TRIGger: ​RUNT:​POLarity ​...................................................................................352
SEARch:​TRIGger: ​LEVel: ​RUNT:​LOWer ​............................................................................352
SEARch:​TRIGger: ​LEVel: ​RUNT:​UPPer ​.............................................................................352
SEARch:​TRIGger: ​RUNT:​RANGe ​.....................................................................................352
SEARch:​TRIGger: ​RUNT:​WIDTh​......................................................................................353
SEARch:​TRIGger: ​RUNT:​DELTa ​......................................................................................353
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SEARch:TRIGger:RUNT:POLarity <Polarity>

Indicates the polarity of a the runt to be searched for.

Parameters:
<Polarity> POSitive | NEGative | EITHer

*RST: POS

Firmware/Software: FW 03.700

SEARch:TRIGger:LEVel:RUNT:LOWer <LowerLevel>

Sets the lower voltage threshold for runt detection. A positive runt crosses the lower level
twice without crossing the upper level.

Parameters:
<LowerLevel> *RST: 400 mV

Default unit: V

Firmware/Software: FW 03.700

SEARch:TRIGger:LEVel:RUNT:UPPer <UpperLevel>

Sets the upper voltage threshold for runt detection. A negative runt crosses the upper
level twice without crossing the lower level.

Parameters:
<UpperLevel> *RST: 600 mV

Default unit: V

Firmware/Software: FW 03.700

SEARch:TRIGger:RUNT:RANGe <Range>

Sets how the measured pulse width is compared with the given limit(s).

To set the width, use ​SEARch: ​TRIGger: ​RUNT: ​WIDTh​.

To set the range ± Δt, use ​SEARch: ​TRIGger: ​RUNT:​DELTa ​.

Parameters:
<Range> LONGer | SHORter | WITHin | OUTSide

LONGer
Finds pulses longer than the given width.
SHORter
Finds pulses shorter than the given width.
WITHin
Finds pulses inside the range width ± Δt.
OUTSide
Finds pulses outside the range width ± Δt.
*RST: LONG
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Firmware/Software: FW 03.700

SEARch:TRIGger:RUNT:WIDTh <Width>

Sets the reference runt pulse width, the nominal value for comparisons.

Parameters:
<Width> Range: Depends on various settings, mainly time base and

sample rate
*RST: 200e-6
Default unit: s

Firmware/Software: FW 03.700

SEARch:TRIGger:RUNT:DELTa <DeltaWidth>

Sets a range Δt to the reference pulse width set with ​SEARch: ​TRIGger: ​RUNT: ​WIDTh​
if ​SEARch: ​TRIGger: ​RUNT: ​RANGe​ on page 352 is set to WITHin or OUTSide.

Parameters:
<DeltaWidth> Range: Depends on various settings, mainly time base and

sample rate
*RST: 50e-6
Default unit: s

Firmware/Software: FW 03.700

14.2.12.7 Data2Clock Search Configuration

SEARch:​TRIGger: ​DATatoclock: ​CSOurce ​.........................................................................353
SEARch:​TRIGger: ​DATatoclock: ​CLEVel ​............................................................................354
SEARch:​TRIGger: ​DATatoclock: ​DLEVel ​............................................................................354
SEARch:​TRIGger: ​DATatoclock: ​CLEVel:​DELTa ​.................................................................354
SEARch:​TRIGger: ​DATatoclock: ​DLEVel:​DELTa ​.................................................................354
SEARch:​TRIGger: ​DATatoclock: ​CEDGe ​...........................................................................354
SEARch:​TRIGger: ​DATatoclock: ​HTIMe​.............................................................................354
SEARch:​TRIGger: ​DATatoclock: ​STIMe​.............................................................................355

SEARch:TRIGger:DATatoclock:CSOurce <ClockSource>

Selects the input channel of the clock signal.

Parameters:
<ClockSource> CH1 | CH2 | CH3 | CH4 | MA1 | MA2 | MA3 | MA4 | MA5 | RE1 |

RE2 | RE3 | RE4
*RST: CH1

Firmware/Software: FW 03.800
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SEARch:TRIGger:DATatoclock:CLEVel <ClockLevel>

Sets the voltage level for the clock signal. Clock level and clock edge define the reference
point for setup and hold time.

Parameters:
<ClockLevel> Range: depends on vertical scale

Firmware/Software: FW 03.800

SEARch:TRIGger:DATatoclock:DLEVel <DataLevel>

Sets the voltage level for the data signal. The data lavel defines the point of data transition.

Parameters:
<DataLevel> Range: depends on vertical scale

Firmware/Software: FW 03.800

SEARch:TRIGger:DATatoclock:CLEVel:DELTa <LevelDelta>
SEARch:TRIGger:DATatoclock:DLEVel:DELTa <LevelDelta>

Set a hysteresis range to the clock and data levels in order to avoid unwanted search
results caused by noise oscillation around the level. For a rising edge, the hysteresis is
below the search level. Otherwise, for a falling edge the hysteresis is above the level.

Parameters:
<LevelDelta> Range: Lower limit depends on vertical scale and other set-

tings, no upper limit

Firmware/Software: FW 03.800

SEARch:TRIGger:DATatoclock:CEDGe <ClockEdge>

Sets the edge of the clock signal to define the time reference point for the setup and hold
time.

Parameters:
<ClockEdge> POSitive | NEGative | EITHer

*RST: POS

Firmware/Software: FW 03.800

SEARch:TRIGger:DATatoclock:HTIMe <HoldTime>

Sets the minimum time after the clock edge while the data signal must stay steady above
or below the data level. The hold time can be negative. In this case, the hold time ends
before the clock edge, and the setup time must be positive and longer than the absolute
value of the hold time.

Parameters:
<HoldTime> Range: depends on time base and sample interval
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Firmware/Software: FW 03.800

SEARch:TRIGger:DATatoclock:STIMe <SetupTime>

Sets the minimum time before the clock edge while the data signal must stay steady
above or below the data level. The setup time can be negative. In this case, the setup
interval starts after the clock edge, and the hold time must be positive and longer than
the absolute value of the setup time.

Parameters:
<SetupTime> Range: depends on time base and sample interval

Firmware/Software: FW 03.800

14.2.12.8 Pattern Search Configuration

SEARch:​TRIGger: ​PATTern:​SOURce ​...............................................................................355
SEARch:​TRIGger: ​PATTern:​FUNCtion ​..............................................................................355
SEARch:​TRIGger: ​PATTern:​LEVel<n> ​..............................................................................356
SEARch:​TRIGger: ​PATTern:​LEVel<n>: ​DELTa​...................................................................356
SEARch:​TRIGger: ​PATTern:​WIDTh: ​RANGe ​......................................................................356
SEARch:​TRIGger: ​PATTern:​WIDTh[: ​WIDTh] ​.....................................................................357
SEARch:​TRIGger: ​PATTern:​WIDTh: ​DELTa ​.......................................................................357

SEARch:TRIGger:PATTern:SOURce <Pattern>

Specifies the search pattern - the state for each channel.

Parameters:
<Pattern> String parameter

String containing 0, 1, X|x for each channel. The order of channels
is fixed: CH1 CH2 [CH3 CH4].

Example: SEAR:TRIG:PATT:SOUR '1X10'
CH1, CH3 are high, CH4 is low. These states are logically com-
bined with ​SEARch: ​TRIGger: ​PATTern: ​FUNCtion​. CH2 does
not matter (don't care).

SEARch:TRIGger:PATTern:FUNCtion <Function>

Sets the logical combination of the channel states.
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Parameters:
<Function> AND | OR | NAND | NOR

AND
The required states of all channels must appear in the input signal
at the same time.
OR
At least one of the channels must have the required state.
NAND
"Not and" operator, at least one of the channels does not have the
required state.
NOR
"Not or" operator, none of the channels has the required state.
*RST: AND

SEARch:TRIGger:PATTern:LEVel<n> <ThresholdLevel>

Sets the threshold value for each specified source channel. You can set different levels
for the channels

Suffix: 
<n>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<ThresholdLevel> Range: Depends on vertical scale

SEARch:TRIGger:PATTern:LEVel<n>:DELTa <LevelDelta>

Sets a hysteresis range to the level of the specified source channel in order to avoid
unwanted search results caused by noise oscillation around the level. For a rising edge,
the hysteresis is below the search level. Otherwise, for a falling edge the hysteresis is
above the level.

Suffix: 
<n>

.
1..4
Selects the input channel. The number of channels depends on
the instrument.

Parameters:
<LevelDelta> Range: Lower limit depends on vertical scale and other set-

tings, no upper limit

SEARch:TRIGger:PATTern:WIDTh:RANGe <Range>

Sets the condition how the duration of a steady pattern is compared with the given ref-
erence time.

To set the reference value width, use ​SEARch: ​TRIGger: ​PATTern: ​WIDTh[: ​WIDTh] ​
on page 357.
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To set a range Δt, use ​SEARch: ​TRIGger: ​PATTern: ​WIDTh:​DELTa ​ on page 357

Parameters:
<Range> WITHin | OUTSide | LONGer | SHORter

WITHin
Finds patterns steady for a time range width ± Δt.
OUTSide
Finds patterns outside a time range width ± Δt.
LONGer
Finds patterns steady for at least the given width.
SHORter
Finds patterns shorter than the given width.
*RST: LONG

SEARch:TRIGger:PATTern:WIDTh[:WIDTh] <Width>

Sets the reference time of a steady pattern, the nominal value for comparisons.

Parameters:
<Width> Default unit: s

SEARch:TRIGger:PATTern:WIDTh:DELTa <DeltaTime>

Sets a range Δt to the reference pattern duration set with ​SEARch: ​TRIGger: ​
PATTern: ​WIDTh[: ​WIDTh]​ if ​SEARch: ​TRIGger: ​PATTern: ​WIDTh:​RANGe ​ is set to
WITHin or OUTSide.

Parameters:
<DeltaTime> Default unit: s

14.2.12.9 Search Results

SEARch:​RESDiagram: ​SHOW​.........................................................................................357
SEARch:​RESult: ​ALL? ​.....................................................................................................358
SEARch:​RESult<n>? ​......................................................................................................358
SEARch:​RCOunt? ​..........................................................................................................359

SEARch:RESDiagram:SHOW <ResultShow>

Shows or hides the table of search results.

Parameters:
<ResultShow> ON | OFF

*RST: OFF

Example: ​chapter 14.3.2.1, "Searching for a Pulse of Specified Width",
on page 432

Firmware/Software: FW 03.400
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SEARch:RESult:ALL?

Returns all result values of the search.

Return values: 
<AllResults> List of results items seperated by comma

For each result, six values are returned:
1. Result number as indicated in the search results table
2. X-position (time) of the search result
3. Y-position of the search result, currently not relevant
4. Type of the search result (Edge, Peak, ...)
5. Slope or polarity of the search result
6. For peak searches, the value contains the peak voltage. For
width searches, it contains the pulse width. For edge searches,
the value is not relevant.

Example: SEARch:RESult:ALL?
Returns all four results of a peak search:
1,-4.7750e-04,0,PEAK,NEGATIVE,-1.530e-02,2,
-4.4630e-04,0,PEAK,NEGATIVE,-1.530e-02,3,
-4.1660e-04,0,PEAK,NEGATIVE,-1.530e-02,4,
-3.8690e-04,0,PEAK,NEGATIVE,-1.530e-02

Example: ​chapter 14.3.2.1, "Searching for a Pulse of Specified Width",
on page 432

Usage: Query only

Firmware/Software: FW 03.400

SEARch:RESult<n>?

Returns the result values of the specified search result.

See also: ​SEARch: ​RESult: ​ALL? ​

Suffix: 
<n>

.
*
Number of the search result

Return values: 
<Result> Comma-separated value list

Meaning of the values:
Result number, time value, y-position (not relevant), search type,
slope or polarity, optional value: voltage for peak search, pulse
width for width search.

Example: SEARch:RESult3?
Returns the result values of the third search result.
3,-4.1660e-04,0,PEAK,NEGATIVE,-1.530e-02

Usage: Query only

Firmware/Software: FW 03.400
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SEARch:RCOunt?

Returns the number of search results.

Return values: 
<ResultCount> *RST: 0

Example: ​chapter 14.3.2.1, "Searching for a Pulse of Specified Width",
on page 432

Usage: Query only

Firmware/Software: FW 03.400

14.2.13 Protocol Analysis

● General.................................................................................................................359
● Parallel Bus...........................................................................................................361
● SPI........................................................................................................................361
● SSPI......................................................................................................................369
● I²C.........................................................................................................................371
● UART....................................................................................................................381
● CAN.......................................................................................................................387
● LIN.........................................................................................................................401

14.2.13.1 General

BUS: ​STATe​...................................................................................................................359
BUS: ​TYPE​....................................................................................................................359
BUS: ​FORMat​................................................................................................................360
BUS: ​DSIZe​....................................................................................................................360
BUS: ​DSIGnals​...............................................................................................................360
BUS: ​POSition​................................................................................................................360
BUS: ​LIST?​....................................................................................................................360
BUS: ​LIST:​SAVE ​............................................................................................................361

BUS:STATe <State>

Switches the protocol display on or off.

Parameters:
<State> ON | OFF

*RST: OFF

BUS:TYPE <Type>

Defines the bus or interface type for analysis. For most types, a special option to the
instrument is required.
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Parameters:
<Type> PARallel | I2C | SPI | SSPI | UART | CAN | LIN

*RST: PARallel

BUS:FORMat <Format>

Sets the decoding format for the display on the screen.

Parameters:
<Format> ASCii | HEXadecimal | BINary | DECimal

*RST: HEXadecimal

BUS:DSIZe <DisplaySize>

Sets the height of the decoded bus signal on the sreen.

Parameters:
<DisplaySize> SMALl | MEDium | LARGe

*RST: MEDium

BUS:DSIGnals <BitsSignals>

Displays the individual bit lines above the decoded bus line.

Parameters:
<BitsSignals> ON | OFF

*RST: ON

BUS:POSition <Position>

Sets the vertical position of the decoded bus signal in divisions on the sreen.

Parameters:
<Position> Range: 4  to  -4

Increment: 0.02
*RST: -3.5
Default unit: div

BUS:LIST?

Returns the contents of the frame table in block data format.

Return values: 
<DataTable> Block data

Usage: Query only
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BUS:LIST:SAVE <FilePath>

Saves the decoded data (frame table) to the specified CSV file (comma-separated list).

Setting parameters: 
<FilePath> String containing the storage device, path, and file name

Example: BUS:LIST:SAVE "/USB_FRONT/MYTABLE.CSV"
Saves the frame table data to the MYTABLE.CSV file on a USB
flash device connected to the front panel.

Usage: Setting only

14.2.13.2 Parallel Bus

BUS: ​PARallel: ​WIDTh​.....................................................................................................361

BUS:PARallel:WIDTh <BusWidth>

Sets the number of lines to be analyzed.

Parameters:
<BusWidth> Maximum number is the number of input channels.

Range: 1  to  4
Increment: 1
*RST: 4
Default unit: Bit

14.2.13.3 SPI

● SPI - Configuration................................................................................................361
● SPI - Trigger..........................................................................................................364
● SPI - Decode Results............................................................................................365

SPI - Configuration

BUS: ​SPI:​CS: ​SOURce ​....................................................................................................362
BUS: ​SPI:​CS: ​POLarity ​.....................................................................................................362
BUS: ​SPI:​CLOCk: ​SOURce ​..............................................................................................362
BUS: ​SPI:​CLOCk: ​POLarity ​..............................................................................................362
BUS: ​SPI:​MOSI:​SOURce ​.................................................................................................362
BUS: ​SPI:​DATA: ​SOURce ​................................................................................................362
BUS: ​SPI:​MISO:​SOURce ​.................................................................................................363
BUS: ​SPI:​MOSI:​POLarity ​.................................................................................................363
BUS: ​SPI:​DATA: ​POLarity​................................................................................................363
BUS: ​SPI:​MISO:​POLarity ​.................................................................................................363
BUS: ​SPI:​BORDer ​..........................................................................................................363
BUS: ​SPI:​SSIZe​..............................................................................................................363
CHANnel<m>: ​THReshold: ​FINDlevel ​................................................................................364
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BUS:SPI:CS:SOURce <Source>

Selects the input channel of the chip select line.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

*RST: CH1

BUS:SPI:CS:POLarity <Polarity>

Selects whether the chip select signal is high active (high = 1) or low active (low = 1).

Parameters:
<Polarity> POSitive | NEGative

POSitive = high active
NEGative = low active
*RST: POSitive

BUS:SPI:CLOCk:SOURce <Source>

Selects the input channel of the clock line.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

*RST: CH1

BUS:SPI:CLOCk:POLarity <Polarity>

Selects if data is stored with the rising or falling slope of the clock. The slope marks the
begin of a new bit.

Parameters:
<Polarity> POSitive | NEGative

POSitive: rising slope
NEGative: falling slope
*RST: NEGative

BUS:SPI:MOSI:SOURce <Source>
BUS:SPI:DATA:SOURce <Source>

Selects the input channel of the MOSI line, or of the data line if only one data line is used.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

*RST: CH1
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BUS:SPI:MISO:SOURce <MisoSource>

Selects the input channel of the optional MISO line.

Parameters:
<MisoSource> CH1 | CH2 | CH3 | CH4 | NONE

*RST: NONE

BUS:SPI:MOSI:POLarity <Polarity>
BUS:SPI:DATA:POLarity <Polarity>

Selects whether transmitted data is high active (high = 1) or low active (low = 1) on the
MOSI line, or on the data line if only one data line is used.

Parameters:
<Polarity> POSitive | NEGative

POSitive = high active
NEGative = low active
*RST: POSitive

BUS:SPI:MISO:POLarity <MisoPolarity>

Selects whether transmitted data is high active (high = 1) or low active (low = 1) on the
MISO line.

Parameters:
<MisoPolarity> ACTLow | ACTHigh

*RST: ACTH

BUS:SPI:BORDer <BitOrder>

Defines if the data of the messages starts with MSB (most significant bit) or LSB (least
significant bit).

Parameters:
<BitOrder> MSBFirst | LSBFirst

*RST: MSBFirst

BUS:SPI:SSIZe <SymbolSize>

Sets the word length, the number of bits in a message.

Parameters:
<SymbolSize> Range: 4  to  32

Increment: 1
*RST: 8
Default unit: Bit
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CHANnel<m>:THReshold:FINDlevel

Executes the analysis of all channels that are configured for the selected bus and sets
the threshold for digitization of analog signals for each channel.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Usage: Event

SPI - Trigger

TRIGger:​A: ​SOURce: ​SPI ​.................................................................................................364
TRIGger:​A: ​SPI: ​MODE​....................................................................................................364
TRIGger:​A: ​SPI: ​PATTern​.................................................................................................365
TRIGger:​A: ​SPI: ​PLENgth​.................................................................................................365
TRIGger:​A: ​SPI: ​POFFset​.................................................................................................365

TRIGger:A:SOURce:SPI <SpiSource>

Sets the line that is used as trigger source.

Parameters:
<SpiSource> MOSI | MISO

*RST: MOSI

TRIGger:A:SPI:MODE <Mode>

Specifies the trigger mode for SPI/SSPI protocols.

Parameters:
<Mode> BSTart | BEND | NTHBit | PATTern

BSTart
Burst start, sets the trigger event to the start of the frame. The
frame starts when the chip select signal CS changes to the active
state.
BEND
Burst end, sets the trigger event to the end of the message.
NTHBit
Sets the trigger event to the specified bit number. To define the bit
number, use ​TRIGger: ​A: ​SPI: ​POFFset ​.
PATTern
Sets the trigger event to a serial pattern. To define the pattern, use
​TRIGger: ​A:​SPI: ​PATTern ​.
For a complete configuration of the pattern mode, you also have
to set ​TRIGger: ​A:​SPI: ​PLENgth ​ and ​TRIGger: ​A:​SPI: ​
POFFset ​.
*RST: BSTart
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TRIGger:A:SPI:PATTern <DataPattern>

Defines the bit pattern as trigger condition. The pattern length is adjusted to the number
of bits defined in the pattern.

Parameters:
<DataPattern> String with max. 32 characters (4 byte + 8 bit) . Characters 0, 1,

and X are allowed.

Example: TRIG:A:SPI:PATT "0011XXXX0110"
Sets a 12bit pattern.

TRIGger:A:SPI:PLENgth <PatternLength>

Returns the number of bits in the previously defined bit pattern ( ​TRIGger:​A: ​SPI: ​
PATTern ​). The command can also be used to shorten a previously defined bit pattern.

Parameters:
<PatternLength> Range: 1  to  32

Increment: 1
*RST: 4

Example: TRIG:A:SPI:PATT "0011XXXX0110"
TRIG:A:SPI:PLEN?
12
TRIG:A:SPI:PLEN 4
TRIG:A:SPI:PATT?
"0011"

TRIGger:A:SPI:POFFset <PatternBitOffset>

Sets the number of bits before the first bit of the pattern.

Parameters:
<PatternBitOffset> Number of ignored bits

Range: 0  to  4095
Increment: 1
*RST: 0

SPI - Decode Results

BUS: ​SPI:​FCOunt? ​.........................................................................................................366
BUS: ​SPI:​FRAME<n>:​STATus? ​.......................................................................................366
BUS: ​SPI:​FRAME<n>:​STARt? ​.........................................................................................366
BUS: ​SPI:​FRAME<n>:​STOP? ​..........................................................................................366
BUS: ​SPI:​FRAME<n>:​DATA: ​MISO? ​.................................................................................367
BUS: ​SPI:​FRAME<n>:​DATA: ​MOSI? ​.................................................................................367
BUS: ​SPI:​FRAME<n>:​WCOunt? ​.......................................................................................367
BUS: ​SPI:​FRAME<n>:​WORD<o>: ​STARt?​.........................................................................368
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BUS: ​SPI:​FRAME<n>:​WORD<o>: ​STOP?​.........................................................................368
BUS: ​SPI:​FRAME<n>:​WORD<o>: ​MOSI?​..........................................................................368
BUS: ​SPI:​FRAME<n>:​WORD<o>: ​MISO?​..........................................................................369

BUS:SPI:FCOunt?

Returns the number of decoded frames.

Return values: 
<FrameCount> Total number of decoded frames.

Usage: Query only

BUS:SPI:FRAME<n>:STATus?

Returns the overall state of the specified frame.

Suffix: 
<n>

.
*
Selects the frame.

Return values: 
<Status> OK | INCFirst | INCLast | INSufficient

INCFirst
First frame is incomplete
INCLast
Last frame is incomplete

Usage: Query only

BUS:SPI:FRAME<n>:STARt?

Returns the start time of the specified frame.

Suffix: 
<n>

.
*
Selects the frame.

Return values: 
<StartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS:SPI:FRAME<n>:STOP?

Returns the end time of the specified frame.

Suffix: 
<n>

.
*
Selects the frame.
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Return values: 
<StopTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS:SPI:FRAME<n>:DATA:MISO?

Returns the data words of the specified frame of the MISO line.

Suffix: 
<n>

.
*
Selects the frame.

Return values: 
<DataMiso> List of decimal values of data bytes

Example: BUS:SPI:FRAM3:DATA:MISO?
-> 94,177,171,60,242,219,100,0

Usage: Query only

BUS:SPI:FRAME<n>:DATA:MOSI?

Returns the data words of the specified frame of the MOSI line.

Suffix: 
<n>

.
*
Selects the frame.

Return values: 
<DataMosi> List of decimal values of data bytes

Example: BUS:SPI:FRAM3:DATA:MOSI?
-> 94,177,171,60,242,219,100,0

Usage: Query only

BUS:SPI:FRAME<n>:WCOunt?

Returns the number of words in the specified frame.

Suffix: 
<n>

.
*
Selects the frame.

Return values: 
<WordCount> Number of words

Usage: Query only
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BUS:SPI:FRAME<n>:WORD<o>:STARt?

Returns the start time of the specified data word.

Suffix: 
<n>

.
*
Selects the frame.

<o> *
Selects the word number.

Return values: 
<StartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS:SPI:FRAME<n>:WORD<o>:STOP?

Returns the end time of the specified data word.

Suffix: 
<n>

.
*
Selects the frame.

<o> *
Selects the word number.

Return values: 
<StopTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS:SPI:FRAME<n>:WORD<o>:MOSI?

Returns the data value of the specified word on the MOSI line.

Use this command if only one line is defined.

Suffix: 
<n>

.
*
Selects the frame (1...n)

<o> *
Selects the word number (1...m)

Return values: 
<Data> Decimal value of the data word

Usage: Query only
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BUS:SPI:FRAME<n>:WORD<o>:MISO?

Returns the data value of the specified word on the optional MISO line.

Suffix: 
<n>

.
*
Selects the frame (1...n)

<o> *
Selects the word number (1...m)

Return values: 
<Data> Decimal value of the data word

Usage: Query only

14.2.13.4 SSPI

BUS: ​SSPI:​CLOCk: ​SOURce ​............................................................................................369
BUS: ​SSPI:​CLOCk: ​POLarity ​............................................................................................369
BUS: ​SSPI:​MOSI:​SOURce ​..............................................................................................370
BUS: ​SSPI:​DATA: ​SOURce ​..............................................................................................370
BUS: ​SSPI:​MISO:​SOURce ​..............................................................................................370
BUS: ​SSPI:​MOSI:​POLarity ​...............................................................................................370
BUS: ​SSPI:​DATA: ​POLarity​..............................................................................................370
BUS: ​SSPI:​MISO:​POLarity ​...............................................................................................370
BUS: ​SSPI:​BITime ​..........................................................................................................370
BUS: ​SSPI:​BORDer ​........................................................................................................371
BUS: ​SSPI:​SSIZe​...........................................................................................................371

BUS:SSPI:CLOCk:SOURce <Source>

Selects the input channel of the clock line.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

CH3 and CH4 are only available with 4-channel R&S RTM oscil-
loscopes.
*RST: CH1

BUS:SSPI:CLOCk:POLarity <Polarity>

Selects if data is stored with the rising or falling slope of the clock. The slope marks the
begin of a new bit.

Parameters:
<Polarity> POSitive | NEGative

POSitive: rising slope
NEGative: falling slope
*RST: POSitive
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BUS:SSPI:MOSI:SOURce <Source>
BUS:SSPI:DATA:SOURce <Source>

Selects the input channel of the MOSI line, or of the data line if only one data line is used.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

CH3 and CH4 are only available with 4-channel R&S RTM oscil-
loscopes.
*RST: CH1

BUS:SSPI:MISO:SOURce <MisoSource>

Selects the input channel of the optional MISO line.

Parameters:
<MisoSource> CH1 | CH2 | CH3 | CH4 | NONE

*RST: NONE

BUS:SSPI:MOSI:POLarity <Polarity>
BUS:SSPI:DATA:POLarity <Polarity>

Selects whether transmitted data is high active (high = 1) or low active (low = 1) on the
MOSI line, or on the data line if only one data line is used.

Parameters:
<Polarity> POSitive | NEGative

POSitive = high active
NEGative = low active
*RST: POSitive

BUS:SSPI:MISO:POLarity <MisoPolarity>

Selects whether transmitted data is high active (high = 1) or low active (low = 1) on the
MISO line.

Parameters:
<MisoPolarity> ACTLow | ACTHigh

*RST: ACTH

BUS:SSPI:BITime <BurstIdleTime>

Within the idle time the data and clock lines are low. A new frame begins when the idle
time has expired and the clock line has been inactive during that time. If the time interval
between the data words is shorter than the idle time, the words are part of the same
frame.
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Parameters:
<BurstIdleTime> Range: 16e-9  to  838.832e-6

Increment: 16e-9
*RST: 100e-6
Default unit: s

BUS:SSPI:BORDer <BitOrder>

Defines if the data of the messages starts with MSB (most significant bit) or LSB (least
significant bit).

Parameters:
<BitOrder> MSBFirst | LSBFirst

*RST: MSBFirst

BUS:SSPI:SSIZe <SymbolSize>

Sets the word length, the number of bits in a message.

Parameters:
<SymbolSize> Range: 4  to  32

Increment: 1
*RST: 8
Default unit: Bit

14.2.13.5 I²C

● I²C - Configuration.................................................................................................371
● I²C - Trigger...........................................................................................................372
● I²C - Decode Results.............................................................................................375

I²C - Configuration

BUS: ​I2C:​CLOCk: ​SOURce ​..............................................................................................371
BUS: ​I2C:​DATA: ​SOURce ​................................................................................................372
CHANnel<m>: ​THReshold: ​FINDlevel ​................................................................................372

BUS:I2C:CLOCk:SOURce <Source>

Sets the input channel to which the clock line is connected.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

CH3 and CH4 are only available with 4-channel R&S RTM oscil-
loscopes.
*RST: CH1
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BUS:I2C:DATA:SOURce <Source>

Sets the input channel to which the data line is connected.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

CH3 and CH4 are only available with 4-channel R&S RTM oscil-
loscopes.
*RST: CH1

CHANnel<m>:THReshold:FINDlevel

Executes the analysis of all channels that are configured for the selected bus and sets
the threshold for digitization of analog signals for each channel.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Usage: Event

I²C - Trigger

TRIGger:​A: ​I2C: ​MODE​....................................................................................................372
TRIGger:​A: ​I2C: ​ACCess ​..................................................................................................373
TRIGger:​A: ​I2C: ​AMODe ​..................................................................................................373
TRIGger:​A: ​I2C: ​ADDRess ​................................................................................................373
TRIGger:​A: ​I2C: ​PATTern ​.................................................................................................374
TRIGger:​A: ​I2C: ​PLENgth​.................................................................................................374
TRIGger:​A: ​I2C: ​POFFset​.................................................................................................375

TRIGger:A:I2C:MODE <Mode>

Specifies the trigger mode for I²C.
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Parameters:
<Mode> STARt | RESTart | STOP | MACKnowledge | PATTern

STARt
Start of the message. The start condition is a falling slope on SDA
while SCL is high.
RESTart
Restarted message. The restart is a repeated start condition.
STOP
End of the message. The stop condition is a rising slope on SDA
while SCL is high.
MACKnowledge
Missing acknowledge. If the transfer failed, at the moment of the
acknowledge bit the SCL and the SDA lines are both on high level.
PATTern
Triggers on a set of trigger conditions: read or write access of the
master, to an address, or/and to a bit pattern in the message.
For a complete configuration of the pattern mode, you have to set:
​TRIGger: ​A:​I2C: ​ACCess ​ (read/write access), and
​TRIGger: ​A:​I2C: ​AMODe ​ and ​TRIGger:​A: ​I2C: ​ADDRess ​
(address), and/or
​TRIGger: ​A:​I2C: ​POFFset ​ and ​TRIGger: ​A:​I2C: ​PLENgth ​
and ​TRIGger: ​A:​I2C: ​PATTern ​ (pattern)

*RST: STARt

TRIGger:A:I2C:ACCess <Access>

Toggles the trigger condition between Read and Write access of the master.

Parameters:
<Access> READ | WRITe

*RST: READ

TRIGger:A:I2C:AMODe <AdrMode>

Sets the lenght of the slave address.

Parameters:
<AdrMode> NORMal | EXTended

NORMal: 7 bit address
EXTended: 10 bit address
*RST: NORMal

TRIGger:A:I2C:ADDRess <AddressString>

Sets the address of the slave device. The address can have 7 bits or 10 bits.
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Parameters:
<AddressString> String with max. 7 or 10 characters, depending on the address

length. Characters 0, 1, and X are allowed, but X cannot be
assigned to a specified bit. If at least one X occurs in the address,
the complete address is set to X.

Example: TRIG:A:I2C:AMOD NORM
TRIG:A:I2C:ADDR "1011"
TRIG:A:I2C:ADDR?
Return value (7bit address): "0001011"

Example: TRIG:A:I2C:AMOD EXT
TRIG:A:I2C:ADDR "10X1"
TRIG:A:I2C:ADDR?
Return value (10bit address): "XXXXXXXXXX"

TRIGger:A:I2C:PATTern <DataPattern>

Defines the bit pattern as trigger condition. Make sure that the correct pattern length has
been defined before with ​TRIGger: ​A:​I2C: ​PLENgth ​.

Parameters:
<DataPattern> String with max. 24 characters (3 byte + 8 bit) . Characters 0, 1,

and X are allowed. X can be assigned to a specified bit. If you
define a pattern shorter than the pattern length, the missing LSB
are filled with X. If you define a pattern longer than the pattern
length, the pattern string is not valid

Example: TRIG:A:I2C:PLEN 2
TRIG:A:I2C:PATT "10X10000XXXX1111"
TRIG:A:I2C:PATT?
Return value (2 bytes): "10X10000XXXX1111"

Example: TRIG:A:I2C:PLEN 1
TRIG:A:I2C:PATT "110"
TRIG:A:I2C:PATT?
Return value (1 byte): "110XXXXX"

TRIGger:A:I2C:PLENgth <PatternLength>

Defines how many bytes are considered in the trigger condition. To set the pattern for
these bytes, use ​TRIGger: ​A:​I2C: ​PATTern ​.

Parameters:
<PatternLength> Number of bytes

Range: 1  to  3
Increment: 1
*RST: 1
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TRIGger:A:I2C:POFFset <PatternByteOffset>

Sets the number of bytes before the first byte of interest, relating to the end of the address
bytes.

Parameters:
<PatternByteOffset> Number of ignored bytes

Range: 0  to  4095
Increment: 1
*RST: 0

I²C - Decode Results

BUS: ​I2C:​FCOunt? ​..........................................................................................................375
BUS: ​I2C:​FRAMe<n>: ​DATA? ​...........................................................................................375
BUS: ​I2C:​FRAMe<n>: ​STATus?​........................................................................................376
BUS: ​I2C:​FRAMe<n>: ​STARt?​..........................................................................................376
BUS: ​I2C:​FRAMe<n>: ​STOP?​...........................................................................................376
BUS: ​I2C:​FRAMe<n>: ​ACCess? ​........................................................................................377
BUS: ​I2C:​FRAMe<n>: ​AMODe? ​........................................................................................377
BUS: ​I2C:​FRAMe<n>: ​ACOMplete?​...................................................................................377
BUS: ​I2C:​FRAMe<n>: ​ADDRess? ​.....................................................................................377
BUS: ​I2C:​FRAMe<n>: ​ADEVice? ​.......................................................................................378
BUS: ​I2C:​FRAMe<n>: ​ASTart?​.........................................................................................378
BUS: ​I2C:​FRAMe<n>: ​AACCess? ​.....................................................................................378
BUS: ​I2C:​FRAMe<n>: ​ADBStart?​......................................................................................379
BUS: ​I2C:​FRAMe<n>: ​BCOunt?​........................................................................................379
BUS: ​I2C:​FRAMe<n>: ​BYTE<o>: ​VALue?​...........................................................................379
BUS: ​I2C:​FRAMe<n>: ​BYTE<o>: ​STARt?​...........................................................................380
BUS: ​I2C:​FRAMe<n>: ​BYTE<o>: ​ACKStart?​.......................................................................380
BUS: ​I2C:​FRAMe<n>: ​BYTE<o>: ​ACCess? ​.........................................................................380
BUS: ​I2C:​FRAMe<n>: ​BYTE<o>: ​COMPlete?​......................................................................381

BUS:I2C:FCOunt?

Returns the number of received frames.

Return values: 
<FrameCount> Total number of decoded frames.

Usage: Query only

BUS:I2C:FRAMe<n>:DATA?

Returns the data words of the specified frame.

Suffix: 
<n>

.
1..n
Selects the frame.

Return values: 
<DataWordsInFrame>Comma-separated list of decimal values of the data bytes.
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Example: BUS:I2C:FRAM2:DATA?
returns four data bytes:
-> 69,158,174,161

Usage: Query only

BUS:I2C:FRAMe<n>:STATus?

Returns the overall state of the frame.

Suffix: 
<n>

.
1..n
Selects the frame.

Return values: 
<State> INComplete | OK | UNEXpstop | INSufficient | ADDifferent

INComplete
The frame is not completely contained in the acquisition.

Usage: Query only

BUS:I2C:FRAMe<n>:STARt?

Returns the start time of the specified frame.

Suffix: 
<n>

.
1..n
Selects the frame.

Return values: 
<StartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS:I2C:FRAMe<n>:STOP?

Returns the end time of the specified frame.

Suffix: 
<n>

.
1..n
Selects the frame.

Return values: 
<EndTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only
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BUS:I2C:FRAMe<n>:ACCess?

Returns the transfer direction - read or write access from master to slave.

Suffix: 
<n>

.
1..n
Selects the frame.

Return values: 
<Access> INComplete | READ | WRITE | EITHer | UNDF

INComplete
The frame is not completely contained in the acquisition.
UNDF
Access is not defined.

Usage: Query only

BUS:I2C:FRAMe<n>:AMODe?

Returns the address length.

Suffix: 
<n>

.
1..n
Selects the frame.

Return values: 
<AddressMode> BIT7 | BIT10

Usage: Query only

BUS:I2C:FRAMe<n>:ACOMplete?

Returns the state of the address.

Suffix: 
<n>

.
1..n
Selects the frame.

Return values: 
<AddressComplete> ON | OFF

ON
Address was received completely.

Usage: Query only

BUS:I2C:FRAMe<n>:ADDRess?

Returns the decimal address value of the indicated frame including the R/W bit.

Suffix: 
<n>

.
1..n
Selects the frame.
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Return values: 
<AddressValue> Decimal value

Range: 0  to  2047
Increment: 1

Usage: Query only

BUS:I2C:FRAMe<n>:ADEVice?

Returns the decimal address value of the indicated frame without R/W bit.

Suffix: 
<n>

.
1..n
Selects the frame.

Return values: 
<SlaveAddress> Decimal value

Range: 0  to  1023
Increment: 1

Usage: Query only

BUS:I2C:FRAMe<n>:ASTart?

Returns the start time of the address for the indicated frame.

Suffix: 
<n>

.
1..n
Selects the frame.

Return values: 
<StartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS:I2C:FRAMe<n>:AACCess?

Returns the address acknowledge bit value for the indicated frame.

Suffix: 
<n>

.
1..n
Selects the frame.

Return values: 
<Acknowledge> INComplete | ACK | NACK | EITHer

Usage: Query only
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BUS:I2C:FRAMe<n>:ADBStart?

Returns the start time of the address acknowledge bit.

Suffix: 
<n>

.
1..n
Selects the frame.

Return values: 
<AckStartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS:I2C:FRAMe<n>:BCOunt?

Returns the number of data bytes in the specified frame.

Suffix: 
<n>

.
1..n
Selects the frame.

Return values: 
<ByteCount im
Frame>

Number of words (bytes)

Example: BUS:I2C:FRAM2:BCO?
-> 4

Usage: Query only

BUS:I2C:FRAMe<n>:BYTE<o>:VALue?

Returns the decimal value of the specified byte.

Suffix: 
<n>

.
1..n
Selects the frame.

<o> *
Selects the byte number.

Return values: 
<ByteValue> Decimal value

Range: 0  to  255
Increment: 1

Example: BUS:I2C:FRAM2:BYTE2:VAL?
-> 158

Usage: Query only
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BUS:I2C:FRAMe<n>:BYTE<o>:STARt?

Returns the start time of the specified data byte.

Suffix: 
<n>

.
1..n
Selects the frame.

<o> *
Selects the byte number.

Return values: 
<StartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS:I2C:FRAMe<n>:BYTE<o>:ACKStart?

Returns the start time of the acknowledge bit of the specified byte.

Suffix: 
<n>

.
1..n
Selects the frame.

<o> *
Selects the byte number.

Return values: 
<AckStartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS:I2C:FRAMe<n>:BYTE<o>:ACCess?

Returns the acknowledge bit value of the specified data byte.

Suffix: 
<n>

.
1..n
Selects the frame.

<o> *
Selects the byte number.

Return values: 
<Acknowledge> INComplete | ACK | NACK | EITHer

Usage: Query only
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BUS:I2C:FRAMe<n>:BYTE<o>:COMPlete?

Returns the state of the byte.

Suffix: 
<n>

.
1..n
Selects the frame.

<o> *
Selects the byte number.

Return values: 
<ByteComplete> ON | OFF

ON
Data byte was received completely.

Usage: Query only

14.2.13.6 UART

● UART - Configuration............................................................................................381
● UART - Trigger......................................................................................................384
● UART - Decode Results........................................................................................385

UART - Configuration

BUS: ​UART:​RX: ​SOURce ​.................................................................................................381
BUS: ​UART:​DATA:​SOURce ​.............................................................................................381
BUS: ​UART:​TX:​SOURce ​.................................................................................................382
BUS: ​UART:​POLarity​......................................................................................................382
BUS: ​UART:​DATA:​POLarity ​.............................................................................................382
BUS: ​UART:​SSIZe​..........................................................................................................382
BUS: ​UART:​PARity ​.........................................................................................................382
BUS: ​UART:​SBIT​............................................................................................................383
BUS: ​UART:​BAUDrate ​....................................................................................................383
BUS: ​UART:​BITime ​.........................................................................................................383
CHANnel<m>: ​THReshold: ​FINDlevel ​................................................................................383

BUS:UART:RX:SOURce <RxSource>
BUS:UART:DATA:SOURce <RxSource>

Selects the input channel of the Rx line.

Parameters:
<RxSource> CH1 | CH2 | CH3 | CH4

CH3 and CH4 are only available with 4-channel R&S RTM oscil-
loscopes.
*RST: CH1

 

Command Reference



Remote ControlR&S®RTM

382User Manual 1305.0595.02 ─ 08

BUS:UART:TX:SOURce <TxSource>

Selects the input channel of the Tx line.

Parameters:
<TxSource> CH1 | CH2 | CH3 | CH4 | NONE

NONE
Disables the optional Tx line.
*RST: NONE

BUS:UART:POLarity <IdleState>

Defines the logic levels of the bus. The idle state corresponds to a logic 1, and the start
bit to a logic 0.

Alternative command for ​BUS: ​UART: ​DATA: ​POLarity ​

Parameters:
<IdleState> IDLLow | IDLHigh

IDLLow: idle low, low = 1
IDLHigh: idle high, high = 1
*RST: IDLH

BUS:UART:DATA:POLarity <Polarity>

Defines if the transmitted data on the bus is high (high = 1) or low (low = 1) active.

Alternative command for ​BUS: ​UART: ​POLarity ​.

Parameters:
<Polarity> POSitive | NEGative

POSitive = high active
NEGative = low active
*RST: POS

BUS:UART:SSIZe <SymbolSize>

Sets the number of data bits in a message.

Parameters:
<SymbolSize> Range: 5  to  9

Increment: 1
*RST: 8
Default unit: Bit

BUS:UART:PARity <Parity>

Defines the optional parity bit that is used for error detection.
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Parameters:
<Parity> ODD | EVEN | NONE

See: ​"Parity" on page 173
*RST: NONE

BUS:UART:SBIT <StopBitNumber>

Sets the stop bits.

Parameters:
<StopBitNumber> B1 | B1_5 | B2

1; 1.5 or 2 stop bits are possible.
*RST: B1

BUS:UART:BAUDrate <Baudrate>

Sets the number of transmitted bits per second.

Parameters:
<Baudrate> Range: 100  to  78.1E6

Increment: 100
*RST: 115200
Default unit: Bit

BUS:UART:BITime <BurstIdleTime>

Sets the minimal time between two data frames (packets), that is, between the last stop
bit and the start bit of the next frame.

Parameters:
<BurstIdleTime> Range: Range depends on the bus configuration, mainly on

bit rate and symbole size.
Default unit: s

CHANnel<m>:THReshold:FINDlevel

Executes the analysis of all channels that are configured for the selected bus and sets
the threshold for digitization of analog signals for each channel.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Usage: Event
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UART - Trigger

TRIGger:​A: ​SOURce: ​UART​.............................................................................................384
TRIGger:​A: ​UART:​MODE​................................................................................................384
TRIGger:​A: ​UART:​PATTern ​.............................................................................................385
TRIGger:​A: ​UART:​PLENgth ​.............................................................................................385
TRIGger:​A: ​UART:​POFFset​.............................................................................................385

TRIGger:A:SOURce:UART <UartSource>

Selects one of the Rx and Tx lines as trigger source.

Parameters:
<UartSource> RX | TX

*RST: RX

TRIGger:A:UART:MODE <Mode>

Specifies the trigger mode for UART/RS-232 interfaces.

Parameters:
<Mode> BSTart | SBIT | NTHSymbol | SYMBol | PATTern | PRERror |

FERRor | BREak
BSTart
Burst start. Sets the trigger to the begin of a data frame. The frame
start is the first start bit after the idle time.
SBIT
Start bit. The start bit is the first low bit after a stop bit.
NTHSymbol
Sets the trigger to the n-th symbol of a burst.
SYMBol
Triggers if a pattern occurs in a symbol at any position in a burst.
PATTern
Triggers on a serial pattern at a defined position in the burst.
To define the pattern, use ​TRIGger: ​A:​UART: ​PLENgth ​ and ​
TRIGger: ​A:​UART: ​PATTern ​.
To define the position, use ​TRIGger: ​A:​UART: ​POFFset ​
on page 385.
PRERror
Parity Error: Triggers if a bit error occured in transmission.
FERRor
Triggers on frame error.
BREak
Triggers if a start bit is not followed by a stop bit within a defined
time. During the break the stop bits are at low state.
*RST: SBIT
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TRIGger:A:UART:PATTern <DataPattern>

Defines the bit pattern as trigger condition.

Parameters:
<DataPattern> Binary pattern with max. 32 bit. Characters 0, 1, and X are allowed.

*RST: 1 = "00000001"

TRIGger:A:UART:PLENgth <PatternLength>

Defines how many symbols build up the serial pattern.

Parameters:
<PatternLength> Number of symbols

Range: 1  to  3
Increment: 1
*RST: 1

TRIGger:A:UART:POFFset <PatternByteOffset>

Sets the number of symbols before the first symbol of the pattern.

Parameters:
<PatternByteOffset> Number of ignored symbols

Range: 0  to  4095
Increment: 1
*RST: 0

UART - Decode Results

BUS: ​UART:​RX: ​FCOunt?​................................................................................................385
BUS: ​UART:​TX:​FCOunt? ​.................................................................................................385
BUS: ​UART:​RX: ​FRAMe<n>:​WCOunt? ​..............................................................................386
BUS: ​UART:​TX:​FRAMe<n>: ​WCOunt?​..............................................................................386
BUS: ​UART:​RX: ​FRAMe<n>:​WORD<o>:​STATe? ​...............................................................386
BUS: ​UART:​TX:​FRAMe<n>: ​WORD<o>:​STATe? ​................................................................386
BUS: ​UART:​RX: ​FRAMe<n>:​WORD<o>:​STARt? ​................................................................386
BUS: ​UART:​TX:​FRAMe<n>: ​WORD<o>:​STARt? ​................................................................386
BUS: ​UART:​RX: ​FRAMe<n>:​WORD<o>:​STOP? ​.................................................................387
BUS: ​UART:​TX:​FRAMe<n>: ​WORD<o>:​STOP? ​.................................................................387
BUS: ​UART:​RX: ​FRAMe<n>:​WORD<o>:​VALue? ​................................................................387
BUS: ​UART:​TX:​FRAMe<n>: ​WORD<o>:​VALue? ​................................................................387

BUS:UART:RX:FCOunt?
BUS:UART:TX:FCOunt?
Returns the number of decoded frames on the RX and TX lines, respectivley.

Return values: 
<FrameCount> Total number of decoded frames.
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Usage: Query only

BUS:UART:RX:FRAMe<n>:WCOunt?
BUS:UART:TX:FRAMe<n>:WCOunt?
Returns the number of symbols in the specified frame.

Suffix: 
<n>

.
*
Selects the frame.

Return values: 
<WordCount> Number of words (symbols, characters)

Usage: Query only

BUS:UART:RX:FRAMe<n>:WORD<o>:STATe?
BUS:UART:TX:FRAMe<n>:WORD<o>:STATe?
Returns the status of the specified symbol (word).

Suffix: 
<n>

.
*
Selects the frame.

<o> *
Selects the word number.

Return values: 
<Status> OK | FRSTart | FRENd | FRMError | STERror | SPERror |

PRERror | INSufficient | BREak

Usage: Query only

BUS:UART:RX:FRAMe<n>:WORD<o>:STARt?
BUS:UART:TX:FRAMe<n>:WORD<o>:STARt?
Returns the start time of the specified symbol (word).

Suffix: 
<n>

.
*
Selects the frame.

<o> *
Selects the word number.

Return values: 
<StartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only
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BUS:UART:RX:FRAMe<n>:WORD<o>:STOP?
BUS:UART:TX:FRAMe<n>:WORD<o>:STOP?
Returns the end time of the specified symbol (word).

Suffix: 
<n>

.
*
Selects the frame.

<o> *
Selects the word number.

Return values: 
<StopTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS:UART:RX:FRAMe<n>:WORD<o>:VALue?
BUS:UART:TX:FRAMe<n>:WORD<o>:VALue?
Return the value of the specified symbol (word) on the Rx line and Tx line, respectively.

Suffix: 
<n>

.
*
Selects the frame.

<o> *
Selects the word number.

Return values: 
<Value> Decimal value

Range: 0  to  511
Increment: 1

Usage: Query only

14.2.13.7 CAN

● CAN - Configuration..............................................................................................387
● CAN - Trigger........................................................................................................389
● CAN - Decode Results..........................................................................................392
● CAN - Search........................................................................................................397

CAN - Configuration

BUS: ​CAN: ​DATA:​SOURce ​...............................................................................................388
BUS: ​CAN: ​TYPE​............................................................................................................388
BUS: ​CAN: ​SAMPlepoint​..................................................................................................388
BUS: ​CAN: ​BITRate​.........................................................................................................388
CHANnel<m>: ​THReshold: ​FINDlevel ​................................................................................388
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BUS:CAN:DATA:SOURce <Source>

Sets the source of the data line. All channel waveforms can be used.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

*RST: CH1

BUS:CAN:TYPE <SignalType>

Selects the CAN-High or CAN-Low line. CAN uses both lines for differential signal trans-
mission.

If you measure with a differential probe, connect the probe to both CAN-H and CAN-L
lines, and set the type CANH.

If you use a single-ended probe, connect the probe to either CAN_L or CAN_H, and select
the data type accordingly.

Parameters:
<SignalType> CANH | CANL

*RST: CANH

BUS:CAN:SAMPlepoint <SamplePoint>

Sets the position of the sample point within the bit in percent of the nominal bit time.

See also: ​"Sample point" on page 181

Parameters:
<SamplePoint> Range: 10  to  90

Increment: 1
*RST: 50
Default unit: %

BUS:CAN:BITRate <BitRate>

Sets the number of transmitted bits per second.

Parameters:
<BitRate> Range: 100 to 5,04E06, depends on instrument type, ADC

clock rate
Increment: depends on the bit rate value
*RST: 50E03
Default unit: Bit/s

CHANnel<m>:THReshold:FINDlevel

Executes the analysis of all channels that are configured for the selected bus and sets
the threshold for digitization of analog signals for each channel.
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Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Usage: Event

CAN - Trigger

TRIGger:A:CAN:TYPE <TriggerType>

Specifies the trigger mode for CAN.

Parameters:
<TriggerType> STOFrame | EOFrame | ID | IDDT | FTYPe | ERRCondition

STOFrame
Start of frame
EOFrame
End of frame
ID
Sets the trigger to a specific message identifier or an identifier
range.
Specify the identifier with ​TRIGger: ​A: ​CAN: ​ITYPe​, ​TRIGger: ​
A:​CAN: ​ICONdition ​, and ​TRIGger: ​A:​CAN: ​IDENtifier ​.
IDDT
Sets the trigger to a combination of identifier and data condition.
The instrument triggers at the end of the last byte of the specified
data pattern.
Specify the identifier (see ID), and the data with ​TRIGger: ​A:​
CAN: ​DLC​, ​TRIGger: ​A: ​CAN: ​DCONdition ​, and ​TRIGger: ​A:​
CAN: ​DATA ​.
FTYPe
Triggers on a specified frame type. Specify the frame type with ​
TRIGger: ​A:​CAN: ​FTYPe ​.
ERRCondition
Identifies various errors in the frame. Specify the errors with ​
TRIGger: ​A:​CAN: ​ACKerror ​, ​TRIGger: ​A: ​CAN: ​BITSterror ​, ​
TRIGger: ​A:​CAN: ​CRCerror ​, and ​TRIGger: ​A: ​CAN: ​
FORMerror ​.
*RST: STOF

TRIGger:A:CAN:FTYPe <FrameType>

Specifies the frame type to be triggered on if ​TRIGger: ​A:​CAN: ​TYPE ​ is set to FTYPe.

Parameters:
<FrameType> DATA | REMote | ERRor | OVERload | ANY

*RST: ERR

Command Reference



Remote ControlR&S®RTM

390User Manual 1305.0595.02 ─ 08

TRIGger:A:CAN:ITYPe <IdentifierType>

Selects the length of the identifier: 11 bit for CAN base frames, or 29 bits for CAN exten-
ded frames.

The command is relevant if ​TRIGger: ​A: ​CAN: ​TYPE ​ is set to ID or IDDT.

Parameters:
<IdentifierType> B11 | B29 | ANY

ANY: only available for CAN trigger type IDDT
*RST: B11

TRIGger:A:CAN:ICONdition <IdentifierCondition>

Sets the comparison condition: If the pattern contains at least one X (don't care), you can
trigger on values equal or not equal to the specified value. If the pattern contains only 0
and 1, you can also trigger on a range greater than or lower than the specified value.

The command is relevant if ​TRIGger: ​A: ​CAN: ​TYPE ​ is set to ID or IDDT.

Parameters:
<IdentifierCondition> EQUual | NEQual | GTHan | LTHan

*RST: EQ

TRIGger:A:CAN:IDENtifier <Identifier>

Defines the identifier pattern. The pattern length is defined with ​TRIGger: ​A: ​CAN: ​
ITYPe ​ on page 390.

The command is relevant if ​TRIGger: ​A: ​CAN: ​TYPE ​ is set to ID or IDDT.

Parameters:
<Identifier> String containing binary pattern with max. 29 bit. Characters 0, 1,

and X are allowed.

TRIGger:A:CAN:DLC <DataLength>

Defines the length of the data pattern - the number of bytes in the pattern.

The command is relevant if ​TRIGger: ​A: ​CAN: ​TYPE ​ is set to IDDT.

Parameters:
<DataLength> Range: 0  to  8

Increment: 1
*RST: 1
Default unit: Byte
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TRIGger:A:CAN:DCONdition <DataCondition>

Sets the comparison condition for data: If the pattern contains at least one X (don't care),
you can trigger on values equal or not equal to the specified value. If the pattern contains
only 0 and 1, you can also trigger on a range greater than or lower than the specified
value.

The command is relevant if ​TRIGger: ​A: ​CAN: ​TYPE ​ is set to IDDT.

Parameters:
<DataCondition> EQUal | NEQual | GTHan | LTHan

*RST: EQ

TRIGger:A:CAN:DATA <Data>

Defines the data pattern. The number of bytes in the data pattern is defined with ​
TRIGger: ​A:​CAN: ​DLC​.

The command is relevant if ​TRIGger: ​A: ​CAN: ​TYPE ​ is set to IDDT.

Parameters:
<Data> String containing binary pattern with max. 64 bit. Characters 0, 1,

and X are allowed. Make sure to enter complete bytes.

TRIGger:A:CAN:ACKerror <AcknowledgeError>

Triggers on acknowledgement errors. An acknowledgement error occurs when the trans-
mitter does not receive an acknowledgment - a dominant bit during the Ack Slot.

The command is relevant if ​TRIGger: ​A: ​CAN: ​TYPE ​ is set to ERRCondition.

Parameters:
<AcknowledgeError> ON | OFF

*RST: OFF

TRIGger:A:CAN:BITSterror <BitStuffingError>

Triggers on bit stuffing errors.

See also: ​"Stuff bit" on page 183.

The command is relevant if ​TRIGger: ​A: ​CAN: ​TYPE ​ is set to ERRCondition.

Parameters:
<BitStuffingError> ON | OFF

*RST: ON

TRIGger:A:CAN:CRCerror <CRCerror>

Triggers on errors in the Cyclic Redundancy Check.

The command is relevant if ​TRIGger: ​A: ​CAN: ​TYPE ​ is set to ERRCondition.
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Parameters:
<CRCerror> ON | OFF

*RST: OFF

TRIGger:A:CAN:FORMerror <FormError>

Triggers on form errors. A form error occurs when a fixed-form bit field contains one or
more illegal bits.

The command is relevant if ​TRIGger: ​A: ​CAN: ​TYPE ​ is set to ERRCondition.

Parameters:
<FormError> ON | OFF

*RST: OFF

CAN - Decode Results

BUS: ​CAN: ​FCOunt?​........................................................................................................392
BUS: ​CAN: ​FRAMe<n>:​TYPE? ​.........................................................................................392
BUS: ​CAN: ​FRAMe<n>:​STATus? ​......................................................................................393
BUS: ​CAN: ​FRAMe<n>:​STARt? ​........................................................................................393
BUS: ​CAN: ​FRAMe<n>:​STOP?​.........................................................................................393
BUS: ​CAN: ​FRAMe<n>:​DATA? ​.........................................................................................394
BUS: ​CAN: ​FRAMe<n>:​ACKState?​...................................................................................394
BUS: ​CAN: ​FRAMe<n>:​ACKValue? ​...................................................................................394
BUS: ​CAN: ​FRAMe<n>:​CSSTate? ​.....................................................................................395
BUS: ​CAN: ​FRAMe<n>:​CSValue? ​.....................................................................................395
BUS: ​CAN: ​FRAMe<n>:​DLCState? ​....................................................................................395
BUS: ​CAN: ​FRAMe<n>:​DLCValue? ​...................................................................................395
BUS: ​CAN: ​FRAMe<n>:​IDSTate?​......................................................................................396
BUS: ​CAN: ​FRAMe<n>:​IDTYpe? ​.......................................................................................396
BUS: ​CAN: ​FRAMe<n>:​IDValue? ​......................................................................................396
BUS: ​CAN: ​FRAMe<n>:​BSEPosition? ​................................................................................396
BUS: ​CAN: ​FRAMe<n>:​BCOunt? ​......................................................................................397
BUS: ​CAN: ​FRAMe<n>:​BYTE<o>: ​STATe?​.........................................................................397
BUS: ​CAN: ​FRAMe<n>:​BYTE<o>: ​VALue?​.........................................................................397

BUS:CAN:FCOunt?

Returns the number of received frames.

Return values: 
<FrameCount> Total number of decoded frames.

Usage: Query only

BUS:CAN:FRAMe<n>:TYPE?

Returns the type of the specified frame.
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Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<FrameType> DATA | REMote | ERR | OVLD

Data, remote, error or overload frame

Usage: Query only

BUS:CAN:FRAMe<n>:STATus?

Returns the overall state of the specified frame.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<FrameStatus> OK | BTST | CRCD | ACKD | CRC | EOFD | NOACk |

INSufficient
OK: frame is valid.
BTST: bit stuffing error occured
CRCD: wrong CRC delimiter occured
ACKD: Wrong ACK delimiter occured
CRC: cyclic redundancy check failed
EOFD: wrong end of frame
NOACk: acknowlegde is missing
INSufficient: frame is not completely contained in the acquisition.
The acquired part of the frame is valid.

Usage: Query only

BUS:CAN:FRAMe<n>:STARt?

Returns the start time of the specified frame.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<StartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS:CAN:FRAMe<n>:STOP?

Returns the end time of the specified frame.
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Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<StopTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS:CAN:FRAMe<n>:DATA?

Returns the data words of the specified frame.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<FrameData> Comma-separated list of decimal values of the data bytes.

Usage: Query only

BUS:CAN:FRAMe<n>:ACKState?

Returns the state of the acknowledge field.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<AcknowledgeState> OK | UNDF

UNDF: Undefined

Usage: Query only

BUS:CAN:FRAMe<n>:ACKValue?

Returns the value of the acknowledge field.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<AcknowledgeValue> Decimal value

Usage: Query only
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BUS:CAN:FRAMe<n>:CSSTate?

Returns the state of the checksum.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<ChecksumState> OK | UNDF

UNDF: Undefined

Usage: Query only

BUS:CAN:FRAMe<n>:CSValue?

Returns the checksum value.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<ChecksumValue> Decimal value

Usage: Query only

BUS:CAN:FRAMe<n>:DLCState?

Returns the state of the data length code.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<DLCstate> OK | UNDF

UNDF: Undefined

Usage: Query only

BUS:CAN:FRAMe<n>:DLCValue?

Returns the number of data bytes in the specified frame.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<DLCvalue> non-negative integer

Usage: Query only
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BUS:CAN:FRAMe<n>:IDSTate?

Returns the state of the identifier.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<IdentifierState> OK | UNDF

UNDF: Undefined

Usage: Query only

BUS:CAN:FRAMe<n>:IDTYpe?

Returns the length of the identifier: 11 bit for CAN base frames, or 29 bits for CAN exten-
ded frames.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<IdentifierType> ANY | B11 | B29

ANY
No length specified, for example, for triggering on data only.

Usage: Query only

BUS:CAN:FRAMe<n>:IDValue?

Returns the decimal address value of the specified frame.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<IdentifierValue> Decimal value

Usage: Query only

BUS:CAN:FRAMe<n>:BSEPosition?

Returns the position of the bit stuffing error in the specified frame (if available).

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<ErrorPosition> *RST: 0

Default unit: s
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Usage: Query only

BUS:CAN:FRAMe<n>:BCOunt?

Returns the number of data bytes in the specified frame.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<ByteCount> Number of words (bytes)

Usage: Query only

BUS:CAN:FRAMe<n>:BYTE<o>:STATe?

Returns the state of the specified data byte.

Suffix: 
<n>

.
*
Selects the frame (1...n).

<o> *
Selects the byte number (1...n).

Return values: 
<ByteStatus> OK | UNDF

UNDF: Undefined

Usage: Query only

BUS:CAN:FRAMe<n>:BYTE<o>:VALue?

Returns the decimal value of the specified byte.

Suffix: 
<n>

.
*
Selects the frame (1...n).

<o> *
Selects the byte number (1...n).

Return values: 
<ByteValue> Decimal value

Usage: Query only

CAN - Search

SEARch:​PROTocol: ​CAN: ​CONDition ​................................................................................398
SEARch:​PROTocol: ​CAN: ​FRAMe ​.....................................................................................398
SEARch:​PROTocol: ​CAN: ​ACKerror ​..................................................................................399
SEARch:​PROTocol: ​CAN: ​BITSterror ​.................................................................................399
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SEARch:​PROTocol: ​CAN: ​CRCerror ​..................................................................................399
SEARch:​PROTocol: ​CAN: ​FORMerror ​...............................................................................400
SEARch:​PROTocol: ​CAN: ​FTYPe ​.....................................................................................400
SEARch:​PROTocol: ​CAN: ​ITYPe ​.......................................................................................400
SEARch:​PROTocol: ​CAN: ​ICONdition ​................................................................................400
SEARch:​PROTocol: ​CAN: ​IDENtifier ​..................................................................................400
SEARch:​PROTocol: ​CAN: ​DLENgth ​..................................................................................401
SEARch:​PROTocol: ​CAN: ​DCONdition ​..............................................................................401
SEARch:​PROTocol: ​CAN: ​DATA ​.......................................................................................401

SEARch:PROTocol:CAN:CONDition <SearchCondition>

Sets the event or combination of events to be searched for. Depending on the selected
event, further settings are required.

Parameters:
<SearchCondition> FRAMe | ERRor | IDENtifier | IDData | IDERror

FRAMe
Search for a frame type. Set the frame type with ​SEARch: ​
PROTocol: ​CAN: ​FRAMe​.
ERRor
Search for errors of one or more error types. Set the error types
with ​SEARch: ​PROTocol: ​CAN: ​ACKerror ​, ​SEARch: ​
PROTocol: ​CAN: ​BITSterror ​, ​SEARch: ​PROTocol: ​CAN: ​
CRCerror ​, and ​SEARch: ​PROTocol: ​CAN: ​FORMerror​.
IDENtifier
Search for identifier.
Specifiy the identifier with ​SEARch: ​PROTocol: ​CAN: ​FTYPe ​, ​
SEARch: ​PROTocol: ​CAN: ​ITYPe​, ​SEARch: ​PROTocol:​CAN: ​
ICONdition ​, and ​SEARch: ​PROTocol:​CAN: ​IDENtifier ​.
IDData
Search for identifier and data.
Set the identifier (see IDENtifier) and the data with ​SEARch: ​
PROTocol: ​CAN: ​DLENgth ​, ​SEARch: ​PROTocol: ​CAN: ​
DCONdition ​, and ​SEARch: ​PROTocol:​CAN: ​DATA ​.
IDERror
Search for errors that occur with a specified identifier.
Set the identifier (see IDENtifier) and the errors to be found (see
ERRor)
*RST: FRAM

SEARch:PROTocol:CAN:FRAMe <Frame>

Selects the frame type to be searched for.

The command is relevant if ​SEARch: ​PROTocol: ​CAN: ​CONDition ​ is set to FRAMe.
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Parameters:
<Frame> SOF | EOF | OVERload | ERRor | DTA11 | DTA29 | REM11 |

REM29
SOF: start of frame
EOF: end of frame
OVERload: overload frame
ERRor: error frame
DTA11: data frame with 11bit identifier
DTA29: data frame with 29bit identifier
REM11: remote frame with 11bit identifier
REM29: remote frame with 29bit identifier
*RST: SOF

SEARch:PROTocol:CAN:ACKerror <AcknowledgeError>

Searches for acknowledgement errors. An acknowledgement error occurs when the
transmitter does not receive an acknowledgment - a dominant bit during the Ack Slot.

The command is relevant if ​SEARch: ​PROTocol: ​CAN: ​CONDition ​ is set to ERRor or
IDERror.

Parameters:
<AcknowledgeError> ON | OFF

*RST: OFF

SEARch:PROTocol:CAN:BITSterror <BitStuffingError>

Searches for bit stuffing errors.

See also: ​"Stuff bit" on page 183.

The command is relevant if ​SEARch: ​PROTocol: ​CAN: ​CONDition ​ is set to ERRor or
IDERror.

Parameters:
<BitStuffingError> ON | OFF

*RST: OFF

SEARch:PROTocol:CAN:CRCerror <CRCerror>

Searches for errors in the Cyclic Redundancy Check.

The command is relevant if ​SEARch: ​PROTocol: ​CAN: ​CONDition ​ is set to ERRor or
IDERror.

Parameters:
<CRCerror> ON | OFF

*RST: OFF
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SEARch:PROTocol:CAN:FORMerror <FormError>

Searches for form errors. A form error occurs when a fixed-form bit field contains one or
more illegal bits.

The command is relevant if ​SEARch: ​PROTocol: ​CAN: ​CONDition ​ is set to ERRor or
IDERror.

Parameters:
<FormError> ON | OFF

*RST: OFF

SEARch:PROTocol:CAN:FTYPe

Specifies the frame type to be searched for if ​SEARch: ​PROTocol:​CAN: ​CONDition ​ is
set to IDENtifier.

Parameters:
<FrameType> DATA | REMote | ANY

SEARch:PROTocol:CAN:ITYPe

Selects the length of the identifier: 11 bit for CAN base frames, or 29 bits for CAN exten-
ded frames.

The command is relevant if ​SEARch: ​PROTocol: ​CAN: ​CONDition ​ is set to
IDENtifier, IDData, or IDERror.

Parameters:
<IdType> B11 | B29

*RST: B11

SEARch:PROTocol:CAN:ICONdition <IdCondition>

Sets the comparison condition for the identifier: If the pattern contains at least one X (don't
care), you can trigger on values equal or not equal to the specified value. If the pattern
contains only 0 and 1, you can also trigger on a range greater than or lower than the
specified value.

The command is relevant if ​SEARch: ​PROTocol: ​CAN: ​CONDition ​ is set to
IDENtifier, IDData, or IDERror.

Parameters:
<IdCondition> EQUal | NEQual | GTHan | LTHan

*RST: EQU

SEARch:PROTocol:CAN:IDENtifier <Identifier>

Defines the identifier pattern. The pattern length is defined with ​SEARch: ​PROTocol:​
CAN: ​ITYPe ​.
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The command is relevant if ​SEARch: ​PROTocol: ​CAN: ​CONDition ​ is set to
IDENtifier, IDData, or IDERror.

Parameters:
<Identifier> String containing binary pattern with max. 29 bit. Characters 0, 1,

and X are allowed.

SEARch:PROTocol:CAN:DLENgth <DataLength>

Defines the length of the data pattern - the number of bytes in the pattern.

The command is relevant if ​SEARch: ​PROTocol: ​CAN: ​CONDition ​ is set to IDData.

Parameters:
<DataLength> Range: 0  to  8

Increment: 1
*RST: 1
Default unit: Byte

SEARch:PROTocol:CAN:DCONdition <DataCondition>

Sets the comparison condition for data: If the pattern contains at least one X (don't care),
you can trigger on values equal or not equal to the specified value. If the pattern contains
only 0 and 1, you can also trigger on a range greater than or lower than the specified
value.

The command is relevant if ​SEARch: ​PROTocol: ​CAN: ​CONDition ​ is set to IDData.

Parameters:
<DataCondition> EQUal | NEQual | GTHan | LTHan

*RST: EQU

SEARch:PROTocol:CAN:DATA <Data>

Defines the data pattern. The pattern length is defined with ​SEARch: ​PROTocol:​CAN: ​
DLENgth ​.

The command is relevant if ​SEARch: ​PROTocol: ​CAN: ​CONDition ​ is set to IDData.

Parameters:
<Data> String containing binary pattern with max. 64 bit. Characters 0, 1,

and X are allowed. Make sure to enter complete bytes.

14.2.13.8 LIN

● LIN - Configuration................................................................................................402
● LIN - Trigger..........................................................................................................403
● LIN - Decode Results............................................................................................405
● LIN - Search..........................................................................................................410
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LIN - Configuration

BUS: ​LIN:​DATA: ​SOURce ​................................................................................................402
BUS: ​LIN:​POLarity ​..........................................................................................................402
BUS: ​LIN:​STANdard ​........................................................................................................402
BUS: ​LIN:​BITRate ​...........................................................................................................402
CHANnel<m>: ​THReshold: ​FINDlevel ​................................................................................403

BUS:LIN:DATA:SOURce <Source>

Sets the source of the data line. All channel waveforms can be used.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4

*RST: CH1

BUS:LIN:POLarity <Polarity>

Defines the idle state of the bus. The idle state is the rezessive state and corresponds to
a logic 1.

Parameters:
<Polarity> IDLHigh | IDLLow

IDLHigh: Low active, negative polarity
IDLLow: High active, positive polarity
*RST: IDLL

BUS:LIN:STANdard <Standard>

Selects the version of the LIN standard that is used in the DUT. The setting mainly defines
the checksum version used during decoding.

The most common version is LIN 2.x. For mixed networks, or if the standard is unknown,
set the LIN standard to AUTO.

Parameters:
<Standard> V1X | V2X | J2602 | AUTO

*RST: V1X

BUS:LIN:BITRate <BitRate>

Sets the number of transmitted bits per second.

Parameters:
<BitRate> *RST: 9.6E03

Default unit: Bit/s
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CHANnel<m>:THReshold:FINDlevel

Executes the analysis of all channels that are configured for the selected bus and sets
the threshold for digitization of analog signals for each channel.

Suffix: 
<m>

.
Selects the input channel. The number of channels depends on
the instrument.

Usage: Event

LIN - Trigger

TRIGger:​A: ​LIN: ​TYPE​.....................................................................................................403
TRIGger:​A: ​LIN: ​CHKSerror ​..............................................................................................404
TRIGger:​A: ​LIN: ​IPERror ​..................................................................................................404
TRIGger:​A: ​LIN: ​SYERror ​.................................................................................................404
TRIGger:​A: ​LIN: ​ICONdition ​..............................................................................................404
TRIGger:​A: ​LIN: ​IDENtifier ​................................................................................................404
TRIGger:​A: ​LIN: ​DATA ​.....................................................................................................405
TRIGger:​A: ​LIN: ​DCONdition ​.............................................................................................405
TRIGger:​A: ​LIN: ​DLENgth ​.................................................................................................405

TRIGger:A:LIN:TYPE <TriggerType>

Specifies the trigger mode for LIN.

Parameters:
<TriggerType> SYNC | WKFRame | ID | IDDT | ERRCondition

SYNC
Start of frame, triggers on the stop bit of the sync field.
WKFRame
Triggers after a wakeup frame.
ID
Sets the trigger to a specific identifier or an identifier range.
Set the identifier with ​TRIGger: ​A:​LIN: ​ICONdition ​ and ​
TRIGger: ​A:​LIN: ​IDENtifier ​.
IDDT
Set the identifier (see ID) and the data with ​TRIGger: ​A:​LIN: ​
DLENgth ​, ​TRIGger: ​A: ​LIN: ​DCONdition ​, and ​TRIGger: ​A:​
LIN: ​DATA ​.
ERRCondition
Identifies various errors in the frame. You can select one or more
error types as trigger condition.
Select the error types with ​TRIGger: ​A: ​LIN: ​CHKSerror​, ​
TRIGger: ​A:​LIN: ​IPERror ​, and ​TRIGger: ​A:​LIN: ​SYERror ​.
*RST: SYNC
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TRIGger:A:LIN:CHKSerror <ChecksumError>

Triggers on a checksum error. The checksum verifies the correct data transmission. It is
the last byte of the frame response. The checksum includes not only the data but also
the protected identifier (PID).

The command is relevant if ​TRIGger: ​A: ​LIN: ​TYPE ​ is set to ERRCondition.

Parameters:
<ChecksumError> ON | OFF

*RST: ON

TRIGger:A:LIN:IPERror <IdParityError>

Triggers on a parity error. Parity bits are the bits 6 and 7 of the identifier. They verify the
correct transmission of the identifier.

The command is relevant if ​TRIGger: ​A: ​LIN: ​TYPE ​ is set to ERRCondition.

Parameters:
<IdParityError> ON | OFF

*RST: OFF

TRIGger:A:LIN:SYERror <SyncError>

Triggers if synchronization caused an error.

The command is relevant if ​TRIGger: ​A: ​LIN: ​TYPE ​ is set to ERRCondition.

Parameters:
<SyncError> ON | OFF

*RST: OFF

TRIGger:A:LIN:ICONdition <IdentifierCondition>

Sets the comparison condition for the identifier: If the pattern contains at least one X (don't
care), you can trigger on values equal or not equal to the specified value. If the pattern
contains only 0 and 1, you can also trigger on a range greater than or lower than the
specified value.

The command is relevant if ​TRIGger: ​A: ​LIN: ​TYPE ​ is set to ID or IDDT.

Parameters:
<IdentifierCondition> EQUal | NEQual | GTHan | LTHan

*RST: EQ

TRIGger:A:LIN:IDENtifier <Identifier>

Defines the identifier pattern.

The command is relevant if ​TRIGger: ​A: ​LIN: ​TYPE ​ is set to ID or IDDT.
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Parameters:
<Identifier> String containing binary pattern. Characters 0, 1, and X are

allowed. Enter the 6 bit identifier without parity bits, not the pro-
tected identifier.

TRIGger:A:LIN:DATA <Data>

Defines the data pattern. The number of bytes in the data pattern is defined with ​
TRIGger: ​A:​LIN: ​DLENgth ​.

The command is relevant if ​TRIGger: ​A: ​LIN: ​TYPE ​ is set to IDDT.

Parameters:
<Data> String containing binary pattern with max. 64 bit. Characters 0, 1,

and X are allowed. Make sure to enter complete bytes.

TRIGger:A:LIN:DCONdition <DataCondition>

Sets the comparison condition for data: If the pattern contains at least one X (don't care),
you can trigger on values equal or not equal to the specified value. If the pattern contains
only 0 and 1, you can also trigger on a range greater than or lower than the specified
value.

The command is relevant if ​TRIGger: ​A: ​LIN: ​TYPE ​ is set to IDDT.

Parameters:
<DataCondition> EQUal | NEQual | GTHan | LTHan

*RST: EQ

TRIGger:A:LIN:DLENgth <DataLength>

Defines the length of the data pattern - the number of bytes in the pattern.

The command is relevant if ​TRIGger: ​A: ​LIN: ​TYPE ​ is set to IDDT.

Parameters:
<DataLength> Range: 1  to  8

Increment: 1
*RST: 1
Default unit: Byte

LIN - Decode Results

BUS: ​LIN:​FCOunt? ​..........................................................................................................406
BUS: ​LIN:​FRAMe<n>: ​CSSTate?​......................................................................................406
BUS: ​LIN:​FRAMe<n>: ​CSValue? ​.......................................................................................406
BUS: ​LIN:​FRAMe<n>: ​DATA? ​...........................................................................................406
BUS: ​LIN:​FRAMe<n>: ​IDPValue?​......................................................................................407
BUS: ​LIN:​FRAMe<n>: ​IDSTate?​........................................................................................407
BUS: ​LIN:​FRAMe<n>: ​IDValue? ​........................................................................................407
BUS: ​LIN:​FRAMe<n>: ​STARt?​..........................................................................................407
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BUS: ​LIN:​FRAMe<n>: ​STOP?​...........................................................................................408
BUS: ​LIN:​FRAMe<n>: ​SYSTate?​.......................................................................................408
BUS: ​LIN:​FRAMe<n>: ​SYValue?​.......................................................................................408
BUS: ​LIN:​FRAMe<n>: ​VERSion? ​......................................................................................409
BUS: ​LIN:​FRAMe<n>: ​BCOunt?​........................................................................................409
BUS: ​LIN:​FRAMe<n>: ​BYTE<o>: ​STATe?​..........................................................................409
BUS: ​LIN:​FRAMe<n>: ​BYTE<o>: ​VALue?​...........................................................................409

BUS:LIN:FCOunt?

Returns the number of received frames of the active LIN bus.

Return values: 
<FrameCount> Total number of decoded frames.

Usage: Query only

BUS:LIN:FRAMe<n>:CSSTate?

Returns the checksum state of the specified frame.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<ChecksumState> OK | ERR | UNDF

ERR: error
UNDF: undefined

Usage: Query only

BUS:LIN:FRAMe<n>:CSValue?

Returns the checksum value.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<ChecksumValue> Decimal value

Usage: Query only

BUS:LIN:FRAMe<n>:DATA?

Returns the data bytes of the specified frame.

Suffix: 
<n>

.
*
Selects the frame (1...n).
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Return values: 
<FrameData> Comma-separated list of decimal values of the data bytes.

Usage: Query only

BUS:LIN:FRAMe<n>:IDPValue?

Returns the parity value.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<IdentifierParityValue>Decimal value

Usage: Query only

BUS:LIN:FRAMe<n>:IDSTate?

Returns the identifier state of the selected frame.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<IdentifierState> OK | PRERror | UVAL | INSufficient

PRERror: parity error
UVAL: unexpected value
INSufficient: the frame is not completely contained in the acquisi-
tion. The decoded part of the frame is valid.

Usage: Query only

BUS:LIN:FRAMe<n>:IDValue?

Returns the identifier value (address)

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<IdentifierValue> Decimal value

Usage: Query only

BUS:LIN:FRAMe<n>:STARt?

Returns the start time of the specified frame.
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Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<StartTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS:LIN:FRAMe<n>:STOP?

Returns the end time of the specified frame.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<StopTime> Range: depends on sample rate, record length, and time

base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS:LIN:FRAMe<n>:SYSTate?

Returns the state of the sync field for the specified frame.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<SyncFieldState> OK | ERR | UNDF

ERR: error
UNDF: undefined

Usage: Query only

BUS:LIN:FRAMe<n>:SYValue?

Returns the value of the synchronization field.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<SyncFieldValue> Decimal value
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Usage: Query only

BUS:LIN:FRAMe<n>:VERSion?

Returns the version of the LIN standard for the specified frame.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<FrameVersion> V1X | V2X | UNK

UNK: Unknown

Usage: Query only

BUS:LIN:FRAMe<n>:BCOunt?

Returns the number of data bytes in the specified frame.

Suffix: 
<n>

.
*
Selects the frame (1...n).

Return values: 
<ByteCount> Number of words (bytes)

Usage: Query only

BUS:LIN:FRAMe<n>:BYTE<o>:STATe?

Returns the state of the specified data byte.

Suffix: 
<n>

.
*
Selects the frame (1...n).

<o> *
Selects the byte number (1...n).

Return values: 
<ByteStatus> OK | INS | UART

The byte is not completely contained in the acquisition
UART
At least one UART error occured. LIN uses UART words without
parity bit.

Usage: Query only

BUS:LIN:FRAMe<n>:BYTE<o>:VALue?

Returns the decimal value of the specified byte.
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Suffix: 
<n>

.
*
Selects the frame (1...n).

<o> *
Selects the byte number (1...n).

Return values: 
<ByteValue> Decimal value

Usage: Query only

LIN - Search

SEARch:​PROTocol: ​LIN: ​CONDition ​..................................................................................410
SEARch:​PROTocol: ​LIN: ​FRAMe ​......................................................................................411
SEARch:​PROTocol: ​LIN: ​IPERror ​......................................................................................411
SEARch:​PROTocol: ​LIN: ​CHKSerror ​.................................................................................412
SEARch:​PROTocol: ​LIN: ​SYERror ​.....................................................................................412
SEARch:​PROTocol: ​LIN: ​ICONdition ​.................................................................................412
SEARch:​PROTocol: ​LIN: ​IDENtifier ​...................................................................................412
SEARch:​PROTocol: ​LIN: ​DLENgth ​....................................................................................412
SEARch:​PROTocol: ​LIN: ​DCONdition ​................................................................................413
SEARch:​PROTocol: ​LIN: ​DATA ​.........................................................................................413

SEARch:PROTocol:LIN:CONDition <SearchCondition>

Sets the event or combination of events to be searched for. Depending on the selected
event, further settings are required.
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Parameters:
<SearchCondition> FRAMe | ERRor | IDENtifier | IDData | IDERror

FRAMe
Search for a frame type.
Set the frame type with ​SEARch: ​PROTocol: ​LIN: ​FRAMe ​.
ERRor
Search for errors of one or more error types.
Set the error types with ​SEARch: ​PROTocol:​LIN: ​CHKSerror ​, ​
SEARch: ​PROTocol: ​LIN: ​IPERror ​, and ​SEARch: ​PROTocol: ​
LIN: ​SYERror ​.
IDENtifier
Search for identifier.
Specifiy the identifier with ​SEARch: ​PROTocol: ​LIN: ​
ICONdition ​ and ​SEARch: ​PROTocol: ​LIN: ​IDENtifier ​.
IDData
Search for identifier and data.
Set the identifier (see IDENtifier) and the data with ​SEARch: ​
PROTocol: ​LIN: ​DLENgth ​, ​SEARch: ​PROTocol: ​LIN: ​
DCONdition ​, and ​SEARch: ​PROTocol:​LIN: ​DATA ​.
IDERror
Search for errors that occur with a specified identifier. Set the
identifier (see IDENtifier) and the errors to be found (see ERRor).
*RST: FRAM

SEARch:PROTocol:LIN:FRAMe <Frame>

Selects the frame type to be searched for.

The command is relevant if ​SEARch: ​PROTocol: ​LIN: ​CONDition ​ is set to FRAMe.

Parameters:
<Frame> SOF | WAKeup

SOF: start of frame
WAKeup: Wakeup frame
*RST: SOF

SEARch:PROTocol:LIN:IPERror <IdParityError>

Searches for parity errors.

The command is relevant if ​SEARch: ​PROTocol: ​LIN: ​CONDition ​ is set to ERRor or
IDERror.

Parameters:
<IdParityError> ON | OFF

*RST: OFF
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SEARch:PROTocol:LIN:CHKSerror <ChecksumError>

Searches for checksum errors.

The command is relevant if ​SEARch: ​PROTocol: ​LIN: ​CONDition ​ is set to ERRor or
IDERror.

Parameters:
<ChecksumError> ON | OFF

*RST: OFF

SEARch:PROTocol:LIN:SYERror <SyncError>

Searches for synchronization errors.

The command is relevant if ​SEARch: ​PROTocol: ​LIN: ​CONDition ​ is set to ERRor or
IDERror.

Parameters:
<SyncError> ON | OFF

*RST: OFF

SEARch:PROTocol:LIN:ICONdition <IdCondition>

Sets the comparison condition for the identifier: If the pattern contains at least one X (don't
care), you can trigger on values equal or not equal to the specified value. If the pattern
contains only 0 and 1, you can also trigger on a range greater than or lower than the
specified value.

The command is relevant if ​SEARch: ​PROTocol: ​LIN: ​CONDition ​ is set to
IDENtifier, IDData or IDERror.

Parameters:
<IdCondition> EQUal | NEQual | GTHan | LTHan

*RST: EQU

SEARch:PROTocol:LIN:IDENtifier <Identifier>

Defines the identifier pattern.

The command is relevant if ​SEARch: ​PROTocol: ​LIN: ​CONDition ​ is set to
IDENtifier, IDData or IDERror.

Parameters:
<Identifier> String containing binary pattern. Characters 0, 1, and X are

allowed. Enter the 6 bit identifier without parity bits, not the pro-
tected identifier.

SEARch:PROTocol:LIN:DLENgth <DataLength>

Defines the length of the data pattern - the number of bytes in the pattern.
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The command is relevant if ​SEARch: ​PROTocol: ​LIN: ​CONDition ​ is set to IDData.

Parameters:
<DataLength> Range: 1  to  8

Increment: 1
*RST: 1
Default unit: Byte

SEARch:PROTocol:LIN:DCONdition <DataCondition>

Sets the comparison condition for data: If the pattern contains at least one X (don't care),
you can trigger on values equal or not equal to the specified value. If the pattern contains
only 0 and 1, you can also trigger on a range greater than or lower than the specified
value.

The command is relevant if ​SEARch: ​PROTocol: ​LIN: ​CONDition ​ is set to IDData.

Parameters:
<DataCondition> EQUal | NEQual | GTHan | LTHan

*RST: EQU

SEARch:PROTocol:LIN:DATA <Data>

Defines the data pattern. The pattern length is defined with ​SEARch: ​PROTocol:​LIN: ​
DLENgth ​.

The command is relevant if ​SEARch: ​PROTocol: ​LIN: ​CONDition ​ is set to IDData.

Parameters:
<Data> String containing binary pattern with max. 64 bit. Characters 0, 1,

and X are allowed. Make sure to enter complete bytes.

14.2.14 Data and File Management

This chapter describes commands on how to print and save screenshots, and how to
manage measurement settings and data..

● Screenshots..........................................................................................................413
● Saving and Loading Data: MMEMory Commands................................................416

14.2.14.1 Screenshots

This chapter describes remote commands used to print and save screenshots.

HCOPy: ​DESTination ​......................................................................................................414
MMEMory:​NAME ​...........................................................................................................414
HCOPy[: ​IMMediate]​.......................................................................................................414
HCOPy: ​LANGuage​........................................................................................................415
HCOPy: ​PAGE:​SIZE ​.......................................................................................................415
HCOPy: ​PAGE:​ORIentation​.............................................................................................415
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HCOPy: ​COLor: ​SCHeme ​.................................................................................................415
SYSTem:​COMMunicate: ​PRINter: ​SELect​..........................................................................415
SYSTem:​COMMunicate: ​PRINter: ​ENUMerate: ​FIRSt?​........................................................416
SYSTem:​COMMunicate: ​PRINter: ​ENUMerate[: ​NEXT]?​......................................................416

HCOPy:DESTination <Medium>

Defines whether the screenshot is saved or printed.

Parameters:
<Medium> MMEM | SYST:COMM:PRIN

String parameter
MMEM
Saves the screenshot to a file. Specify the file name and location
with ​MMEMory: ​NAME ​.
SYST:COMM:PRIN
Prints on the printer specified with ​SYSTem: ​COMMunicate:​
PRINter: ​SELect​. The printer must be specified before the
HCOPy:DESTination is sent.

*RST: MMEM

Example: HCOP:DEST "MMEM"
​chapter 14.3.3.1, "Saving Screenshots to File", on page 433

MMEMory:NAME <FileName>

Defines the file name to store an image of the display with ​HCOPy[: ​IMMediate] ​.

Parameters:
<FileName> String parameter

Example: ​chapter 14.3.3.1, "Saving Screenshots to File", on page 433

HCOPy[:IMMediate]

Prints an image of the display to the printer or saves an image to a file or the clipboard,
depending on the ​HCOPy:​DESTination ​ setting.

Before starting the printout, make sure that:
● The printer is defined by ​SYSTem: ​COMMunicate: ​PRINter: ​SELect​.
● The path for storage is defined correctly by ​MMEMory: ​CDIRectory ​
● The file name for storage is defined by ​MMEMory: ​NAME ​.

Example: ​chapter 14.3.3.1, "Saving Screenshots to File", on page 433

Usage: Event
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HCOPy:LANGuage <Format>

Defines the format of the printed or saved screenshot.

Parameters:
<Format> GDI | BMP | PNG

GDI
For output on printer
BMP | PNG
File formats for saved screenshots
*RST: PNG

Example: ​chapter 14.3.3.1, "Saving Screenshots to File", on page 433

HCOPy:PAGE:SIZE <Size>

Defines the page size to be used.

Parameters:
<Size> A4 | A5 | B5 | B6 | EXECutive

HCOPy:PAGE:ORIentation <Orientation>

Defines the page orientation.

Parameters:
<Orientation> LANDscape | PORTrait

HCOPy:COLor:SCHeme <ColorScheme>

Defines the color mode for saved and printed screenshots.

Parameters:
<ColorScheme> COLor | GRAYscale | INVerted

INVerted inverts the colors of the output, i.e. a dark waveform is
printed on a white background.
*RST: COLor

Example: ​chapter 14.3.3.1, "Saving Screenshots to File", on page 433

SYSTem:COMMunicate:PRINter:SELect <PrinterName>

Selects a configured printer.

Parameters:
<PrinterName> String parameter

Enter the string as it is returned with ​SYSTem: ​COMMunicate: ​
PRINter: ​ENUMerate: ​FIRSt? ​ or ​SYSTem: ​COMMunicate: ​
PRINter: ​ENUMerate[: ​NEXT]?​.
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SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt?

Queries the name of the first printer in the list of printers. The names of other installed
printers can be queried with the ​SYSTem: ​COMMunicate: ​PRINter: ​ENUMerate[: ​
NEXT]?​ command.

Return values: 
<PrinterName> String parameter

If no printer is configured an empty string is returned.

Usage: Query only

SYSTem:COMMunicate:PRINter:ENUMerate[:NEXT]?

Queries the name of the next printer installed. The ​SYSTem: ​COMMunicate: ​
PRINter: ​ENUMerate: ​FIRSt? ​ command should be sent previously to return to the
beginning of the printer list and query the name of the first printer.

Return values: 
<PrinterName> String parameter

After all available printer names have been returned, an empty
string enclosed by quotation marks (") is returned for the next
query. Further queries are answered by a query error.

Usage: Query only

14.2.14.2 Saving and Loading Data: MMEMory Commands

The Mass MEMomory subsystem provides commands to access the storage media and
to save and reload instrument settings and data.

The R&S RTM has three storage devices indicated as drives:
● /INT: internal storage with default directories for each data type
● /USB_FRONT: USB connector on the front panel
● /USB_REAR: USB connector on the rear panel

Common computer and network drives like C:, D:, \\server\share are not available.

Name conventions

The names of files and directories have to meet the following rules:
● Only the 8.3 format with ASCI characters is supported.
● No special characters are allowed.
● Use / (slash) instead of \ (backslash).

MMEMory:​DRIVes? ​........................................................................................................417
MMEMory:​MSIS ​.............................................................................................................417
MMEMory:​CDIRectory ​....................................................................................................417
MMEMory:​MDIRectory ​...................................................................................................417
MMEMory:​RDIRectory ​....................................................................................................418
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MMEMory:​DCATalog? ​....................................................................................................418
MMEMory:​DCATalog: ​LENGth? ​.......................................................................................419
MMEMory:​CATalog? ​......................................................................................................419
MMEMory:​CATalog: ​LENGth?​..........................................................................................420
MMEMory:​COPY ​...........................................................................................................420
MMEMory:​MOVE ​...........................................................................................................421
MMEMory:​DELete ​..........................................................................................................421
MMEMory:​DATA ​............................................................................................................421
MMEMory:​STORe: ​STATe​...............................................................................................422
MMEMory:​LOAD: ​STATe​.................................................................................................422

MMEMory:DRIVes?

Returns the storage devices available on the R&S RTM.

Return values: 
<Drive> List of strings, for example, "/INT","/USB_FRONT","/USB_REAR"

/INT: internal storage
/USB_FRONT: USB connector on the front panel
/USB_REAR: USB connector on the rear panel

Usage: Query only

MMEMory:MSIS [<MassStorageIS>]

Changes the storage device (drive).

Parameters:
<MassStorageIS> One of the available drives: /INT, /USB_FRONT, or /USB_REAR

Example: MMEM:MSIS '/USB_FRONT'
Sets the USB flash drive connected to the front panel as storage
device to be used.

MMEMory:CDIRectory [<DirectoryName>]

Specifies the current directory for file access.

Setting parameters: 
<DirectoryName> String parameter to specify the directory, including the storage

device.

Example: MMEM:CDIR "/USB_FRONT/DATA"
Example: ​chapter 14.3.3.2, "Saving, Copying, and Loading Setup Data",

on page 433

MMEMory:MDIRectory <DirectoryName>

Creates a new directory with the specified name.
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Setting parameters: 
<DirectoryName> String parameter

Absolute path including the storage device, or relative to the cur-
rent directory.

Example: Create directory DATA on the front USB flash device, with abso-
lute path:
MMEM:MDIR "/USB_FRONT/DATA"

Example: Create directory JANUARY in the DATA directory, with relative
path:
MMEM:CDIR "/USB_FRONT/DATA/"
MMEM:MDIR "JANUARY"

Usage: Setting only

MMEMory:RDIRectory <DirectoryName>

Deletes the specified directory.

Note: All subdirectories and all files in the specified directory and in the subdirectories
will be deleted!

You cannot delete the current directory or a superior directory. In this case, the instrument
returns an execution error.

Setting parameters: 
<DirectoryName> String parameter, absolute path or relative to the current directory

Example: MMEM:RDIR "/INT/TEST"
Deletes the directory TEST in the internal storage device, and all
files and subdirectories in the directory.

Usage: Setting only

MMEMory:DCATalog? <PathName>

Returns the subdirectories of the specified directory. The result corresponds to the num-
ber of strings returned by the MMEMory:DCATalog:LENgth? command.

Query parameters: 
<PathName> String parameter

Specifies the directory.

Return values: 
<FileEntry> String parameter

List of subdirectory strings separated by commas. If the specified
directory does not have any subdirectory, the current and the
parent directories are returned (".,,0","..,,0")
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Example: Query for directories with absolute path:
MMEM:DCAT? "/USB_FRONT/*"
received ".,,0","..,,0","DATA,,0","DATA_NEW,,
0","SCREENSHOTS,,0"
MMEM:DCAT:LENG? "/USB_FRONT/*"
received 5

Example: Query for directories in the current directory:
MMEM:CDIR "/USB_FRONT/DATA/"
MMEM:DCAT? "*"
received ".,,0","..,,0","JANUARY,,
0","FEBRUARY,,0"
MMEM:DCAT:LENG? "*"
received 4

Example: Query with filter:
MMEM:DCAT? "/USB_FRONT/DA*"
received "DATA,,0","DATA_NEW,,0"
MMEM:DCAT:LENG? "/USB_FRONT/DA*"
received 2

Usage: Query only

MMEMory:DCATalog:LENGth? <PathName>

Returns the number of directories in specified directory. The result corresponds to the
number of strings returned by the MMEMory:DCATalog? command.

Query parameters: 
<PathName> String parameter

Specifies the directory.

Return values: 
<FileEntryCount> Number of directories.

Example: see ​MMEMory: ​DCATalog? ​

Usage: Query only

MMEMory:CATalog? <PathName>[,<Format>]

Returns the a list of files contained in the specified directory. The result corresponds to
the number of files returned by the MMEMory:CATalog:LENgth? command.

Query parameters: 
<PathName> String parameter

Specifies the directory. A filter can be used to list, for example,
only files of a given file type.

<Format> ALL | WTIMe
ALL: Extended result including file, date, time and attributes
WTIMe: Result including file, date, time
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Return values: 
<UsedMemory> Total amount of storage currently used in the directory, in bytes.

<FreeMemory> Total amount of storage available in the directory, in bytes.

<FileEntry> String parameter
All files of the directory are listed with their file name, format and
size in bytes.

Example: Query for files in the DATA directory, with absolute path:
MMEM:CAT? "/USB_FRONT/DATA/*.*"
received: 511104,8633856,"MONDAY.TXT,,
8","TUESDAY.CSV,,8"

Example: Query for TXT files in the DATA directory, with relative path:
MMEM:CDIR "/USB_FRONT/DATA"'
MMEM:CAT? "*.TXT"
received: 511104,8633856,"MONDAY.TXT,,8"
MMEM:CAT:LENGTH? "*.TXT"
received 1

Example: ​chapter 14.3.3.2, "Saving, Copying, and Loading Setup Data",
on page 433

Usage: Query only

MMEMory:CATalog:LENGth? <PathName>

Returns the number of files in the specified directory. The result corresponds to the num-
ber of files returned by the MMEMory:CATalog? command.

Query parameters: 
<PathName> String parameter

Directory to be queried, absolute or relative path

Return values: 
<Count> Number of files.

Example: see ​MMEMory: ​CATalog? ​

Usage: Query only

MMEMory:COPY <FileSource>,<FileDestination>

Copies data to another directory on the same or different storage device. The file name
can be changed, too.

Setting parameters: 
<FileSource> String parameter

Name and path of the file to be copied

<FileDestination> String parameter
Name and path of the new file. If the file already exists, it is over-
written without notice.
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Example: MMEM:COPY "/INT/SETTINGS/SET001.SET",
"/USB_FRONT/SETTINGS/TESTSET1.SET"

Example: ​chapter 14.3.3.2, "Saving, Copying, and Loading Setup Data",
on page 433

Usage: Setting only

MMEMory:MOVE <FileSource>,<FileDestination>

Moves an existing file to a new location.

Setting parameters: 
<FileSource> String parameter

Path and name of the file to be moved

<FileDestination> String parameter
Path and name of the new file

Example: MMEM:MOVE "/INT/SETTINGS/SET001.SET",
"/USB_FRONT/SETTINGS/SET001.SET"

Usage: Setting only

MMEMory:DELete <FileSource>

Removes a file from the specified directory.

Setting parameters: 
<FileSource> String parameter

File name and path of the file to be removed. If the path is omitted,
the specified file will be deleted in the current directory. Filters are
not allowed.

Example: ​chapter 14.3.3.2, "Saving, Copying, and Loading Setup Data",
on page 433

Usage: Setting only

MMEMory:DATA <FileName>,<Data>

Writes data to the specified file in the current directory ​MMEMory: ​CDIRectory ​, or reads
the data.

Parameters:
<Data> 488.2 block data

The block begins with character '#'. The next digit is the length of
the length information, followed by this given number of digits pro-
viding the number of bytes in the binary data attached.

Parameters for setting and query: 
<FileName> String parameter containing the file name
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Example: MMEM:DATA "abc.txt",  #216This is the file
#2: the length infomation has two digits
16: the binary data has 16 bytes.
MMEM:DATA? "abc.txt"
received: This is the file

Example: ​chapter 14.3.3.2, "Saving, Copying, and Loading Setup Data",
on page 433

MMEMory:STORe:STATe <StateNumber>,<FileName>

Saves the current device settings to the specified file in the current directory.

Setting parameters: 
<StateNumber> Range: 1  to  1

Increment: 0
*RST: 1

<FileName> String parameter
File name, with or without file extension

Example: MMEM:CDIR "/USB_FRONT/DATA"'
MMEM:STOR:STAT 1,"MORNING.SET"

Example: ​chapter 14.3.3.2, "Saving, Copying, and Loading Setup Data",
on page 433

Usage: Setting only

MMEMory:LOAD:STATe <StateNumber>,<FileName>

Loads the device settings from the specified file in the current directory.

Setting parameters: 
<StateNumber> Range: 1  to  1

Increment: 0
*RST: 1

<FileName> String parameter
File name, with or without file extension

Example: MMEM:CDIR "/USB_FRONT/DATA"'
MMEM:LOAD:STAT 1,"MORNING"

Example: ​chapter 14.3.3.2, "Saving, Copying, and Loading Setup Data",
on page 433

Usage: Setting only
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14.2.15 General Instrument Setup

DISPlay: ​LANGuage​........................................................................................................423
DISPlay: ​LANGuage: ​ADD​................................................................................................423
DISPlay: ​LANGuage: ​REMove ​..........................................................................................423
SYSTem:​NAME ​.............................................................................................................424
SYSTem:​DATE ​..............................................................................................................424
SYSTem:​TIME ​...............................................................................................................424
SYSTem:​SET ​................................................................................................................425
SYSTem:​ERRor: ​[NEXT]? ​................................................................................................425
SYSTem:​ERRor: ​ALL? ​....................................................................................................425
SYST:​PRESet ​...............................................................................................................425

DISPlay:LANGuage <Language>

Sets the language in which the softkey labels, help and other screen information can be
displayed.

Up to four languages can be installed on the instrument. Make sure that the required
language is installed before you set it.

Parameters:
<Language> ENGLish | GERMan | FRENch | SPANish | RUSSian | SCHinese |

TCHinese | JAPanese
Supported languages are listed in the "Specifications" data sheet.
*RST: Reset does not change the language

DISPlay:LANGuage:ADD <Language>,<SourcePath>

Installs the specified language on the instrument. For each language, softkey labels,
display texts, and - if available - the online help are provided. To install or update a lan-
guage or online help, the language file RTM10xx.HMG is required on a USB flash drive.
The language file contains all available languages and online helps. Up to four languages
can be installed on the instrument.

To change the displayed language, use ​DISPlay: ​LANGuage​.

Setting parameters: 
<Language> ENGLish | GERMan | FRENch | SPANish | RUSSian | SCHinese |

TCHinese | JAPanese | KORean

<SourcePath> String parameter containing source path and file

Example: DISP:LANG:ADD GERM,"/USB_FRONT/RTM1054.HMG"
Usage: Setting only

DISPlay:LANGuage:REMove <Language>

Removes the specified language from the instrument.
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Setting parameters: 
<Language> ENGLish | GERMan | FRENch | SPANish | RUSSian | SCHinese |

TCHinese | JAPanese | KORean

Example: DISP:LANG:REM GERM
Usage: Setting only

SYSTem:NAME

Defines an instrument name.

Parameters:
<Name> String with max. 20 characters

SYSTem:DATE <Year>,<Month>,<Day>

Specifies the internal date for the instrument.

Parameters:
<Year> Increment: 1

Default unit: a

<Month> Range: 1  to  12
Increment: 1

<Day> Range: 1  to  31
Increment: 1
Default unit: d

Usage: SCPI confirmed

SYSTem:TIME <Hour>,<Minute>,<Second>

Specifies the internal time for the instrument.

Parameters:
<Hour> Range: 0  to  23

Increment: 1
Default unit: h

<Minute> Range: 0  to  59
Increment: 1
Default unit: min

<Second> Range: 0  to  59
Increment: 1
Default unit: s

Usage: SCPI confirmed
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SYSTem:SET <Setup>

Defines or queries the device settings that can be saved and load manually with FILE >
"Device Settings".

Parameters:
<Setup> 488.2 block data

Usage: SCPI confirmed

SYSTem:ERRor:[NEXT]?

Queries the error/event queue for the oldest item and removes it from the queue. The
response consists of an error number and a short description of the error.

Positive error numbers are instrument-dependent. Negative error numbers are reserved
by the SCPI standard.

Return values: 
<Error> Error/event_number,"Error/event_description>[;Device-depend-

ent info]"
If the queue is empty, the response is 0,"No error"

Usage: Query only
SCPI confirmed

SYSTem:ERRor:ALL?

Queries the error/event queue for all unread items and removes them from the queue.
The response is a comma separated list of error number and a short description of the
error in FIFO order.

Positive error numbers are instrument-dependent. Negative error numbers are reserved
by the SCPI standard.

Return values: 
<Error> List of: Error/event_number,"Error/event_description>[;Device-

dependent info]"
If the queue is empty, the response is 0,"No error"

Usage: Query only
SCPI confirmed

SYST:PRESet

Resets the instrument to the default state, has the same effect as *RST.

Usage: Event
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14.2.16 Status Reporting

14.2.16.1 STATus:OPERation Register

The commands of the STATus:OPERation subsystem control the status reporting
structures of the STATus:OPERation register:

See also:
● ​chapter 14.1.6.1, "Structure of a SCPI Status Register", on page 252
● ​"STATus:OPERation Register" on page 257

The following commands are available:

STATus:​OPERation: ​CONDition? ​.....................................................................................426
STATus:​OPERation: ​ENABle ​...........................................................................................426
STATus:​OPERation: ​NTRansition ​.....................................................................................426
STATus:​OPERation: ​PTRansition ​.....................................................................................426
STATus:​OPERation[:​EVENt]? ​.........................................................................................427

STATus:OPERation:CONDition?

Returns the of the CONDition part of the operational status register.

Return values: 
<Condition> Condition bits in decimal representation. ALIGnment (bit 0) ,

SELFtest (bit 1) , AUToset (bit 2), WTRigger (bit 3).
Range: 1  to  65535
Increment: 1

Usage: Query only

STATus:OPERation:ENABle <Enable>

Parameters:
<Enable> Range: 1  to  65535

Increment: 1

STATus:OPERation:NTRansition <NegativeTransition>

Parameters:
<NegativeTransition> Range: 1  to  65535

Increment: 1

STATus:OPERation:PTRansition <PositiveTransition>

Parameters:
<PositiveTransition> Range: 1  to  65535

Increment: 1
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STATus:OPERation[:EVENt]?

Return values: 
<Event> Range: 1  to  65535

Increment: 1

Usage: Query only

14.2.16.2 STATus:QUEStionable Registers

The commands of the STATus:QUEStionable subsystem control the status reporting
structures of the STATus:QUEStionable registers:

Fig. 14-4: Structure of the STATus:QUEStionable register
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See also:
● ​chapter 14.1.6.1, "Structure of a SCPI Status Register", on page 252
● ​"STATus:QUEStionable Register" on page 257

The following commands are available:

STATus:​PRESet ​............................................................................................................428
STATus:​QUEStionable: ​CONDition? ​.................................................................................428
STATus:​QUEStionable: ​COVerload:​CONDition? ​................................................................428
STATus:​QUEStionable: ​LIMit:​CONDition? ​.........................................................................428
STATus:​QUEStionable: ​MASK:​CONDition? ​.......................................................................428
STATus:​QUEStionable: ​ENABle ​.......................................................................................429
STATus:​QUEStionable: ​COVerload:​ENABle ​......................................................................429
STATus:​QUEStionable: ​LIMit:​ENABle ​...............................................................................429
STATus:​QUEStionable: ​MASK:​ENABle ​.............................................................................429
STATus:​QUEStionable[: ​EVENt]?​.....................................................................................429
STATus:​QUEStionable: ​COVerload[:​EVENt]? ​....................................................................429
STATus:​QUEStionable: ​LIMit[:​EVENt]? ​.............................................................................429
STATus:​QUEStionable: ​MASK[:​EVENt]?​...........................................................................429
STATus:​QUEStionable: ​NTRansition ​................................................................................429
STATus:​QUEStionable: ​COVerload:​NTRansition ​...............................................................429
STATus:​QUEStionable: ​LIMit:​NTRansition ​........................................................................429
STATus:​QUEStionable: ​MASK:​NTRansition ​......................................................................429
STATus:​QUEStionable: ​PTRansition ​.................................................................................430
STATus:​QUEStionable: ​COVerload:​PTRansition ​................................................................430
STATus:​QUEStionable: ​LIMit:​PTRansition ​.........................................................................430
STATus:​QUEStionable: ​MASK:​PTRansition ​......................................................................430

STATus:PRESet

Resets all STATUS:QUESTIONALBLE registers.

Usage: Event

STATus:QUEStionable:CONDition?
STATus:QUEStionable:COVerload:CONDition?
STATus:QUEStionable:LIMit:CONDition?
STATus:QUEStionable:MASK:CONDition?
Returns the contents of the CONDition part of the status register to check for questionable
instrument or measurement states. Reading the CONDition registers does not delete the
contents.

Return values: 
<Condition> Condition bits in decimal representation

Range: 1  to  65535
Increment: 1

Usage: Query only
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STATus:QUEStionable:ENABle <Enable>
STATus:QUEStionable:COVerload:ENABle <Enable>
STATus:QUEStionable:LIMit:ENABle <Enable>
STATus:QUEStionable:MASK:ENABle <Enable>

Sets the enable mask that allows true conditions in the EVENt part to be reported in the
summary bit. If a bit is set to 1 in the enable part and its associated event bit transitions
to true, a positive transition occurs in the summary bit and is reported to the next higher
level.

Parameters:
<Enable> Bit mask in decimal representation

Range: 1  to  65535
Increment: 1

Example: STATus:QUEStionable:MASK:ENABle 24
Set bits no. 3 and 4 of the STATus:QUEStionable:MASK:ENABle
register part: 24 = 8 + 16 = 23 + 24

STATus:QUEStionable[:EVENt]?
STATus:QUEStionable:COVerload[:EVENt]?
STATus:QUEStionable:LIMit[:EVENt]?
STATus:QUEStionable:MASK[:EVENt]?
Returns the contents of the EVENt part of the status register to check whether an event
has occurred since the last reading. Reading an EVENt register deletes its contents.

Return values: 
<Event> Event bits in decimal representation

Range: 1  to  65535
Increment: 1

Usage: Query only

STATus:QUEStionable:NTRansition <NegativeTransition>
STATus:QUEStionable:COVerload:NTRansition <NegativeTransition>
STATus:QUEStionable:LIMit:NTRansition <NegativeTransition>
STATus:QUEStionable:MASK:NTRansition <NegativeTransition>

Sets the negative transition filter. If a bit is set, a 1 to 0 transition in the corresponding bit
of the condition register causes a 1 to be written in the corresponding bit of the event
register.

Parameters:
<NegativeTransition> Bit mask in decimal representation

Range: 1  to  65535
Increment: 1

Example: STATus:QUEStionable:MASK:NTRansition 24
Set bits no. 3 and 4 of the STATus:QUEStionable:MASK:NTRan-
sition register part: 24 = 8 + 16 = 23 + 24
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STATus:QUEStionable:PTRansition <PositiveTransition>
STATus:QUEStionable:COVerload:PTRansition <PositiveTransition>
STATus:QUEStionable:LIMit:PTRansition <PositiveTransition>
STATus:QUEStionable:MASK:PTRansition <PositiveTransition>

Sets the positive transition filter. If a bit is set, a 0 to 1 transition in the corresponding bit
of the condition register causes a 1 to be written in the corresponding bit of the event
register.

Parameters:
<PositiveTransition> Bit mask in decimal representation

Range: 1  to  65535
Increment: 1

Example: STATus:QUEStionable:MASK:PTRansition 24
Set bits no. 3 and 4 of the STATus:QUEStionable:MASK:PTRan-
sition register part: 24 = 8 + 16 = 23 + 24

14.3 Programming Examples

14.3.1 Data Export

14.3.1.1 Reading Waveform Data from Memory

Set data format and sample range, read channel header and data.

Command description in ​chapter 14.2.3, "General Remote Settings and Queries",
on page 267 and ​chapter 14.2.4.5, "Waveform Data", on page 283.

* Connected to: TCPIP0::192.168.1.1::inst0::INSTR
SYST:ERR?
<-- 0,"No error"
*IDN?
<-- Rohde&Schwarz,RTM1052,1305.0008K52/101489,04.502

*RST
CHAN:TYPE HRES            // Set high resolution mode (16 bit data)
ACQ:WRAT MSAM             // Set maximum waveform rate
TIM:SCAL 1E-7             // Set time base
FORM REAL                 // Set REAL data format 
FORM:BORD LSBF            // Set little endian byte order
CHAN:DATA:POIN DMAX       // Set sample range to memory data in displayed time range
SING;*OPC?                // Start single acquisition
<--  1
CHAN:DATA:HEAD?           // Read header
<--  -4.9980E-07,5.0000E-07,5000,1    // Xstart, Xstop, record length in samples
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CHAN:DATA?                // Read channel data
<--  #520000>??[>??[>??[>??[>??[>??...   // Binary block data, 
                                         // 4-byte floating point number/sample

14.3.1.2 Reading Waveform Data in Unsigned Integer Format

Read the channel header, the waveform conversion data, set the UINT binary data format
and read the channel data.

Command description in: ​chapter 14.2.3, "General Remote Settings and Queries",
on page 267.

*RST
TIM:SCAL 1E-7
CHAN:DATA:POIN DMAX       // Set data range
SING;*OPC?
<--  1
CHAN:DATA:HEAD?           // Read header
<--  -4.9980E-07,5.0000E-07,5000,1    // Xstart, Xstop, record length in samples
CHAN:DATA:YRES?           // Read vertical resolution
<--  8
CHAN:DATA:YOR?            // Read voltage value for binary value 0
<--  -2.549999943E-2
CHAN:DATA:XOR?            // Read time of the first sample
<--  -4.998000058E-7
CHAN:DATA:XINC?           // Read time between two adjacent samples                
<--  2.000000023E-10
FORM UINT,8;FORM?         // Set data format to unsigned integer, 8 bit
<--  UINT,8
CHAN:DATA:YINC?           // Read voltage value per bit
<--  1.999999949E-4
CHAN:DATA?                // Read channel data
<--  128,125,120...       // 5000 bytes total
FORM UINT,16;FORM?        // Change data format to unsigned integer, 16 bit
<--  UINT,16
CHAN:DATA:YINC?           // Read voltage value per bit
<--  7.812499803E-7
CHAN:DATA?                // Read channel data
<--  32768,32000,30720... // 10000 bytes total

Note the following correlations:
● The number of received data values matches the number of samples indicated in the

header.
● The time of the first sample (XORigin) matches the start time Xstart indicated in the

header.
● The Y-increment adjusts to the data length defined in the data format (8 or 16 bit).

Data conversion

Definition: the sample numbers start with 0 and end with record length - 1.
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Sample time

tn = n * xIncrement + xOrigin

First sample: t0 = -4.998000058E-7 (= Xstart)

Last sample: t4999 = 4999 * 2E−10 − 4.998E−7 = 5.0 E−7 (= Xstop)

Sample value

Yn = yOrigin + (yIncrement * byteValuen)

The format UINT,8 has the data range 0 to 255. The voltage value for byte value 128 is:

Yn = −2.55E-2 + (2E−4 * 128) = 0.0001

The center of the display at position 0 div always has the byte value 127.5. The corre-
sponding voltage value is:

Yn = −2.55E-2 + (2E−4 * 127.5) = 0

8-bit and 16-bit data

At the end of the above example, the 8-bit waveform is read as 16-bit data, for example,
0xFF is read 0xFF00, or 0x1A is read 0x1A00. The yOrigin value is the same in both
cases, but the yIncrement differs.

 8-bit data 16-bit data Result

yIncrement * byteValuen

2e-4 * 128 7,8125E-7 * 32768 0,0256 V

2e-4 * 125 7,8125E-7 * 32000 0,025 V

In the reverse case, if a 16-bit waveform is read with 8-bit data format, data precision may
be reduced. Data values ar truncated, and only the more significiant bits remain. For
example, the 16-bit data 0xabcd is read 0xab in 8-bit format, and cd is lost.

14.3.2 Search

14.3.2.1 Searching for a Pulse of Specified Width

Search for positive pulses with pulse width 12 ± 10 µs (2 µs to 22 µs).

Command description in: ​chapter 14.2.12, "Search", on page 343.

SEAR:STAT ON                // Turn on search
SEAR:COND WIDTH             // Select search condition
SEAR:SOUR CH2               // Configure search source
SEAR:TRIG:WIDT:POL POS      // Configure search parameters: Polarity
SEAR:TRIG:WIDT:RANG WITH    // Configure search parameters: Condition = within
SEAR:TRIG:WIDT:WIDT 12e-6   // Configure search parameters: Pulse width
SEAR:TRIG:WIDT:DELT 10e-6   // Configure search parameters: +/- delta
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SEAR:RESD:SHOW ON           // Show result table
SEAR:RCO?                   // Get number of search events found
<--  1.400E+01 
SEAR:RES:ALL?               // Get all search results 
<--  1,5.201200e-06,0,WIDTH,POSITIVE,1.220160e-05,2,4.120040e-05,0,WIDTH,
POSITIVE,3.076800e-06,3,4.732480e-05,0,WIDTH,POSITIVE,9.127200e-06,4,
6.499960e-05,0,WIDTH,POSITIVE,1.835160e-05,5,8.634920e-05,0,WIDTH,POSITIVE,
3.052000e-06,6,1.293984e-04,0,WIDTH,POSITIVE,9.176800e-06,7,1.477228e-04,0,
WIDTH,POSITIVE,3.052000e-06,8,1.623224e-04,0,WIDTH,POSITIVE,3.102000e-06,9,
1.684724e-04,0,WIDTH,POSITIVE,1.215160e-05,10,1.953216e-04,0,WIDTH,POSITIVE,
3.027200e-06,11,2.044716e-04,0,WIDTH,POSITIVE,6.052000e-06,12,2.252212e-04,0,
WIDTH,POSITIVE,3.052000e-06,13,2.435456e-04,0,WIDTH,POSITIVE,3.027200e-06,14,
2.496456e-04,0,WIDTH,POSITIVE,6.702000e-06

14.3.3 Data and File Management

14.3.3.1 Saving Screenshots to File

Save two display images in png format to the PIX folder on a USB flash drive that is
connected to the front panel. One screenshot is colored and the other is grayscaled.
Finally, the data of the gray screenshot is read for further user on the control computer.

Command description in: ​chapter 14.2.14.1, "Screenshots", on page 413.

*RST
MMEM:CDIR "/USB_FRONT"
MMEM:MDIR "/USB_FRONT/PIX"
MMEM:CDIR "/USB_FRONT/PIX/"

HCOP:DEST "MMEM"
HCOP:LANG PNG
HCOP:COL:SCH COL
MMEM:NAME "COLORED"
HCOP:IMM
HCOP:COL:SCH GRAY
MMEM:NAME "GRAY"
HCOP:IMM

MMEM:CAT? "*.PNG"
MMEM:DATA? "GRAY.PNG"

14.3.3.2 Saving, Copying, and Loading Setup Data

Save instrument settings to a file on internal storage device, duplicate this file and save
it to a USB stick attached to the front panel. Finally, there are three setup files on the
internal storage /INT/SETTINGS, and one file on the USB flash device.
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Command description in: ​chapter 14.2.14.2, "Saving and Loading Data: MMEMory Com-
mands", on page 416.

CHAN1:STAT ON                       // Turn channel 1 on
CHAN2:STAT ON                       // Turn channel 2 on
TIM:ZOOM:STAT ON                    // Show zoom diagram
MMEM:CDIR "/INT/SETTINGS"           // Set storage device and directory
MMEM:STOR:STAT 1,"ZOOM_A.SET"       // Save settings to internal storage 
MMEM:CAT? "*.SET"                   // Check
<--  332112,8633856,"ZOOM_A.SET,,2759"
MMEM:COPY "ZOOM_A.SET","ZOOM_B.SET" // Copy file
MMEM:CAT? "*.SET"                   // Check
<--  332112,8633856,"ZOOM_A.SET,,2759","ZOOM_B.SET,,2759"
MMEM:COPY "/INT/SETTINGS/ZOOM_B.SET","/USB_FRONT/ZOOM_B.SET"
                                    // Save copied file to USB stick
MMEM:CDIR "/USB_FRONT"              // Check
MMEM:CAT? "*.SET"
<--  4890624,-641765376,"ZOOM_B.SET,,2759"
MMEM:COPY "/USB_FRONT/ZOOM_B.SET","/USB_FRONT/ZOOM_USB.SET"
                                    // Duplicate file on USB stick
MMEM:CAT? "*.SET"                   // Check
<--  4890624,-641765376,"ZOOM_B.SET,,2759","ZOOM_USB.SET,,2759"
MMEM:DEL "ZOOM_B.SET"               // Delete original file
MMEM:CAT? "*.SET"                   // Check
<--  4886528,-641765376,"ZOOM_USB.SET,,2759"
MMEM:COPY "/USB_FRONT/ZOOM_USB.SET","/INT/SETTINGS/"
                                    // Copy new file to the instrument
MMEM:CDIR "/INT/SETTINGS"           // Check
MMEM:CAT? "*.SET"   
<--  332112,8633856,"ZOOM_A.SET,,2759","ZOOM_B.SET,,2759","ZOOM_USB.SET,,2759"
*RST;*OPC?
<--  1
MMEM:CDIR "/INT/SETTINGS"
MMEM:LOAD:STAT 1,"ZOOM_USB.SET"     // Load settings
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